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Preface

At its 26" meeting in Brest, France, in October 2010, the GEBCO Guiding Committee (GGC)
approved a proposal from its Technical Sub-Committee on Ocean Mapping (TSCOM) that they
prepare a publication to be called the "GEBCO Cook Book" to provide an educational resource
for a wide range of persons interested in preparing gridded datasets from bathymetric data.

This publication includes inputs from a wide range of individuals and organizations all of whom
are experts in their respective fields, as set out in more detail in the opening pages and in Chapter
1. Itis intended that this will be a living document that will be maintained on a continuous basis
as new or amended techniques and software become available. Future updates will be prepared
by the Chief Editor under the direction of TSCOM and endorsed by the GGC. Dr. Karen Marks
of NOAA has acted as the Chief Editor on behalf of TSCOM for the preparation of the initial
text.

The initial text was endorsed by the GGC at its 28" meeting in San Diego, USA, in October
2011, adopted by the IHO as announced in CL 47/2012 in May 2012, and approved by the IOC
Executive Council in October 2012,

The IHO-10C GEBCO Cook Book, IHO Publication B-11, is available for free download via
links from the GEBCO web site (http://www.gebco.net) and the IHO Publication download web
page http://www.iho.int/iho_pubs/IHO Download.htm. This publication is also available as I0OC
Manuals and Guides, 63 on the IOC website http://www.ioc-unesco.org/documents.

The citation format is:
International Hydrographic Organization, Intergovernmental Oceanographic Commission, The

IHO-10C GEBCO Cook Book, IHO Publication B-11, Monaco, Dec. 2015, 429 pp — 10C
Manuals and Guides 63, France, Dec. 2015, 429 pp.
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Chapter 1.0 Introduction

GEBCO, the General Bathymetric Chart of the Oceans, is a joint project of the International
Hydrographic Organization (IHO) and the Intergovernmental Oceanographic Commission (I0C)
bringing together an international group of experts whose aim is to provide the most authoritative
publicly available bathymetry of the world's oceans, for scientific and educational use. GEBCO
welcomes and encourages new contributions of data and expertise from all over the world.

One of GEBCO's products is a global gridded bathymetry data set. This grid contains depth
(and, on land, elevation) estimates on a 30 arc-second mesh, which near the equator is about a
one-kilometer spacing. Over the oceans, seafloor depths are from ship soundings, and where
there are no soundings depths are interpolated, using estimates from satellite altimetry as a guide.
The global bathymetry grid is periodically updated by incorporating additional bathymetric
survey data, new compilations, and improved data. With this document, the "GEBCO Cook
Book," we hope to enable more people to contribute data and gridded compilations to GEBCO.

The Cook Book contains chapters that span basic to advanced topics. These have been written
by expert GEBCO contributors from more than a dozen international research organizations,
universities, governments, and companies. The Cook Book is a "living document"” that will be
continually updated and expanded as new contributions are received, and as the GEBCO
community's sense of best practices evolves. The Cook Book is available for free download
from the GEBCO website (http://www.gebco.net).

Approach

The Cook Book is composed of three main sections- "Gridding Examples,” "Fundamentals,” and
"Advanced Topics."
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Cookbook Sections

Gridding Examples Fundamentals Advanced Topics

Ch. 2: Creating a Grid from Ch. 3: Gathering Software Ch. 10: Uncertainty
XYZ Data
Ch. 4: Software Overview Ch. 11: LANDSAT &
Satellite-Derived
Ch. 5: Gathering Data Bathymetry
Ch. 6: Data Cleaning Ch. 12: Digital Terrain Map
Editing
Ch. 7: Metadata
Documentation Ch. 13: Maosaics in Caris
Ch. 8: Gridding Data Ch. 14: Nautical Chart
Adequacy
Ch. 9: Data Analysis
Techniques
R / -\\,

We start with gridding examples so that beginning users desiring to straightaway produce a grid
from xyz data can do so by delving into the first section. We make available an example xyz
data set through Internet download and also show an alternate method to obtain it through the
National Centers for Environmental Information (NCEI) website. A brief overview of gridding
software packages, some of which are freely available for download from the Internet, is
provided. lllustrated step-by-step instructions that include command lines to process and grid
Xyz data using the various software packages are listed. The command lines can be cut-and-
paste onto the user's computer and, along with the example xyz data, the user can reproduce the
results shown in the Cook Book and then apply the same technique to their own data. The
results are displayed in maps and plots that can be reproduced with the given command lines as
well. This step-by-step approach also allows us to encourage users, once they are familiar with
running the example command lines and producing grids and maps, to try changing the
command options so that they can see for themselves how the changes affect the final result.

The second section, "Fundamentals,” gives a more in-depth look at topics related to preparing,
processing, and gridding xyz data. An overview of various gridding software packages,
including ArcGIS, CARIS HIPS, Generic Mapping Tools (GMT), r2v, Surfer, and Global
Mapper, is included. Also covered are the topics of data cleaning, assessing data quality,
validation, metadata documentation, discussion on the various gridding techniques and data
analysis techniques.
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The third section, "Advanced Topics," contains discussions that more experienced users may
find useful. Uncertainties are covered in detail- its sources, and methods of measurement
including Monte Carlo and Network techniques, windowed regression, error growth models, and
more. Methods of sharing uncertainty results in the form of ASCII, netCDF, and "BAG" files is
included. There are also chapters on deriving bathymetry from LANDSAT 8 satellite data,
digital terrain map editing using DTMediting software, creating mosaics using CARIS software,
and procedures for assessing nautical chart adequacy.

Lastly, three Annexes are provided. Annex on Additional Resources enables the user to find
more information and includes a list of websites from institutions and organizations that make
multibeam data available for public Internet download. An Annex containing a Glossary as well
as an Annex with Acronyms and Abbreviations are also provided.

We note that the IHO, 10C, GEBCO, and the contributing authors and institutions do not endorse
or promote any particular software package or software provider. The information in this
document is provided to benefit the user in good faith but the accuracy and completeness cannot
be guaranteed.
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GRIDDING EXAMPLES

Chapter 2.0 Creating a Grid from XYZ Data

This chapter provides step-by-step instructions that will show a user how to process and grid xyz
data. Anexample data set is made available so the user can follow along on their own computer.

2.1 Gridding XYZ Data with Generic Mapping Tools (GMT)
Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA
Updated by Karolina Chorzewska, University of New Hampshire, USA

2.1.1 Downloading Example Data Set

In this section we demonstrate how to create a grid from xyz bathymetry data. The data set used
in this demonstration is available for download from
ftp://ftp.star.nesdis.noaa.gov/pub/socd/lsa/karen/outgoing/ngdc.topo.xyz

These data may also be downloaded directly from the NOAA National Centers for
Environmental Information (NCEI, formerly NGDC) website as follows. First, access the
GEODAS (GEOphysical DAta System) webpage at http://www.ngdc.noaa.gov/mgg/gdas/,
which is shown in Fig. 2.1.

) NATIONAL GEOPHYSICAL
Ingt’ DATA CENTER SEARCH NGDE

NOAA > NESDIS > NGDC > MGG > marine geophysics privacy polic
n: ion physi

“ GEODAS Search and Data Retrieval Systems

NGDC's GEOphysical DAta System (GEODAS) allows On-line Searches and data Retrieval of several of
NGDC's gecphysical databases, including Marine Trackline Geophysics Data, Aeromagnetic Survey Data, the
NOS Hydregraphic Surveys database, US Coastal Relief Model Grids, Great Lakes Bathymetry Grids and
ETOPO1 Global Relief Grids

GEODAS Data Systems

* Marine Trackline Geophysics ArcGIS Map System

* NOS Hydrographic Surveys ArcGIS Map System

+ Aeromagnetic Surveys

* Grid Translator Design-a-Grid

NOAA > NESDIS > NGDC > MGGD > Marine Geology & Geophysics Questions: trackline.info@noaa.gov

NGDC Home | Contacts | Data | Disclaimers | Education | News | Privacy Policy | Site Map

Figure 2.1 NOAA National Centers for Environmental Information (NCEI) GEODAS website

Select "Marine Trackline Geophysics ArcGIS Map System” to reach the Geophysical Survey
Data web page (see Fig. 2.2 below).
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NATIONAL GEOPHYSICAL
. DATA CENTER ...,

v

Switch to Arctic View witch to Antarctic View

Posil 85.957,50402

MOAA > NESDIS > NGDC > Maps > Geophysical Survey Data
= : — -

Geophysical Survey Data

National Geophysical Data Center

Privacy Policy

Select Basemap ~ ‘ More..

AlTARE e

Layers

Marine Surveys:
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& Clear Selection.

Legend

More Information
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Figure 2.2 Geophysical Survey Data web page.

Check “Bathymetry” in the “Layers” window on the right side of the screen (Fig. 2.2). Click the

XY icon (“ldentify with Coordinates”) in the top-left corner of the map (also Fig. 2.2). It will

open a “Specify an Area of Interest” window (see Fig 2.3 below). Our data set ranges from 15 to
20 N latitude, and from 150 to 154 E longitude. The user should enter these geographic
coordinates into the corresponding boxes, and then press “OK.”

NATIONAL GEOPHYSICAL
) DATA CENTER

Position: -128.145, 57.232

Geophysical Survey Data

Privacy Policy|

Specify an Area of Interest

North: [20

West: [150 | East: [154

South: |15

Latitude: -85 to 85, Lorgitude: - 150 to 150
(sigrea cecmal aegrees)

Layers

Marine Surveys:

|_| All Parameters (5682 surveys)
[¥] Bathymetry (5137 surveys)
|| Gravity {1994 surveys)

|_| Magnetics (2869 surveys)

] Multi-Channel Seismics (93

— surveys)
|| Seismic Refraction (99 surveys)
| Shot-Point Navigation (251
— surveys)
|_| Side Scan Sonar (46 surveys)
= Single Channel Seismics (1356
surveys)
| Subbottom Profile (452 surveys)

E"_? Find Marine Surveys_

Airborne Surveys:
|| Aeromagnetics (104 surveys)
E% Find Airborne Surveys

&7 Clear Selection

Legend
More Information

Help
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Figure 2.3 Geographic boundaries selection window.

The specified area’s boundary is now shown on the map and available surveys are listed in the
“Identified Features” window (see Fig. 2.4 below).

&) NATIONAL GEOPHYSICAL i
L N()A,A DATA CENTER Geophysical Survey Data
= J L

National Geaphysical Data Center

OAA > NESDIS > NGDC > Maps > Geophysical Survey Data Privacy Policy]

Layers
Marine Surveys:

[ ] All Parameters (5682 surveys)
[¥| Bathymetry (5137 surveys)
[ Gravity (1994 surveys)

I:‘ Magnetics (2869 surveys)

Multi-Channel Seismics (83
surveys)

[] seismic Refraction (99 surveys)

Shot-Point Navigation (251
surveys)

["] side Scan Sonar (46 surveys)

Single Channel Seismics (1356
Ssurveys)

[ ] subbottom Profile (452 surveys)

B3 Find Marine Surveys

Airborne Surveys:
D Aeromagnetics (104 surveys)
E’ Find Airborne Surveys

|7 Clear Selection

85002211 (1985)
Bathymetry
RC2610 (1985)

Legend

Switch to Arctic View il Switch to Antarctic View S i 3 ; || More Information

Position: 161.396,20220  s=""-o=""1,, \ 5 Help

Figure 2.4 Search results image.

Select “Get Marine Data.” The results of the search are displayed (see Fig. 2.5 below). Select
“Download MGD77-type Data.”
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Search Criteria:

SEARCH LIMITS:
20.000
150.000

SURVEYED PARAMETERS:
Bathymetric Soundings

154.000

NOAA >NESDIS >NGDC >Marine Gealogy & Geophysics >Geophysics
@ NATIONAL GEOPHYSICAL
N DATA CENTER

sillllr Search Results Listing 2013/06/03

Search Key: GD190646

Trackline Geophysical Data Summary

Defense Mapping Agency

Scurce  NGDC-Id  HNav Bath Mag Grav SC Seis MC Seis Sub-Bot Shot-Pt

10075 35320002 digital digital data plot

27474 35320001 digital digital data plot
France IFREMER

Scurce  NGDC-Id  HNav Bath Mag Grav SC Seis MC Seis Sub-Bot Shot-Pt

85002211 67010148 digital digital digital data plot
Hawaii, U of

Scurce  NGDC-Id  HNav Bath Mag Grav SC Seis MC Seis Sub-Bot Shot-Pt

76010301 08010077 ana+dig digital analog analog analog data plot

76010302 08010033 ana+dig digital ana+dig ana+dig analog analog data plot

77031703 08010067 ana+dig digital ana+dig ana+dig analog analog data plot

81062603 08010081 ana+dig digital digital digital analog analog data plot

81062604 08010061 ana+dig anatdig digital digital analog analog data plot

MHBB0S 08020050 ana+dig digital digital digital analog analog data plot
Japan Hydrographic Dept

Source NGDC-Id  Nav Bath Mag Grav 8C Seis MC Seis Sub-Bot Shot-Pt

HS02TS63 J1020060 digital digital digital digital data plot

HTO0TS21 J1010134 digital digital digital digital data plot

HT02T562 J1010139 digital digital digital digital data plot

privacy policy]
Marine Trackline
Data

Download MGD77-type Data

Figure 2.5 Portion of Search Results web page.

The desired format of the downloaded data can be designated next (see Fig. 2.6 below). For our

data set, select "Single File of All Survey Data in Area," "Space Delimited XYZ Format," and
select Longitude, Latitude, and Corrected Depths (meters) in the box. Then press the "Process

Digital MGD77T-type Data" button.

NOAA > NESDIS > NGDC > Marine Geology & Geophysics > Geophysics

4 NATIONAL GEOPHYSICAL
H DATA CENTER

wiillly Process MGD77T-type Digital Data for Download @1l

Reset | | Process Digital MGD77T-type Data |  Skip This |

(+) Single File of All Survey Data in Area
() Multiple Survey Files, Data in Search Area

() Multiple Survey Files, Complete Surveys

1 Download File-saving Options

Longitude

Latitude
%2 Format of Output Data (choose z field)
Uncx ted Depth (meters)
Carrected Depth (meters)
Mag Total Field (gammas)
Mag Res. Field (gammas)
Grav Observed (mgals)
Grav Free Air (mgals)

(_JMGD?7T Tab-Delimited Format
Legacy MGD77 ASCII Exchange Format
(*)Space Delimited XYZ Format

Download Only Records containing selected Parameters:

ALL PARAMETERS

Bath 2-|
Bath Corrected Depth
Mag Total Field 1
Mag Total Field 2
Mag Residual Field
Grav Observed

Grav Free Alr

Seis Shot Pt Num

[“JUse legacy NGDC Numbers for survey file names

privacy poiic

Marine Geophysical Data
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Figure 2.6 Download Format web page.

A web page notifying the user that the data have been processed and are available for retrieval
comes up next (see Fig. 2.7 below). Press the "Compress and Retrieve Your Data" button. The
GEODAS system has assigned the arbitrary name "GD190646" to the data set.

NOAA >NESDIS >NGDC >Marine Geology & Geophysics >Geophysics privacy policy
y

& NOAA NATIONAL GEOPHYSICAL Marine Trackline 03
() DATA CENTER ne %)
\t Data_

silllly GD190646 Data Processed! Compress and Retrieve @help

Space delimited XYZ Format: lat, lon, corrected depth in meters
Processing only records containing:

Bathymetry Corrected Depth
Output Single File with all Survey Data

Process for Download Progress

Ll.l.l. Il.l.ll.l.ll 43 Surveys Processed for Download

Open log file to view download details and diagnostics.

Compress and Retrieve Your Data |

| Include NG Wind ftware for loads Ver 1.0.2 (6mb) 2
| Include GSHHG Geography/Shorelines (158mb) T4
(] Include GEODAS Coastlines (24mb)

disclaimers

Website of the US Dept of Commerce/NOAA/NESDIS/NGDC, last update Jan 10, 2006
Questions: trackline.info@noaa.qov

Figure 2.7 Compress and Retrieve data web page.

The next web page provides information about retrieving the data (see Fig. 2.8 below). Push the
"Retrieve" button to download the data set. If the download file size is particularly large, select
"Retrieve Compressed File" next to the retrieve button to reduce the size of the download file.
The data file is then downloaded onto the user's computer.

NOAA >NESDIS >NGDC >Marine Geology & Geophysics >Geophysics privacy policy
< NATIONAL GEOPHYSICAL Marine Trackline €%
L) DATA CENTER e rockine )
waillly Retrieve Data for Key GD190646

[Compressed data saved as file GD190646.zip.To Retrieve your compressed data simply click on the Retrieve Button below and save the file to your computer. (If you do not see a Save Dialog, you
can click Retrieve Button with your right (secondary) mouse button.) Uncompress the file and see files readme.txt and help.htm for further information.

Retrieve up|

Retrieve Compressed File

If you wish to wait and retrieve the data later, go to folder www.nadc.noaa.gov/maa/tmp/1/gtrk/ and bookmark that page. Your file GD190646.zip will be available for 24 hours

(Once you have successfully retrieved your data files to your computer, you can remove them from the NGDC Server by clicking the button below. This will free up space for other jobs.

Delete files from Server

disclaimers

Website of the US Dept of Commerce/NOAA/NESDIS/NGDC, last update Nov 8, 2012
Questions: trackiine.info@noas.qov

Figure 2.8 Retrieve download.
The data are downloaded (or uncompressed) as a directory (e.g., geodas_ GD190646) on the

user’s computer. Within the directory are documents, readme information, and the data file
(GD190646.xyz). We chose to rename the xyz data set "ngdc.topo.xyz."
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2.1.2 Generic Mapping Tools (GMT)

GMT (Generic Mapping Tools) (Wessel and Smith, 1998) is a collection of open source
mathematical and mapping routines for use on gridded data sets, data series, and arbitrarily
located data. The GMT package is available for download from the University of Hawaii
website (http://gmt.soest.hawaii.edu/) (see Fig. 2.9). We utilized GMT routines for our gridding
and mapping examples shown in this section. Actual GMT command lines are provided in the
discussions that follow.

Overview  Activity  Roadmap  lssuss Mm Farums

What is GMT?

The GMT World Domination

Podeasts
References

Wiki

Start page
Index by title
Index by date

T release around the world based on web traffic. Each colored circle in the map above represents a
nioaded GMT. Download geolocation is based on © MaxMind's freely available Geolite data

s &

Figure 2.9 University of Hawaii website for GMT.
2.1.3 Plotting Data with GMT

It is desirable to plot the xyz data on a map to see the locations of the points. The xyz data may
be plotted on a map using Generic Mapping Tools (GMT).
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http://gmt.soest.hawaii.edu/

XYZ Points
W o

18" A -7 =
— ./ ".r
i A
_ A
16° *{
» o —
S A

150° 152° 154°

Figure 2.10 Map of XYZ point locations.
Figure 2.10 (above) was produced with the following GMT commands:

psbasemap -R150/154/15/20 —Im0.5 -Ba2f1:."XYZ Points":WeSn -K > Fig.2.10.ps
psxy ngdc.topo.xyz -R -Jm -Sp -O >> Fig.2.10.ps

It is useful to note the distribution of the data points. In the center of the map there are few ship
tracks, leaving large areas with no bathymetry measurements. In the northeastern corner, there is
systematic survey coverage.

2.1.4 Gridding XYZ Data with GMT

It is possible to create a grid from the randomly located xyz data points. GMT routine "surface"
is an adjustable tension continuous curvature gridding algorithm that can be used to grid the xyz
data. We input the xyz data into "surface," setting the tension factor to 0.25 (surface tension set
to "0" gives the minimum curvature solution, and set to 1" gives a harmonic surface where
maxima and minima are only possible at control points). Figure 2.11 (below) shows the
resulting grid.
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Grid from XYZ Points

-6000 -3000 0
Depth, m

Figure 2.11 Grid of XYZ data points, using GMT “surface” with tension set to 0.25.
The GMT commands used to produce the gridding solution and plot it in Fig. 2.11 follow.

surface ngdc.topo.xyz -R150/154/15/20 -I1m -T0.25 -Gngdc.topo_grd

grdgradient ngdc.topo_grd -AO -Ne0.2 -Ggrad_grd

grdimage ngdc.topo_grd -Igrad_grd -Ctopo.cpt -Jm0.5 -K>Fig.2.11.ps

pscoast -G175 -R150/154/15/20 -Jm0.5 -W2 -Df -Ba2f1:."Grid from XYZ Points":WeSn
-K -O>>Fig.2.11.ps

grdcontour ngdc.topo_grd -R -Jm -C1000 -W1 -K -O>>Fig.2.11.ps

psscale -D1/-.5/2/.125h -Ctopo.cpt -Ba3000g1000:"Depth, m": -I -N300 -O >>Fig.2.11.ps

The color palette table (topo.cpt) is:

-7000 300 .350000 .85 -6500 275.625 .350000 .85
-6500 275.625 .300000 .90 -6000 250.3125 .300000 .90
-6000 250.3125 .300000.90 -5500 225 .300000 .90
-5500 225 .300000 .90 -5000 199.6875 .300000 .90
-5000 199.6875 .300000 .90 -4500 175.3125 .300000 .95
-4500 175.3125 .300000 .95 -4000 150 .350000 .95
-4000 150 .350000 .95 -3500 125.625 .350000 .95
-3500 125.625 .350000 .95 -3000 99.375 .350000 .95
-3000 99.375 .350000 .95 -2500 75 .350000 .95
-2500 75 .350000 .95 -2000 50.625 .350000 .95
-2000 50.625 .350000 .95 -1500 25.3125 .350000 .95
-1500 25.3125 .350000 .95 -500 10 .250000 .85
-500 10 .200000.85 O 10 .150000 .80
B 300 .350000 1

F 0 0.00000 1.0

The color palette file above specifies the depth ranges (in meters) over which colors are assigned
by the HSV (Hue, Saturation, Value) color system. The color palette file is entered into GMT
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routine “grdimage” above via the “-C” command line argument. Online GMT documentation
(http://gmt.soest.hawaii.edu) provides details about color palette files and various color systems.

There are other algorithms that can be used to grid the xyz data points, and each will produce a
different solution; the differences are most evident in areas where there are large gaps between
measurements. Changing the tension parameter in GMT "surface™ will also produce a different
solution. "Nearneighbor" uses a nearest neighbor algorithm to assign an average value within a
radius centered on a node. "Triangulate™ performs optimal Delaunay triangulation. We show the
results of GMT "surface," "nearneighbor," and "triangulate” gridding algorithms below.

Surface w/T0 Surface w/T1

150° 152° 154°  150° 152° 154°
-6000 -3000 0 -6000 -3000 0
Depth, m Depth, m
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Nearest Neighbor Triangulate

-6000 -3000 0 -6000 -3000 0
Depth, m Depth, m

Figure 2.12 Results of gridding XYZ data (black dots) with GMT gridding routines “surface” with tension
set to O (top left) and set to 1 (top right), “nearneighbor” (bottom left), and “triangulate” (bottom right).

The command lines used for the corresponding GMT gridding routines follow. The commands
to plot the figures are the same as listed for Fig. 2.11, and the color palette file is the same.

surface ngdc.topo.xyz -R150/154/15/20 -I1m -TO -Gngdc.topo_grd

surface ngdc.topo.xyz -R150/154/15/20 -I1m -T1 -Gngdc.topo_grd

nearneighbor ngdc.topo.xyz -R150/154/15/20 -N4/1 -S100k -I11m -Gngdc.topo_grd
triangulate ngdc.topo.xyz -R150/154/15/20 -11m -Gngdc.topo_grd > junk

Each gridding algorithm produces a very different result because each one uses a different
method of interpolating depth estimates in the gaps between data points. Where the gaps are
large, areas of shallower seafloor (orange-yellow colored anomalies) appear to follow the ship
tracks. This is because ships collect depth measurements along one-dimensional tracks without
detecting seafloor away from the track. Seafloor can be mapped in two dimensions when the
survey coverage is adequate (for example, in the northeast corner of the study area).

Bathymetry models that estimate depths from a combination of ship measurements and depths

derived from satellite gravity can also map the seafloor in two dimensions. Fig. 2.13 below
shows the Smith and Sandwell (1997) bathymetry model (version 13.1) over our study area.
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Satellite Bathymetry

-6000 -3000 0
Depth, m

Figure 2.13 Grid of estimated depths from altimetric bathymetry model, black dots are ship controls used in
model.

It is important to note that some bathymetry anomalies lie in gaps between ship controls (black
dots), and are also mapped away from the ship tracks. Because bathymetry models incorporate
depths estimated from satellite gravity and the satellite tracks have ~4 km uniform spacing over
the oceans, bathymetry anomalies are accurately mapped in two dimensions. Grids created only
from xyz data containing large gaps may not accurately map the seafloor located between the
ship tracks.

In our experience, GMT "surface" with a tension set to 0.25 produces a nice-looking bathymetry
grid.

2.1.5 What does a Bad Track in a Grid look like?

Gridding algorithms simply ingest the xyz data supplied, and produce a grid. If the xyz data
contain errors, they may be visible in the resulting grid. A common problem is a "bad track,"
where the ship data along a track are poor, which can result from a variety of reasons. To
demonstrate what a "bad track™ in a grid looks like, we added 2000 m to the depths of track
01010060 (NGDC ID number) and combined it with the example xyz data set and gridded it
using routine GMT "surface" (see Fig. 2.14).
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Grid from XYZ Points Grid with Bad Track

Depth, m Depth, m

Figure 2.14 Grid of XYZ data points (left), and grid of same XY Z data points with “bad track” included
(right).

In the right panel of Fig. 2.14, the bad track stands out as a line of local shallow seafloor
anomalies. Contours adjacent to the line are contorted and jagged. Sometimes a bad track or

other data with errors can be easy to find as in this demonstration, but they can also be subtle.

is important to use data that are as clean and free of errors as possible.

It
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2.2  Gridding XYZ Data with ArcMap

Contributed by Anastasia Abramova, Geological Institute Russian Academy of Sciences, Russia
Updated by Karolina Chorzewska, University of New Hampshire, USA

Here we present step by step example on how to open .xyz space delimited column data in
ArcMap and to interpolate data points into a grid of appropriate resolution. As an example
ngdc.topo.xyz file (See Section 2.1.1) in geographic coordinate system is used. We would like to
create a grid in UTM projection with appropriate cell resolution using Inverse Distance
Weighting Interpolation algorithm. The procedure of reprojecting the data, assessing the data
density to choose suitable grid size is described. Tools available in ArcMap in order to select
optimal interpolation parameters and to compare resultant surface with original data points are
discussed. In order to be able to carry out above noted you will need to have Spatial Analyst and
Geostatistical Analyst extensions.

2.2.1 Importing XYZ file in ArcMap
In order to open ngdc.topo.xyz file in Arc, you need to modify it: text file needs to have header,

data should be comma separated and file name should not have spaces in it.

In order to modify ngdc.topo.xyz text file, import it into MS Excel:

Y F||e>open Text Irnport Wizard - Step 1 of 3 @
ngdc topo XyZ The Text Wizard has determined that your data is Fixed Width,
If this is carrect, choose Mext, or choose the data bype that best describes vour data,

Original data bype

° Se I ect Del | m |ted’ preSS Choose the file bype that best describes wour data:
N t @) Delimited - Characters such as commas or tabs separate each field,
ex Fixed width - Fields are aligned in columns with spaces between each field.

Start import at rowe: |1 = File grigin: 437 : OEM Urited States IZ|

Preview of file E:\WORK_spacelcookbook)gridding_in_ArcZ\ngdc.topo.xwz.

1050 50626 LE. 00054 -E941.
EO.E0S57 1E. 00130 -E943.
EO_E11E7 1E. 00207 -5932.
E L0.E1414 15 00272 -E5933.
EO_E167Z 15.00249 -5932.
4 [

ooooo

Cancel i Mext = ]| Firish
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Text Irmport Wizard - Step 2 of 3

e =)

This screen lets vou set the delimiters vour data contains, You can see how your text is affected in the preview

below,
Delimiters
| Tab
Semicolon
comma
/| Space
Other:

Daka preview

| Treat consecutive delimiters as one

Text gualifier:

-]

L0.E0E2E
L0.Eo2s?
LO.E11E7
L0.E1414
L0.E1&7z2

o n N

-0o0E4
-oo1zo
-oozo?
-oog7e
- 00245

E94]1.
L9423,
Lo3z.
Lo3z.
Lo3z.

ooooo

Insert header row, type header name for each

column (no spaces!)

Cancel | | < Back | | Mexk = | | Einish
Clipboard [F] Fant
c1 ~ (0 % « f| Depth

Fiy B [ O

1 Longitude Latitude |Depth l

2 | 150.5064 15.00054 -5941

3 150.509  15.00132 -5943

4 1 150.5116 15.00207 -5933

5 | 150.5141 15.00278 -5933

A | 150.5167 15.00349 -5933

7 150,51%3 15,0042 -5935

g | 150,5218 15.00492 -53941

9 0 150,5244 15.00562 -5934

10 150,527 15.00633 -5931

Aara maas

ar Aaoaa

s

33



[ogpeadc - Bl e &
Home | Insert  Pagelayout  Formulas  Data R

eview  View  Acrobat

Make sure that the cells that contain =] - 3
numbers are formatted as Numbers in L[l (W2 SIS netse S oo gl

Bl£ o -f[E S A =||ZE 55| | Emergeacenter - || 8 - % 9 |[%§ 53| Conditional Fo

Paste
- f Format Painter Formatting = as T
MS Excel Clipboard il Font il Alignment o) Number B
| Az - = | 15050636
A 8 c D £ F G H 1 1 K L
- 1 |Long Lat Depth
File> Save as ngdc_topo.dbf (*.dbf) D | p—— =)
. - 3| 15050897 150013 -5943
(Or * XIS Wi ” Work too) 4| 1505157 15.00207 _5933] Number | aigment | Font | sorder |l | Protecton
5| 15051414 1500278 -5933| ||| category:
6| 15051672 15.00349  -5933| ||| [Gene .| Sampe
7| 15051927 15042 -5935 150.50636
- ’ 8| 15052184 1500492  -s5341f Accounting Jpisces: |0
Close file In MS Excel! (Arc doesn’t  ©| S5 v o | e
se 1000 Separator
T 10| 15052699  15.00633 -5931f Percentage
want to Open it If itis Opened 11| 15052963  15.00701 -5936 Fractor. egate nmbers:
12| 15053239 15.0077 5883 T
somewhere else) | sesse sows ol || 5
18| 15053779 1500907  -5937)
15| 15054049 15.00975  -5934)
16| 1505432 15.01043 -5936)
17| 1505459 1501112 -593g)
18| 1505486 150118 -5934) =
S| ENEEmD B -593§ e i sed o general deplay of rumbers. Cureny s Acouning o el fomaitn
20 150558 1501317 -5841f 1 monetary value.
21| 15055655 15.01391  -5939)
2| 15055903 1501465  -5936)
23| 15056152 1501538  -593g)
24| 15056403 15.01611  -5840)
25| 15056652 1501685  -5935|
26| 15056901 1501757 -zl

Open ArcMap: File> New > Blank Document [ Display XY Data ? =

A fable containing X and Y coondinabe data can be added o the

Go to Tools> Add XY data and add ngdc_topo.dbf file || ™™™

Chesres a tabla from the map or browss Tor another table:
Select the appropriate fields: X as Latitude and Y as | nzto.gidess -] =
Longitude. In order to define the input data projection: [t e T AT T T

press Edit > Select> Geographic> World > WGS 1984. XPeld:  [Lanude =]
Press Ok MR ey 3
Coordinate System of nput Coonfinstes

Description:

Coomdirate System: -
Mame: GC5_WGS_1354

]

I™ Sheww Detais Edn_.

[ Vit mia I the resuking laver wil have restricted functionalty

ok | cace |
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Now we need to save file as ArcMap
shape file, right click on the Layer>
Data> Export Data> Save as
ngdc_topo.shp file (this is the file we
will be working with further on)

2.2.2 Reprojecting the data

I
Copy
¥ Bemove
Open Attribute Table
Joins and Relates »

@ Zoorm To Layer

Wisible Scale Range »
Use Syrmbol Levels

Selection »

Label Features

% Convert Features to Graphics..,

Convert Symbology to Representation...

Save D Layer File...
Create Layer Package..

Export Data...

We would like to create a grid in UTM projection with units in meters, instead of

degrees. For that we need to reproject our data.

Click on Show/Hide ArcToolbox:

In opened ArcToolbox choose Data Management Tools>
Projections and Transformations> Feature> Project

BRI Y4 q‘J%EI:I'- K? || @ & o

HTUW."HIdl: AreToolbox 'n."l"lnduwl

=13 Data Management Tocls

1  Database

o @ Data Comparisan

o] Ei Disconnected Editing

| & Distrnbuted Geodatabase

# & Darnains

o @ Feature Class

ol % Features

- Fields

M & File Geodatabase

# & General

+ & Generalizatian

| % Indexes
w8 Jains

+ & Layesrs and Table Views
=18 Projections and Transformations

= ﬁ Feature

2 Bakch Project
#* Create Spatial Reference

>

i B Raster

,lh‘ Crexte Custom Geagraphic Ti
A Define Projection

=% Raster
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e Define the Input and Output files (ngdc_tpo_UTM.shp) and Output Coordinate System.
In our case it is Projected Coordinate System>UTM>WGS1984>UTM_Zone_56N).
Press Ok

Vs Project

Input Dataset or Feature Class

| ngdc_topo
Input Coordinate System (optional)

| Gcs_wies_1984

Output Dataset or Feature Class

| E:\'WORK_spacelcookbookigridding_in_arc2\ngde_topo_UTM. shp
Qutput Coordinate System

| WiES_1984_LUTM_Zone_S6k

Geographic Transformation {optional)

e You might want to change the data frame projection view from Geographic to
UTM_Zone_56N now (projection in the data frame view is defined by projection of the
first opened file). Right click on Layers> Properties> Coordinate Systems. Select from
Predefined list Projected> UTM> WGS 1984> UTM Zone 56N. Press Ok. Now data
frame view has the same projection as reprojected file.

e Finally our added data looks like this. As
you can notice, the data point density varies
over the area
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2.2.3 Defining cell resolution for the grid

The choice of grid resolution depends on your purpose. Meanwhile, data distribution,
density, complexity of modeled terrain and scale of the final map should be taken into

account as well.

We would like to create grid with 2 km cell resolution. Here we show how to identify the
percentage of cells which values will be defined by interpolation and how to estimate the
data density within each cell for the chosen grid size.

Make sure that Spatial Analyst Extension is activated: go to Tools> Extensions> check
Spatial Analyst. Also, add Spatial Analyst toolbar: go to View> Toolbars> check Spatial

Analyst.

From Spatial Analyst toolbar select
Convert> Features to Raster

Select appropriate field and cell resolution:

Spatial Analyst

R | spatial Anatys =

Distance

S— Dgnsil;y. .

Interpolate to Raster ¥

Surface Analysis

Cell Sgatistics._.

Meighborhood Statistics...

Lonal Statistics... II 1 i ..
Zonmal Histogram -, o ]
Beclassify... '&‘ 1 g i,
Raster Calculator... ~ B " 3
Options.. Raster to Fratures..,

Features to Raster

Input Features:
Field:
Cukput cell size:

Outpuk rasker:

7|l
ngde_topo_UTH ~| g
Depth ~|
[z

|ding_in_.D.rc2'l,ngdc_top|:|_2knJ,

Ok

Cancel |
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As you can see, in = Laers
=2 O ngdec_tapa UTM

the created raster .
(ngdc_topo_2km), =0 ngdetopo
only cells with data
points in it have
non zero values:

SALLE -

-6,223 - -5,664.111111
-5,664.11111 - -5,105.222322
-5,105.222221 - -4,546,333333
-4,546,333332 - -3,967.444444
-3,987.444443 - -3,428.555556
-3,428.555555 - -2,869.666667
-2,869.666666 - -2,310.777778
-2,310.777777 - -1,751.888480
-1,751.858888 - -1,193

O0dffEENEnN

In order to find out what is the percentage
of cells with “no data values”, go to Layer>
Properties> Source. Here you can look up
the total number of cells in the grid created
by multiplying total number of rows by
number of columns (216*279=60264)

Layer Properties

General Source |E:-:tent] Dizplay | Symbology | Fielt

Property Walue

= Raster Information
Columns and Rows ( 216, 279 }
Murmbet of Bands 1
Cellsize (%, ¥ 2000, 2000
Uncompressed Size 235.41 KB

In order to find out how many cells have non zero values, go to Symbology tab in Layer
Properties window and click on Classified. Select Classify tab:

Layer Properties

Shav:
nigue Values

.Generall Source] Extentl Display  Symbology | Fields | Joins & Felates |

Draw raster grouping values into classes

Stretched Fields
Yalue: | vaLLE= =l
Mormalization: | <Hone>

Import...

Equal Interval

Classification

J Classes: - f CIassiFy..!

Coalor Ramp: |

- . -

Swmbol | Range

| -

| EEECREEEERTRNE

6,223 - 5,664, 111111
I = ccd. 111111 - 5.105.222222 -5.664.11111 - -5,105.222257 L
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e The classification table will appear. In Classification Statistics Window, Count will tell
the amount of non zero cells (8971). This is approximately 14 % of total amount of cells.
Therefore, the values for 86% of cells will have to be estimated by interpolation at chosen

resolution of 2 km:

Classification -5 |
Classification Classification Statistics
Method: Equal Interval Count: L 8971 |
) Minirnri: -G,
Classes: 9 - Maxirmum: -1,193
Data Exclusion Surmn: -44,150,837.82
Mean: -4,021.506836

Exclusion ... Sampling ... Skandard Deviation: 1,265,289472

The density of data points per cell for the chosen grid size should be checked. Number of

data points per one cell depends on your purpose.

e Choose Point to Raster tool from ArcToolbox
(ArcToolbox — Conversion Tools — To Raster —
Point to Raster).

ArcToolbox

& ArcToolbox

' @ 3D Analyst Tools

@ Analysis Tools
@ Cartography Tools
=] @ Conversion Tools
& From GPS
%; From KML
& From Raster
&5 From WFS
& Metadata
&y To CAD
& To Collada
& To Coverage
& To dBASE
& To Geodstabase
& To KML
= & To Raster
.ar\% ASCI to Raster
.r\ DEM to Raster
.ar\% Feature to Raster
.ar‘% Float to Raster
"rx% LAS Dataset to Raster
NPoin o s
"rxh Polygon to Raster
“r\ Polyline to Raster
5 Raster To Other Format (multiple)
5 To Shapefile

m
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e Use your projected data setas ., point to Raster = | B X

Input Features. Leave default

FID in Value field. Choose a i“wea‘”’es I @
name and directory for your V:fu':cﬁet l:pu'um =
output file. Choose COUNT as FID -
Cell assignment type. It will Output Raster Dataset

aSS|gn the number of p0|nts E:\Dokumenty \GEBCO Nippon\II semester laptop\DEM in ArcGIS\density
within the cell to the output CEL assgnment type (optional) :
raster’s cell. Leave Priority Prieity fiekd (apfional)

field with NONE and type your NONE v
gridding cell size in meters in Celisize (optional)

Cellsize box. 2000 i

’ OK H Cancel ”Environments...][ Show Help > > I

Find more information about Point to Raster tool here:
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Point to Raster/00120000002z00
0000/

Table Of Contents 1 =

= = layers
= O ngdc_topo_UTM

e This is the result.

= density
Value

I High : 135

“Low:l
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http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Point_to_Raster/00120000002z000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Point_to_Raster/00120000002z000000/

You can zoom in and check the results of your computations. Shape file with your data
points is displayed over the density raster layer. Use the “Identification tool” to click on a
cell and check the number of data points within it. It will appear in Identify window under

the name of layer and as a Pixel value. Moreover, as a Count value, you have a total number
of cells with the same points number as chosen cell.

File Edit View Bookmarks Insert Selection Geoprocessing Customize  Windows  Help

0 Ej' & % ) <k - | 1:100.000 v |z [;] @ | Sa - : Geostatistical Analy
RAMQ e W-TIK[@EIZNDRITIRE
Table Of Contents 1 x .
TR \@2 o Identify ax
[ = Layers .
tdensy from:
o ngde_tope_UTM fy <Top-most layer> [
. [=)- density
. B
= density
Value l;‘
I High:135 Location: 151°45'53,799°E 19°48'23.964 ~
L 1 Field Value
ow:

Stretched value 116
Pixel value 3
Rowid 5
COUNT 290

Identified 1 feature

e Maximum density of data points for 2000 m grid size is 135 points. This grid size will be
used in the further part of this example, but you may want to change it.

224 Creating a gridded surface

There are several interpolation algorithms available in ArcMap, these include Global and
Local Polynomials, Kriging, Spline, Natural Neighbor and Inverse Distance Weighting
available within Spatial Analyst and 3D extensions. The description of some of these
interpolation algorithms can be found in Chapter 8.0. More information on interpolation
from point to surface methods can be found:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An overview of the
Raster Interpolation toolset
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http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_the_Raster_Interpolation_toolset

A list of interpolation algorithms are available through Spatial Analyst and Geostatistical
Analyst toolboxes:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmI#/An introduction to interp
olation methods/003100000008000000/

Here we will present how to create a gridded surface using Inverse Distance Weighting
(IDW) algorithm using Geostatistical Analyst.

IDW can be a good choice for fast interpolation of sparse data. IDW interpolation
predicts values at unmeasured locations according to the values from the surrounding
data points. Points which are closer to the prediction location have more influence
(weight) on prediction than those which are further away. For more information on IDW
see:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3304&pid=3302&topicname=H
ow Inverse Distance Weighted %28IDW%?29 interpolation works

In order to choose optimal parameters for interpolation, you can use Geostatistical
Analyst toolbox. Activate the extension through Tools> Extensions> check Geostatistical
Analyst. Also add it to your display through View> Toolbars> Geostatistical Analyst.

Geostatistical Analyst> Geostatistical Wizard provides cross-validation of your model
according to parameters chosen. The wizard allows you to manipulate parameters and to
look at the output statistics for the created model. For more information see:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3355&pid=3334&topicname=Pe
rforming cross-validation and validation

In Geostatistical Analyst open Geostatistical Wizard. Select our input data point layer
ngdc_topo_UTM and Depth as an attribute:

Methods: Dataset 1 | Y alidakion |

Inverse Distance Weighting

alobal Polynomial Interpolation Input data: K} nigdc_topo_UTH j =
Local Polynomial Interpolation

Radal s Functons ptrbute: .
Kriging

Cokriging # Figld: |S|‘|ape J
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http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_introduction_to_interpolation_methods/003100000008000000/
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3304&pid=3302&topicname=How_Inverse_Distance_Weighted_%28IDW%29_interpolation_works
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http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3355&pid=3334&topicname=Pe%09rforming_cross-validation_and_validation
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3355&pid=3334&topicname=Pe%09rforming_cross-validation_and_validation

Click next. In the appeared window select
Use Mean> Ok

A set Parameters window
will appear. As an example
we will use Neighbors to
include 15, Include at least
10, sector type Four . After
we set the parameters we can
click Optimize power value
button on top left corner.
Optimized power will be 4.3.
Also you can change the
preview type to Surface, and
while changing the
parameters you can see how
it will affect the output
surface. Click next.

Dataset Mame: ngdc_topo_UTh4

Handling Coincidental Samples

Two or more sample points = Use Mean
exist at the same location,
Select a method for handling " Remove al

the coincidental sample points.

" Include all

" Use Minirmum

" Use Maxirmum

r Do nok show this dialog again For this dataset while in this ArcMap

session,
CK | Cancel
1 Geostatistical Wizard - IDW Interpolation: Step 1 of 2 - Set Parameters @
Optimize power value | Power: IW
F | @ @ @ O Symbol size: E Standard |Sm00th |

Lt Meighbors to include: =
[V Include at least: 10 =
Sectar bype: QI @I @I @
Ellipse
angle: m
Major semiaxis: I 175432
Minor semiaxis: I 175432
Anisotropy Factor: 1

Tdentify

"

ki

Neighbors
Estimated Yalue

INeighbors LI

Preview type:

395687 425248583
1872640.31 908551
120

-1385.6

Show weights ==

< Back I Mext = |

Finish | Cancel |
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The window of Cross-
Validation will appear. The Predeted |emor |

Geostatistical Wizard - IDW Interpolation: Step 2 of 2 -

Cross Walidation

root mean square error is more

than 100 meters. You can vary

Predicted , 10-3

interpolation parameters and

see how they affect on the
model fit. Click Finish.

-6.22 -5.38

Regression function:

-4.55

0.998* x + -8.739

-3

-287

-2.03 -1.1¢

Measured, 10-3

Prediction errors

Mean:
Root-Mean-Square:

Samples: 21199 of 21199

Save cross validation, .,

Source 1D [ Included

| Measured [ Predicted | Error

103.7 13345
13346
13347
13348
18956
13349
5018

E174
‘

e The summary window will appear. Ok

e The surface is being created

Yes
Yes
Yes
‘fes
‘fes
Yes
Yes
Var

< Back

-5637
-5637
-5637
-5637
<5663
-5624
-5615

A7
m

-5635.1
-5639

-5655.5
-5662.6
-5637.2
-5639.5
-5614.3
=EEQ0 4

Finish

-1. 1004
-1.9755
-18.546
-25.631
£5.601

-15.538
0.73376
2% &nt

]

I Cancel

e After adjusting the color bar and checking contours (Layer Properties>Symbology), our
final surface using above described parameters looks like that:

=

EE= Layers
=] Triverse Distance Weighting
Prediction Map
[ngdc_topo_UTR][Depth]
Hillshade
Contours
— -5,304.66667
— -4.546,33333
— -3,708
-2,869.66667
-2,031,33333
Grid
-6,223 - -6,141.87097
-6,141.87097 - -6,060,.74194
-6,060,74194 - -5,979.6129
-5,979.6129 - -5,898.48347
-5,895.48387 - -5,817.35484
-5,817.35484 - -5,726,22581
-5,736.22581 - -5,655.00677
-5,655.09677F - -5,573.96774
-5,973.96774 - -5,482.83471
-5,492,83871 - -5,411.70968
-5,411.70968 - -5,330.58065
-5,330.58065 - -5,249.45161
-5,249,45161 - -5,168,32258
-5,168.32258 - -5,087.19355
SR NAT 19365 - W5 (N6 NARAST -

| »

m
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2.2.5 Comparison with original data values

Here we present how to compare the original data point values with created surface. This
could be useful in order to investigate spatial distribution of misfit between model and the
measured points. For more information on quality assessment of grids see Chapter 4.1.

Export our Inverse

Distance Weighting layer

as ESRI grid: Layer>
Data> Export to Raster.

Set cell size of 2000. Save
as "IDW grid" file name

=] Inwerse Distanceiiial

Prediction b 52 Copy
[hgdc_topo. ¥ Remawe
Hillshade
Contours

-5 04 G666T Yisible Scale Range

— -4 545,33333
— -3 08 - o
— 2 860.56667 = alidation..
-2 03133333 __7 Brediction...

Compare..,

<& Zoom To Layer

55 warmples

=489 Schematics Toals
-2 Server Taols

-2l Spatial Analyst Toals
% Conditional

% Density

% Distance

El% Extraction
A Extract by Attributes
- Extract by Circle
g Extract by Mask

M -5,223--61

M -6,141.27097 Save As Layer File..,

B -6,060,74194
B -5,070.6120
B -5,398.49367 ' Properties..

4 Methad Praperties...

2 | Exxport to Raster..,

Export to Wector..,
" SHTTTETC
| % Generalization

Now we can extract values from the gridded surface at corresponding original data points
with Spatial Analyst Tools> Extraction>Extract Values to Points. Where Input point
features is our ngdc_topo_UTM points and Input raster is our IDW grid interpolated

raster . OK

}" Extract Walues to Points

Input point features

| ngdc_topo_LTH
Input raskter

|IDWY grid

Cukput point features

|E:'I,WDRK_space'l,cDDkaDk'l,gridding_in_.ﬁ.rcz'l,extract _poink_IDW  shp

[ Interpolate values at the point locations (optional]

[ Append all the input ragter attributes to the output point features [optional]
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As a result, a point feature layer is created (we call it extract_point _IDW).

. Copy
You can view the Attribute table of IDW grid 3¢ Remove
the layer by right click on the layer> Walue

Open attribute table:

@l

High Open Attribute Table
igh :

T Ml etk

3
a1

I loins and Relates LN
T S 3
As you can see from the table it , ,
contains information for Attributes of extract_point 1D
original data points (x,y,z) and FID | Shape* | LONGITUDE | LATITUDE | DEPTH | RASTERVALU
corresponding depth values k 0 | Poirt 15050636 1500054 | -5941 | -5540.353557
from our g“dded surface 1 | Poirt 15050397 150013 -3943 | -3940 3383587
(RASTERVALU) for each 2 | Poirt 130531157 15.00207 -3933 | -3935.120603
iginal dat int: 3 | Poirt 13031414 1500275 -3933 | -3935.120603
original Gata point. 4 | Poirt 13031672 15.00349 -3933 | -3935.120603
3 | Point 15051927 15.0042 -3933 | -3935.120603
G | Point 150.521584 1500492 -3941 | -3935 661133
u ¥ | Point 15052441 15.00562 -3934 | -3935 661133
T
Select 4l

You can calculate differences between these values and
visualize them. Go to Options on inside the Attribute
table (bottom right corner) and select Add Field option.
We will call the new column as “Difference”.

VIR QO[O0 D0 | 0D 00| 00| 0| | | | | R | D LD | D D] LD | D | D
AR AR R = R R R R R R R R e By g ey

Records [0 out of 21534 Selected)

Add Field...

Turn &ll Fields On
v Show Field Aliases
Restore Default Column Widths
Joins and Relates
Related Tables
Rf] Create Graph...
Add Table to Layout

& Reload Cache

&b Print...
Reparts
Export...

Appearance...

Options =
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After the column is created, right click on the header  sstervaLu| bifter— -

of new created column and select Field Calculator

Inside the Field calculator we can
define expression for the new column
values: a difference between Depth
and RASTERVALUE columns (double
click on the Fields to add them to the
expression). After clicking Ok, the
values are calculated. Close the
attribute table

-

2940.355537 = Sortfscending
58940.358887 £ Sort Descending
9935120605 A .
235 120605 z¢ Advanced Sorting..
5935120605 SUmMmarize...
5935120605 z
5335 661133 S
5935661133 E Eield Calculator...
5935661133
2935150391 | Calculate Geormetry.,
SHISASDIE | TumField O
5935150391 |
5935150391 Freeze/Unfreeze Column
59351503
5A35 150341 » Delete Field
Field Caleulator |2 [t
Fialdsz Type: Functions:
d = £y
FID = Mumber l"nJEl: 2 -
Shape Elﬂ E[ ]
¥ " Stri wast
. B -1 S =
- " Date ?HE )
RASTERVALL ﬂ )
Difference o
snl )
Sar( ) il
il A Y
Difference = ™ Advanced j J j
[2] - RASTERVALLI -
Load, ..
1

Now you can visualize the Difference by right clicking on the point layer
(Extract_point_IDW)> Properties. Go to Symbology tab. Select Quantities> Graduated
colors. Select the Value Fields as Difference, select the color ramp and number of

classes, and click Ok.
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Layer Properties

' Generall Sourcel Selectionl Display  Symbology I Fields | Definition Quelyl Labelsl Joing &Helatesl HTHML F'Dpupl

Shiow:

Features |Draw quantities uzing color to show values. Impart.... |
Categories r Field: Clazsification

E\I_uantities Walue: Dlfference Matural Breaks [lenks]

i+ Graduated colors .
Graduated symbols Mormalization: Inone LI Classes: IT"' VI Classify... |
Propartional symbals

Charts Color Ramnp: I- B | j

Multiple Attributes Symbl I Riange I Label I

- 945 - 472 946 - 472

& 471 --2M 471 - -2

& 200 - &1 -200 - -51

o -B0- B2 B0 - B2

o E3-Z70 B3-270

@ 271 - 7BG 271 -7EA

- TEE - 1765 VEE - 1765

[~ Show class ranges using feature values Advanced = |

0K I Cancel | Apply

e Now you can see overlaid difference results over the created gridded surface and
investigate the regions where differences seem to be significant (make Layers" IDW
grid” and "extract_point_IDW " visible):

— ——y—-

= extract_point_IDW/

DIfference |
@ -946 - -472 r
@ -471- -1
£3 -200--51
31 -50-62
£3 63-270
@ 271- 765 . .I- -
-
@ 766 - 1765 - P L OO0 L
= DWW grid L 1]
- =1
Walue I --.
High : -1192.03 »y
9 | » L

- Lowe: -6222.99
g O ngde_topo_UTH
*
=] Ireverse Distance Weighting
Prediction Map
[ngdi_topo_UTM].[Depth]
Hillshade

..iil-'l‘! T T T T
L

B
II
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e For more information on analyzing gridded surfaces that you create go to:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About analyzing rast
er data

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=603&pid=598 &topicname=Surf
ace creation and analysis

See more on interpolation error analyses:

http://webhelp.esri.com/arcqiSDEsktop/9.3/index.cfm?TopicName=About geoprocessin
g with 3D Analyst
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FUNDAMENTALS

Chapter 3.0

Gathering Software

Some software packages are freely available for download from the internet. The purpose of this
chapter is to show where to find such software and how to obtain it.

3.1 Generic Mapping Tools

Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA

GMT (Generic Mapping Tools) (Wessel and Smith, 1998) is a collection of open source

mathematical and mapping routines for use on gridded data sets, data series, and arbitrarily

located data. The GMT package is available for download from the University of Hawaii

website (http://gmt.soest.hawaii.edu/) (see Figure 3.1). We utilized GMT routines for much of

our data analyses, gridding, and mapping discussed in selected chapters that follow. Software
packages such as MATLAB, IMSL, ArcGIS and others may also provide similar mathematical

and mapping capabilities, but these are not free.

C MAPPING TOOLS

GMT Pages maintained by:
Paul Wessel

Last updated:
November 1, 2010

5 —

Visit SOEST home page

What is GMT?

GMT is an open source collection of ~60 tools for manipulating geographic and Cartesian data sets (including filtering, trend fitting,
gridding, projecting, etc.) and producing Encapsulated PostScript File (EPS) illustrations ranging from simple x-y plots via contour maps
to artificially illuminated surfaces and 3-D perspective views. GMT supports ~30 map projections and transformations and comes with
support data such as GSHHS coastlines, rivers, and political boundaries. GMT is developed and maintained by Paul Wessel and Walter
H. F. Smith with help from a global set of volunteers, and is supported by the National Science Foundation. It is released under the GNU
General Public License.

Current version is 4.5.5, Released November 1, 2010. For a peak at the next generation GMT 3, see our GMT 5 pages.

607

60" —, !
2407 3007 o £0° 120° 1807

GMT is used all over the world. Each yellow dot represent a 15x15 arc minute block with one or more registered user or institution. So far, almost 2000
such blocks have been registered, representing more than 15 000 individual GMT users. To add your dot, fill out the registration form.

23 SCHOOL OF OCEAN AND EARTH SCIENCE AND TECHNOLOGY

UNIVERSITY

Figure 3.1 University of Hawaii website for GMT.

To download the GMT software package, click on “download” shown in the left column of the
figure above. Instructions for how to obtain and install the GMT software are given on the

download webpage (see Figure 3.2).
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GMT Pages maintained by:
Paul Wessel

Last updated:
Navember 1.2010

P

Visit SOEST home page

Obtaining and Installing GMT

fip fror & global set of fip servers: each contain the same files as the main server in Hawail, File tansfee is unsally faster if you select the server clasess ta you, Our
installer will ically get th hi 1he ftp site you choose.
Users with a slaw Intermet d wsers who desire largy s of dala sets ready to be used with GMT: See the GMT Campanion DVD-R products distributed by Grawars.

Fast-track for (repeat) UNIX/Linux/OSX users
Twe done this before. Take me disecily 1o the [NSTALL FORM.,

Platform-specific Instructions

1 UNIX.,r 5= LU Note: The install process requires bzip?,

1. Awtomated insall [Recommended]. Obtain ard install GMT by interscsing with the [NSTALL PORM. Follow instrustions there to obtain the Boume shell invall-script and a customized
install parametes file. The autamated install will also install 6etCDF if needed.

2. Menwal install, If you peefer, you can alu do the typical masual install by fipiag the fles, ustas, ran canfigurs, nuke stc. Read the README filo for the required deps. For manual imazall
yau must also manually get and insaall the Unidasa netCTF libmry which GMT mquires, ar have the library already installed, Use fip ta any of the GMT mimoe sites.

3. VS insallation far GMT gurus. To get the bleeding edge GMT venion and even contribute 10 the development of GMT. consider installing the "live” GMT venion by following the CVS

8 owmwm;:

X35 barch files rule. M you just want to invinl] Windows executables and get on with it, visit our GMT Windows page for sccess to Windows Insiallers. Note thet many of the [0S example

scripts utilize GNU awk: the WINI2 executable gk has thercfore been placed on all ftp sites.

DOS batch files swck, part 1, Because you cansot get nisch dose with DOS basch jobs, we strongly mcommend that you install Cygwin, a free UNIX eanulation package for Windows. Cygwin

leta yous mpen whel] wisdows and scceis tasdand UNIX toals sch as e, gee, ote, You wosld then inatall GMT avdescribed above far UNIN Linss.

DOS barch files suck, part 11 1f you ren Windows, you can get i command wind. installing the frecly available Windows Sxrvices for LINTX, 8 UNIX environmens for

Windaws. SFL lets you install GMT as described for UNIV/Linux abave.

DS batch files swck, part I, Finally, you may consider the option of ranning Lisus within a virtual machine. ssch as VMWae or Vidual Box, and then pursse the general Linus/UNIX

install option.

. Cygwin sucks, Cygwin is painflly slow 1o run configure scripts and to lsurch programs foece launched, programs run fast), so sctually the best and casiest way of runsing GMT under
Cygwin is to use the Windaws native binasies. All it takes for this saltion is 1o install the Windows exccutables (GMT Windows) and add the GMT Win bin directary o yaur Cygwin path

wiathe hawnre file.

£ 05 X: GMT installs and runs under Apple's 05 X which is UNDCbased: just follow instructions for UNIXLinax above, You must fint install the Xeode Developer Tools (which includes
e GNU C campiler, make, ete) as these are aot installed by defailt bist is an aptrosal install via the 05 X knstall DVD, You can abso dowslosd them from Agple's support site. Also sebost to install
X11, Finally, the Intewt venions of GMT are alss availshle as user fricndly pacikapes vis Fizk.

4 “IPMIZGHTIIII been ported to 0872, For i ion and

Obtaining the old GMT 3.4.6 version

o

w

see Allen Coghills GMT 052 page-

I you Fre whiatever rranos need to install the final version of the GMT 3 weies you must masually fp the tar-balls from SOESTs GMT srchive asd run the inutallstion (follow the seps in the README
file).

Figure 3.2 GMT download and installation web page.
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Chapter 4.0 Software Overview

The purpose of this chapter is to give an overview of various software packages that can be used
to clean, process, manipulate, analyze, and plot data used in scientific research and production.

41 ArcGIS

Contributed by Pauline Weatherall, British Oceanographic Data Centre (BODC), UK

The software company, ESRI (www.esri.com), produces a range of Geographic Information
System (GIS) products suitable for accessing, processing, sharing and serving geo-referenced

data, working both in a MS Windows environment and also via the internet.

Further information about ESRI’s products; accessible data sets; development tools; specialized
applications and open source products can be found on ESRI’s web site:

http://www.esri.com/products/index.html

The information below aims to give a very broad overview of some of the functionality of
ArcGIS for Desktop software, specifically in relation to GEBCO’s work with building gridded
bathymetric data sets. The information and links below relate to ArcGIS Desktop version 10.

4.1.1 What is ArcGIS for Desktop Software?

ArcGIS for Desktop is ESRI’s MS Windows-based GIS software. As part of its functionality, the
software can be used to:

View, overlay, manage, edit, analyse and capture geo-referenced data
Produce and share maps, data and imagery

Grid data

Search for data and imagery

Carry out datum and projection transformations

Edit/develop metadata

4.1.2 Is the software free, what licences are available and how can you
access the software?

ESRI makes available a range of desktop software products, some are available free of charge
and some are available commercially at a number of licensing levels. The functionality of the
software depends on the licensing level and is also reflected in the price of the software.
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Further details about software access and licensing for each product can be found on ESRI’s web
site:

http://www.esri.com/products/index.html#desktop gis panel

4.1.3 What type of computer platform does it run on?

ArcGIS for Desktop products are designed for use in a MS Windows environment. Details about
supported operating systems and hardware and software requirements can be found on ESRI’s
web site:

http://www.esri.com/software/arcgis/arcgis-for-desktop/system-requirements

4.1.4 What does the software do?

As outlined above, the software can be used to visualise, edit, capture, process, share and analyse
geo-referenced data.

Firstly, we need to look at what the various component packages of the ArcGIS Desktop
products do and what types of data and data formats they can work with. The following is a
broad overview of their functionality, further information can be found in the products’
documentation.

ArcGIS for Desktop application packages - what are they and what do they do?
ArcMap is used for creating, displaying, exploring, analysing and editing your data; assigning

styling to the display and for building images and map layouts from individual data layers or data
sets.
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Displaying information from GEBCO’s data sets in ArcMap — a Tiff image overlain by a
shapefile of point data

An introduction to ArcMap:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//006600000001000000.htm

A quick tour of ArcMap:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#/A quick tour of ArcMap/00660
0000332000000/

ArcCatalog lets you organise, preview and manage your data sets. In simple terms it can be
thought of as acting a little like MS Windows Explorer in that it provides an overview of the
contents of the directories on your PC. However, it displays the information in a form that is
useful for working with ESRI software, i.e. although a shapefile is made up of at least three
separate files when viewed with Windows Explorer, within ArcCatalog it is just represented as
one file. ArcCatalog also lets you view and enter metadata for your data sets in a number of
standard formats. A catalog window is available in ArcMap to let you manage your data sets.

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006m00000069000000.htm
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ArcToolbox is a collection of data processing tools collected into related ‘toolboxes’ and
‘toolsets’. They have a wide range of functionality, including data analysis and conversion tools.
The availability of the various toolboxes and toolsets depends on the level of your ArcGIS
Desktop license.

ArcToolbox

= SfArcToolbox

+ &3 3D Analyst Tools

+ &P Analysis Tools

+ @ Cartography Tools

+ & Conversion Tools

+ @ Coverage Tools

+ e Data Interoperability Tools
} @ Data Management Tools

: @ Editing Tools

@ Geocoding Tools

+ @ Geostatistical Analyst Tools
] e Linear Referencing Tools
+ @ Multidimension Tools

+ &P Network Analyst Tools

+ & Parcel Fabric Tools

+ &P Schematics Tools

@® e Server Tools

+ a Spatial Analyst Tools

X Q Spatial Statistics Tools

+ & Tracking Analyst Tools

-

B E

Table Of Contents | {g ArcToolbox! |

Some of the Tool sets available through ArcToolbox
A quick tour of geoprocessing tools:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#/A quick tour of geoprocessing/0
02s00000002000000/

Information on finding tools can be found at:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmI#/A quick tour of finding tools/0
02400000001000000/

The packages, ArcScene and ArcGlobe are part of the 3D Analyst extension package and can be
used to view data in 3D and produce and animations (ArcScene) and display data on a globe
(ArcGlobe).
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Displaying the GEBCO Grid in ArcGlobe
Further information about extension packages can be found on ESRI’s web site:

http://www.esri.com/software/arcgis/arcgis-for-desktop/extensions.html

In what formats and structures does ESRI ArcGIS Desktop software store data?

ESRI ArcGIS Desktop software works with and stores data in a number of ways, as individual
data files or as collections of related data files. The data sets may be stored individually on disc
or be part of a database. The data sets can be in the form of 3D surfaces (e.g. rasters), vectors
(e.g. points, lines or polygons) or images.

The following outlines the main data storage types used by ESRI’s ArcGIS Desktop software
products.

Geodatabase
This is the main data model for ArcGIS and is the primary data format used for editing and data
management. It is made up of a collection of files (feature classes, raster data sets and tables).

Feature classes are collections of features of the same type, such as points, lines or polygons.
They also share a common set of attribute fields. Within a Geodatabase they can be grouped into
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feature data sets which are collections of feature classes with the same geographic reference
information (i.e. datum and projection).

Geodatabases work across a range of database management system (DBMS) architectures and
file systems, can be of various sizes, and be single or multi-user.

Within some ArcDesktop GIS packages, storing your data in a geodatabase allows you to carry
out advance editing and quality control procedures on vector data sets, i.e. looking at how the
vector data sets which make up the geodatabase ‘“interact’ or share geometry — this is called
topology. For example making sure the outlines of individual polygons do not overlap. This
functionality is not available for shapefiles.

Further information about geodatabases can be found on ESRI’s web site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//003n00000002000000

Shapefiles

The Shapefile is a format that ESRI software uses to store the shape, geometric location and
attribute information about a data set. Individual shapefiles can contain only one feature ‘type’,
I.e. points, lines or polygons. Shapefiles can be edited but they cannot be used as part of a
topology for more advanced quality control procedures.

Further information about shapefiles can be found on ESRI’s web site:

http://downloads2.esri.com/support/whitepapers/mo /shapefile.pdf

3D Surfaces

ESRI products work with the concept of three types of surface models:

. Rasters — rectangular array of grid cells (holding a data value) arranged in rows
and columns
. Triangular Irregular Networks (TINS) - a surface consisting of nodes (or

points) joined by edges into various sizes of triangles. Because the nodes can be
irregularly spaced, a TIN can show higher resolution information where there is more
variation in terrain and be lower resolution where there is less variation.

J Terrain surfaces — are a set of “pyramided’ TINSs, i.e. a set of TIN’s at multiple
levels of resolution. This helps when working with high volume data sets.

Find out more about how ArcGIS software works with 3D surfaces:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Fundamentals of Surfaces/00g80
0000052000000/
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How do you work with your data in ArcGIS Desktop packages — do you have to reformat it?

As described above, ArcGIS Desktop packages work with data in a number of forms, as
individual ‘stand-alone’ files or as part of a geodatabase.

Data in some formats can be imported or used directly with ArcGIS Desktop applications, others
need to be converted to ESRI formats.

Information about supported data formats for import and export can be found on ESRI’s web
site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//009t00000000000000

Through the ArcGIS Data Interoperability Extension tool set, data can be imported, exported
and converted to a number of formats. Further information can be found at:

http://www.esri.com/software/arcgis/extensions/datainteroperability/index.html

Further information about importing data is given below:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An overview of the To Raster
toolset/00120000002r000000/

In addition to creating rasters from input point data sets, you can also create rasters from polyline
and polygon data sets. Further information is available at the above link.

Connecting to Open Geospatial Consortium (OGC) Web Services

You can connect directly to Web Map Services (WMS), Web Coverage Services (WCS) and
Web Feature Services (WFS). Further information can be found on ESRI’s web site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//003700000002000000.htm

Working with KML files
Information on working with KML files can be found on ESRI’s web site at:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00s20000000m000000.htm

Adding X Y data
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Point data, in ASCII format, can be imported into ArcMap as a layer using the Add XY option,
attribute information can also be imported along with the data. The data can then be exported as
a shapefile or feature class.

Working with netCDF files
Grid files, in 2D netCDF form, can be imported into ArcMap as a ‘netCDF raster layer’ through
the “Make NetCDF Raster Layer’ Multidimension Tools set in ArcToolbox. Further details can
be found on ESRI’s web site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//004300000006000000.htm

Additional tools for data import

There are ‘add on’ tools such as ETGeowizards (http://www.ian-
ko.com/ET_GeoWizards/gw_main.htm) which can be used to help with the import and export of
vector and raster data sets for use with ArcMap.

Can you create a 3D surface from your source data sets?

The following outlines how you can use ESRI’s software to create a raster or Triangular
Irregular Networks (TIN) from your input data.

Creating a raster from point data

As part of the ArcGIS 3D Analyst extension software package you can create a raster from a data
set of points using a number of interpolation methods:

. Inverse distance weighted
o Spline

. Kriging

) Natural neighbours

Further information about creating rasters can be found in the ArcGIS 3D Analyst product
documentation, available from ESRI’s web site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//00g900000034000000

Further information about gridding using ESRI software can be found in the section 8.2.10 of
this document, ‘Gridding with ArcMap’.

Working with raster surfaces
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The following are examples of some simple tasks that you may want to carry out, for the full
range of functionality see the ArcGIS Desktop documentation.

Analysing surfaces and generating contours

You can analyse the surface of your 3D model, looking at slope and aspect and hill shade and
also generate contours at specified intervals. This can be done through the 3D Analyst
extension — which provides a set of tools for working with rasters, TINs and terrain surfaces.
Further information is given in the documentation.

http://help.arcgis.com/en/arcqgisdesktop/10.0/help/index.html#/An overview of the 3D Analyst
toolbox/00gq900000070000000/

The Spatial Analyst extension provides a set of tools for working with and analysing both raster
and vector data sets.

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#/An overview of the Spatial An
alyst toolbox/009z00000003000000/

Raster calculations

You can carry out mathematical operations on cells in a raster. This includes carrying out
calculations on grid cells such as add, subtract or divide. This can be done by either adding or
subtracting one grid from another or by adding or subtracting single values for each grid cell.

The following table lists the available toolsets and gives a brief description of each:

http://help.arcais.com/en/arcgisdesktop/10.0/help/index.htmli#/An overview of the Raster Mat
h toolset/000900000063000000/

Extracting data from rasters

You can extract data from rasters either based on geographic area “clipping’ or by cell values
(attributes). For example, you may select a geographic sub-area from a grid or select cells from a
grid with a depth greater than say 100m.

The majority of the extraction tools are available with the Spatial Analyst Extension; however,
the “Clip’ tool is available with any ArcGIS license.

Further information about the “Clip’ tool can be found at:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000009n000000

For information about data extraction as part of the spatial analyst extension see:
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http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An overview of the Extraction
tools/009z00000028000000/

Resampling, generalising and filtering rasters

A set of resampling, generalisation and filtering tools is provided as part of the ArcGIS Desktop
products.

Resampling a raster, i.e. changing the size of the grid cells can be done through the ‘resample’
tool, part of the Data Management Toolbox:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Resample/00170000009t000000/

The ArcGIS Spatial Analyst extension contains a number of tools for generalising and filtering
rasters:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmli#/An overview of the Generalizati
on tools/009z00000033000000/

Working with your data in ArcMap
ArcMap is the ArcGIS Desktop package which can be used to view and edit your data sets in 2D.
Further information can be found on ESRI’s web site:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#//006600000001000000.htm

A quick tour of the functionality of ArcMap is given at the following link:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#/A quick tour of ArcMap/00660
0000332000000/

The following are examples of some of simple functions that you might want to do in ArcMap.

To view a data set, it needs to be in a format which can be recognised by ESRI ArcGIS Desktop
software (see above for more information). Click on the *‘Add Data’ button from the ArcMap
toolbar, then search your data directories to select the file that you want to load.

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Adding layers to a map/006600
00000t000000/

In version 10 of ArcGIS Desktop you can also search for GIS content in your own file system
and on the internet:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Using search in ArcGI1S/006600
000079000000/
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Once a data set is loaded you can experiment with changing how the displayed layer looks, for

example, altering the colours or symbols used to display the data and adding label and text
information. This can help to highlight aspects of the data set that you want to enhance, e.g.
displaying data in a particular depth range all one colour.
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available for display in the map window.

map display window - showing a bathymetric grid
colour-coded for depth at 1000m intervals.

In the above example a bathymetric grid is displayed colour-coded at 1000m intervals

The grid will appear in the layers list in the table of content. Right click on the grid’s file name

and then click on “properties’. For raster data sets, you can choose to display the grid using

stretched values along a colour ramp, you define the start and end colour values, using values

and classified intervals, e.g. equal intervals, natural breaks, defined intervals etc. or unique
values for each separate cell attribute. You can define a colour scheme, choosing from pre-
existing colour schemes or defining and saving your own colour scheme.

You can change the properties of individual colour intervals, perhaps changing one interval to be

transparent, this helps with overlaying data sets. You can also make a selected range of values

one colour, for example for land areas.
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In the above image the grid is now coded at depths of 200m intervals and land areas are
displayed in grey.

Further information about choosing display colours can be found in ‘help’ system.

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmi#/About displaying layers/00s5000
00015000000/

For vector data, you can change the symbology used to display the data set to get the most out of
your data set. Symbols can be defined on size of attributes and/or colour and attribute
information can be displayed on the map. For example, when plotting sounding points you can
colour code them for attribute information such as depth or for contributing organisation.

You can change the drawing order of the displayed layers, for example to plot points on top of a
map. For further information on working with layers:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/A quick tour of map layers/00s
500000015000000/

Example of using ArcMap and ArcScene to help assess a bathymetric grid

As described above, ArcMap can be used to visualise your data sets in 2D. In the following
example a grid is loaded into ArcMap. Colour coding the grid at defined depth intervals
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highlights some features in the grid. Overlaying the source sounding data, used to generate the
grid, can help investigate the origin of the features and let us determine if there are any errors in
the source data.

The above image seems to show an anomalous feature (circled), shown as a ‘blue line’. We can
investigate the original of the feature by overlaying the source sounding data that was used to
generate the grid onto the map display.
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The above image shows the coverage of ship-track data (shown in black) which was used to
generate the bathymetric grid.

The ship-track soundings, as xyz data, can be colour-coded for their various available attribute,
e.g. depth or source survey. This can help to visually identify any spikes in the data set.
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The above image is zoomed into the area of the anomalous feature. The source sounding data file
has been colour coded for depth. We can see that a trackline plots along the anomalous feature,
judging from the colour of the soundings, they appear to be a different depth value of those in the
surrounding region — they may be in error and causing the anomalous feature in the grid. We can
query the soundings to find out the depth of the individual sounding points and if available,
query the accompanying metadata.

In addition to viewing the gridded data in 2D using ArcMap, ArcScene can be used to view the
data in 3D.
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The above image shows the grid displayed in 3D in ArcScene. Potential errors in the grid are
now more visible.

We can zoom into the image to investigate further and also overlay the source sounding data
onto the grid. In the example below, the anomalous feature is displayed in 3D and overlain by
the source sounding data points.
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How can | get help with using the software?

There are documents and links on ESRI’s web site under ‘support’ http://support.esri.com/en/

ArcGIS Support: http://support.esri.com/en/

ArcDesktop help: http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html

Technical articles: http://support.esri.com/en/knowledgebase/techarticles/index

About ArcGIS for Desktop: http://www.esri.com/software/arcgis/arcgis-for-desktop/index.html
An introduction to commonly used GIS tools:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_introduction to the commonl
y used GIS tools/002s00000006000000/

4.2  CARIS HIPS (Hydrographic Information Processing System)

68



http://support.esri.com/en/
http://support.esri.com/en/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html
http://support.esri.com/en/knowledgebase/techarticles/index
http://www.esri.com/software/arcgis/arcgis-for-desktop/index.html
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_introduction_to_the_commonly_used_GIS_tools/002s00000006000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_introduction_to_the_commonly_used_GIS_tools/002s00000006000000/

Contributed by Cmdr. Izabel Jeck, Directorate of Hydrography and Navigation (DHN), Center
of Hydrography (CHM), Brazilian Navy, Brazil

4.2.1 Introduction

The purpose of this document is to present to the user the basic workflow of the
program CARIS HIPS (Hydrographic Information Processing System), version 7.0, to process
multibeam data.

HIPS is a suite of comprehensive hydrographic data processing tools that can be
used to process simultaneously multibeam, backscatter, side scan sonar, LiDAR and single beam
data. CARIS HIPS is a program developed by a Canadian company named CARIS
(www.caris.com).

To use this software it should be note the computer minimum configuration, this
information and any extra information can be obtained in the software documentation or in
CARIS web page.

4.2.2 Acknowledgements

This document was made with the contribution and the authorization of CARIS -
Universal System Ltd. Company, and further information can be obtained in www.caris.com.

4.2.3 HIPS Workflow

The figure below presents the software workflow.

T ——
CUBE Workflow in HIPS

Process Subset Data

Create a Vessel File (HVF): Setup the sensor locations and uncertainties in the vessel reference
frame.

Create a New Project: Setup the Project - Vessel - Day data structure.

Convert Raw Data: Raw data is converted into HIPS data format.
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Save Session: Save the current workspace (data and current view).

Sound Velocity Correction: Load and edit sound velocity profiles and apply the correction.
Load Tide: Load tide data from one or more tide stations.

Merge: Combine vertical and horizontal information to produce geo-referenced data.

Compute TPU: Utilize uncertainty values entered in the HVF in an effort to compute the total
propagated uncertainty of each individual sounding.

Define New Field Sheets: Define the map projection and location of the data.

Generate BASE Surface (CUBE): Merged data is used to produce CUBE surface.

Data QC: Sensors, such as navigation, gyro, heave, etc. are examined if problems have been
identified in the BASE surface.

Automated Filters: Filter soundings using swath geometry and/or according to IHO survey
order accuracies.

Process Subset Data: Validate CUBE surface and edit the geo-referenced soundings directly, on
many lines simultaneously, where the CUBE surface has been adversely affected by erroneous
soundings.

Recompute: Update the BASE Surface after the data has been edited and the surface has been
validated.

Finalize: Finalize BASE Surface to ensure designated soundings are carried through to
bathymetric products.

Create Product Surface: Produce a generalized product surface from the BASE Surface.
Contours: Use either the BASE Surface, product surface or tile set to output contours.

Sounding Selection: Use a height source for selection of a representative sounding set.

Export Data: HIPS soundings and surfaces can be exported to various formats for data transfer.

Before start the processing the user must know:
- dX,dY,dZ sensor offsets
- echo sounder used and number of beams
- sensor timing corrections
- sensor bias corrections
- positioning format (geographic or ground coordinates recorded?)
- have calibration offsets been applied?
- has vessel motion been removed?
- has remote heave been removed?
- has draft been applied?
- has sound velocity corrections been applied?

4.2.4 Project Data Tree and General Information

The Control Window displays the data in an expandable tree. This display is organized to reflect
the Project, Vessel, Day, Line directory structure. Data deleted from the Project tree is sent to the
Recycler folder as defined in an Environment variable in the Options dialog.

Project information can be viewed in the Project Properties dialog box. General project
information and information about the coordinate system is stored here. The project geodetics
can be transformed using this dialog box if required.
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Default Options

- Presentation and Performance

The default options can be accessed using the Tools > Options menu. The Options dialog box is
organized into six tabs.

The General tab controls zoom and pan factors, and settings for displaying sounding size, the
SVP location symbol and the navigation point symbol. The pick aperture setting determines how
close the cursor has to be to an item in order to select it. A number of other options can be
enabled or disabled in the General tab.

The Display tab controls the colour of lines and backgrounds in different parts of HIPS and
related editors.

Under the Display tab the user can configure the presentation of Geographic or Projected Grids
& Scale Bars for the HIPS Display window. Grids, which can be displayed as lines, ticks or
crosses, will be displayed, with a scale bar, appropriately for the current zoom factor. Under the
Units section users can configure the display units for their data.

All data in HIPS is stored in metres and so the conversion will be applied to the display of the
data.

- Directories and Environment

The Directories tab enables the user to modify the location of project dependent data files, either
one at a time or by using the Root Path, to set all the HIPS and SIPS data paths at once, if they
all have the same base path. This information is saved to the registry.

The Environment tab enables the user to modify the locations of the HIPS and SIPS support
information, such as the master file, symbol file, datum file, scratch location, etc.

By default, this information is located in the ..\CAIRS\HIPS\System directory.

- S-52 and S-57

The S-52 tab controls the display of S-57 ENC data, there are options to select colours and
transparency for depth areas, symbols, contours etc.

The S-57 Environment tab controls the location of S-57 dependent configuration files.

- 3D View

The 3D tab controls the behavior of the keyboard and mouse controllers when navigating the 3D
View:

* Controller Type

- Terrain Flyer: navigate from the perspective of the height source.

- First Person: navigate from a camera view of the current 3D scene.

* Flight Speed: Controls the speed at which you move through the display during a fly-through.
» Zoom Speed: Controls how fast the view is changed when using the zoom controls.

» Smooth-Fly-To Speed: Controls how fast the view is changed when a user double-clicks an
area of the 3D View.

Open Background Information
Both vector and raster information can be loaded into HIPS as background information. This
option can be accessed using the File > Open Background Data.
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Layers Data Tree

The Control Panel displays the data in an expandable tree. This display is organized to reflect
the layers of data displayed in the HIPS Display Window. It is possible to toggle these layers on
and off using the check boxes in the Layers tab, and the draw order of the layers can be changed
by dragging and dropping the layers in the Draw Order tab.

Entire Fieldsheets can be turned off from the right-click context menu.

In order to select data such as track lines in the Display Window, the layer must first be
highlighted in the Layers tab of the Control Window.

Selecting Data in HIPS and SIPS

Survey lines can be selected by highlighting them in the Project tab of the Control Window, or
by clicking on them in the Display window. Multiple lines can be selected using the shift and
control keys. Lines can also be selected by dragging a box over the lines in the Display Window.
Selection in the Display Window can be done in two ways: Select by Range or Select by Lasso.
Lines cannot be selected when the cursor is in constant zoom mode. When in constant zoom
mode. To exit from zoom mode, click on the zoom icon or use the ESC key.

Other selection options are All in Display, All and Clear Selection.

Note: The Select by Range tool is depressed by default. If you are unable to select lines in the
Display Window check to see that this tool is selected.

Query Lines

Query Lines E

* Generate report of line status and statistics
« Select Query fields and sort

All the information listed when a line is queried is calculated on-the-fly so it may take a few
minutes to list. The data is displayed in the Worksheet Window and the columns can be sorted by
clicking on any of the headings. By right-clicking on the headings and selecting Query Fields...
from the pop-up menu you can choose which fields are displayed. The options Select All, Copy
and Paste and Save As...allow the contents of the Worksheet Window to be taken into software
like Excel.

Right-click in the Display Window brings up a pop-up menu you can use to copy the geographic
coordinates of the cursor position to the clipboard.
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4.25 HIPS Workflow- Detailed

Vessel editor

The Vessel Editor is used to create and edit HIPS Vessel Files (HVF). The HVF contains
information necessary for combining all sensor data to create a final position/depth record.
Sensor information is used during the merge process. All sensor entries are time stamped,
therefore one HIPS vessel file can be used for the life of a vessel. If a sensor is moved or added,
the new offset information is given a new timestamp. The merge process compares the date and
time of the observed data with the date and time of the HVF sensor information to ensure that the
appropriate offsets for that time are used.

Note:

It is not possible to process sensor data time stamped prior to the earliest HVF timestamp, as the
program applies the most recent information.

The positions of the sensors in the HVF may not be the same as the actual configuration of the
vessel. For example, if sensors offsets are applied in the acquisition software, the HVF should
describe the “corrected’ position, not the actual position of the sensor.

The vessel editor can be accessed using the edit > vessel configuration...from the main menu.

Create a Vessel File E
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A list of existing projects will be displayed in the option file > open project, you can also create
a new project using file > new.

Note: Do not use spaces in the name of the project.

In the file > new, highlight the project created, click the Add Vessel... button and select the hvf
vessel file; click the Add Day... button. Select the geographic parameters for the project.

Note: Regions of the world appear in the Group list. When a group is selected, the user can
select from a pre-built set of map Zones. These parameters are referenced by the Map Definition
File (Hips\System\mapdef.dat). This file can be appended to if additional definitions are required
or another file can be selected by accessing Tool > Options from the main HIPS menu and then
selecting the Environment tab.

The user may also opt to have the program automatically select the appropriate UTM zone.
Define a geographic window for the project. The default region is the entire globe. If an existing
project in the area is open, the Current View button can be used to get the extents.

Convert Raw Data
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- Select the Conversion Wizard icon or File > Import > Conversion Wizard... from the menu
to start the conversion wizard.

- Select data format from the list of formats.

- Select the File selection type from the list, in this case RawData

- Select all the lines.

Raw data files are usually stored in PreProcess so this is the default location.

- Select the destination Project, Vessel, and Day folder for the converted

- Select the geographic reference system used for the acquisition of the raw data. If Ground
Coordinates are used, the appropriate zone definition needs selecting from the list. If Geographic
Coordinates are used nothing more needs to be set.

- Do not set Navigation or Depth filters. The Navigation filter is useful to restrict data to a
specific geographic region. The geographic region can be defined manually or by Project File
extents. The Depth filter is used to reject large bathymetric spikes that fall outside of the min and
max depths of the survey area.

The first five steps of the Conversion Wizard are the same for all data formats. From Step 6 the
wizard differs to accommodate individual requirements for each format type.

The <Back button can be used to check that no mistakes have been made in the settings. Once
the line data has finished converting the <Back button changes to << Restart.

Open Survey Data
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Once converted the data can be opened in the main interface.

The lines will be listed in the Contents window.

If side scan data was converted and resides in the same files as the bathymetry data then the
tracklines showing the vessel and towfish positions should both be selected.

Save Session

Save Session
= Save a file that remembers all the data you

have open
- Session file format, .wrk, includes:
— Meta Data Er—

— Survey Lines
— Background CARIS Map e
— Background Images
— ENC Data

— Field Sheets

e cariscom i e CANIS

The session file is a text file located in the HIPS\Session directory. It consists of a series of data
objects in XML format describing:

» Workspace — Creator of the session, HIPS project name, creation and last modification times,
and location of the HIPS source data.

* View Extent — The last used window size and location.

* Project Data — Survey lines, CARIS files, background images, and field sheets.

Double clicking a session file in Windows will automatically open the session in HIPS.

Sessions should be used to efficiently organize the data that you are working with.

Having a series of small work areas as separate sessions instead of one large project will allow
for faster, more effective data access.
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Raw data formats such as Simrad contain two-way travel time and beam launch angles.
Producing a geographically referenced sounding position and depth from this data is a two-stage
process.

* The procedure for calculating the length and path of the sound wave through the water column
for each beam is called the Sound Velocity Correction (SVC).

The result is an along-track/across-track/depth for each beam.

» The Merge process (which is explained later) converts the along-track/across-track/depths into
latitude, longitude, depth by combining the ship navigation with horizontal and vertical offsets in
the HIPS vessel file.

The SVC algorithm calculates the ray path of the sound wave through the water column for each
beam. In order to do this the program needs to know several things:

* Any rotations that have to be applied to the sensor head — both static (i.e., setup and calibration
parameters) and dynamic (measured by the attitude sensors).

 The acoustic velocity of the water column. This information is loaded into the program as a
sound velocity profile.

There are different options for applying velocity information to a swath:

* Previous in time — This is the method traditionally used by HIPS, which applies the profile
taken immediately before the collected swath.

* Nearest in time — In this situation HIPS will apply the SVP with the time stamp closest to that
of the collected swath.

 Nearest in distance — Uses the position attributes of the profile to determine the nearest profile
to a given swath.

» Nearest in distance within time — Uses the position attributes of the profile to determine the
nearest profile to a given swath within a time window which the operator has to enter.

Note:

The profile selection methods listed above are made on a swath-by-swath basis and so it is
possible to have several SVPs used in the same survey line.

For Simrad data, the sound velocity and attitude corrections have been applied during
acquisition, and do not need to be reapplied.
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The process checks the HVF to see if the heave, pitch, and roll are set to Apply “Yes”. Since
Simrad has already corrected for Sound Velocity, it does not have to be re applied. Doing so
would skew the data.

Note that in this case there is no sensor called SVC to the Vessel File (hvf). This sensor would
need to be configured in order to apply (or reapply) sound velocity.

Sound Velocity Correction
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As stated earlier, some of the parameters that are usually applied in the merge process can be
applied during the SVC process.

If you sound velocity correct your raw data to produce a new observed depth, the merge process
knows what has been applied and will not reapply it as SVC is optional.

The following are taken into account during SV correction:

* Travel Time - angle observations

* Sound Velocity Profile

* All entries in the SVP section.

» Water line

» Dynamic heave, pitch and roll, along with any errors. Including pitch and roll induced heave
calculated from MRU lever arm offsets (X, Y and Z of motion sensor)

» Dynamic Draft - uses a table of speed versus draft values in the HVF.

» The Dynamic Draft values are only used to find the proper sound velocity layer to start SVC.
The draft values will be applied to the observed depths in the Merge Process.

Note: The dynamic heave, pitch and roll will only be applied if Apply is set to Yes in the HVF
for each individual parameter. However, the offset values for Roll, Pitch and Yaw entered into
the Swath/SVP will always be applied.

Tide Loading
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Tide data can be applied in two ways:

* The tide data from a single tide station can be applied to each survey line as a whole.

» Tide data from multiple tide stations can be compiled. The tide data is loaded for each part of a
line as determined by the zone the part falls into.

To define a tide zone several parameters are required:

* Zone boundary in geographic coordinates.

* The location of the primary tide station.

* Locations of up to 3 optional secondary tide stations.

* Time offset in minutes for each station.

* Range offset / tide scalar for each station.

* Outage limit in minutes controls when data will be extracted from secondary stations.

* Interpolation interval in seconds for final interpolated tide loaded into each survey line data
structure.

Note: When using data from multiple stations, a weighted average of tidal observations along the
survey line is generated. This only works if the information about the tide coefficients is given in
the tide zone file. The weight given to the tide data is inversely proportional to the distance
between the station and the swath data, which is why the zone definition file should include
latitude and longitude positions for tide stations.

To apply tide you have to select all of the lines and click on the Load Tide tool button or select
Process > Load Tide.

The tide weighting formula can be expressed as the following;

Ti = The tide value for the ith profile along the line

tx = The tide value from the xth tide station for the time and location of the ith profile
Wx = The weight of the tide value coming from the xth tide station

dx = The distance between the ith profile along the line and the xth tide station.

GPS Tide
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HIPS has the ability to use ellipsoid heights from GPS RTK instead of traditional tide data.

GPS Tide data is applied optionally as part of the Merge process. It is used as a direct
replacement for regular tide data. The vessel configuration is used as normal with respect to
transducer offsets, calibration values, application of heave, pitch, and roll, etc.

In order to apply GPS tide you first need to calculate it. This calculation is performed with the
Process > Compute GPS Tide... command.

To be able to use the GPS height information for tidal corrections, the separation between the
ellipsoid and the vertical survey datum needs to be known. When computing the GPS tide this
separation can be entered as a single value or a model file can be used. Two binary sounding
datum models can be used for computation of GPS tide:

* GEOID99

* EGG97 (European Gravimetric Geoid 1997)

Alternatively, an ASCII sounding datum model can be used. The data must be in the format Lat,
Long, Z, for example: -33.848326,151.192435,20.4

Not in all cases raw GPS height will be recorded in the raw data files. The used acquisition
system may already have made corrections on this data. To allow for this it, is possible to select
which terms of the GPS tide computation should be applied and which not. If a sensor has
already been applied on the GPS heights by the acquisition system, it should not be applied by
HIPS. Only corrections that are selected in the Compute GPS Tide dialog will be applied in the
computation.

Merge
Merge takes into consideration all of the horizontal and vertical offsets in the HVF to produce a

processed sounding.
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Parameters marked with an * have been applied in the SVC process. Some additional parameters
need to be selected as part of the Merge process. These include:

* Apply Refraction coefficients

* Apply GPS tide

* Smooth Sensor data

Compute TPU
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In order to generate TPU values for each sounding, the definition of uncertainty estimates for
each of the contributing sensor measurements has to be combined using a propagation
algorithm. The result is a separate uncertainty estimate for the depth, DpTPU, and horizontal
position of the sounding, HzTPU. The results are presented at the 95% confidence interval
which is equivalent to 1.96 x the standard deviation.

The compute TPU function must be performed after the Sound Velocity correction. Whether it is
applied before or after Merge will depend on your adopted workflow. When you compute TPU it
will always be done on the Observed depths, therefore tide and draught offsets will not affect the
values.

This calculation is performed with the Compute TPU tool button or Process > Compute TPU.
The TPU values will be calculated for the soundings based on the errors defined in the HVF, the
Total Propagation of Uncertainty algorithms and the survey specific uncertainty estimates

81




defined.

Defining New Field Sheets

Field sheets are essential for the creation of Weighted Grids and BASE Surfaces.

Field Sheets can be created in locations other than the directory directly under HIPS.

To create a New Field Sheet the user can use the New Field Sheet tool button or select Process
> New Field Sheet.

- Enter a Name for the Field Sheet.

Note: Field Sheet names should be made up of alphanumeric characters only and should not
contain spaces.

- Enter a Scale.

- Leave the default values for the Horizontal and Depth Resolutions. This will define the
measurable accuracy of the coordinate and depth resolutions.

- Confirm the UTM Zone / Mercator

- Define Field Sheet extents by three ways:

1) Select the Current Display button to use the current display as the perimeter.

2) Define the extents with the mouse by clicking on the User Defined Area button.

3) Type in the coordinates for the bottom left and top right corners of the field sheet.

- Create a user defined Field Sheet large enough to accept all of the data in the survey area.

Once a new Field Sheet has been created it will appear as a new layer in the Layer tab of the
Control Window. The display of the Field Sheet name and outline can be controlled by the
Properties dialog box.

The Field Sheet icon in the Control Window is green, meaning that this is the active Field Sheet.
If you have more than one Field Sheet open then it is possible to change which is set as active.
This is achieved by right-clicking on the Field Sheet name in the Control Window and selecting
the Set as Active Field Sheet option from the pop-up menu.

The BASE Surface
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HIPS supports the ability to create three different surface types:

» the Swath angle surface,

» the Uncertainty surface, and

» the CUBE surface.

Through the BASE Surface Wizard the user can select which type will be created. The surface
types use different weighting algorithms to produce gridded images of the sonar data. All three
surface types will produce a smooth surface that retains the sonar resolution. The user also has
the ability to preserve shoal or critical values.

The CUBE surface is also a powerful, semi-automated cleaning tool that can be used to increase
processing efficiency. Both Swath and Uncertainty surfaces can also be used for cleaning to
some degree.

BASE Surface

When the cursor is moved over the BASE Surface, tool tips are displayed showing the value for
the nearest Base Surface node. This option can be toggled on/off in the Tools > Options menu
option under the General tab.

BASE Surface nodes can also be selected and queried. To query surface node values, enable the
display of the surface in the Control Window and highlight that layer. Left click and drag to
select an area of nodes. Select the Edit > Query menu option to have the XYZ values of the
selected nodes displayed in the Query window.

Note: To obtain the maximum BASE Surface resolution it is often best to create a small BASE
Surface and work upwards. If working with a single resolution the first BASE Surface you create
may be 1% of the average water depth. The other option is to create a surface with a resolution
that varies with the water depths of the survey area.

The initial BASE Surface may contain holes; the holes represent areas where the data was not
dense enough for the resolution selected. In such areas you can interpolate to fill in the holes.
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The Swath Angle BASE surface is a rasterization method specifically designed for multibeam
data. It is an accurate representation of multibeam data because it considers the actual geometry
of the sonar system. It does this in three ways:

Variable radius of influence - The radius of influence of each sounding is calculated from the
beam width of the selected sonar, and increases with depth and grazing angle. This addresses the
increase in footprint size with distance from the sonar head.

Range weighting - The range weighting for each sounding decreases with distance from a node.
This lessens the effect that soundings further away from the node will have on the BASE surface.
Grazing angle weighting - Errors in multibeam data tend to increase in magnitude in the outer
beams due to the longer ray path distances. This tends to magnify refraction problems and other
errors. The grazing angle weight function is applied to each sounding to reduce the effects of the
outer beam soundings on the BASE Surface.

This weight function is controlled in an ASCII file called GrazingAngleWeights.txt in the
HIPS\System directory. This file can be modified by the user

84




Uncertainty Surface — Theory
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As mentioned previously, the horizontal TPU (HzTPU) and depth TPU (DpTPU) values are used
in the creation of an Uncertainty BASE Surface. When creating an Uncertainty BASE Surface
each sounding value will have an associated depth uncertainty and horizontal uncertainty. The
depth uncertainty that each sounding has increases with the horizontal distance from the surface
nodes. Therefore the greater the distance, the greater the uncertainty, and the less the sounding
will contribute to the node.

The point at which a sounding will no longer contribute to a node is dependent upon the IHO S-
44 Order selected. A sounding will only contribute to a node if the propagated vertical
uncertainty of the sounding does not exceed the vertical accuracy requirement specified by the
order.

CUBE Surface — Theory
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The CUBE (Combined Uncertainty and Bathymetry Estimator) Surface can be used as a cleaning
tool in the HIPS workflow, besides being an end product or for product creation.
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During the CUBE Surface creation, soundings are weighted and contribute to surface grid nodes
based on TPU values and distance from the nodes. The weighting method is similar to the
Uncertainty BASE Surface creation.

The CUBE Surface however, allows for multiple depth estimates or hypotheses to exist at a
single grid node, depending on the variation of the sounding data. CUBE then uses
“Disambiguation” to determine which hypothesis at each node is the most “correct”.

Users can verify, and if necessary override, CUBE decisions in Subset Editor. Once any
necessary edits have been made to the CUBE surface, the CUBE filter can be applied to the data.
Any sounding data that is not in agreement with the selected hypotheses will be flagged as
rejected.

Before generating a CUBE Surface, all lines to be included must be merged and TPU must be
computed.

- Highlight the field sheet name and then select the New BASE Surface tool or select Process >
BASE Surface > New.

- Enter a name for the BASE Surface.

Note: It is a good idea to give the grid a name that relates to the resolution. Do not use spaces or
non-alphanumeric characters.

- Enter a Resolution.

- Select CUBE for the Surface Type.

The Depth Filter can be used to limit the depth range of the generated surface to a specific
interval.

- Set IHO S-44 Order.

- Select Density & Locale as the Disambiguation method.

- Click the Advanced button and ensure that the Default Configuration is selected on the
Advanced Options dialog.

- Ensure that the Initialization Surface option is deselected.

The Disambiguation method will determine the method CUBE will use to determine the most
likely bathymetry estimates. In this case it will use Density but if it is not confident in a selection
it will utilize the Locale method.

The Advanced Options tab allows users to select or define the parameters to be used for the
CUBE Surface creation. There are several pre-configured parameter sets available for selection.
The configuration selection should be made based on the water depths and seafloor complexity
of the survey area.

Note: Only experienced users should adjust or define the CUBE parameters. It is also possible
for CUBE can use an Initialization Surface to ensure that grossly erroneous soundings will not be
utilized in the CUBE surface creation. The CUBE surface will be visible in the Display window
and the surface child layers, which are created by default, will be added to the Layers tab.

The CUBE surface contains the following layers:

* Density: The number of soundings that contributed to the selected hypothesis.

* Depth: The depth estimation of the selected hypothesis.

» Hypothesis Count: The number of different depth estimations at the surface node.

» Hypothesis Strength: A value to describe how mathematically confident CUBE is that the
correct hypothesis was selected during disambiguation. Like Uncertainty, lower values are better.
* Mean: The mean of the soundings that contributed to the selected hypothesis.
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* Node Standard Deviation: The combined standard deviation of the soundings that contributed
to the selected CUBE hypothesis.

« Standard Deviation: The average standard deviation of the soundings that contributed to the
selected CUBE hypothesis.

» Uncertainty: The vertical uncertainty associated with the selected hypothesis. Lower
uncertainties are better.

» User Nominated: This layer indicates if the hydrographer has nominated a hypothesis during
hypothesis editing. This process will be explained further in a later exercise.

» Guide_Depth: This layer represents the depth values of the initialization surface but resampled
and displayed at the same resolution as the CUBE surface. This layer is only displayed if an
initialization surface was selected during the surface creation.

» Guide_Uncertainty: This layer represents the uncertainty values of the initialization surface
but resampled and displayed at the same resolution as the CUBE surface. This layer is only
displayed if an initialization surface was selected during the surface creation.

* Bounding Polygon: This layer is a coverage polygon representing the boundaries of the data.
The polygon includes the outer boundary of the data as well as an holes in the data.

The CUBE Surface can be shaded to assist in feature recognition. This and other image
manipulation tools can be accessed via the Properties tab. This window can be used to
manipulate the display of the various layers displayed in the Layers tab well as change the
Disambiguation method used in the CUBE surface Creation.

Furthermore, the layer selected in the Layers tab will be displayed in the Properties tab. The
following can be accessed when a BASE surface layer is selected:

 Colour Map and Colour Range — Control the display of images using Colour Maps (colours
defined by pixel values) or Colour Ranges (colours defined by surface values). Colour Maps
and Colour Ranges can be edited by click the Browse button to launch their respective editors.

» Transparency (%) — Set a transparency percentage to be applied to the display of the image.
This is useful when displaying multiple images in the HIPS Display.

» Depth Filter — Filter the display of surface nodes by specifying a minimum and maximum
depth value.

» Raster Legend — Enable the display of a Raster Legend to show the correlation between the
surface values and selected colours in the HIPS Display window.

» Shading and Vertical Exaggeration — Shade the image to bring out surface texture. The
shading can be changed by moving the sun symbol or entering values for Azimuth and Angle.
Use the Vertical Exaggeration option to control the apparent vertical height of the surface, as
this can also help to distinguish features.

Whether a surface is updated when changes are made in Subset Editor is defined using the “Keep
Up To Date” flag for a surface.

Data Quality Control

87




Data Quality Control

* Problems with sensor
offsets, auxiliary sensor
data, etc. become apparent
in the BASE Surface

— Analyse and, if necessary,
edit problem areas
highlighted in the BASE
Surface

— Technigue to improve
processing efficiency

caris

Prior to surface creation the auxiliary sensor data has not been investigated. The BASE surface
can be used to highlight problems that may exist in the attitude and/or navigation data, problems
which can be addressed using the Navigation and Attitude Editors.

By relying on the gridded data to highlight problems in the auxiliary sensors, processing
efficiency can be improved, as the user is no longer required to investigate the motion and
navigation of each survey line.

Note: A survey line must be selected before any of the line editors can be opened.

—

Data Quality Control
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If changes are made to the navigation and/or motion data through the QC process it will be
necessary to repeat previous steps in the HIPS workflow. The workflow diagram displayed here
outlines the operations that need to be recalculated if changes are made.

Navigation Editor

The Navigation Editor lets you examine and clean individual position fixes as recorded by the
vessel’s positioning system.

- Select the first survey line in either the Control or Display Window.

- Select Tools > Navigation Editor or click on the Navigation Editor button in the Tools toolbar.
The Navigation Editor tab will be added to the Control window. This tab has four areas
containing navigation editor controls:
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» The General section allows the size of the navigation fixes to be changed. You can also specify
if you want the points to be connected. You can select to display the graphs vertically or
horizontally, and choose whether the minimum and maximum values displayed are for the entire
line or the current view.

» The Interpolation method section determines the interpolation method used. This can be
either linear or a tight, medium, or loose bezier curve. These are explained on the next slide.

* The Spike detection sections contain controls for finding speed jumps or time jumps.

* The final section deals with the Number of points that are displayed in the Display Window,
this can either be based on a zoom factor or a fixed value. Users may also enable the display of
Gyro Indicators and set the length and colour to provide an visual indication for the direction that
the survey line was run.

When checking navigation, keyboard shortcuts can be used to speed up the procedure.

Navigation Interpolation:

Position observations do not usually occur at exactly the same instant in time as a depth
observation (ping). It is also unlikely that there is a position for every ping.

In most cases it will be necessary to interpolate positions to match the times for each ping. The
interpolation method is set in the Interpolation method section of the Navigation Editor tab.

The default method is Linear, where interpolation between each successive position is obtained
by simply connecting the positions with a straight line. Linear interpolation is suitable when the
original navigation positions are clean and do no significantly deviate from the neighboring
positions.

The other three options (Loose, Medium, Tight) are various degrees of Bezier Curve. In these
cases the line of interpolation will not follow the navigation positions exactly.

Edit Navigation:

There are four main edit functions that are used when editing data in the navigation or attitude
editors.

» Accept - This will change the status of all selected sounding positions to Accepted. This can
also be activated using the A key as a shortcut.

* Reject - Break Interpolation - This will reject selected sounding fixes without trying to
interpolate their position. (Navigation for the pings is interpolated from the navigation data.)
This function causes all soundings between the navigation fixes immediately before and after the
gap to be rejected. Use B as a the shortcut key.

* Reject -With Interpolation - This rejects selected navigation fixes but interpolates a position
over the gap. This can also be activated using the W key.

* Query - This gives the details of the fixes in the Worksheet window. The data can then be
sorted in ascending or descending order by double-clicking the column heading. This can be
useful for finding jJumps and spikes. The Q key can also be used.

The whole line can be queried by right-clicking and selecting Query Line from the popup menu.
This information is in memory, so it lists quickly, and the data can be pasted or saved as a text
file for use in other software.

Attitude Editor
The attitude editor is used to display and edit sensor information.
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You have to select a line, and then select the Attitude Editor tool button or Tools > Attitude
Editor.

Gyro, Heave, Pitch and Roll sensor information is displayed by default. More sensors can be
added by selecting them from the available sensors list, which can be accessed from the Tools >
Sensor Layout menu.

Other sensor data could be GPS Tide, Side Scan Gyro, ROV Altitude etc.

The four default windows in the Attitude Editor display time series graphs for Gyro, Heave,
Pitch and Roll. The tools to manipulate this data are available in the Control Window under the
Attitude Editor tab.

When the cursor is placed on one of the time series graphs, the value is displayed as a tool tip.
Gyro data in CARIS HIPS is displayed as a positive value when a clockwise rotation is
experienced.

Heave data in CARIS HIPS is displayed as a positive value when the vessel is heaved upwards.
Pitch data in CARIS HIPS is displayed as positive when the vessels bow is down. Roll data in
CARIS HIPS is displayed as positive when the vessels starboard side is up.

Filtering:

The Moving Average option works by averaging data within a window. The window size can be
based on seconds or number of data points. Increasing the size of the window increases the level
of smoothing.

The Fast Fourier option takes out all frequencies which have a shorter wavelength than the box
size set in points or seconds.

The Threshold option sets the cut-off value as a multiple of the standard deviation. The cut-off
value is applied to the difference data. The Difference between the filter line and the sensor data
is then calculated. This difference will be greater in areas in which local variability is high. Any
difference values outside of the threshold limit will be rejected with interpolation.

Filtering can be applied in three ways: either the present screen only, filter to the end of the line,
or filter the whole (selected) line. Filtering can be applied with or without interpolation. As in the
Navigation Editor, sensor values may be Queried, Accepted, Rejected (with interpolation), or
Rejected (break interpolation).

Motion data that contains high-variability noise can be addressed by using the smoothing routine.
Smoothing parameters will be stored separately and applied during Sound Velocity Correction.

Swath Editor

The Swath editor is used to view and edit the multibeam swath data. This can be either a manual
process or a semi-automated one using filters based on knowledge of the data.

After select the first survey line in the Project tab of the Control Window click on the Swath
Editor button or select Tools > Swath Editor.

The Swath Editor has several windows:

» Swath Editor tab - A new tab appears in the Control Window, containing a number of sub-
panels that are used to manipulate the data in the Swath Editor.

* Plan View - Displays the beams and swaths in plan view. The bottom of the display is the start
of the line. The scroll bar can be used to page through the data.

* Side View - This is an along track profile of all the swaths in the Plan View viewed from the
starboard side, so that forward is to the right of the window.
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* Profile View - This view represents a single swath at a time viewed from the rear. The scroll
bar can be used scroll through the individual profiles.

* Rear View - This is the data displayed in the Plan View window viewed from the rear of the
ship.

» Amplitude - If the sonar data contains intensity information then it can be displayed in this
window. This view can assist in feature recognition.

* 3D View - In addition to image manipulation in the 3D View, the data can be selected, rejected,
queried and accepted.

Subset Editor

The Subset Editor is activated by either clicking on the Subset Editor icon or by selecting Tools
> Subset Editor > Open from the main menu.

A new Subset tab will appear in the Control window, and an additional toolbar will be displayed.
The cursor in the Display Window will change to crosshairs to define the outline of the subset to
be edited.

To define a subset drag a box around the data to be included using the left mouse button.

The subset outline can be rotated by holding down the Ctrl key while drawing. The subset can
also be resized by dragging the corner anchor points.

The yellow 2D profile window can be resized or moved by dragging the anchor points.

To move the 2D slice along the subset use the keyboard arrows.

The toolbar has the following options:

* 2D and 3D windows can be toggled on and off.

* The status of subset tiles can be set to incomplete, partially complete or complete.

» The subset can be locked, so that the no accidental resizing, moving, and rotation can take
place causing a redraw. The subset can also be locked by pressing the <L> key.

The Subset Editor tab has the various Subset Editor items organized into a Data tree. By
selecting the items in the Data tree, the corresponding properties will be displayed in the
Properties section of the Subset Editor tab.

Subsets should not be too large. If they contain too many soundings they will take too long to
open.

Editing windows:

The user can pan (middle mouse button) and zoom in/out (Crtl+right mouse button) on the 2D
View. Other functionality includes:

» The View Direction of the data in the window is relative to the subset orientation. The yellow
arrow on the subset outline in the Display points towards the top. The view direction should be
selected with this in mind. Select Automatic to always have the 2D View display along the
longest edge of the slice.

* Set the display by selecting Auto Exaggeration, min/max values or by adjusting it manually
using the Vertical Exaggeration in the 2D View. You can also choose to Include Rejected
soundings in the scaling. Soundings can be displayed as digits and graticule labels can be turned
on and off.

The 3D View is controlled in the same way as the 3D View for the Swath Editor. There are
however functions that are specific to the Subset Editor.

» The Data Display options allow for the 3D view display Type to be set as Points, Spheres,
Cylinders, Surface or Surface Wireframe. The Subset Outline and 2D view slice can also be
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enabled for display in the 3D View. 3D Dynamic Skip reduces the number of points displayed
while the 3D View is being manipulated by the user.

» Under the Controls the user can Allow rotation under data. This allows the operator to rotate
the data beyond the horizontal and view the underside of the sounding data. The display of the
Compass, Lighting and Exaggeration can also be enabled/disabled.

Recompute the BASE Surface

Recompute the BASE e
+ Use the Recompute function to rebuild a BASE
Surface s
— Recalculate node values using only accepted ﬂ
soundings
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After you have finished editing the data in the Subset Editor and exited out, or cleaned the
bathymetry using the Surface filter, the BASE Surface may appear outdated. This is indicated by
a red exclamation mark on the BASE Surface icon in the Session tab of the Control Window.
The Recompute function enables quick recomputing of a BASE Surface to update any changes
that have been made.

If all manual edits had been performed in the Subset Edit with the Automatic BASE surface
update option selected under Tools > Options the surface would already be up-to-date and
would not need to be recomputed. Automatic BASE surface update recomputes small sections
of the surface as the user moves across the point cloud in Subset Editor.

If the surface is outdated select the BASE Surface from the Control Window, right mouse click
and select Recompute from the pop-up menu.

All changes made during the editing process will be applied to the BASE Surface.

The data should now be geo-referenced and cleaned.

The HIPS data can now be used to create bathymetric products. These are generated in the Field
Sheet Editor.

Bathymetric products include Selected Soundings, Contours and others.

Product Surface

The first step to generating smoother contours is to create a Product Surface. The Product
Surface maintains the designated soundings from the finalized BASE Surface and can be used to
create more cartographically correct contours. A generalized surface is created by rolling an
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imaginary ball over the BASE Surface. The user can specify the scale and radius of the ball. The
ball will be rolled over the surface at the interval defined by the resolution.

The Product Surface is activated highlighting the Field Sheet layer and selecting Process >
BASE Surface > New Product Surface.

Sounding Selection

It is impossible to display all soundings produced by a multibeam survey on a map or chart and
maintain legibility. The selection of soundings that appear should be dependent on chart scale
and purpose. Soundings can be created from a Tile layer or BASE Surface.

Click on the Create Sounding Layer icon or select the Process > Products > Soundings >
New Sounding layer.

Soundings can be displayed in two ways, the soundings can be engineering style, with decimals,
or they can appear as slanted soundings with drop decimeters.

Note: In most situations it is wise to use the same data source for soundings and for contours.
This removes the possibility of producing soundings on the wrong side of contours.

Contouring

Contours are created using a three step wizard.

Open the Contouring wizard by clicking on the New Contour Layer icon or by selecting the
Process > Products > Contours > New Contour Layer.

Contouring from different sources produces different results. The BASE Surface (swath angle
method) is a mean surface, whereas tiles or bins can be shoal-biased. If you are creating products
that will be used for navigation then a bin or uncertainty BASE Surface maybe a more
appropriate source for building contours.

- Select the Depth layer of the generalized Product Surface as the height source.

- From the Standard Contour tab select an interval.

- The Theme Number will determine how layers are named and organised, this information can
be used by CARIS GIS to differentiate the data.

Export Data

* CARIS HIPS and SIS~ [aydney St Export Data ﬁ

+The export wizard supplies a
variety of export options for
multibeam data:

— CARIS Map

— ASCII files

— GSF, HOB, HTF
— Images
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This will launch the Export Wizard. There are various export options available. Data, grids, and
images can all be exported using this wizard.

The BASE Surface generated in HIPS can be exported to image file or ASCII file. The user can
specify the units for the exported depth values and additional sounding information can also be
exported as optional attributes.

The depth can be exported as an ASCII file.

4.3 Generic Mapping Tools (GMT)

Generic Mapping Tools (GMT) (Wessel and Smith, 1998) is a collection of open source
mathematical and mapping routines for use on gridded data sets, data series, and arbitrarily
located data. The GMT package is available for download from the University of Hawaii
website (http://gmt.soest.hawaii.edu/).

4.4  r2v, Surfer, Global Mapper
Contributed by John Hall, Geological Survey of Israel (Retired), Israel

Recent compilations of the Caspian Sea and the Red-Arabian Seas illustrate the preparation of
high  resolution grids using the r2v  (www.ablesw.com), Global Mapper 12
(www.globalmapper.com), Surfer 9 (www.goldensoftware.com) software.

An overview of each of the packages follows:

4.4.1 Able Software Corporation's r2v (raster to vector)

A license for r2v costs $395 for an academic user, or $795 for non-academic
(www.ablesw.com/rv2/price.html). A USB dongle is now employed. As used for bathymetry, a
scanned map is geo-referenced, either using Global Mapper (more convenient), or r2v. Once a
.tfw (true world file) exists, r2v can work in map coordinates, which are usually Mercator. Very
few of r2v's capabilities are used for this work. Mainly the automatic line following is used,
following conversion to grayscale, and then contrast selection to accentuate contours while
eliminating background. The program will rapidly follow a line until a gap or branch is
encountered. One then toggles to manual mode, passes the obstruction, and continues in
automatic mode. The program gives complete control over the nodes, adding, moving,
smoothing, deleting, and joining. Use of the F2 and F3 keys allows almost unlimited
magnification for very steep slopes. Navigation across the map is very easy. Contour values are
easy to apply, either individually, or by identifying a beginning value and increment and then
drawing a line across sequential contours. For complicated contours it is possible to color code
the contours. Output of r2v is generally via a .dxf vector file, or as .xyz points, although other
formats are available. The program is also able to digitize points, but each point requires a
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number of steps. Dr. Ted Wu is the owner of Able Software and readily answers questions. A
trial version of r2v can be downloaded.

4.4.2 Global Mapper Software LLC - Global Mapper 12

A license for Global Mapper 12 is $349 (www.bluemarblegeo.com), and somewhat less
expensive for multiple licenses. Global Mapper was started in 1991 by Mike Childs, who is very
responsive to additions and modifications to the program, which undergoes regular
improvements. In short, GM12 is a comparatively easy to use program which deals with a wide
variety of raster images, grids and vectors, especially those available on the Internet. It deals with
a continually increasing number of projections and datums, as well as formats, and allows speedy
conversion between them. For our purposes, GM12 allows rapid geo-referencing of charts, rapid
TIN display of .xyz files prepared by r2v, projection change of .dxf files, rapid display of
multiple grids, superposition of various raster and vector layers, highspeed input of grids
(ASTER-GDEM, SRTM, SRTM30-Plus, GEBCO_08, IBCAOQ etc.), and their manipulation
(cropping, clipping, translation, scaling, offsetting etc.). Global Mapper has a tight non-lossy grid
format (.gmg).

Global Mapper also offers display and logging of GPS data, draping of imagery or maps on grids
with 3-D display, digitization tools, contouring, view-shed and water-shed analysis, screen
capture, topographic profiles with slopes, palette construction, shading options etc. It has also
become an important connectivity and display tool for sophisticated multi-platform users of
programs such as GMT, ArcGIS, CARIS, and IVS Fledermaus. Two features lacking on Global
Mapper are the ability to convert .dxf files to xyz (which can be done with the free program
dxf2xyz from www.guthcad.com), and the use of degrees minutes and seconds for geographic
coordinates output to .csv format. This is important for merging new digitized contours and
shorelines with the spot soundings digitized years ago, to form a single file for interpolation by
Surfer. The work-around of course is to use Cartesian meridional parts for Mercator maps, or
else UTM coordinates.

4.4.3 Golden Software Inc. Surfer® Version 9

A license for Surfer's latest version 9 is $699. Global Mapper has the 3-D display, contouring
and hypsometric shading and palette selection capabilities of Surfer. However Surfer is the
program of choice for interpolation of grids from the tens of thousands of points generated by
r2v and the historical digitization of soundings. The Surfer gridding interface allows rapid
investigation of the input files, and the Filter Data function deals with duplicates as well as
averaging points that are so close that steep gradients would be formed.

Grid Construction
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As an example, over 55% of the Mediterranean has now been mapped with multibeam sonar.
The MediMap Group (http://www.ciesm.org/marine/morphomap.htm) has pooled their data and
it is currently available within the group at a node spacing of 500 m. Efforts to decrease this
spacing has apparently been opposed by commercial interests. Basically this coverage is
sufficiently good to make a first pass at a 0.1' grid for IBCM-I1. Israel is now concluding a
decade of pro-active mapping with a Kongsberg-Simrad EM1002 owned by John Hall, installed
on the Israeli government vessel R/V Etziona. Over 10,000 km? of the Mediterranean offshore
have been surveyed, from minimum depths of 15 m to about 700m with the EM1002, and then
recently out to 1,600 m depth with a rented L-3 ELAC Gmbh SB3050 system. While the Israeli
government regards the digital data as classified, grids of 1200 m on the shelf and 50 m in deeper
waters are available. Hopefully this will encourage other countries to allow use of higher
definition deep water data.

The seas that are of interest follow, in order of size etc.:

Water Body Total Area Max Depth Shoreline Countries
Mediterranean 2,966,000 km? 5267 m 46,000 km 22
Red Sea 438,000 km? 2211 m 11,254 km 8
Black Sea 474,000 km? 2206 m 4,340 km 7
Caspian Sea 371,000 km? 1025m 6,397 km 4
Persian Gulf 251,000 km? 90 m 3,334 km 8

Russian charting at about 1:200,000 covers the periphery of all these bodies. Thus grids can be
obtained by first taking the land coverage at 30 m from the latest ASTER-GDEM. These come in
one degree squares (called granules) and can be downloaded, up to 2000 at a time, from
http://reverb.echo.nasa.gov. It is necessary to register, and after choosing and verifying the
coverage wanted, one receives a verification and link to an ftp site. The granules can be quickly
downloaded with an ftp client program like Filezilla (http://filezilla-project.org). The files consist
of the height values (.dem format) and the number of scenes used (.num). Global Mapper 12 will
rapidly ingest the height data while ignoring the .num component, and can then output single
.gmg grid files with the data for the overall area. The next step is to remove the data over the sea.
This can be done by using Tools>Control Center> Options>Alter Elevation Values to reject
anything below 0.1 m. While this will generally work, sometimes the alternative is to single out
specific granules and crop them using an area boundary in Global Mapper or a blanking file in
Surfer. Such a file is usually the 0 m contour from the digitizing done in r2v.

The clipped ASTER-GDEM file gives a pretty good indication of where the land is, and for
checking the marine data which often is pre-WGS84 or WGS72 datums. Older Russian charts
sometimes referred to the Russian Pulkovo S42 datum of 1942, or in the case of early British
surveys, relative to one of the 700 datums used in UKHO surveys. Global Mapper's ability to
overlay and translate charts can correct some of these geodetic displacements.

The next step is to geo-reference the 300 dpi color scans of the charts, one at a time, using
Global Mapper. The georeferencing can be checked by bringing up
Tools>Configure>General>Grid Display>Lat/Long Grid and specifying the map graticule
interval. Visual inspection will then indicate the quality of the georeferencing. General four
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corner control points will suffice, but for a long body like the Red Sea, perhaps as many as 20
points may be necessary. Using File>Export Raster Image Format>GeoTiff allows export of a
GeoTiff with .tfw true world file that can be used in r2v. At present 92 different projections can
be used. Generally it is best to use Cartesian coordinate like meridinial parts or UTM.

Within r2v the coastline and available contours are digitized and their depths noted. Where inset
charts at larger scale are available, the spot soundings were separately digitized, and data from
them can be digitized separately and then later merged by loading the larger scale .dxf contour
file into the smaller scale chart. Where necessary, spot soundings can also be picked up. In order
to seamlessly place the bathymetry under the land coverage, the high elevations shown on the
navigational chart may be digitized so that the kriging process will apply a landward slope
commensurate with the actual topography. Inshore contours at 3, 6, 10, 20, and 50 m are often
almost continuous, so that the shallows are reasonably well represented. For the southern Red
Sea, where there are numerous reef areas indicated from space imagery, fictitious contours at 20
and 3 m depths help to define the reefs. In general, where ships travel, the hydrographers have
soundings, but of course, regardless of what the final grid spacing is, the results must be clearly
marked as "Not To Be Used For Navigation.”

Coastal navigational charts generally overlap one another, so if each is digitized and then
interpolated to a grid, their grids can later be cropped and stacked appropriately within Global
Mapper for output as the final grid. In the case of the Red Sea, UTM grids were interpolated at
100 m for Zones 36 and 37. Global Mapper keeps the grids at the finest scale used, so with
ASTER-GDEM 30 m data the default output would be 100 m.
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Chapter 5.0 Gathering Data

There are many types of geophysical data available for free download from the internet. In this
chapter we show where to obtain data useful for researchers desiring to create grids from
publicly available bathymetric data.

5.1 NCEI and IHO DCDB Bathymetry Data
Contributed by Susan McLean, National Geophysical Data Center, USA

The National Centers for Environmental Information’s (NCEI, formerly NGDC) mission is to
provide long-term scientific data stewardship for marine geology and geophysical data, ensuring
quality, integrity, and accessibility. This includes archiving and making available bathymetric
data collected by NOAA, UNOLS (University-National Oceanographic Laboratory System),
other US government agencies, and foreign entities. These data include ocean multibeam and
single beam surveys, coastal multibeam and single beam surveys (hydrographic surveys), and
digital elevation models compiled from various data sources. NGDC is co-located with the
International Hydrographic Organization Data Center for Digital Bathymetry (IHO DCDB)
which serves IHO member states and the international community by archiving and providing
access to global bathymetric data.

Both Centers provide ancillary data files essential to bathymetric data processing. These files
include metadata records, sound velocity profiles, navigation files, tides files, and ship logs.
When provided by the chief scientist, survey derived products are also made available. However,
the bulk of data archived and available to the public are raw multibeam files.

Availability of the raw data allows scientists to edit the data to any specification. Raw multibeam
data require a multibeam reader/editor to produce products which are more widely interoperable.
Since manipulating the raw data files can be time consuming, the centers offer products which
are already edited and in a format readable by many desktop applications. One such product is
the Bathymetric Attributed Grid (BAG) file. BAG (http://www.opennavsurf.org) is a gridded,
multi-dimensional bathymetric data file.

5.1.1 Discovering and Identifying Data

NCEI’s Bathymetry Data Viewer (http://maps.ngdc.noaa.gov/viewers/bathymetry) (Figure 5.1)
is an interactive mapping application that allows discovery, identification, and access to
bathymetry data archived at NCEI. Here we describe how to interact with the map to identify and
obtain data from the NCEI website.
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Figure 5.1 NCEI Bathymetry Data Viewer, displaying Multibeam Bathymetry Surveys. Surveys are color-
coded by year (newer surveys are green and older surveys are orange).

Navigating the map:

Click and drag to pan the map.

Use the zoom slider to zoom in/out, or shift-click and drag to zoom into a box.

Toggle the different basemaps with the “Select Basemap” drop-down menu.

Toggle the boundaries/labels and graticule with the “More...” drop-down menu.

Switch to an Arctic map projection with the button in the lower-left.

Toggle the various data layers with the checkboxes in the right panel. The available layers are:
Multibeam Bathymetry surveys (shown in Figure 5.1)

Trackline (single-beam) Bathymetry surveys (shown in Figure 5.2)

NOS Hydrographic Surveys for U.S. near-shore areas. The user can toggle Digital Surveys,
Analog Surveys, and Bathymetric Attributed Grids (shown in Figure 5.3)

Digital Elevation Models (shown in Figure 5.4)

DEM Hillshades: shaded-relief visualization of DEMs (also shown in Figure 5.4)
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Figure 5.3 NOS Hydrographic Surveys
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Figure 5.4 Extents of Digital Elevation Models, with shaded-relief visualizations.
Identifying data:

Click on the map to identify data at the point clicked.

Alternatively, a user may define a rectangular area using the ¥ tool to draw a box on the map,
or the 5¥ tool to define a latitude/longitude extent.

A popup will appear, displaying data near that location (Figure 5.5).

Multiple surveys may be returned near where user clicks; mouse over the list to highlight the
surveys on the map.
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Figure 5.5 After clicking near the Hawaiian Islands, 5 surveys have been identified. EX0909 is highlighted on
the map.

Zoom to the extent of a survey using the magnifying-glass icon.
Click “Show Summary” to view a summary of all surveys in the list.
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Link to Data: Cruise File List ;
Survey Mame: Ex0909 =tHC
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Figure 5.6 Attributes shown for survey EX0909. For multibeam surveys, click on “Cruise File List” to go to a
page where data can be downloaded (described below).

Click on a row to display additional attributes for that survey (Figure 5.6).
A user can follow the link to go to a page where the data can be downloaded.

Downloading Data:
After clicking the download link from the map, a list of Multibeam data files is shown (Figure
5.7) and can be downloaded either individually, or as one large package. Shown below are

download pages for NOS Hydrographic Surveys (Figure 5.8), Trackline Bathymetry (Figure
5.9), and Digital Elevation Models (Figure 5.10).
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EX0909 Data File List

These data are not to be used for navigation.

Multibeam Bathymetric Data

Downloads may take 3 long time, depending on file size and data transfer rates,
Download All Files | < ---Click here to package and download all files listed below

File Name {click to view/download)

Multibeam Files ---- MBSystem Gruise Surnunary

Version 1 Full Resolution----

0000 20090822 210611 EX.mb58.qz

0000 20090825 214655 EX.mb58.qz

0000 20090826 060627 EX.mb58.gz

0000 20090831 215444 EX.mb58.9z
0000 20090912 214507 EX.mb58.gz
0000 20090915 031554 EX.mb58.9z
0000 20090915 183202 EX.mb58.97

0000 20090925 194808 EX.mb58.gz

0000 20091002 030850 EX.mb58.9z

0000 20091003 164419 EX.mb58.q7

0000 20091003 232450 EX.mb58.9z

nnnn_2?nnainn? 1aNAN7 FY¥ mh&0 e

File
Size

164.4
MB

4.6
ME
75.7
ME
29.4
MB
241.3
MB
75.8
MB
69.0
MB
24.0
MB
322.7
MB
136.7
ME
26.4
ME
O A hf

Description

Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format
Simrad multibeam format

Simrad multibeam format

Cimrad multihoam farmat

Figure 5.7 Multibeam Data download page.
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Office of Coast Survey

Survey Product List

These data are not to be used for navigation,
For navigation please refer to NOS Mautical Charts,

Downloads may take a long time, depending on file size and data transfer rates,

File

File Mame {click to view/download) Size

FGOC Metadata —---
gov.noaa.nos:H11272

Descriptive Beport ———-
H11272.pdf

Bathymetry Attributed Grid (BAG) —---

Data Select Data

O 12.4
H11272 10m Combined MLLW 3o0f3.bag.qz MB

[0 H11272 10m MLLW 2of3.bag.qz 1[352

Figure 5.8 NOS Hydrographic Survey download page.

Description

MNOAASMNOS FGDC fRSE metadata record
Usually presented as an %ML document, which
captures the basic characteristics of a data or
information resource.

MNOAASMNOS Descriptive Report in PDF format
The report may be viewed using a free Adobe
Reader.

[ select / Unselect All BAG files for conversion to XYZ text format. [ check here to include Uncertainty

NOAASMNOS Bathymetry Attributed Grid (BAG)
file

The BAG is a gridded, multi-dimensional bathymetric
data file, (http: ffwww .opennavsurf.org)),

Free Wiewer

NOAA/NOS Bathymetry Attributed Grid (BAG)
file

The BAG is a gridded, multi-dimensional bathymetric
data file, (http: ffweww opennavsurf.org/).

Free Wiewer

BAG files are available for this survey.
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DATABASE: Marine Trackline Geophysics Data
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Geophysical Data Summary in nautical miles

TS Nawvy Naval Oceanod
Survey Hawr Bath Maog Grav Seismics s3/ref wm77-recs data

GEODAS Search Complete!
1.2 Megabytes needed to store standard MGD?7T data from this SEARCH

Digtal Data with Format Options

disclaimers | guestions

website of the US Dept of Commerce/NOAAMNESDIS/MNGDC, last update Jan 10, 2006
page mantained by Dan & Mstzger@noss. qou

Figure 5.9 Trackline Bathymetry data download page (GEODAS).
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NGDC Coastal DEMs E

Mame
States
Region

Extent

Date Completed
Tyee

Hovizonts! Daturn
Frojection
Vertica! Daturn
Coverage

Cell Size
Registration
lYersion

Source

Froject

Contact

Start Mew Search

Santa Monica, CA 1/3 arc-second MHW DEM

Santa Monica

Califarnia
West Coast
34.2
N
+
-119.14 We4eE -117.8
33.2
2010-03-12

Tsunarmi Inundation

WS 54

Geographic

MHW {rmeters)
Bathy-topao

1/3 arc-second

Grid-node

1

MOAS S NGO [ MGG
MOAA Tsunami Inundation

Barry W Eakins @ NOAS S NGDC

The Santa Monica MHYY DEM covers the coastal area surrounding Santa Monica, California including the communities of Los Angeles, Malibu, Marina del Rey,
Redondo Beach, Long Beach, and Huntington Beach. The coordinate boundaries are 117.80% to 119.14%W and 33.20°N to 34.20°N.

ETOPCH
BoundariesLabelz

Channel
Islands

Downloads

DEM Development Repart (20.7 MB, pdfi
Santa Monica CA 1-3 arc-second MHW DEM.zip (490.9 MB, ESRI Arc ASCI

DEM Metadata Record

Related DEMMs

Santa Monica, CA 173 arc-second MAYD 88 DEM

DEM Restrictions

WARNING: DEM not to be used for navigation.

How to cite this DEM

Flease cite the DEM development report.

3

Figure 5.10 DEM Download Page. Data is provided in ESRI Arc ASCII format.

5.2 JAMSTEC Data

Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA
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Many types of geophysical data are available for download from the JAMSTEC website
(http://www.godac.jamstec.go.jp/cruisedata/e/), which is shown in Figure 5.11. Users who make
use of the JAMSTEC website are requested to register (click on “User Registration” tab). Here

we demonstrate how to obtain multibeam data from the JAMSTEC website.

@ JAMSTEC Data Site for Research Cruises
TAMSTEC BAIRET—FY1 I

Terms and Conditions | User Registration | Application

Data and Samples

JAMSTEC Top Page » Databases > JAMSTEC Data Site for Research Cruises

S,

JAMSTEC operates research vessels and submersibles for various area
and objectives. At this site JAMSTEC disseminates the data and samples
that have been obtained via its research cruises. Cruises are arranged in
vessels, years and cruise codes. Links to the page for each data and
sample are posted on the related cruise page.

This site posts the data and samples from JAMSTEC fleets; Natsushima,
Kaiyo, Yokosuka, Kairei and Mirai, and submersibles operated on these
vessels. Data and samples from submersibles are found on the data page
of the related vessel.

Please read the "Terms and Conditions" page before using the data or
samples on this site. For the off-line data or samples, please refer to the
"Application for Data and Samples" page.

[ What's new __m
+ 2010/10/08
+ 2010/10/07
+ 2010/10/01

+ 2010/08/30 YKO8-EDS5: Three component magnetometer data and Gravity
data were registered.

NT10-13 LegZ2 was registered.
K¥10-11 Legl was registered.
KY10-10 was registered.

+ 2010/09/30 NTO8-20: XBT data was registered.

+ 2010/09/30 XBT data and Bathymetry data were registered.
NTO8-19, NTO8-21 Legl, Leg2

» 2010/09/30 KY08-09: CTD data and XCTD data were registered.

+ 2010/09/30 KRO8-11: XBT data, XCTD data, Bathymetry data and Three
component magnetometer data were registered.

+ 2010/09/30 KRO8-10: XBT data, Bathymetry data, Three component
magnetometer data and Proton magnetometer data were registered.

» 2010/08/30 YK10-08B was registered.

Data Policy

© Japanese

JAMSTEC Top Page
Contact Us

NATSUSHIMA
data archives

KAIYO
data archives

YOKOSUKA
data archives

MIRAI
data archives

KAIREI
data archives

Search by Area
{ JAMSTEC Data Search Partal )

Site Policy | Privacy Policy

lechnology

& JAMSTEC &5ike

AAPAN AGENCY FOR MARRE-EARTH SCEMCE AND TECHMOLOGY

Figure 5.11 JAMSTEC Data Site for Research Cruises.
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Multibeam data may be downloaded from the JAMSTEC website as follows. The user first
selects the “data archives” link for one of the five research vessels on the main JAMSTEC
website (Fig. 5.11). The link opens a global map of cruises color-coded by collection year (Fig.
5.12). The user selects the desired year, and then the cruise ID. Selecting “Apply” opens the
individual cruise web page (Fig. 5.13). To reach the bathymetry web page, the user selects
“Bathymetry” from the right side of the cruise web page (see Fig. 5.13).

TAMSTEC fRJlfRET— 541 b

{@ JAMSTEC Data Site for Research Cruises © Japanase

Data Policy | JAMSTEC Top Page

Terms and Conditions | User Registration | Application for Data and Samples | Contact Us

JAMSTEC Data Site for Research Cruises » KAIRE| Research Data

KAIREI Research Data

Description of
the vessel

I Selection of Cruise

Please choose "Year" of the cruise, and then "Cruise ID". =
Eguipments

Year: === 2] Cruise ID: [=——- s (Apply )

Publicaticn list

0 G0E 10E 180 120'W EDW 0

Site Policy | Privacy Policy

ht 2008 Japan Agency for Marine-Earth Science and Technology @ JAMSTE :szﬁm{i“

RPN AGENCY FOR MARINE- EARTH SCIRMCE AND TECHUOLOG Y

Figure 5.12 KAIREI Research Data web page.

110




@ JAMSTEC Data Site for Research Cruises © Japanese
JTAMSTEC B HIRET — 541

Data Policy | JAMSTEC Top Page

Terms and Conditions | User Registration | Application for Data and Samples | Contact Us

JAMSTEC Data Site for Research Cruises > KAIRE| Research Data > KR05-01

KAIREI Data Site : KR0O5-01

KRO5-01 4 Cruise Report and Data Set
Peried : 05 Jan,, 2005 - 24 Jan,, 2005 *Bf Cruise Summary (Japanese)
Chief Scientist : Millard F. Coffin {The University of & Cruise Report
Tokyo)
B Mavigation
R KAIRE Crase Tracklina i KROS-0
- B XBT

B Bathymetry

B Three component
magnetometer

B Gravity

(RN s e v s v o oy e R

@fEnIarge Image

Site Policy | Privacy Policy
Copyright 2008 Japan Agency for Marine-Earth Science and Technology @ JAMSTE BITFEEA

TFE R
RPN MM FOHR MARINE EARTH SCEMCE AMD TECHMOLDGY

Figure 5.13 KRO05-01 Cruise web page.

Bathymetry data may be downloaded from the bathymetry web page (Fig. 5.14) via the “Data”
link, as well as information on the instruments, data format, and collection system details (i.e.,
the “Instruments,” “Format description,” and “Readme” links, respectively). The bathymetry
data may be downloaded as a number of compressed files in “zip” format (see Fig. 5.15) that
need to be uncompressed (“unzipped”) and then assembled sequentially into a single file. The
bathymetry data are ASCII xyz (longitude, latitude, depth) multibeam echo sounder ping records.
There may not be data along the entire track plot shown on the bathymetry web page and making
a plot of the coverage will reveal any gaps.
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@ JAMSTEC Data Site for Research Cruises © Japanese
JAMSTECHBARET —¥-1 |-

Data Policy | JAMSTEC Top Page

Terms and Conditions | User Registration | Application for Data and Samples | Contact Us

JAMSTEC Data Site for Research Cruises > KAIRE| Research Data » KR05-01 > Bathymetry Data

KAIREI Data Site : KR0O5-01 Bathymetry Data

Last Madified : 22 Feb., 2008

Processed Data

Instruments & Format description Readme © Data

Cruise information
P - Period : 05 Jan., 2005 - 24 Jan,, 2005
: «~ Chief Scientist : Millard F. Coffin (The University of Tokyo)

Site Policy | Privacy Policy
Copyright 2008 Japan Agency for Marine-Earth Science and Technology @ JAMSTEC IR A

ToFEREN
AN MGEMCY FOHR MAR E-EARTH SCINCE AND TECHMOLDGY

Figure 5.14 KRO05-01 Bathymetry Data web page.
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i i JAMSTEC Data Site for Research Cruises © Japanese
TAMSTEC fBARET—51 - |-

Data Policy JAMSTEC Top Page
Terms and Conditions | User Registration | Application for Data and Samples | Contact Us

JAMSTEC Data Site for Research Cruises » KAIRE| Research Data » KR05-01 » Bathymetry Data > Processed Data

KAIRE! Data Site : KR0O5-01 Bathymetry Data : Processed Data

+ Data Files

File name : YYYYMMDD.dat
YYYY: year, MM : month, DD: day
* These data are compressed in zip format, please use that after unpacking.

File name Size Date
20050106.zip 0.14 MB 06 Jan., 2005
20050107 .zip 3.76 MB 07 Jan., 2005
20050108.zip 491 MB 08 Jan., 2005
20050108.zip 3.86 MB 09 Jan., 2005
20050110.zip 4.23 MB 10 Jan,, 2005
20050111.zip 6.71 MB 11 Jan,, 2005
20050112.7zip 7.37 MB 12 Jan., 2005
20050113.zip 8.67 MB 13 Jan., 2005
20050114.zip 2.06 MB 14 Jan,, 2005
20050115.zip 11.38 MB 15 Jan., 2005
20050116.zip 1046 MB 16 Jan., 2005
20050117.zip 6.63 MB 17 Jan., 2005
20050118.zip 577 MB 18 Jan., 2005
20050118.zip 251 MB 19 Jan.,, 2005

Site Policy | Privacy Policy

Copyright 2008 Japan Agency for Marine-Earth Science and Technology @ JAMSTEC 5525 8nn

ARPRN AGEMCY FOR MARIRE- EARTH SCIRMCE AND TECHNOUDGY

Figure 5.15 KRO05-01 Bathymetry Data files available for download.

An alternate way to reach bathymetry web pages is for the user to click on the “JAMSTEC Data
Search Portal” tool (see Fig. 5.11). This accesses instructions on how to use the tool as well as
provides an entryway to the tool’s ArcIMS interface (see Fig. 5.16). On the ArcIMS interface,
the user may drag the red box on the global map (upper left corner) to the desired study location,
then select “Quick Search” to drag a box on the main map. This brings up a search result panel
(see Fig. 5.17) that lists the cruises that traverse the study box. The bathymetry web page for the
cruise of interest can then be reached by clicking on “Jump.”
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Figure 5.16 JAMSTEC Data Search Portal.

Search Result (Select Data Set : Bathymetry) 16 Selected

No. Data ID Latitude | Longitude | Perlod (start) | Period (end)| Ship Name Cruise ID |DSAY Name |Dive No. |Web Site
1 |oo13-00000027 2002/02/20  |2002/03/29 [MIRAI MRO2-K02 Jump
2 |0013-00000035 2003/02/19  |2003/03/28 |MIRAI MRO3-KO1 Jﬂmg
3 |0013-00000052 200411416 | 2004/12/08 |MIRAI MAD4-07 J'HEE
4 |0013-00000054 2005/01/413 | 2005/02/18 |MIRAI MRO4-08_leg2 Jﬂmg
5 |0013-00000058 2005/05/24 |2005/06/30 |MIRAI MRO5-02 J'HEE
& |0013-00000064 2006/02/04 | 2006/0317 | MIRAI MROE-01 JHEE
7 |0013-00000073 2007/02/15 |2007/03/25 |MIRAI MRO7-01 J'HEE
8 |0013-00000075 2007/05/30  [2007/07/13 [MIRAI MRO7-03 Jump
8 |0013-00000085 2008/07/01 |2008/08/05 |MIRAI MRO8-03 J'HEE
10 |0013-00000211 2005/01/04 |2005/01/23 |KAIRE KRO5-01 Jump
11 |0013-00000228 2005/12/09 |2005/12/24 |KAIRE| KRO5-17 Jﬂmg
12 |0013-00000242 2006/08/11 | 2006/ 08/22 |KAIRE| KRDE-12

13 |0013-00000264 2007/11/22  |2007/12/01 |KAIRE KROT-16 Jump
14 |0013-00000328 2002/09/29 [2002/10/14 |KAIYO KY¥02-10_leg1

15 |0013-00000833 2001/01/03  [2001/01/14 |YOKOSUKA |YKO1-01

16 |0013-00000915 2009/11/02  [2009/12/11 [MIRAI MRO9-04

Figure 5.17 Data Search Portal Results.
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Chapter 6.0 Data Cleaning

6.1

Quality Assessment

Contributed by Barry Eakins, NOAA-CIRES, Rob Hare, Canadian Hydrographic Service, and
Martin Jakobsson, Stockholm University, Sweden

6.1.1 Sources of uncertainty

Elevation value

Instruments such as multibeam swath sonars and airborne lidar do not actually measure
elevation, but rather travel time (of sound or light, respectively). Many different sources
therefore contribute to the uncertainty of a calculated depth/elevation value. Although the
following text focuses on uncertainties in data acquired with multibeam swath sonar systems, it
should be noted that it is in principle applicable to data acquired with any elevation measurement
system; a single-beam echosounder is just a special case of a multibeam echosounder (i.e. nadir
beam only). Agencies conducting surveys are encouraged to provide uncertainty budgets, or total
propagated uncertainty (TPU) estimates for their own systems.

Sound or light speed uncertainty — how accurately was sensor measurement or time
converted into a depth/elevation value?

Multibeam swath sonar systems rely on frequent measurements of sound speed,
typically taken an XBT (expendable bathythermograph) or CTD (conductivity-
temperature-depth package), and sometimes measured directly using an SVP (sound
speed profiler). These measurements should be taken at least daily, or with changing
weather conditions, as longer time intervals decrease the accuracy of the soundings due to
improper ray-tracing. Measurements should be taken more frequently in areas of known
oceanographic fronts and off the mouths of major rivers.

The sound speed profile is used to calculate depth for each beam, via ray tracing, and
is embedded in the binary sonar files. The profiles can be extracted and replaced with
different profiles using multibeam processing software such as MB-System, which can
recalculate depths and positions for each beam footprint.

Because sound travels farthest for the outermost, lowest grazing angle beams,
especially in deep water, and because ray bending increases as the tangent of the beam
angle, these beams have the largest depth uncertainty due to sound speed uncertainty
caused by ray bending, and often contain anomalous values inconsistent with other,
overlapping data. As such, they are frequently flagged for exclusion. If sound speed
profiles cannot be taken at a rate which minimizes the uncertainty due to refraction, then
line spacing should be decreased in order to increase the overlapping region, and provide
additional confidence in the bathymetry with many of the outer beams eliminated from
the gridding process.

Uncertainty in the measurement of vessel roll with also contribute significantly to the
TPU of depth in the outer beams.
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Position uncertainty — how well known was the position of the sensor?

With swath sonar systems the distance between the sounding on the seafloor and the
positioning system antenna can be very large, especially in deep water. Because of this,
sounding position uncertainty is a function of the errors in vessel heading, beam angle
solution, refraction correction model and the water depth, in addition to the uncertainty of
the positioning system itself.

Roll and pitch errors will also contribute to the uncertainty in the positions of
soundings. Overall, it may be very difficult to determine the position uncertainty for each
sounding as a function of depth. The uncertainties are a function not only of the swath
system but also of the location of, offsets to and accuracies of the auxiliary sensors.

The use of non-vertical beams introduces additional uncertainties caused by incorrect
knowledge of the ship’s orientation at the time of transmission and at time of reception of
sonar echoes.

Uncertainty associated with the calculated depth of an individual swath sonar beam will
include the following components:

a)
b)

c)

d)
€)

Positioning system uncertainty (e.g. of the GPS antenna)

Sensor location uncertainty (of the sonar’s transducer and hydrophones relative to the
GPS antenna)

Beam angle uncertainty (relative to the sensor), including beam steering uncertainty when
sound speed at the transducer face in not directly measured

Uncertainty associated with beam detection of seabed reflection echo (angle or time)
Uncertainty in the orientation of the vertical motion sensor (relative to the sonar); pitch
bias and roll bias

Vessel motion sensor uncertainty, i.e. roll, pitch and heave

Uncertainty in vessel heading (distinct from path over ground)

Uncertainty associated with the ray path model (including the sound speed profile)
Sensor offset uncertainty (relative to local water level)

Ellipsoidal / vertical datum transformation model uncertainty (if applicable)

Time synchronization / latency between all of the systems

All uncertainties should be combined statistically to obtain a total vertical uncertainty (TVU).

Morphologic change since data collection

Morphologic change is an ongoing process that will, over time, decrease the accuracy of
survey data. In the coastal zone especially, the movement of sand alters seabed morphology. This
may occur as the result of a major storm, or long-term sediment dispersal or accumulation.
Regional tectonic uplift or subsidence may also play a role. The older the data is the greater its
uncertainty, with the greatest rates of change occurring in shallow water.

Data not measuring ground surface

Not all instrument measurements detect Earth’s solid surface. Many individual sonar depths
may actually reflect water column noise. Spikes often occur directly along the ship track, where
the sound energy returning to the transducer is strongest. Returns from the water surface or from
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tree canopy are also common in topographic lidar. These values need to be identified and
deleted.

6.1.2 How to determine data uncertainty

a. Typical for modern data types
i. Lidar [Fugro Earthdata, 2007]

Point spacing Vertical accuracy (RMSE)
1m 0.09 m
2m 0.20 m
3m 0.30m
4m 0.40 m
5m 0.51m

ii. Multibeam swath sonar
iii. Hydrographic surveys undertaken prior to 1998

Depth Vertical accuracy
<30m 0.3m
>30m 1% of depth

b. Estimating navigation uncertainty for older data
c. Comparison with other data

6.2 Data Cleaning Techniques

Contributed by Rob Hare and Paola Travaglini, Canadian Hydrographic Service, and Martin
Jakobsson, Stockholm University, Sweden

6.2.1 Automatic (non-interactive) data cleaning

During this stage, the coordinates (i.e. positions and depths) obtained should be controlled
automatically by a program using suitable statistical algorithms which have been documented,
tested and demonstrated to produce repeatable and accurate results. When selecting an algorithm,
robust estimation techniques should be taken into consideration as their adequacy has been
confirmed. Many high-density bathymetry processing packages have built-in statistical
processing tools for detecting and displaying outliers. Generally speaking, higher-density data
sets with large amounts of overlap between lines provide an increased likelihood of detecting
blunders. In addition to statistics, threshold values for survey data can be used to facilitate the
detection of blunders. Each agency is responsible for the validation of the algorithm used and the
procedures adopted.
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All blunders and erroneous and doubtful data should be flagged for subsequent operator
control. The type of flag used should indicate that it was set during the automatic stage.

6.2.2 Manual (interactive) data cleaning

Following automated processing procedures, there is a requirement for an experienced and
responsible hydrographer to review the automated results and validate those results and/or
resolve any remaining ambiguities.

For this stage the use of 3-D visualization tools is strongly recommended. Decision making
about whether to accept or reject apparently spurious soundings can often be enhanced by
viewing combined data sets in three dimensions. These tools should allow viewing the data
using a zoom facility. The interactive processing system should also offer different display
modes for visualization, e.g. depth plot, uncertainty plot, single profile, single beam, backscatter
imagery etc. and should allow for the visualization of the survey data in conjunction with other
useful information e.g. shoreline, wrecks, aids to navigation etc. Editing the data should be
possible in all modes and include an audit trail. When editing sounding data, it can often be
useful to understand the spatial context of the examined data points. What may appear to be bad
soundings (blunders) out of context may be recognized as real seafloor artifacts (submerged
piles, wrecks, etc.) when viewed in the context of a chart backdrop for example. If feasible, data
displays should be geo-referenced. The ability to compare surfaces from newly collected data to
ones generated from historical information can often be useful in validating the quality of the
new information, or alternatively, for notifying the collecting agency of an unresolved systematic
bias that requires immediate attention.

If feasible, these tools should include the reconciliation of normalized backscatter imagery
with bathymetry and, provided that automated object detection tools were used, the display of
flagged data for both data modes should be possible.

The rules to be observed by operators during this stage should be documented.

The flags set during the automatic stage, which correspond to depths shallower than the
surrounding area, should require explicit operator action, at least, for Special Order and Order 1
a/b surveys. If the operator overrules flags set during the automatic stage, this should be
documented. If a flag is set by the operator, the type of flag used should indicate this.

It can be helpful to create a map plotting ship track and date/time to assist with correcting
anomalies discovered during visualization.

6.2.3 Clipping to polygon or elevation value (e.g., zero)

6.2.4 Common multibeam swath sonar errors

Spikes under nadir
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Spikes may be present directly under nadir for many multibeam swath sonar systems,
especially older systems. This appears to result from excessive sound energy reflected back
toward the sonar and being received in the side lobes of non-nadir beams. Care should be taken
when flagging these values as actual seafloor features may appear similar to these spikes.

Tracking water-column noise

Modern multibeam swath sonar systems generally include automated bottom tracking
algorithms. Such algorithms search for seafloor echoes in a window centered on the previous (or
adjacent) ping’s depths. However, the system can begin to track water column noise, and may
continue to do so if the system is not actively monitored. Depth variability between pings can be
large, the across-track depth profiles are not consistent with seafloor topography, and most of the
beams/pings should be discarded.

Roll-over on inward-facing steep slopes

In areas of steep slopes, especially where the seafloor rises towards the sea surface, some
sonar systems have a tendency to “roll over” the outermost beams to create a backside or lip.
These values must be flagged. These errors can often be detected when editing the data in the
context of a priori knowledge of the seabed shape, especially man-made vertical structures or
known topography of canyons or fjord walls.

Anomalies on outward-facing slopes

Where steep hills and seamounts are located off ship track, little sound energy from the sonar
pulse that strikes the outward-facing slope may be reflected toward the sensor, and the quality of
the returning echo is severely degraded. In such cases, the along-track distance between beams is
significantly increased, and the variability in depths between pings can be large. Most of these
values should be flagged. These types of errors can often be easily discovered when comparing
against the overlapping deeper water swaths.

Navigation missing on first ping

In some cases, the first ping of a sonar file may be missing the associated position
information supplied by the ship’s onboard navigation system. This is generally a time
synchronization issue, resulting from the sonar system having not yet received the position from
the GPS system. This can be corrected by editing the sonar file’s navigation and extrapolating
the latitude and longitude backward from subsequent pings.

Inaccurate sound speed profile used

If an inaccurate sound speed profile was used in ray-tracing, the resulting across-track depth
profiles tend to tilt upwards on the outermost beams on both sides (“smiles”) or downwards
(“frowns™). These data require the application of a better sound speed profile, which might be
obtained from other, nearby sonar data, or historical averages for the region. In any event, the
uncertainty in the resulting depths is expected to be large, especially on the outermost beams.
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Some processing software packages have the facility to modify the observed sound speed profile
in order to bend the outer beams of multiple overlapping swaths until a best fit is achieved in the
overlap area.

6.2.5 Common lidar errors
Bomb craters

Most lidar data sets contain scattered too-low points, or negative blunders, perhaps produced
when a specular reflection or too-close ground saturates the detector and produces an internal
echo. If vegetation reflections are removed by a find-the-lowest-point-in-the-vicinity algorithm,
true ground points adjacent to the negative blunders may be misidentified as vegetation
reflections and removed. The result can be a conical crater that is entirely an artifact. (from Puget
Sound Lidar Consortium, 2011).

Vegetation and buildings

First returns in lidar surveys commonly come from the tops of tree canopies, buildings, etc.,
not ground surface. The lidar data need to be classified, allowing removal of all non-bare earth
returns. Some lidar systems provide backscatter intensity values that can be used to validate
assumptions about types of ground cover. If geo-registered colour imagery is available, this
should also be used to validate assumptions about types of ground cover.

Water-surface values

Lidar surveys (topographic) at the coast are typically flown at low tide for surveying of the
inter-tidal zone. As such, water-surface values over the ocean are common, and individual waves
may be identifiable. A lidar classification schema may be used to remove these values (water
surface returns are generally of low intensity). Alternatively, the data may be clipped to a
coastline, though clipping to a high-water coastline may eliminate valid measurements in the
exposed inter-tidal zone. As a last resort, edit the data manually by paying attention to where the
slope of the inter-tidal zone transitions to wave caps and troughs.

6.3 Data Validation

Contributed by Rob Hare and Paola Travaglini, Canadian Hydrographic Service, and Martin
Jakobsson, Stockholm University, Sweden

The final survey data should be subject to independent in-house validation employing

documented quality control procedures.

6.3.1 Internal self-consistency
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http://pugetsoundlidar.ess.washington.edu/
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comparison with other survey soundings (e.g., from overlapping swaths) on the same
survey

6.3.2 External consistency

comparison with other datasets (e.g., systematic offsets), checklines from independent
systems (or vessels, or dates)

6.3.3 Comparison with reported survey specifications

analysis of statistics at cross check points/lines, or in grid cells over flat seafloor,

provided a sufficient number of points are available in each cell to compute reliable
statistics.
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The following has been extracted from 5" Edition, S-44 (2008) Annex B by Rob Hare and edited for
context

6.4 Use of uncertainty surfaces

Many statistical bathymetry processing packages also have the ability to generate an uncertainty
surface associated with the bathymetry using either input error estimates or by generating spatial
statistics within grid cells. Displaying and codifying these uncertainty surfaces is one method of
determining whether the entire survey area has met the required specifications. If some areas fall
outside the specifications, these areas can be targeted for further data collection or use of
alternative systems in order to reduce the uncertainty to within an acceptable tolerance. When
performed in real-time, the sampling strategy can be adapted as the survey progresses, ensuring
the collected data are of an acceptable quality for the intended use. Each agency is responsible
for the validation of these processing capabilities prior to use.

6.5 Validation Procedures
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The final data should be subject to independent in-house validation employing documented
quality control procedures.
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Chapter 7.0 Metadata Documentation

The following has been extracted from 5" Edition, S-44 (2008) Chapter 5 by Rob Hare and edited for
context

7.1 Introduction

To allow a comprehensive assessment of the quality of survey data it is necessary to record or
document certain information together with the survey data. Such information is important to
allow exploitation of survey data by a variety of users with different requirements, especially as
requirements may not be known when the survey data is collected.

7.2 Metadata

Metadata should be comprehensive but should comprise, as a minimum, information on:
- the survey in general e.g. purpose, date, area, equipment used, name of survey platform;
- the geodetic reference system used, i.e. horizontal and vertical datum including ties to a
geodetic reference frame based on ITRF (e.g. WGS84) if a local datum is used;
calibration procedures and results;
sound speed correction method,;
tidal datum and reduction;
uncertainties achieved and the respective confidence levels;
any special or exceptional circumstances;
rules and mechanisms employed for data thinning.

Metadata should preferably be an integral part of the digital survey record and conform to the
“IHO S-100 Discovery Metadata Standard”, when this is adopted. Prior to the adoption of S-100,
ISO 19115 can be used as a model for the metadata. If this is not feasible similar information
should be included in the documentation of a survey.

Agencies responsible for the survey quality should develop and document a list of metadata used
for their survey data.

7.3 Point Data Attribution

All data should be attributed with its uncertainty estimate at the 95% confidence level for both
position and, if relevant, depth. The computed or assumed scale factor applied to the standard
deviation in order to determine the uncertainty at the 95% confidence level, and/or the assumed
statistical distribution of errors should be recorded in the survey’s metadata. (For example,
assuming a Normal distribution for a 1D quantity, such as depth, the scale factor is 1.96 for 95%
confidence. A statement such as “Uncertainties have been computed at 95% confidence
assuming a standard deviation scale factor of 1.96 (1D) or 2.45 (2D), corresponding to the
assumption of a Normal distribution of errors,” would be adequate in the metadata.) For
soundings this should preferably be done for each individual sounding; however a single
uncertainty estimate may be recorded for a number of soundings or even for an area, provided
the difference between the individual uncertainty estimates can be safely expected to be
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negligible. The attribution should, as a minimum, be sufficient to demonstrate that the
requirements of these Standards have been met.

7.4  Bathymetric Model Attribution

If a Bathymetric Model is required, metadata should include: the model resolution; the
computation method; the underlying data density; uncertainty estimate/uncertainty surface for
the model; and a description of the underlying data.
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Chapter 8.0 Gridding Data
8.1 Introduction to gridding

TEXT IN PREPARATION

8.1.1 Polynomials

TEXT IN PREPARATION

8.1.2 Near-neighbor searches

TEXT IN PREPARATION

8.1.3 Triangulation

TEXT IN PREPARATION

8.1.4 Splines

TEXT IN PREPARATION

8.1.5 Kriging

TEXT IN PREPARATION

8.2 Examples of gridding methods

8.2.1 Gridding JAMSTEC multibeam data

Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA

A grid can be formed from the individual multibeam xyz points downloaded from the JAMSTEC
website (see Figure 5.4). Because there are so many data points it is advantageous to first take
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their block average using GMT routine “blockmedian,” calculating the median z (at the x, y
location of the median z) for every non-empty grid cell on a 6 arc-second mesh. The next step is
to use GMT routine “surface,” an adjustable tension continuous curvature surface gridding
algorithm, to form a grid at 6 arc-second spacing in longitude and latitude from the median
depths. Routine “grdmask” is then used to create a mask that is applied to the grid using
“grdmath” so that it holds values only in cells that contain one or more of the original xyz points.
Below we list the GMT routines used to create the grid from KR05-01 xyz multibeam points that
is shown in Figure 8.1. We also list the GMT routines used to produce Figure 8.1.

KRO05-01
13.5°
13
12.5°
12°
152° 152.5°
-6050 -6000 -5950 -5900
depth, m

Figure 8.1 Color shaded-relief image of gridded KR05-01 multibeam points.
GMT routines that created the grid shown in Figure 8.1:

blockmedian KR05-01.xyz -R151.75/152.75/11.75/13.5 -16¢ -Q > KR05-01.blockmedian.6¢.xyz
surface KR05-01.blockmedian.6¢.xyz -R151.75/152.75/11.75/13.5 -16¢ -T0.25 -GKR05-01.surf.6¢_grd
grdmask KR05-01.xyz -GKR05-01.mask_grd -R151.75/152.75/11.75/13.5 -I6c -NNaN/1/1 -S6c
grdmath KR05-01.surf.6¢_grd KR05-01.mask_grd OR = KR05-01.surf.6¢.nan_grd

Figure 8.1 (above) was produced with the following GMT commands:
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grdgradient KR05-01.surf.6¢c.nan_grd -AO -Ne0.2 -Ggradient_grd

grdimage KR05-01.surf.6¢.nan_grd -Igradient_grd -Cmb.cpt -Jm2 -K > Fig.8.1.ps

psbasemap -R151.75/152.75/11.75/13.5 -Jm2 -Ba.5f.25:."KR05-01":WeSn -O -K >> Fig.8.1.ps
psscale -D1/-.5/2/.125h -Cmb.cpt -Ba50g25:"depth, m": -1 -N300 -O >> Fig.8.1.ps

8.2.2 GMT Surface and Nearneighbor

We used depth values from the constrained grid cells from V12.1" in the study area as input into
different gridding algorithms: GMT routine “surface,” employed with the tension set to “0” and
set to “1,” and GMT routine “nearneighbor.” Surface tension set to “0” gives the minimum
curvature solution, and set to “1” gives a harmonic surface where maxima and minima are only
possible at control points. “Nearneighbor” uses a nearest neighbor algorithm to assign an
average value within a radius centered on a node. The GMT command lines used to produce the
gridding solutions shown in Figure 8.2 are listed below.

Surface w/T0 Surface w/T1 Nearest Neighbor

Depth, m Depth, m Depth, m

Figure 8.2 Results of gridding depths from V12.1" at constrained grid cells (black dots): GMT “surface”
gridding routine with tension set to 0 (left) and set to 1 (middle), and “nearneighbor” gridding routine (right).

Gridding solutions shown in Figure 8.2 were produced with the following GMT commands:

img2grd -R149/154/14/19 topo_12.1*.img -Gtopo_12.1*.controls_grd -T2 -m1 -D

surface topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -11m -TO -Gsurface.tO_grd

surface topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -11m -T1 -Gsurface.tl_grd

nearneighbor topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -N4/1 -S100k -I11m
-Gnearneighor.1m_grd
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8.2.3 GMT Triangulate

TEXT IN PREPARATION

8.2.4 Spline pyramid

TEXT IN PREPARATION

8.2.5 Kriging

TEXT IN PREPARATION

8.2.6 Spline Interpolation

Contributed by Chris Amante and Matt Love, NOAA National Centers for Environmental
Information (NCEI)

Spline interpolation estimates elevation values using a mathematical function to create a
continuous surface that passes exactly through all input elevations while minimizing the overall
squared curvature. Oscillation effects of a minimum curvature surface can be reduced by using
tension. The surface can be thought of as a flexible rubber plate that can be adjusted using
tension, with a tension of zero corresponding to the minimum curvature surface. Two open-
source software programs, the Generic Mapping Tools (GMT;
http://www.soest.hawaii.edu/gmt/), and MB-System (http://www.ldeo.columbia.edu/res/pi/MB-
System/), offer spline gridding algorithms, “surface’ and *‘mbagrid,” respectively.

Prior to using GMT’s ‘surface,’ it is recommended that the user pre-process the data with
GMT *‘blockmean’, ‘blockmedian’, or ‘blockmode’ to avoid spatial aliasing and to eliminate
redundant data. As an example, for two adjacent NOS surveys in xyz format, H10393, and
H10394, pre-process the data using ‘blockmedian’. Required user defined parameters include the
input xyz file(s), the grid spacing (-1), the region of interest (-R), and the name of the output xyz
file. Numerous other options can be specified (See GMT Manual Pages).

GMT *‘blockmedian’ example:

blockmedian H10393.xyz H10394.xyz -11c/1c -R-88.13/-88.02/30.07/30.15 >
blockmedian.xyz
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Required user defined parameters for GMT ‘surface’ include the xyz input data, the name
of the output binary 2-D .grd file (-G), the grid spacing (-1), and the region of interest (-R).
Numerous other options can be specified (See GMT Manual Pages). Most notably, the user can
define a tension value between 0 and 1 (-T). A tension value equal to zero indicates a minimum
curvature solution.

GMT ‘surface’ example:

surface blockmedian.xyz -Gsurface_example.grd -11c/1c -R-88.13/-88.02/30.07/30.15 -T0.25

Required user defined parameters for MB-System’s ‘mbgrid’ include the name of the
datalist containing a list of the input data files and their format (-1), and the character string to be
used as the root of the output filenames (-O). There are numerous other user-defined parameters
(See MB-System Manual Pages). Most notably, the user can define the datatype (-A), the
distance from the data that the spline interpolation may be applied and the interpolation mode (-
C), the grid spacing (-E), the gridding algorithm mode (-F), the format of the output grid file (-
G), the region of interest (-R), the tension value between 0 and infinity (-T), and the extension of
the internal grid so that the output grid is a subset from the center of a larger grid allowing for
data outside of the output grid to guide the spline interpolation at the edge of the output grid (-
X).

MB-System ‘mbgrid’ example:

mbgrid -lgebco.datalist -Ombgrid_example -A2 -C10/2
-E0.00027777778/0.00027777778/degrees! -F1 -G3 -R-88.13/-88.02/30.07/30.15 -T100
-X0.05

8.2.7 Global Mapper

TEXT IN PREPARATION

8.2.8 r2v

TEXT IN PREPARATION

8.2.9 Surfer
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8.2.10 Gridding in ArcMap

Contributed by Anastasia Abramova, Geological Institute Russian Academy of Sciences, Russia

Here we present step by step example on how to open .xyz space delimited column data in
ArcMap and to interpolate data points into a grid of appropriate resolution. As an example .xyz
file with Latitude, Longitude and Depth in Geographic projection covering area between 2-11E
and 72-74N is used. We would like to create a grid in UTM projection with appropriate cell
resolution using Inverse Distance Weighting Interpolation algorithm. The procedure of
reprojecting the data, assessing the data density to choose suitable grid size is described. Tools
available in ArcMap in order to select optimal interpolation parameters and to compare resultant
surface with original data points are discussed. In order to be able to carry out above noted you
will need to have Spatial Analyst and Geostatistical Analyst extensions.

Importing .XYZ file in ArcMap

In order to open .xyz file in Arc, you need to modify it: text file needs to have header, data
should be comma separated and file name should not have spaces in it.

In order to modify .xyz text file, import it into MS Excel:

° Fi|e>open XyZ Text Import Wizard - Step 1 of 3 ' [

The Text Wizard has detenmined That your &3i3 i Celimited,

® [F Hhs s correct, chodde et & choade the data hpe that Best deadrbes pour data,
e Select Delimiters that you Crighal data bype have
- . Cheote S Bl bype that bect descibes your dakac
then press Flnlsh @ el !:-_-:_ |.|:::_|I « Chararters such s cormmas of taba separate each feld.

Food wid®h - Fackds are abigred n columns vath spaces betmeen each fisld,

Saimpoitstiove | 1 = e grginc 457 : OFEM Usited States LI

Previe of Be GWORE_space \Coskback_grddingire poyz_be_gricl ey,

. 1639871, 4042-216
[2h. 1650663, 7028-3253
[ab.1e622560.292-2076.5
ﬂ- 16ERIEER, FEP=2315. 5

P.166RTE . 43T0=-334%

Carenl Bt = Frish |

Text Import Wizard - Step 2 of 3 [ i

Thig sieen bats you et e delmitars your data containg, You (0 5o how your text i affacted in the praveew
B

Dedmiters

+ Tz
Semicolon | Treat conseasfre defmiters o5 one
S Taxt guatfer: | [=]
+ Epace! -
I o
Dats prescew
16338 L AB4T X114
}. LE50E 5. 7818 3263
I.1ERIIR [FE. 131 ITE. B
1E65EF W9, 757 [?745 L]
1E6F 1 AF7R 13D
cacel | [ ospeck | [ best> | [ pomn |
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]

Faste - . " B LS U-

Insert header row, type header name for each column Cipbosia = Font
(no spaces!) a v (3 % o fu| Depth]
| B C o

Latitude Longitude [Depth l

DL16358 714242 -216
O 16506 63.7318 -3253

0165135 62131 -2976.5

File> Save as .CSV (Comma delimited) ;
3
Close file In MS Excel! (Arc doesn’t want to open it T—, 0166525  69.968 32485
B
7
B
9

if it is opened somewhere else) 01663 724373 2349
01679 7316308 -30815

0. 16886 TZ.188 -2333
0.165775 73.5958 -3097.5

10 017001 70,535 -2652
11 0178 72,1687 -2458

am PR PP PRy

Open ArcMap: File> New > Blank Document

Select Add Data from Standard Toolbar (Or goto File> .\ oo Took Window Helo

Add Data) and add your .csv file mex |0~ &
Add Data

To display your data right click on the layer> Display =& Layen

= ) GAWORK space
XY Data | ;
@ Qpen
Joing and Felstes [
¥ Bemaove
Data 3
BN Geocode Addrenes.
7 Displey Royte Evants.
L) Disply ¥ Data .|
P Broperies...
. . . . Dizplay XY Data (9 =
Select the appropriate fields: X as Latitude and Y T —————
as Longitude. In order to define the input data r e
projection: press Edit > Select> Geographic> l”“““’"‘l'a““‘”’“““‘”“'“'““'“m‘““' S
World > WGS 1984. Press Ok - Speciy the fiekds for the Xand Y coordinates:
¥ Fiold: | Latitude =
¥ Fiedd: |Lengtude -
Coordiniste System of kput Coondinstes
[rescription:

Cogrdinate System:
Pamea: GC5_WGS_1584

™ Shew Detzie Edt__

[+ Wam ma f the reauling layer wil have restncted functionaity

_ ok | e []] 139
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e Inorder to save file as ArcMap shape - o
file, right click on the layer> Data> X pomere '
Export Data> Save as .shp file W Ope Al Tobre

Joury ared Falate *
@ Teem TaLayer
&
Yle Scale Range el
Lz Fymibcd Ly, .D-
Latection ¥

Labal Faabaran

SH Comart Bratuns to Graphict..
Compart Symnbslogy ko Reprivantsticn_
e i e e - ST

Reprojecting the data

e We would like to create a grid in UTM projection with units in meters, instead of
degrees. For that we need to reproject our data.

e Click on Show/Hide ArcToolbox: .
|8 £Por N Qa

¢ Inopened ArcToolbox choose Data Management #?gt; ":'5"‘;9mf}t Tools ]
- ata Lompansan

Tools> Projections and Transformations> Feature> Project | . & patabase
=85 Disconnected Editing
| & Mistnbuted Geodatabasze
| =& Domains
3-% Feature Class
| m i Features
|- Fieds
H E File Geodatabaze
# & General
3-& Generalization
| om i Indees
=8 loins
H & Layers and Table Views
= % Projections and Transforrnations
E & Feature
B Batch Project
L Create Spatial Reference
=
1+ -h Raster
¥ Crexte Custom Geographic T
| F* Define Projection
3-1&1 Raster
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Defining cell resolution for the

grid

F}" Project
Define the Input and Output files and J

Output Coordinate System (In our l‘””“ ”*‘”:“"F““m’“

e . XyI_to_gn
case it is WGS 1984, UTM Zone o T
30N). Press Ok. | Bos _wies_1sss

Output Dataset or Feature Class

| Ex\AreTSeyz_to_grd_LUTM.shp
Cutput Coordinate System

| wGs_1988_LTM_Zone_300

Gaographic Transfiormaibon (pptional)
I

You might want to change the data frame projection view from Geographic to
UTM_Zone_30N now (projection in the data frame view is defined by projection of the
first opened file). Right click on Layers> Properties> Coordinate Systems. Select from
Predefined list Projected> UTM> WGS 1984> UTM Zone 30N. Press Ok. Now data
frame view has the same projection as reprojected file.

Finally our added data AT “-th_.
looks like this. As you can L
notice, the data point i ]
density varies over the area SRR
Lo
R I

L o
&
§ B
r‘:—"'f;%:

!,.1{- i

ik
Fﬁgi
ASET

I":‘\a-"z""*‘.“-"lI

The choice of grid resolution depends on your purposes. Meanwhile, data distribution,
density, complexity of modeled terrain and scale of the final map should be taken into
account as well.

We would like to create grid with 2 km cell resolution. Here we show how to identify the
percentage of cells which values will be defined by interpolation and how to estimate the
data density within each cell for the chosen grid size.

Make sure that Spatial Analyst Extension is activated: go to Tools> Extensions> check
Spatial Analyst. Also, add Spatial Analyst toolbar: go to View> Toolbars> check Spatial
Analyst.
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e From Spatial Analyst toolbar select Spatial Analyst

Convert> Features to Raster B | Spatial Anatyst = | |2
' Distance
Demsity.—.
Interpolate to Raster ¥
Surface Analysis 3
Cell Sgatistics._.
Meighborhood Statistics...
Lonal Statistics...
Zonal Histogram ...
Freclassify...
Raster Caboulator... 'j £ :
Options... Raster to Features...
w F ) w
e  Select appropriate field and cell resolution: Features to Raster e )
Irput f=atures: |xyr_tn_-qmd_l.l'l'l‘d j E I
o = =]
Dutput cel size: 2000
Cutput raster: | woiilS templcyz_to_grd_Hen E
[ ok ]  cames |

e Asyou can see, in the created raster, only cells with data points in it have non zero
values:

= B oayz_to_grd2km
<WALUE=

[]-3814 --3,238
[]-2,237.965000 - -2,014
[-2,913.999000 - -2,614
-2,613.999999 - -2,390.5
I -2,350.499900 - -2,185
I -2,1584.999900 - -1,908
I -1,507 95959599 - -T14
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In order to find out what is the
percentage of cells with “no data
values”, go to Layer> Properties>
Source. Here you can look up the total
number of cells in the grid created by
multiplying total number of rows by
number of columns (157*116=18212)

Layer Properties

General Source | Exent | Display | Symbalogy | Felds | Joins & Refats

Froperty Value
= Raster Information

Colurres and Rows ':: 157, 116

Mumber of Bands 1
Celsize (X, 1) 2000, 2000
Uncompressed Size 71 14KB

In order to find out how many cells have non zero values, go to Symbology tab in Layer
Properties window and click on Classified. Select Classify tab. The classification table

will appear. In Classification Statistics W

indow, Count will tell the amount of non zero

cells (6661). This is approximately 36 % of total amount of cells. Therefore, the values

for 64% of cells will have to be estimated

by interpolation.

Classification |M
—Classification —Classification Statshos
Method: | N ~ Count: s
Mirimim; -3,814
Classes: ks j' Maimem: 714
— Diata Exdusion Sum: -16,651,650,85
Mean: -2,499.972521
Exdusion ... | Samping ... | Standard Deviation: 309, 2080225

Now we would like to find out what is the maximum density of data points per cell for
the chosen grid size (we don’t want it to be too small or too big - although in the end in

depends on your purpose).

From Spatial Analyst toolbar select Density: Spatial Analyst
[ | Spetial Anabyst = | Layer: [syz_to_gmiZn =] im

El'; Distance ]

| Denay.

Interpaolate to Raster ¥

Lurface Analysis 3

Leave population field to “None”, define
search radius and output cells size in projection

units (meters), and desired output area un
(square km)
For more information on how the density
work go to:

http://help.arcgis.com/en/arcgisdesktop/10.0/he

Ip/index.html#/An overview of the Density t

00ls/009z0000000r000000/

" Density [0 i
its Input data: vz _to_grd LT | ﬂ
Popiation Beld: [<rsones ~|
tools p— S .
sachrads: | B
Area units: [scuse kameters =]
Cutputcellsze: | 2000
Dutput raster: [ density_sa_kal E
o« | cace |



http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_overview_of_the_Density_tools/009z0000000r000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_overview_of_the_Density_tools/009z0000000r000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/An_overview_of_the_Density_tools/009z0000000r000000/

Calculated result represents density of data points per unit area (squared km) within the
neighborhood of defined search radius (2000 by 2000 square meters).

In order to calculate amount of data points per grid cell of chosen resolution, go to Spatial
Analyst toolbar and select Raster Calculator.

In Raster Calculator syntax is very important. For more information on map algebra rules
and on how to use raster calculator:

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.htmli#/An overview of the rule
s for Map Algebra/00p600000006000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z000000z7000000.ht
m

We would like to create a new raster layer with the name [point_per_pixel] (put layer
name into square brackets and better avoid spaces in the names). We would calculate
number of points per cell from the density layer by multiplying it by the area of search
radius (2000 by 2000 square meters). Note that units should be the same as units in the
density layer: density map was in km squared, therefore we multiply density layer by 2*2
km sq:

7
#: Raster Calculator

Layers
=501 | 521 [N [N S B | 2
v e s 8| 5] -] o
| o [ R
| 3l [ S | }INM
i [poind_per_cell] = [density_sq km]* E*2
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As a result we get the following raster:

1= L MYZ_TOo_gra_uina

*
(=@} point_per_cell

Value

High : 2.23738

ILGw:ﬂI

As you can see, density of points is maximum 2.2 points per grid cell. This can be
considered not enough; therefore you might want to change grid size to coarser
resolution. We will use this grid spacing in our example.

Creating a gridded surface

There are several interpolation algorithms available in ArcMap, these include Global and
Local Polynomials, Kriging, Spline, Natural Neighbor and Inverse Distance Weighting
available within Spatial Analyst and 3D extensions . The description of these
interpolation algorithms can be found in other sections of Chapter 8.2. More information
on interpolation from point to surface methods can be found:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview of the
Raster_Interpolation_toolset
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview of the
Interpolation_toolset

Here we will present how to create a gridded surface using Inverse Distance Weighting
(IDW) algorithm. IDW can be a good choice for fast interpolation of sparse data. IDW
interpolation predicts values at unmeasured locations according to the values from the
surrounding data points. Points which are closer to the prediction location have more
influence (weight) on prediction than those which are further away. For more information
on IDW see:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3304&pid=3302&topicname=H
ow Inverse Distance Weighted %28IDW%?29 interpolation works
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IDW is available through ArcToolbox Spatial Analyst Tools> Interpolation>IDW (or
through Spatial Analyst toolbar> Interpolate To Raster> Inverse Distance Weighting).
The IDW window will appear.

As you can see several parameters need to [ inwerse Distance Weighted P |
be defined. Power defines the distance S e 3 & |
weight given to each data point in the . - ' .
: : : w : R |
interpolation process. The higher the Zmue s .
power, the faster the weights decrease with Power: 2 '
distance. The number of points defines Seanch radhs type: [variasie =]
number of points with known values to be Search Radus Setings f
used for prediction of the unknown value. Nuniber of peinis: = \
M distance! :
[ Use barrer polyines: [auee._' e :‘ ﬂ |
Cubput ced size: 2000
Oulput raster: [rovi_power2_s2 3|
[ x| s |§
E— - 141-—_—;

In order to choose optimal parameters for interpolation, you can use Geostatistical
Analyst toolbox. Activate the extension through Tools> Extensions> check Geostatistical
Analyst. Also add it to your display through View> Toolbars> Geostatistical Analyst.

Geostatistical Analyst> Geostatistical Wizard provides cross-validation of your model
according to parameters chosen. The wizard allows you to manipulate parameters and to
look at the output statistics for the created model. For more information see:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=3355&pid=3334&topicname=Perfor

ming cross-validation and validation

In Geostatistical Analyst open Geostatistical Wizard. Select input data point layer and
attribute (Depth)

Geastatistical Wizard - IOW Interpolation: Step 1 of 2 - Set Parameters . 2 [
As an example we will use I (e
Power 2.5, and minimum - RaTe Symbolsae: [5 5] Standrd | smooth |

Heighbers to induda: 5 _,Z:I
W Indude atleast: 10 =
L Y [T

Elipsa
Angle: 0.0 =

Petafor Semiseia; 470778
Hinor semiaxis: 70778

Arisatrepy fachor: 1

number of points 10. Click
next.

Ederitify

| ¥ B9534, 89436475
==t SRR B185136, 05446365
B W N A | eighbors 15

Estimated valse -2900.93

ﬂ Shaw weights >>

<gack [ mexiz | Fch | cancel |
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e You can see from the figure below results of our cross-validation. The root mean square
error is more than 100 meters. This can be explained by low density of data points (see
figure above) and overall uncertainty of depth in the area (average depth of 2000m, with
uncertainty of around ... water depth). You can vary interpolation parameters and see
how they affect on the model fit.

Geostatistical Wizard - IDW Interpolation: Step 2 of 2 - Cross Validation

281 = =1 | H i
381 =33 278 -2.26 -1.78 -1.23 0.7
Measured, 10-3
Regression funclion: 0.931 *x + -168.502
~Prediction errors 1
Mot 0.9874 Source I0_ | Incuded | Measured | Preduted | Erver -
Fioot-Mean-Squars: 06,2 2307 s 3138 259636 174,35
4336 fes =317 -33M.1 -154.08
samples: 7277 of 7277 M fes -3025 -3019.8 £.2142
6554 s -3713 -3673.6 33,3657
4687 feg -2641 -3412.9 -IFLEE
3353 es 2530 2552.6 <52.564
15 es 224, 5 29978 173,12 L]
S W =Tl 1 b b - WL
th| 11 ¥
Seve ooss valideson.. | <Beck | | Frish | Cancel
—

e Our final surface using above described parameters look like that:

£F Layers

m O wyz_to_grd_UTM

=]
I -3 8126555518 - -3 4682800422
[ -3.432.8000 21 - -3,152.945326
[1-3152.945325 - -2,823.09023
[]-2.823.09022% - -2 403.235135
[ -2,493.235134 - -2 163380039
[ -2 163330038 - -1,833.5245943
[ -1,833.524042 - -1,503 663347
[ -1,503.569845 - -1,173.814752
[]-1,173.814751 - -B43.0506558

m

Comparison with original data values
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e Here we present how to compare the original data point values with created surface. This
could be useful in order to investigate spatial distribution of misfit between model and the
measured points. For more information on quality assessment of grids see section 9.2.1.

e You can extract values from the gridded surface corresponding to original data points
with Spatial Analyst Tools> Extract Values to Points. Where Input point features are your
original .xyz data points and Input raster is your interpolated raster :

}“ Extract Walues to Points

Input pant festres

lr,'z_t:-_grd_UTM
Input raster

[I]ZJ‘l.l'a'_Ej_pr:-wer
Cutput point features

| ErArcGIs Extract oyz_to_IDW.shp

™ Interpolate values at tha poirt lacalione {aplional)

I Append al the input rester atiribubes to the output port features foptional)

e Asaresult, a point feature layer is created (we call it Extract_xyz_to_IDW).

e You can view the Attribute table of the
layer by right click on the layer> Open
attribute table:

e As you can see from the table it contains
information for original data points (X,y,z)
and corresponding depth values from our
gridded surface (RASTERVALU) for each
original data point:

e You can calculate differences between these values

and visualize them.

Q Layers - ArcToa
= © EE e e 30,
* By Copy

m O wyz to_grd_UTK ¥ Remove
= B W25 pawer — —
B 331265550 I5)|| Open Attrbute Table
[ -3 48253004 Joins and Relates 3

[O-315254532 {a Zoom To Layer

PR3 manTh

-
B s s e o
FID | Shape- | X ¥ | Z |RASTERVALU|
F 0 § Poind B.AT302 [ T28545 -XA53 | 2353 02B4ET
1 | Point GBI | T2 TE4S | 2aT2E | 2aMEMTTT
2 | Poind BE1184 | 725063 -2248 | -2242000458
| 3 I Puini 11.0081 | 725115 | =2011.5 [ -2011.498755 |
|| 4 | Paint B.SS25T | 728885 | 23875 | 2388124758
% | Poirt 831345 | 72,8049 2471 | -2EBRE0T4ZR
& | Foint 11.2085 | 724505 -1953 | -1852 330448
| | 7 | Paint T.41687 [ 727341 =2535 | -2533.513672 |
& | Poind Q05T | T2842 -XI2E | -23M.0BMEE
= e s s ek
TERVALU [ Differanca 1
53028487 L Sort Ascending
WENTIT) & Son Descending
48000488
Namrs | E‘J, Adyanced Sarting...
5.1 24758 SUMMSTE..
BEEOT422
£2 110424 = Statistics...
LA N S~ | Ficld Calculater...
31862156
a1 21004 Lalculate Geornetry...
B2 270254 : -
T Ty — Turn Field O 141
48714335 Freeze/Unfreeze Column
S5 908938
42 44081 ¥ Delete Field
5234618 -
FFE0F4ER Pfﬁ“l‘[ﬂm




Go to Options inside the Attribute table and select Add Field option. We will call the
new column as “Difference”. After the column is created, right click on the header of
new created column and select Field Calculator

Inside the Field calculator we
can define expression for the

new column values: a
difference between Z and

RASTERVALUE columns.
After clicking Ok, the values

are calculated. Close the
attribute table

Now you can visualize the Difference by right clicking on the point layer
(Extract_xyz_to_IDW)> Properties. Go to Symbology tab. Select Quantities> Graduated
colors. Select the Value Fields as Difference, select the color ramp and number of
classes, and click OK.classes, and click OK.

["Fietd Cateutstor . - » |2 [
Frzlds: Type: Functions:
= =
FID 1 abs |} a
shape £ ami ]}
** com 2]
:': - -
z " Date L]
RASTERVALL mi[ I'] |
Difference e i
Sor () i
I Y
Difference = ™ advanced =) ==
[2] - [rasTERWALUI P
Load, ..
i

Sho

Feahures

Categories

Cueantitics
Gradusted colors
Gradusted symbols
Fropartional symbols

Chasta

Multiple Attributes

Fiekds Classificstion
Df=rerce -

Wl Matural Braaks (Jenka)

Momalzation: |rone: - Clagses: [H - Classfy...
. -

[ Losel I

<857 --172
-171 - 68
718
1820
21-75
76- 166
167 - 536

- -
e =)

General | Seurse | Sslection | Displey  Symbology | Fielde | Defintion Qusry | Labele | Joine & Relsles | HTHL Pooup |

GKIEumdl

Apey

Now you can see overlaid difference results over the created gridded surface and
investigate the regions where differences seem to be significant:
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£F layers -~
(= [ Extract_xyz_to IDW
Difference

& -557--172

e -171 - -6

¢ -67 - -19

e -18- 20

¢ 21-75

& 76 -166

+ 167 -536

@
B -3.512.655516 - -3,482.8004 22
] -2 482800421 - -3,152 845226
[-3,152.045325 - - 282309023
[]-2,823.090229 - -2,493.235135
[1-2,493.235134 - -2,163.380029
[ -2,163.380036 - -1,633.524943
B -1,333.524942 - -1,503 669847 =
1 -1,503.665846 - -1,173 814752
[1-1173.B14751 - -B43.9596558

m

e For more information on analyzing gridded surfaces that you create go to:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About analyzing raster d

ata
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=603&pid=598&topicname=Surface
creation and analysis

See more on interpolation error analyses in other sections 8.3.

8.2.11 Gridding the International Bathymetric Chart of the Arctic Ocean
(IBCAO) Version 3.0

IMartin Jakobsson, !Benjamin Hell, 'Rezwan Mohammad, 2Pauline Weatherall and 3IBCAO
Compilation Team

! Department of Geological Sciences, Stockholm University, 106 91 Stockholm Sweden
2 British Oceanographic Data Centre (BODC), 6 Brownlow Street, Liverpool, UK
3See Appendix 111

Introduction

This Chapter of the IHO-I0OC GEBCO Cook Book describes the process used to generate
Version 3.0 of the IBCAO grid — a terrain model for the Arctic Ocean region (Jakobsson et al.,
2012). The description is aimed to provide the general principles of the gridding and the
provided scripts can be adapted and used to generate bathymetric grids for other geographic
areas.

Creating a bathymetric grid from source data sets with extreme variations in data density, e.g.

sparse ship-track soundings and multibeam grids poses specific problems. Gridding routines are
required that can sub-sample high resolution source data while preserving as much detail as
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possible in these areas and at the same time, interpolating in areas of sparse data coverage
without generating gridding artifacts.

To address these issues, the IBCAO 3.0 grid has been generated in a two-stage process. Firstly a
grid is created, using all the available bathymetric data, at a larger grid cell size than required for
the final grid. This step helps to address the issue of generating artifacts through interpolation in
areas of sparse data coverage. This grid is then sampled to the required grid cell size creating a
‘base grid’. In a final step, the high resolution data sets are added on top of the “base grid’, using
the remove-restore procedure, which was first developed and used by Forsberg (1993) and
Forsberg and Tscherning (1981), and later implemented by Hell and Jakobsson (2011) and Smith
and Sandwell (1997), in order to preserve the detail in these areas.

The gridding work is done using routines from the Generic Mapping Tools (GMT) software suite
(Wessel and Smith, 1991), http://gmt.soest.hawaii.edu/. In the examples given below, the GMT
routines are embedded in script files for ease of use. However, if preferred, the individual GMT
routines can be run separately.

The generation of the IBCAO 3.0 grid is described in the following sections:

Background to the IBCAO
IBCAO 3.0 Compilation
Workflow overview
Data preparation and merging — workflow step A
Comparing the input data sets — the disambiguation process
Generating ASCII xyz files for use in the gridding process
Gridding — workflow steps B and C
Generating the ‘base grid’ — procedure and gridding script
Remove-restore — workflow step D

Appendix 1: Python script | - Procedure for generating the ‘base grid” from all available source data
Appendix 2: Python script Il - The remove-restore procedure

Background to the IBCAO

The International Bathymetric Chart of the Arctic Ocean (IBCAO) project was initiated in St
Petersburg, Russia, in 1997 (Macnab and Grikurov, 1997). The main goal was to create an up-to-
date bathymetric portrayal of the Arctic Ocean seafloor north of 64°N. This geographic limit was
chosen because the IBCAO aimed to replace the Polar Stereographic Fifth Edition GEBCO
Sheet 5.17 (Johnson et al., 1979), extending from 64°N to the North Pole.

At the time that the IBCAO was initiated, Digital Bathymetric Models (DBM) were rapidly
becoming the standard bathymetric database used in Geographic Information Systems (GIS) and
other mapping analysis software. For this reason, a limit at 64°N was not practical fora DBM
compiled on a Polar Stereographic projection with a Cartesian xy-coordinate system, so the
IBCAO was extended to a cover a rectangular area as shown in Figure 8.3.

The first IBCAO was released into the public domain in 2000 and was referred to as the “Beta
version” (Jakobsson et al., 2000). This version was compiled using all the bathymetric data
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available at that time including soundings acquired along ship and submarine tracks, spot
soundings, and digitized depth contours from published maps. Land topography was included
and taken from the USGS GTOPO30 topographic model (U.S. Geological Survey, 1997), except
for over Greenland where the topographic grid developed by Ekholm (1996) was used.

140°W 160'W 180° 160'E T40°E

Bathymetric and topographic tints (Meters above and below Mean Sea Level)

|
SELPL TSP PLP PR PP PP RSP

Figure 8.3 The extent of the IBCAO DBM. Projection: Polar Stereographic, true scale at 75° N, WGS 84
horizontal datum. Depths are referenced to Mean Sea Level.

The grid-resolution of the first IBCAO DBM was 2500 x 2500 m on the adopted Polar
Stereographic projection. Since this first release, three major updates have been completed;
Version 1.0 (Jakobsson and IBCAO Editorial Board Members, 2001), 2.0 (Jakobsson et al.,
2008) and 3.0 (Jakobsson et al., 2012).

With specific emphasis on the actual gridding of the bathymetric data, this chapter explains the
compilation methods used for generating the IBCAO Version 3.0, from now on referred to as
IBCAO 3.0. The DBM grid resolution has been increased to 500 x 500 m and the compilations
methods are improved since the Beta version from 2000.

IBCAO 3.0 Compilation
Workflow overview

IBCAO 3.0, is compiled using gridding algorithms and various data processing and filtering
tools available in Generic Mapping Tools (GMT), http://gmt.soest.hawaii.edu/. GMT version
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4.5.8 was used to compile IBCAO 3.0. These GMT routings are embedded in Python scripts
(http://www.python.org/).

The compilation method is briefly described in the auxiliary material of Jakobsson et al. (2012).
The explanation given here complements previously published method descriptions. The aim is
to provide a comprehensive guide to the complete grid compilation process. The main gridding
workflow of the IBCAO 3.0 is summarized in Figure 8.4. The text below explains each of the
steps, A-F, in this workflow.

Compared to the previously released IBCAO 2.0 (Jakobsson et al., 2008), the gridding of
Version 3.0 has been enhanced with adding source data with a spatial horizontal resolution equal
to, or better than, 500 m and in a final step using the remove-restore method (Forsberg, 1993;
Forsberg and Tscherning 1981), described in Appendix 2. This generates a grid that preserves the
details to the scale of 500 m horizontally in areas with dense source data, i.e. mainly in areas
covered by multibeam surveys.

In addition, a source identification grid (SID) is generated allowing users to identify the type of
bathymetric source data that contributed to a particular grid cell’s depth value. The generation of
the source grid is not described in this chapter.

A) Data preparation and merge B) Gridding
Raw data Processed data
(multibeam, single beam soundings) @ Multibeam * t *4+o 1t
(,-,\‘,?J?:f;','],g,,,, @ Single beam 988080
® Olex * e eeee I
egee o e
@ Digitized contours -ttt
Digitzed Data merge/analyzes AAAAE A
charts GIS Database (cross track analyzes, | Blockm d_l fitteri +
lockmedian filtering
removal of contours) GMT blockmedian Resampling to 500 x 500 m
L 2000 x 2000 m grid cells GMT grdsample
F) FEggin_g of | —1- Median z-value in
. o a block
outliers and e +
correction of >, J
identified o | Gridding using 2000 m 3
= . g | o ® GMT surface s
systematic E)Vi lizati 2000 x 2000 m a
oS, ) Visualization o
Inspection of DBM: data L
blending, outliers etc " &
L — — 4 L D,) Remove-restore C) Filtering
Multibeam, single beam (including Olex) Spatial filtering with weights
and land data are blockmedian fittered following a cosine taper <
to S00 x 500 m. over 6000 m | —
GMT blockmedian GMT grdfilter

Blockmedian values (x,.y,.2,.. X .Y, 2,)

are compared to nearest values in the
filtered 500 x 500 m grid resulting -
from C). A z-difference grid is produced. | 4§
GMT grdtrack

If there is a difference in z-value at a
particular grid node, the blockmedian
z-value is replacing that of the grid node.
GMT grdmath

DMBE: IBCAO_V3_500m_RR.grd

DMB: IBCAO_V3_500m_SM.grd Dz) Remove-restore
Same as D,, but only using the land
data.

Figure 8.4 Panels A-F describes the most important components in the IBCAO 3.0 compilation process.
Figure is modified from Jakobsson et al. (2012).
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Data preparation and merging — workflow step A

Preprocessing of all the source bathymetric data to be used in the gridding process is done
depending on the data type and origin. This will not be described further here; instead we will
focus on the grid generation procedure from the point where the main preprocessing of the data
has already been done.

The “clean” bathymetric source data, in the form of high resolution grids, depths soundings
along ship tracks, or spot soundings are merged into a GIS database. In addition, digitized depth
contours from published maps are imported as line features (polygons) into the database.

In the case of the IBCAOQ, Intergraph’s GIS GeoMedia Professional is used to visualize and
analyze all the bathymetric data (Figure 8.5). It should be noted that any GIS capable of
visualizing and analyzing very large amounts of point and line features with assigned z-values
(depth values) and associated metadata can be used for this process.

Relevant metadata are imported along with the bathymetric data to the GIS database. For a more
comprehensive discussion on metadata, the reader is referred to the relevant chapters in this
Cook Book.
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Figure 8.5 Screen view of the GeoMedia Professional GIS workspace with some of the IBCAO source data
displayed. The source database resides in several databases that are accessed using GeoMedia Professional.
Stored depth data with associated metadata can be displayed and analyzed. In this screen view individual
soundings stored as point features are displayed as well as polygons enclosing grids contributed from
multibeam surveys. The metadata of the multibeam survey with RV Marcus Langseth 2011 is shown.
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The IBCAO compilation has aimed to include as a minimum the metadata listed in Table 8.1,
although even this limited set of information has not been available for all bathymetric soundings
used in the gridding process. The metadata may be critical for various quality assurance analyses,
for example, in the estimation of random errors (EImore et al., 2012; Jakobsson et al., 2002). The
GIS database structure, including how the metadata is linked to soundings, is a comprehensive
topic in itself (Hell and Jakobsson, 2008), which will not be described further here.

Although the IBCAO workflow, shown in Figure 8.4, is centered on the use of a GIS database,

the actual grid compilation algorithms (B-D) operate on a suite of exported ASCII xyz flat files.
This means that a grid compilation project can be setup to use the gridding procedure described
here without using a GIS database as a central warehouse for bathymetric data storage.

Minimum metadata requested for contributed bathymetric grids

CONTRIBUTOR: (Institution, company, organization etc.)
CONTRIBUTING_COUNTRY: (Country codes, ISO_3166)

URL_ORIG_DATA: (URL to website describing the grid if available)
URL_METADATA: (URL to metadata by the contributor if available)

GRID_VERSION: (Version, could be a compilation date)
ORIGINAL_GRID_RESOLUTION: (Original horizontal resolution, i.e. grid cell size)
INCORPORATED_GRID_RESOLUTION: (Horizontal resolution of the incorporated grid)
ORIGINAL_PROJECTION: (Projection of the contributed grid, Mercator, UTM etc.)
ORIGINAL_HOR_DATUM: (Horizontal datum of the contributed grid, i.e. WGS 84, NAD1983 etc.)
10 VERTICAL_DATUM: (Vertical datum of the contributed grid, i.e. MSL, MLLW etc.)

11. ORIGINAL_DATA SOURCES: (Multibeam/Singlebeam/Mixed etc.)

CoNoOA~LNDE

Minimum metadata requested for contributed multibeam grids

As for the contributed bathymetric grids (described above), but with the following additions:

12. MB_SYSTEM: (Brand, model and frequency)

13. SVP_CORRECTION: (CTD, XBT, uncorrected nominal sound speed etc.)

14. SHIP: (Ship name)

15. NAVIGATIONAL_SYSTEM: (RTK GPS, DGPS, GPS etc.)

16. CRUISES: (If the contributed multibeam grid is compiled from more cruises these are listed)
17. YEAR_CRUISES: (Cruise year(s))

18. PI: (Cruise PI(s))

Minimum metadata requested for contributed single beam soundings

As for multibeam grids, except for non-relevant parameters, such as grid cell size etc.

Table 8.1 Minimum metadata requested for bathymetric data contributed for inclusion in the IBCAO

Comparing the input data sets — the disambiguation process

148




Available GIS tools in GeoMedia Professional are used to compare the input data sets in a
disambiguation process involving, for example, analyzes of cross-tracks and the match between
digitized contours and soundings (Figure 8.6). Systematic errors are identified during this
process and corrected if possible. The most commonly found systematic error is due to the sound
velocity applied during the conversion from travel time to depth of echo soundings.

IBCAO has adopted the criteria that the DBM grid should contain so-called “corrected depths”,
i.e. each depth should be derived from travel time using a proper harmonic mean of the water
column’s sound velocity. However, several contributed bathymetric surveys were carried out
using a flat nominal sound velocity of 1500 m/s, and if that not is stated in the metadata, the
depths values will systematically be different from corrected depths. This inconsistency is
commonly found from cross track analyzes. When such a systematic difference has been
identified, a correction has been carried out using the capability of performing calculations in the
GIS environment. For example, during the compilation of IBCAO 2.0 systematic differences
between the included soundings from US nuclear submarine cruises were identified and adjusted
(Jakobsson et al., 2008).

The digitized depth contours from bathymetric maps were used in the compilation of the first
IBCAO Beta version. Since then, one of the main goals has been to remove these contours from
the grid compilation and instead grid directly from the sounding database where data density
permits (Figure 8.6). However, IBCAO still relies on gridding using digitized depth contours
from published maps in areas of the Arctic where original soundings either are to sparse to grid
or not have been made available to the IBCAO Compilation Team.
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Figure 8.6 Screen view of the GeoMedia Professional GIS workspace with depth contours from GEBCO
shown together with echo soundings from a seismic reflection survey contributed to IBCAO through the
Geological Survey of Denmark and Greenland (GEUS). The color coding represents depths. Note how the
contours are cropped at the edge of the echo sounding data. If there are noticeable mismatches between
soundings and contours, edgematching may have to be carried out by moving the contours to fit the
soundings. The general goal for IBCAO has been to remove contours from the compilation and instead grid
directly from sounding data.

The GIS capability has also been used to carry out spatial queries to find single beam and spot
soundings that reside within the boundaries of areas mapped with multibeam. When this is the
case, the single beam and spot soundings are flagged and removed from the gridding process.

Generating ASCII xyz files for use in the gridding process

After the time consuming disambiguation process, all data that pass the set criteria for use in the
gridding process are exported from the GIS database as xyz points. In the case of depth contours,
the xyz values of their nodes are exported.

The horizontal datum of the IBCAO is WGS84 and the projection is Polar Stereographic with a
true scale at 75°N. Therefore, the xy-coordinates for each exported depth (z-value) are based on
this projection and datum.

Each multibeam or single beam survey, digitized contours from a bathymetric map, or collection
of spot soundings is exported to separate ASCII files. This permits the generation of the SID grid
and the option to use different kinds of data in the different gridding steps shown in Figure 8.4
B-D.

Gridding — Workflow steps B and C

The IBCAO gridding is done using GMT routines that are embedded in two Python scripts.
Other scripting languages such as Perl or AWK can be used or you can run the GMT commands
individually without embedding them in a script.

However, there are numerous advantages to using a scripting language. For example, it is
possible to work with variables and the script programming language allows the user to construct
their own data processing routines.

We use two Python scripts:

e  One for the main gridding procedure to develop the ‘base grid’
e  One for the remove-restore procedure to add the higher-resolution data sets on top of the *base grid’.

IBCAO was gridded on a computer with Windows 7 (64-bit). The Python scripts are executed in
a DOS-prompt, and the GMT specific commands are executed in Python using:

os.system(‘gmtcommand’)

Both GMT and Python are available for other operating systems, and the procedure described here is not limited to
Windows.
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A simplified version of the IBCAO Python gridding script is supplied in Appendix 1. The simplification consists of
removing several internal data checking procedures in order to make the gridding recipe easier to follow.

Generating the ‘base grid’ — the gridding script

Explanations of the components of this script are given below and are numbered to match the corresponding sections
in the script outlined in Appendix 1.

1) Setup the input variables
There are numerous variables that are defined here to be used in the Python script. The concept has been that instead
of changing, for example the grid cell size, boundary box or data path in all the individual GMT routines that will

use these parameters, variables are set so it is necessary to change their values only in one place. The different
variables are described in Appendix 1.

2) Creation of a list of input files for use in the gridding process

A list of all the individual ASCII xyz-files that will be used in the gridding process is assembled as in the example
Python script below:

FILElist=[filel_SB.xyz', 'file2_MB.xyz', 'file3_CONT.xyz','file4_TOPO.xyz']
In this example, four xyz files are listed for use in the gridding process. Further files can be added to this list.

At this stage, we do not separate the data files depending on their data type, e.g. multibeam, spot soundings, contour
or grid etc. there is no separation of the different data categories as the first grid created will constitute a “base grid”
developed from all the available data.

A separation is made later in the process where remove-restore is used to add all the higher resolution single beam,
multibeam and topography data on top of the “base grid”.

3) Check data consistency and merge files

When large amounts of data are exported from a database, there may occasionally be some problems with data
inconsistency such as, for example, an empty line, a missing coordinate, or missing depth value. Therefore a simple
loop is included that goes through every line in the input files and check if three xyz values are included. This loop
can be extended with additional criteria, such as maximum allowable depth or height etc.

The output from this loop is one large file of data merged from the individual input files. The name of this merged
file is set by variable DATAstr, defined in the ‘set variables’ section of the Python script file.

4) Segment the data into regions to handle large data amounts with GMT "'blockmedian"

This tiling of the data set may only be necessary when working with large volumes of data. For too large datasets,
the GMT program blockmedian may not be able to allocate enough memory.

It was noted that when the data set is comprised of more than approximately 100 million soundings, and the spatial
area to be gridded is as large as the IBCAOQ, then the available RAM became an issue. The exact limitation has not
been investigated. To further boost the available memory the following two DOS commands have been added to the
script:

set EMM=RAM
set dos=high, umb

Within the Python script, the GMT routine gmtselect is used to cut the data into four tiles.
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The following example shows the use of gmtselect to extract a subset from the IBCAO source data set — generating
file R1.xyz

Routine as shown in python script I

os.system('gmtselect -R%s -V %s\\%s > %s\%s' % (BM_R1,DIRstr, DATAstr, DIRstr, R1))

Version using parameters from the ‘setup variables’ section of python script I:

gmtselect —R0/2910000/0/2910000 -V C:\IBCAOData\\IBCAOinput.xyz > C:\IBCAOData\\R1.xyz

5) Block median filtering

Block median filtering is shown as the first step in the gridding process in Figure 8.4B. This is required as a data
preprocessing step before the subsequent surface spline in tension gridding is carried out using the GMT routine
surface (Smith and Wessel, 1990).

Block median filtering provides a way of decimating the input data so that a maximum of one z-value remains for
each grid cell. This step is done as it is not possible to fit a surface exactly through more than one point at each grid
node; the surface is then simply over determined.

There are several ways to decimate your data, in the case of developing a bathymetric grid, one of the reasons for
using the median value within every non-empty cell is that this will decrease the influence of potential outliers
compared to if the mean is used.

There are a number of options available with the GMT routine blockmedian. For developing the, IBCAO 3.0 the
option —Q is used. This finds the median z-value within the defined grid cell size and uses its xy coordinates.
Blockmedian’s default is that the median x and median y is found independently of median z.

In the case of the IBCAO 3.0, the grid cell size in the block median filtering processing was set, with the option I,
to 2000 m. This should be the same as the cell size that will be used when gridding the data with the GMT surface
command.

The following example shows the use of blockmedian to median filter the subset of the IBCAO source data set.
Routine as shown in python script I

os.system('blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s' % (BM_R1,BM_1I, DIRstr, R1, DIRstr, BM_OUTPUT1))
Version using parameters from the ‘setup variables’ section of python script |

blockmedian -R0/2910000/0/2910000 -12000 -V -Q C:\IBCAOData\\R1.xyz > C:\IBCAOData\WOUTFILE_BM1.xyz

6) Merge the GMT Blockmedian filtered segments into one file

This step consists of Python loops that open each of the four files of block median values and
merges them all into one file that will be used as input to the gridding process using GMT’s
surface.

7) Gridding, crop, filter and re-sampling
This section covers the gridding, filtering and re-sampling of the ‘base grid’, generated from all the available source

data. The first step consists of gridding all the data that have been filtered with blockmedian with the GMT routine
surface. The following key parameters are set for surface:
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-R This sets the geographic limits of the grid and should be same as the combined subset regions
created in step 4. Note that a slightly larger area is gridded than is required for the final grid. It
may be enough to extend the gridded region with a few grid cells in all directions. Edge effects
often occur during the gridding, and by applying a larger area here the outer edges may be cropped
subsequently.

-1 Grid cell size in the same units as the data, in the case of the IBCAO this is meters. The cell size
should be the same as used in the blockmedian filtering process. IBCAO 3.0 used 2000 m.

-N Maximum number of iterations in each gridding cycle. The default is 250. Complex data may
require more than 250 iterations in order to allow the surface to fully converge to the data points.
For IBCAO 3.0 compilation —N5000 was used.

-T Tension of the minimum curvature surface. A value of 0 applies no tension and gives a minimum
curvature smooth solution while a value of 1 applies maximum tension, which gives a harmonic
spline solution where local max/min z-values only occur at real data points. Trial and error has
resulted in the IBCAO grids being compiled using values between 0.32 and 0.4.

-Lu The parameter has recently been added to the GMT surface routine. It allows the user to constrain
the range of the output grid, in this case, setting an upper limit of the z range of the grid. For the
IBCAO V3.0, this was set to -0.1. IBCAO is gridded with both topography and bathymetry data in
order to get a good representation of the coastline. However, the grid created in this first step is
limited to only contain values below the coastline. The topography is later merged onto this grid
using the remove-restore concept.

An example of the use of the GMT surface routine for gridding the blockmedian filtered data:

Routine as shown in python script I:

os.system('surface %s\\%s -R%s -1%s -N%s -T%s -G%s\\%s -Lu%s -V' % (DIRstr, BM_OUTPUT, BM_R, S_I, N_I,
S _T, DIRstr, S_grd_out, LU))

Version using parameters from the ‘setup variables’ section of python script I :

surface C:\IBCAOData\\OUTFILE_BM.xyz -R-2910000/2910000/-2910000/2910000 —2000
—N5000 -T0.32 -G C:\\IBCAOData\\out_grd.grd —Lu-0.1 -V

The grid generated with the GMT surface command above is cropped to its final extent using grdcut and filtered
using grdfilter. The latter is optional, and has been implement specifically as all the high resolution data will again
be merged onto this “base grid” using remove-restore.

An example of using GMT’s grdcut to crop the grid generated using surface:

Routine as shown in python script I

grdcut %s\\%s -R%s -G%s\\%s' % (DIRstr, S_grd_out, CUT_R, DIRstr, CUT_grd_out

Version using parameters from the ‘setup variables’ section of python script I:

grdcut C:\\IBCAOData\\out_grd.grd -R-2904000/2904000/-2904000/2904000 -G C:\IBCAOData\\out_grd01.grd
There are several types of spatial filters to choose between. For IBCAO 3.0 a cosine arch was selected with —

Fc6000 . This means that a weighted averaging with cosine arc weights are applied over 6000 m. The parameter —-DO
means that the set filter width is in the same unit as the grid.
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An example of using GMT’s grdfilter to filter the cropped grid:

Routine as shown in python script I:

‘grdfilter %s\\%s -G%s\\%s -R%s -DO0 -Fc%s' % (DIRstr, CUT_grd_out, DIRstr, FILT_grd_out, CUT_R, FILT))
Version using parameters from the ‘setup variables’ section of python script I:

grdfilter C:\IBCAOData\\out_grd01.grd -G C:\\IBCAOData\\filt_grd01.grd -R-2904000/2904000/-2904000/2904000 -
DO —F6000

The final step of the gridding procedure, shown in Figure 8.4B, consists of resampling the grid to a higher resolution
using GMT’s grdsample. This resolution should match the desired resolution of your final grid. In the case of
IBCAO 3.0 the grid is resampled to 500x500 m.

An example of using GMT’s grdsample to sample the cropped/filtered grid to the desired resolution of your final
grid:

Routine as shown in python script I:

os.system('grdsample %s\\%s -G%s\\%s -R%s -1%s -V' % (DIRstr, FILT_grd_out, DIRstr, RESAMP_grd_out, CUT_R,
R_I))

Version using parameters from the ‘setup variables’ section of python script I:

grdsample C:\IBCAOData\\filt_grd01.grd -GC:\IBCAOData\\resamp_grd01.grd -R-2904000/2904000/-
2904000/2904000 -1500 -V

This re-sampled grid is now the ‘base grid’ to be used as a base for in the remove-restore process described below.

Remove-restore — Workflow step D

The gridding steps and algorithms used to develop the IBCAO 2.0 are nearly identical to those
described above. However, for the generation of the IBCAO 3.0, a final of step of adding the
multibeam, dense single beam echo soundings and land topography on top of the ‘base grid’
using the remove-restore method was included (Forsberg, 1993; Forsberg and Tscherning,
1981).

This final step, generates a grid that preserves the detail to the scale of 500 m horizontally in
areas with dense source data, i.e. mainly in areas covered by multibeam surveys. The value of the
predicted bathymetry is added back to the interpolated difference.

The remove-restore procedure uses a set of GMT routines. The first step is to calculate the
difference between two gridded data sets. These difference values are then gridded and added on
top of the base grid. This preserves the resolution of the input data.

For the IBCAO V3.0 grid generation work, dense single beam echo soundings refers to a spatial
coverage where the soundings are closer to or less than 500 m apart. This is because the target
resolution of the final grid is 500 x 500 m. Sparse random tracklines are omitted from the
remove-restore process.
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The grid used in this step is the 500 x 500 m “base grid’ created from re-sampling of the filtered
2000 x 2000 m grid, Box C in Figure 8.4.

The following gives a description of the components of the remove-restore python script in
Appendix 2. The description is organized so that each numbered explanation is marked with a
corresponding number in the script. The numbering starts from 8 in order to avoid confusion
with the description of the script in Appendix 1.

8) Setup the input variables

As described in section 1 above, the variables to be used in the GMT routines and Python script
are setup. These variables are defined in the script in Appendix 2.

9) Merge all the input data

The separate files of multibeam and dense single beam echo soundings and land topography data
are merged into one file. In the case of the IBCAO 3.0, this also includes the Olex echo sounding
data collected primarily by fishing vessels (see Jakobsson et al., 2012).

The merge is done by reading all the input files and checking that there are three variable
provided (this procedure is described in section 2 above). One merged output file is written
containing all the data that will be added onto the input ‘base grid’ grid using remove-restore.

10) Cut the data set into sub-regions

This step may only be necessary when working with large volumes of data which may cause memory issues when
using the GMT routine blockmedian. See explanation 4 above.

In this example, the outputs from this segmentation process are the files R1_RR.xyz......
R4_RR.xyz. Note that the number and geographic division of the regions can be modified to fit
the data volume and spatial distribution.

11) Block median filtering

Block median filtering provides a way of decimating the input data so that a maximum of one z-
value remains for each grid cell. This step is done as it is not possible to fit a surface exactly
through more than one point at each grid node; the surface is then simply over determined. See
explanation 5 above.

Routine as shown in python script 11:

os.system('blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s' % (BM_R1,BM_lI, DIRstr, R1, DIRstr,
BM_RR_OUTPUT1))

Version using parameters from the ‘setup variables’ section of python script 11:

blockmedian -R'0/2910000/0/2910000' -1500 -V -Q m:\my_data\R1_RR.xyz >
C:\IBCAOData\OUTFILE_RR_BM_1.xyz
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12) Merge the blockmedian filtered segments

One output file is created from this process. The name of the file is set by variable
IBCAO_RR_SEGMENT. For further details, see explanation 6 above.

13) Find the depth in the ‘base grid’ at the location of the blockmedian filtered data points

This next step finds the depth in the ‘base grid’ at the location of the blockmedian filtered data
points. This is done so we can compare the difference in z-values between the high resolution
data that were blockmedian filtered and the resampled 500 x 500 m base grid.

The following line in the script will take the merged blockmedian filtered data, the resampled
500 x 500 m grid and interpolate from the grid at the points in the input file.

Routine as shown in python script 11:

os.system('grdtrack %s -G%s -V -S > %s' % (IBCAO_RR_SEGMENT,IBCAO_resamp,IBCAO_resamp_predict))

Version using parameters from the *setup variables’ section of python script II:

grdtrack IBCAO_RR_SEGMENT.xyz —Gresamp_grd01.grd -V -S > resamp_grd01_pred.xyzz

The resulting output ASCII file, “resamp_grd01_pred.xyzz” , looks like:
X1 Y1 Z1bm Zyj

Xn Yn Znbm Zni

where x1,y1,are the coordinates for a blockmedian depth ziu, created in step 11) and z1: the depth
retrieved from the 500 x 500 m grid at this location.

14) Compute the difference in z-values between the blockmedian filtered data and the base grid
That is the difference between zipm and zij in the example above. If the depth difference here is

bigger than a threshold set in the script detailed in Appendix 2 (variable DIFF_P) it is written to
a file: IBCAQO_diff.xyz

15) Create a difference grid

A grid is created, using the GMT nearneighbor routine, that consist of the differences between
the blockmedian filtered data and the resampled 500 x 500 m base grid. The neighbor routines
reads x,y,z from an input file and uses a nearest neighbor algorithm to assign an average value to
each node that have one or more points within a radius centered on the node.

An example is given below of gridding with nearneighbor:
Routine as shown in python script I1:

os.system('nearneighbor %s -G%s -R%s -1%s -S1000 -N4 -EO -V' %
(IBCAO_resamp_diff,IBCAO_resamp_diff GRD,BM_R,BM_1I))
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Version using parameters from the “setup variables’ section of python script I1:

nearneighbor IBCAO_diff.xyz ~GIBCAO_diff.grd —R-2904000/2904000/-2904000/2904000 —I500 -S1000 -N4 -EO -V
16) Merge the difference grid on top of the base grid

The difference grid, from step 15, above is ‘added’ to the base grid using the GMT routine
grdmath to create the final grid. In the example given below, the final grid file is called
IBCAO _final_RR.grd.

Routine as shown in python script I1:
os.system('grdmath %s %s ADD = %s' % (IBCAO_resamp,IBCAO_resamp_diff_GRD,IBCAO _final))

Version using parameters from the “setup variables’ section of python script Il:

grdmath resamp_grd01.grd IBCAO_diff.grd ADD = IBCAOQ_final_RR.grd
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Appendix 1: Python script |

Procedure for generating the *base grid’ from all available source data

# -*- coding: cp1252 -*-

T T T T

# GEBCO Cook Book Appendix 1 "Stage 1: generating a base grid for the International Bathymetric Chart of the Arctic
Ocean (IBCAQ) Version 3.0"

#

# This script contains the procedure used in stage 1 of the IBCAO 3.0 grid generation process. It covers the generation
# of a base grid based on all the available bathymetric source data. Stage 2 of the process involves adding high density data
#on top of the base grid using the 'remove-restore’ procedure. This is covered in a separate script.

#

#This script is setup with example values included. The example values were used to grid IBCAO 3.0.

# The script will perform the following:

# 1. Setup of variables

# 2. Creation of file list for input to gridding

# 3. Check data consistency and merge files

# 4. Segment the data set into regions to handle large data amounts with GMT "blockmedian"

# 5. Block median filtering

# 6. Merge block median filtered segments into one file

# 7. Gridding, crop, filter, and resampling

# 7.1. 6ridding using surface.
# 7.2. Crop and filter the grid
# 7.3 Resampling of the grid.
#

# Written by Martin Jakobsson
#Department of Geological Sciences
# Stockholm University

#

# September 23, 2012

#

#

#

#

B
HHHHHH R

from __future__ import division #This line includes the true division avoiding problems with unwanted floor division
import fileinput
import os

HH A

# 1: Setup of variables

A AT

Cint=0 #Counter for loop in section 3

DIRstr="C:\\IBCAOData\\" #Path to data files

DATAstr="1BCAOinput.xyz" #Main file holding the source data for gridding. It consists of a merge of all input files.

# GMT input variables

BM_I="2000" # Blockmedian filter bin size, this should be the same as will be used for the gridding work,
BM_R="-2910000/2910000/-2910000/2910000" #Blockmedian region set for GMT. This is the regional set in
Polarstereographic coordinates for the IBCAO gridding.

#The user must change this to the appropriate region for the task. It could be set in any coordinate system or lat lon if a
geographic grid is created. Note that this region should extend slightly outside of the final grid boundaries to account for
edge effects.

BM_R1="0/2910000/0/2910000" #Region 1 for subset tiling. This tiling is only required for very large data sets (100
million soundings or more).
BM_R2="0/2910000/-2910000/0" #Region 2 for subset tiling
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BM_R3="-2910000/0/-2910000/0" #Region 3 for subseft tiling
BM_R4="-2910000/0/0/2910000" #Region 4 for subset tiling

#Output files from the subset tiling
R1="R1l.xyz"
R2="R2_.xyz"
R3="R3.xyz"
R4="R4 _xyz"

#Output files from the Blockmedian filtering of the different regions
BM_OUTPUT1="0UTFILE_BM1.xyz"
BM_OUTPUT2="0UTFILE_BM2.xyz"
BM_OUTPUT3="0UTFILE_BM3.xyz"
BM_OUTPUT4="0UTFILE_BM4.xyz"
BM_OUTPUT="0UTFILE_BM.xyz" #Output file of the entire region

S_1="2000" #6ridding cell size. Value is set as used for IBCAO 3.0

R_I="500" #Resampling grid size

FILT="6000" #Filter size for smoothing

S_T="0.32" #Tension parameter, for use with GMT's surface

N_I="5000" #Max iterations in each gridding cycle. Default is set to 250
LU="5000" #Value constraining the upper limit of the grid
S_grd_out="out_grd._grd" #6rid output file, unfiltered
CUT_R="-2904000/2904000/-2904000/2904000" #Geographic region of the final grid
CUT_grd_out="out_grd01.grd" #Cropped grid
FILT_grd_out="Ffilt_grd0l.grd" #Filtered grid
RESAMP_grd_out="resamp_grd01.grd" #Resampled grid at the spacing set by R_T

HAAHH A A A

# Point 2: Creation of filelist for input to the gridding procedure

# Note that there is not a separation of the data here into different categories, this is done in the remove-restore
procedure

HHAAHH A A A

#Input files are listed below, for additional files increase the list

FILElist=["filel_SB.xyz", "file2_MB.xyz", "file3_CONT.xyz","file4 TOPO.xyz"]

print FILElist[1]

FHHHHFHHFHHHHHHHH

# PomT 7 Gr'lddmg cr'op fllTer and r'esamplmg

FHHHHHHHHHHHHH?

def grld()

HHHHHAH A A

# 7.1. 6rid the data using GMT surface

os.system(“surface %s\\%s -R%s -1%s -N%s -T%hs -GUs\\%s -Lu%s -V" % (DIRstr, BM_OUTPUT, BM_R,
S_ I, N_I, S_T, DIRstr, S_grd_out, LU))

e

#7.2. Crop and filter The grad

os.system("grdcut %s\\%s -R%s -G%s\\%s®" %6 (DIRstr, S_grd_out, CUT_R, DIRstr, CUT_grd_out))

os.system("grdfilter %s\\%s -G%s\\%s -R%s -DO -Fc%s" %o (DIRstr, CUT_grd_out, DIRstr, FILT_grd_out,
CUT_R, FILT))

HEHHHHH AR A

# 7.3 Resampling of the IBCAO grid

os.system("grdsample %s\\%s -G%s\\%s -R%s -1%s -V* % (DIRstr, FILT_grd_out, DIRstr, RESAMP_grd_out,
CUT_R, R_D)
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exit()

AT A T
# Point 3: Check the data for consistency (no empty lines or large outliers) and file merge
R e

F=open(r"%s\\%s" %6 (DIRstr,DATAstr), "w+" )

print "input file directory %s\n® 26 (DIRstr)
print "1. The following files will scanned and checked for consistency\n*®
print "%s*® % (FILElist)

while Cint <= len(FILElist)-1:
G=open("%s%s" % (DIRstr,FILElist[Cint]), "r" )
while 1:
line=G.readline()
line_items=line.split()
if not line: break
if len(line_items) ==
F.write(line)
Cint +=1
G.close()

F.close()

HERHRHBHBHBHBHR AR HBHRERHRHREH
# Point 4: Segment the data set into regions to handle large data amounts with GMT "blockmedian"
HAHA R AR AR AR H R AR R R T

os.system(“set EMM=RAM®)

os.system("set dos=high, umb®)

os.system("gmtselect -R%s -V %s\\%s > %s\\%s®" % (BM_R1,DIRstr, DATAstr, DIRstr, R1))
os.system(“gmtselect -R%s -V %s\\%s > %s\\%s*" % (BM_R2,DIRstr, DATAstr, DIRstr, R2))
os.system("gmtselect -R%s -V %s\\%s > %s\\%s" % (BM_R3,DIRstr, DATAstr, DIRstr, R3))
os.system(“gmtselect -R%s -V %s\\%s > %s\\%s" % (BM_R4,DIRstr, DATAstr, DIRstr, R4))

B e e e e
# Point B: Block median filtering
# HHH AR AR AR AR R R

os.system("set EMM=RAM™)

os.system(“set dos=high, umb*)

os.system("blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s" % (BM_R1,BM_I, DIRstr, R1, DIRstr,
BM_OUTPUT1))

os.system(“blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s" % (BM_R2,BM_I, DIRstr, R2, DIRstr,
BM_OUTPUT2))

os.system(“blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s" % (BM_R3,BM_I, DIRstr, R3, DIRstr,
BM_OUTPUT3))

os.system(“blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s" % (BM_R4,BM_I, DIRstr, R4, DIRstr,
BM_OUTPUT4))

#os.system('blockmedian -R%s -I%s -V -Q 7%s\\%s > %s\\%s" % (BM_R,BM_I, DIRstr, DATAstr, DIRstr, BM_OUTPUT))
#If only one region is used, the lines above should be commented out and this line used instead.

HHHHHHAHHFHH AR AR AR A
# Point 6 in the explanation. Merge all the block median data into one file
B B eSS
I=open(r*%s\\%s" % (DIRstr,BM_OUTPUT), “"w+" )

H=open("%s%s" % (DIRstr,BM_OUTPUT1), "r" )

while 1:
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line=H.readline()

if not line: break

l.write(line)
H.close()

J=open("%s%s" % (DIRstr,BM_OUTPUT2), "r" )
while 1:

line=J.readline()

if not line: break

l.write(line)
J.close()

K=open("%s%s" % (DIRstr,BM_OUTPUT3), "r" )
while 1:

line=K.readline()

if not line: break

l.write(line)
K.close()

L=open("%s%s* % (DIRstr,BM_OUTPUT4), "r* )
while 1:

line=L.readline()

if not line: break

l.write(line)
L.close()

l.close()

T T T T A T

# Point 7 in the explanation, see function in the beginning of the script.

A T T T T

gridQ
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Appendix 2: Python script Il: the remove-restore procedure

The following script details the procedure for adding the higher resolution source data sets, such
as multibeam, dense single beam echo soundings and land topography on top of the ‘base grid’
using the remove-restore method

The script is written in Python and uses embedded GMT routines.

-*- coding: cp1252 -*-

#

# GEBCO Cook Book Appendix 2 "Step 2 in the process of gridding the International Bathymetric Chart of the
Arctic Ocean (IBCAQ) Version 3.0"

#

# This script is stage two in the procedure used in generating IBCAO 3.0. I't uses embedded GMT routines.
# The script uses a number of variables which are setup in Point 8. These example values were used to grid
#IBCAO 3.0. The user should modify these variables to match their own gridding project.

#

# The script will perform the following:

# 8. Setup of the variables

# 9. Creation of an input file for gridding

# 10. Segment the data into regions to handle large data amounts with GMT "blockmedian"

# 11. Block median filtering

# 12. Merge block median filtered segments into one file

# 13. Find the depth in the 'base grid' at the location of the block median filtered data points

# 14. Compute the difference in z-values between the block median data and the base grid

# 15. Create a difference grid

# 16. Merge the difference grid on top of the base grid

#

#This script originated from the remove-restore script written by D. Sandwell 08/08/07

# Written by Martin Jakobsson November 27 2011

#

#

#

#

from __future__ import division #This line includes the true division avoiding problems with unwanted floor
division

import fileinput

import os

HHHHHHHAHHAHAA A
# Point 8: Setup of the variables
HEHHHHHH R

DIRstr="C:\\IBCAOData\\' #Directory path to the data files, change to your path
BM_R="-2904000/2904000/-2904000/2904000" #Blockmedian region set in GMT, this must fit the
geographic extent of the grid which is going to be updated
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#It could be any coordinate system, the main point is that the region fits the geographic region of the base
grid to be updated

#The following are the output files from the Blockmedian filtering from each of the segmented regions for use
in remove restore

BM_RR_OUTPUT1='OUTFILE_RR_BM_1.xyz'

BM_RR_OUTPUT2='OUTFILE_RR_BM_2.xyz'

BM_RR_OUTPUT3='OUTFILE_RR_BM_3.xyz'

BM_RR_OUTPUT4='OUTFILE_RR_BM_4.xyz'

BM_I1="500" # Blockmedian filter bin size, this should be the same as the cell size of the resampled base grid.
IBCAO_resamp="'resamp_grd01.grd' #The base grid

IBCAO_RR='IBCAO_RR.Xyz' #The input ASCII file of all multibeam and dense single beam echo
soundings and land topography.

IBCAO_RR_SEGMENT='IBCAO_RR_SEGMENT.xyz" #This is a file that consists of all merged blockmedian
files.

IBCAO_resamp_predict="resamp_grd01_pred.xyzz' #This is the interpolated values output from grdtrack
IBCAO_resamp_diff="IBCAO_diff.xyz' #Points that are different when from the old IBCAO after check
with grdtrack against the new data

IBCAO_resamp_diff GRD='IBCAQO_diff.grd"

IBCAO_final="IBCAO_final_RR.grd' #The final grid file

DIFF_P='0.5' #the difference criteria that need to be passed for updating of grid. In other words, the data
sets need to be different by at least this amount for an update to take place

S_C='0.001" #Tteration parameter
S_T='0.32' #Tension variable for use with the GMT surface gridding command

#In order to handle large volumes of data with Blockmedian, it may be necessary to cut the full area into
sections. The user must change the values given here to those appropriate for their own gridding project.
Values can be set in any coordinate system or latitude or longitude if a geographic grid is created. Note that
this region should extend slightly outside of the final grid boundaries to account for edge effects.
BM_R1="0/2910000/0/2910000" #Region 1 for subset tiling. This tiling is only required for very large data
sets (100 million soundings or more).

BM_R2='0/2910000/-2910000/0" #Region 2 for subset tiling
BM_R3="-2910000/0/-2910000/0' #Rregion 3 for subset tiling
BM_R4="-2910000/0/0/2910000" #Region 4 for subset tiling

#Output files from the subset tiling
R1='R1_RR.xyz'
R2='R2_RR.xyz'
R3='R3_RR.xyz'
R4='R4_RR.xyz'

HEHHHH R R R R

# Point 9: Creation of an input file for gridding
HH B
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0s.system('set EMM=RAM")

0s.system(’set dos=high, umb")

DATAstr=IBCAO_RR

FILElist=["filel_SB_dense.xyz','file2_MB.xyz','file4_TOPO.xyz"] #All input files should be listed

here.
print '%s" % (FILElist)
F=open(r'vos\\%s' % (DIRstr,DATASstr), 'w+")
Cint=0
while Cint <= len(FILElist)-1:
G=open('%s%s' % (DIRstr,FILElist[Cint]), 'T")
while 1:
line=G.readline()
line_items=line.split()
if not line: break
if len(line_items) == 3:
F.write(line)
Cint +=1
G.close()

HEH R R R R R R R R R R
# Point 10: Segment the data into regions to handle large data amounts with GMT "blockmedian"
HHBHH R R

os.system(‘gmtselect -R%s -V %s\\%s > %s\\%s' % (BM_R1,DIRstr, DATAstr, DIRstr, R1))
os.system(‘gmtselect -R%s -V %s\\%s > %s\\%s' % (BM_R2,DIRstr, DATAstr, DIRstr, R2))
os.system(‘gmtselect -R%s -V %s\\%s > %s\\%s' % (BM_R3,DIRstr, DATAstr, DIRstr, R3))
os.system(‘gmtselect -R%s -V %s\\%s > %s\\%s' % (BM_R4,DIRstr, DATAstr, DIRstr, R4))

HHBHH
# Point 11: Block median filtering
HHBHH R

os.system('blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s' % (BM_R1,BM_I, DIRstr, R1, DIRstr,
BM_RR_OUTPUTL1))

os.system('blockmedian -R%s -1%s -V -Q %s\\%s > %s\\%s' % (BM_R2,BM_I, DIRstr, R2, DIRstr,
BM_RR_OUTPUT2))

os.system(‘blockmedian -R%s -1%0s -V -Q %s\\%s > %s\\%s' % (BM_R3,BM_I, DIRstr, R3, DIRstr,
BM_RR_OUTPUT3))

os.system(*blockmedian -R%bs -1%0s -V -Q %s\\%s > %s\\%s' % (BM_R4,BM_I, DIRstr, R4, DIRstr,
BM_RR_OUTPUT4))

F.close()

HHBHH BB R
# Point 12: Merge the blockmedian filtered segments
HEHHHHH BB R R R R

DATAstr2=IBCAO_RR_SEGMENT
L=open(r'%s\\%s' % (DIRstr,DATAsStr2), ‘w+")
FILElist2=['OUTFILE_RR_BM_1.xyz',"OUTFILE_RR_BM_2.xyz','"OUTFILE_RR_BM_3.xyz',"OUTFILE_RR_B
M_4.xyz']
Cint2=0
while Cint2 <= len(FILElist2)-1:

K=open('%s%s' % (DIRstr,FILElist2[Cint2]), 'r")

165




while 1:
line=K.readline()
line_items=line.split()
if not line: break
if len(line_items) == 3:

L.write(line)
Cint2 +=1
K.close()

L.close()

HEHBHHIHHBH BRI

# Point 13: Find the depth in the 'base grid' at the location of the blockmedian filtered data points
HHBHH R

#Find the depth in the base grid at the location of the blockmedian filtered data points.

os.system('grdtrack %s -G%s -V -S > %s' %
(IBCAO_RR_SEGMENT,IBCAO_resamp,IBCAO_resamp_predict))

T T T T T T T T R T T R T R i
# Point 14: Compute the difference in z-values between the blockmedian data and the base grid

HEHHH R R R R R R R R R

I=open('%s' % (IBCAO_resamp_diff), 'w+")
H=open('%s"' % (IBCAO_resamp_predict), 'r')
while 1:

line2=H.readline()

if not line2: break

X_str,Y_str,Z1_str,Z2_str=line2.split()

X_f=float(X_str)

Y_f=float(Y_str)

Z1 f=float(Z1_str)

z2_f=float(Zz2_str)

DIFF_1=7z2_ f-Z1_f

DIFF_2=71 f-zZ2_f

DIFF_P_f=float(DIFF_P)

if DIFF_1 > DIFF_P_f or DIFF_2 > DIFF_P_f:

l.write("%s %s %s\n' % (X_str,Y_str,DIFF_2))

l.close()

PRI I I I T
# Point 15: Create a dif ference grid
HHBHH

#Create a grid using the GMT nearneighbor routine, that consist of the differences between the blockmedian
filtered data and the base grid

os.system('nearneighbor %s -G%s -R%s -1%s -S1000 -N4 -EO -V' %
(IBCAO_resamp_diff,IBCAO_resamp_diff_ GRD,BM_R,BM_1))

R T T T R T R T R T R
# Point 16: Merge the difference grid on top of the base grid
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HEHHIH BB R R R R

#This step adds the difference grid on top of the base grid using grdmath from GMT
os.system(‘grdmath %s %s ADD = %s' % (IBCAO_resamp,IBCAO_resamp_diff _GRD,IBCAO_final))

Hit

### clean up the mess
Ht

##rm global.grd diff.grd

import fileinput
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Appendix 3: IBCAO Compilation Team

!Martin Jakobsson, ?Larry Mayer, *Bernard Coakley, “Julian A. Dowdeswell, °Steve Forbes,
®Boris Fridman, "Hanne Hodnesdal, ®Riko Noormets, °Richard Pedersen,'®Michele Rebesco
Hans-Werner Schenke, *2Yulia Zarayskaya, °Daniela Accettella, 2Andrew Armstrong,
3Robert M. Anderson, *Paul Bienhoff, t°>Angelo Camerlenghi, ®lan Church, ’Margo Edwards,
2James V. Gardner; *John K. Hall, ‘Benjamin Hell, *°Ole Hestvik, 2°Yngve Kristoffersen,
IChristian Marcussen, *Rezwan Mohammad, 2David Monahan, ?David Mosher, *Son V.
Nghiem, ®Maria Teresa Pedrosa, °Paola G. Travaglini, 2*Pauline Weatherall;

!Dept. of Geological Sciences, Stockholm University, Sweden; 2Center for Coastal and Ocean
Mapping/Joint Hydrographic Center, University of New Hampshire, USA; 3Dept. of Geology
and Geophysics, University of Alaska Fairbanks, USA; #Scott Polar Research Institute,
University of Cambridge, UK; °Canadian Hydrographic Service, Canada; ®Moscow
Aerogeodetic Company, Russian Federation; ‘Norwegian Mapping Authority, Hydrographic
Service, Norway; 8The University Centre in Svalbard, Longyearbyen, Norway; °National Survey
and Cadastre, Denmark; ‘Istituto Nazionale di Oceanografia e di Geofisica Sperimentale (OGS),
Italy; 1*Alfred Wegener Institute for Polar and Marine Research (AWI), Germany; *? Laboratory
of Ocean Floor Geomorphology and Tectonics, Geological Institute RAS, Russian Federation;
13Science Applications International Corporation, USA; * Johns Hopkins University Applied
Physics Laboratory, USA;ICREA and University of Barcelona, Spain; **Dept. Geodesy and
Geomatics Engineering, University of New Brunswick, Canada;'’University of Hawaii at
Manoa, USA;8Geological Survey of Israel, Israel;'®OLEX, Norway;?°Dept of Earth Science,
University of Bergen, Norway;?*Geological Survey of Denmark and Greenland,
Denmark;??Geological Survey of Canada, Canada®Jet Propulsion Laboratory, California
Institute of Technology, USA; ?*British Oceanographic Data Centre (BODC), UK.

8.3  Testing of gridding methods

In order to test different gridding methods, it is necessary to compare the resulting grid with
control data that were not used to make the grid. These control data may have been intentionally
withheld for testing purposes, or they may not have been available when the grid was calculated.
The differences between the control data and the grid are considered to be "errors,” which can be
quantified and compared to assess how well a gridding method does.

8.3.1 Distance to Control
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Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA

We have developed a method that can be used to test different gridding algorithms. It has been
used previously to assess errors in bathymetry models (Marks and Smith, 2010). The method
can also be used to assess errors in any local or regional depth grids where there are multibeam
or other “ground truth” depths available to compare the grids against. The “ground truth” data
must not be incorporated into the depth grid for the technique to work, and there needs to be an
area with a large gap between control points for testing. This method can also be used to
evaluate different gridding techniques. A successful gridding algorithm will have smaller errors
when compared to the ground truth data.

We demonstrate the use of the error assessment method to evaluate different gridding algorithms.
For this example, following NOAA Technical Report NESDIS 132 (Marks and Smith, 2011), we
select a small study area encompassing several seamounts (left panel in Figure 8.7) that has large
gaps between control points and is traversed by several swaths of JAMSTEC multibeam data that
can serve as “ground truth.” Figure 8.7 (right panel) shows a distance to control map that was
calculated from control points in bathymetry model version 12.1". Version 12.1" had JAMSTEC
data intentionally withheld from bathymetry model version 12.1 (Smith and Sandwell, 1997) for
testing purposes.

Distance to control may be calculated in two ways. Smith wrote a program (Appendix C; Marks
and Smith, 2011) exploiting the even/odd encoding of control points in Smith and Sandwell
bathymetry models to compute a distance to control grid directly from the model “img” file.
However, distance to control may be calculated from any control points using the GMT routine
“grdmath” with the PDIST operator. The command line for calculating distance to control from
any user-supplied control points is listed below. This will enable users to test any bathymetry
grids for errors as a function of distance to control.

grdmath controlpoints.xy —Rminlon/maxlon/minlat/maxlat —Igrdspacing —fg PDIST = distance_grd
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Figure 8.7 JAMSTEC multibeam swaths (red) plotted on bathymetry version 12.1" (left). Map of “distance
to control” corresponding to bathymetry version 12.1" (right). Black dots are V12.1" grid cells constrained by
ship soundings. V12.1" was created without JAMSTEC data.

In our example here we used depth values from the constrained grid cells from V12.1" in the
study area as input into different gridding algorithms: GMT routine “surface,” employed with the
tension set to “0” and set to “1,” and GMT routine “nearneighbor.” Surface tension set to “0”
gives the minimum curvature solution, and set to “1” gives a harmonic surface where maxima
and minima are only possible at control points. “Nearneighbor” uses a nearest neighbor
algorithm to assign an average value within a radius centered on a node. The GMT command
lines used to produce the gridding solutions shown in Figure 8.8 are listed below.

Surface w/T0 Surface w/T1 Nearest Neighbor
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Figure 8.8 Results of gridding depths from V12.1" at constrained grid cells (black dots): GMT “surface”
gridding routine with tension set to 0 (left) and set to 1 (middle), and “nearneighbor” gridding routine (right).

surface topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -11m -TO -Gsurface.t0_grd

surface topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -11m -T1 -Gsurface.tl_grd

nearneighbor topo_12.1.nojamstec.controls.xyz -R0/2.7/0/3.41666666667 -N4/1 -S100k -11m
-Gnearneighor.1m_grd

Each gridding algorithm produces a very different result. By comparing these results to the
JAMSTEC multibeam “ground truth” data (red dots in Fig. 8.7, left panel), we can assess which
algorithm produced the best match to the observed depths. Note that no interpolated solution
detects seamounts in gaps between ship controls (Fig. 8.8). However altimetric bathymetry
model VV12.1" (Fig. 8.7, left panel) does detect seamounts in gaps between ship soundings. The
model fills these gaps with depths estimated from satellite gravity, which reflects the underlying
seafloor topography.

In Figure 8.9 we show the errors (i.e., the absolute value of the differences) between the

JAMSTEC multibeam depths and depths produced by the different GMT gridding routines. In
our example, GMT routine “surface” with a tension of 1 has the smallest errors.

MB - Surface w/T0 MB - Surface w/T1 MB - Nearest Neighbor

2000

Error, m

1] 10 20 30 40 1] 10 20 30 40 0 10 20 30 40
Distance from Control, km Distance from Control, km Distance from Control, km

Figure 8.9 Errors are the absolute value of the differences between multibeam depths from swaths plotted in
Figure 8.7 and gridded depths from GMT routines “surface” with tension set to 0 (left) and set to 1 (middle),
and from GMT “nearneighbor” (right), plotted against distance from the nearest sounding control.

8.3.2 Histograms

The errors can also be displayed in the form of a histogram (Figure 8.10). The error distribution
from gridding with GMT routine “surface” with tension set to 0 shows the largest errors and they
are generally negative (depths from “surface” grid are deeper than multibeam depths).
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Figure 8.10 Histogram of the differences between multibeam depths from swaths plotted in Figure 8.7 and
grids from GMT routines “surface” with tension set to 0 (left) and set to 1 (middle), and from GMT
“nearneighbor” (right) depths.

It is also possible to map regional errors resulting from the different gridding algorithms. The
interpolated grids (shown in Fig. 8.8) can be subtracted from a gridded solution that incorporated
all the ship controls (in this example, bathymetry model VV12.1). The pattern of regional depth
differences (Fig. 8.11) can help in evaluating how well a gridding routine is doing.

V12.1 - Surface w/TO V12.1 - Surface w/T1 V12.1 - Near Neighbor

40 200 ] 200 40 40 200 ] 200 40 -4 200 ] 200 40
Depth Difference, m Depth Difference, m Depth Difference, m

Figure 8.11 Regional depth differences between VV12.1 and results from different GMT gridding routines
(shown in Fig. 8.8). Black dots are constrained grid cells in V12.1.
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8.3.3 Statistical tests

TEXT IN PREPARATION

8.4  Other routines for use on gridded data
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Contributed by Matthew Love and Barry Eakins, National Geophysical Data Center, USA, and
David Sandwell, Scripps Institution of Oceanography, USA

Below are miscellaneous routines for use on gridded data. The routines include gdal_query.py,
which compares gridded elevations with xyz data, update_grid, which updates a grid with new
grid cell values, and gdal_perspective.py, which creates color-perspective images of DEMs.

gdal_query.py

This Python script uses GDAL (http://www.gdal.org/) to query a GDAL-readable grid, such as
netcdf, at the locations of xyz data in a specified file. It returns an ASCII file with xyz of the
original data, as well as the grid elevation value at each point and the difference between these
values. This script is useful for quantifying how well the grid represents the source data it was
built from, or compares with other, independent data that were not used in grid development.
Developer - Matthew Love, NOAA National Geophysical Data Center.

#1/usr/bin/env python

#H -
# Description: Compare the values found in a source "xyz" ascii
# file to those of a gdal compatible gridfile, or
# sample a gridfile to xy points In an xy* Tile.
#
# Depends: GDAL ; NumPy
H#H -
H——
import sys
import os
import math
import re

import struct

import numpy as np

import osgeo.gdal as gdal
H——

gg_version = "1.8.2"

def con_dec(x, dec):
"""Return a float string with n decimals
(used for ascii output).""*

if x is None:
print >> sys.stderr, 'gdal_query: Error, Attempting to convert a
"None® value."
return
fstr = "%." + str(dec) + "f"
return fstr % x

# Convert a geographic x,y value to a pixel location of geoTransform
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def geo2pixel( geo_x, geo_y, geoTransform ):
if geoTransform[2] + geoTransform[4] ==

pixel_x = (geo_x - geoTransform[0]) /-geoTransform[l]
pixel y = (geo_y - geoTransform[3]) / geoTransform[5]

else:

pixel_x, pixel_y = apply_gt( geo_x, geo_y,

invert_gt( geoTransform ) )

# Convert a pixel location to geographic coordinates given geoTransform
def pixel2geo( pixel_x, pixel_y, geoTransform ):

def

return int(pixel_x), int(pixel_y)

geo_x, geo_y = apply_gt( pixel_x, pixel_y, geoTransform )

return geo_x, geo_y

apply_gt( in_x, in_y, geoTransform ):
out x = geoTransform[0] + in_x * geoTransform[1l] + in.y *

geoTransftorm[2]

out y = geoTransform[3] + Iin_x * geoTransform[4] + in_y *

geoTransftorm[5]

def

return out_x, out_y

invert_gt(geoTransform):

det = geoTransform[1l] * geoTransform[5] - geoTransform[2] *

geoTransftorm[4]

def

it abs(det) < 0.000000000000001:
return
invDet = 1.0 / det

# compute adjoint and divide by determinate

outGeoTransform = [0,0,0,0,0,0]
outGeoTransform[1]
outGeoTransform[4]
outGeoTransform[2]
outGeoTransfrom[5]
outGeoTransform[0]

return outGeoTransform

geoTransform[5] * invDet
-geoTransform[4] * invDet
-geoTransform[2] * invDet
geoTransform[1] * invDet

( geoTransform[2] * geoTransform[3] -
geoTransform[0] * geoTransform[5] ) * invDet

outGeoTransform[3] = ( -geoTransform[1] * geoTransform[3] +
geoTransform[0] * geoTransform[4] ) * invDet

query_gdal (inxyz,ingrd,delim,xloc,yloc,zloc,nodata,out form,addit,return_a
11,verbose):

"""Compare an xyz Ffile to a gdal-compatible grid file.

if inxyz == sys.stdin:
in_plot = inxyz
else:
in_plot = open(inxyz, "r")

# Process the grid file

ds = gdal .Open(ingrd)

comp_geot = ds.GetGeoTransform()
band = ds.GetRasterBand(1)

175




# Load the grid into a numpy array

tgrid = band.ReadAsArray()

#except:
xyz_vs_gdal(inxyz, ingrd,delim,xloc,yloc,zloc,nodata,out form,addit,return_
all,verbose)

# Get some grid info
iT nodata 1s None: nodata
if nodata is None: nodata

band.GetNoDataValue()
-9999

cellsize = [float(comp_geot[1l]), float(comp_geot[5])]
xextent = Ffloat(comp_geot[0])
yextent = float(comp_geot[3])

# Process the xyz fTile

n=2=20
for 1 in in_plot:
n+=1

iT verbose:
print >> sys.stderr, '‘gdal _query: " + str(n), "\r",

try:
x = Tloat(i.split(delim)[int(xloc)].strip())
y = float(i.split({delim)[int(yloc)].strip())
if zloc == "-":
Z = nodata
else:

z = Ffloat(i.split(delim)[int(zloc)].strip())

except:
print >> sys.stderr, '‘gdal _query: Failed to read
line: %s" %(i),
x=xextent - 10
y=yextent + 10

# Continue if values are reasonable.
if x > xextent and y < yextent:
Xpos,ypos = geo2pixel(x,y,comp_geot)
#xpos = int(math.fabs(math.ceil((xextent -
x)/float(cellsize[0]))))
#ypos = int(math.fabs(math.ceil((y -
yextent)/fFloat(cellsize[1]*-1))))

# Locate the grid cell and get it"s value
try: g = tgrid[ypos,xpos]
except: g = nodata

d = nodata

Cc = nodata

p = nodata

S = nodata

if g !'= nodata:
d=2z-g
p=z+g
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#
d

# FIXME ## as d/g*100 woudl fail if g was zero
if g == 0:

g += 0.0000001
/FIXME ##
is the percent difference
con_dec(math.fabs(float(d/g*100)), 2)
is the "scaled” difference
con_dec(math.fabs(d /7 (z + 9)), 4)

O HOHFHR
Inmwilo

IO

rint out the results
con_dec(d, 4)

outs = []
for i1 in out form:

outs.append(varsQILil)

print(delim.join(map(str, outs)))

else:
i

f return_all:

d = nodata
p = nodata
C = nodata
S = nodata
g = nodata
outs = []

for i1 in out form:
outs.append(varsQI[i])
print(delim.join(map(str, outs)))

if verbose:
print >> sys.stderr, '\n",

def Usage():

print(“Usage: gdal _query.py [-delimiter char] [-s_format 0,1,2'] °)

print(”
header]")
print(”
print(”
print(™")

[-d_format '"'xyzgdps'] [-d_nodata value] [-

[-return_all] [-verbose]®)
grdfile [srcfile]")

print(" Input options: ™)

print(”
to ")
print(”
print(”
with,")
print(”
print(”
print(”
specifying™)
print("
print(”
print("
print(™")
print(~Ou
print(”
specifying ")

grdfile\tSpecifies which gdal-compatible grid file in which

\t\tquery values.")
srcfile\tSpecifies which xy* file in which to query grdfile

\t\tif not given, will read from standard input.")
—-delimiter\tSpecifies the input xy* delimiter~)
-s_Tormat\tSpecifies the input xy* format, a quoted triplet

\t\twhere the x,y and z values are located.")
\t\tlf there is no input z value, specify with a -, i.e. %)
\t\t-s_ format "0,1,-"7)

tput options:*)
-d_format\tSpecifies the output xy* format, a quoted string
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print(" \t\twhich output values to return.")
print(" \t\tOptions are x,Y,z,0,d,p,Cc,S; where z is the input z

value, g is the grid *)

print(" \t\tz value, d is the difference between the input z value

and grid®)

print(" \t\tz value, p i1s the product of the input z value and the

grid z vallue, ")

print(" \t\tc i1s the percetage difference and s is the scaled

difference.")

print(" -d_nodata\tSpecifies the output nodata value, will use the

nodata value from®)

print(" \t\tthe input grid if not specified.")
print(" -header\tlndicates that the output will have a header

included, default is False.")

print(" -return_all\tWill prompt the return of all iInput points,

regardless of location®)

print(" \t\twhen compared to the input grid file, with grid values

considered as nodata. ")

print(™")

print(“General options:*)
print(" -verbose\twWill 1
print(™")
print("Example: ")
print("To query grd.tif with an ascii xy file (values.xy) with comma

ncrease verbosity.")

delimited fields and *)

print("no z-value and return the xy values from the input xy file and

the z values™®)

print("from grd.tif:")
print(“gdal_query.py -delimiter ","” -s format "0,1,-" -d_format "xyg"

grd.tif values.xy > values.xyz")

print(*\ngdal_query v.%s" %(gg_version))
sys.exit( 1)

inxyz=None
ingrd=None
delim=" "
xyzf="0,1,2"
out_xyzf=""xyzg"
xyzh=False
addit=False
verbose=False
return_all=False
out _nodata=None

gdal .AllRegister()
argv = gdal.GeneralCmdLineProcessor( sys.argv )
if argv is None:

sys.exit(0)

# Parse command line arguments.
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i=1
while 1 < len(argv):

arg argv[i]

if arg == "-delimiter~:
delim = argv[i+1]
i=i+1

elif arg == "-s_format":
xyzf = str(argv[i+l1l])
i=i+1

elif arg == "-d_format":
out xyzf = str(argv[i+1])
i=1+1

elif arg == "-d_nodata-“:
out nodata = float(argv[i+1])
i=1+1

elif arg == "-header”:
xyzh = True

elif arg == "-addition”:
addit = True

elif arg == "-verbose~:
verbose = True

elif arg == "-return_all":

return_all = True

elif arg[0] == "-":
Usage()

elif ingrd is None:
ingrd = arg

elif Inxyz is None:
inxyz = arg

else:
Usage()

if inxyz == None:
inxyz = sys.stdin

if ingrd == None:
Usage()
sys.exit(0)

#-- Parse point locations.
xloc = xyzf.split(",")[0]-strip(Q
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yloc = xyzf.sphit(’,")[1]-strip(
zloc = xyzf._split(",")[2].stripQ

out form = tuple(re.findall(r*(\D)",out xyzf))

it xyzh == True:
outs = []
for 1 in out_form:
outs.append(i)
print delim_join(outs)

query_gdal (inxyz,ingrd,delim,xloc,yloc,zloc,out nodata,out form,addit,retu
rn_all,verbose)

#--END
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update_grid

This csh script uses GMT (http://gmt.soest.hawaii.edu/) to update a GMT readable grid with new
data from a specified xyz file. The new grid created will have elevation values representative of
the new data, not the values in the original grid. Cells without new data will retain the values of
the original grid. This script is useful for quickly improving a pre-compiled grid with new,
trusted data. Developer — David Sandwell, Scripps Institution of Oceanography.

#1/bin/csh
# D. Sandwell 08/08/07
#
# Update the topography grid using some new trusted data.
#
# check the number of arguments
#
if ($#argv < 9) then
echo " Usage: update_grid topo.xyz topo old.grd lonO lonf latO latf dlon
dlat edit”

echo topo.xyz - file of lon, lat, depth (neg meters)”

echo " topo_old.grd - existing low resolution grid of topography*

echo " 1on0 - left boundary of output grid (0-360)"

echo " lonf - right boundary of output grid (0-360)"

echo " latO - lower boundary of output grid”

echo " latf - upper boundary of output grid"

echo " dlon - longitude spacing of output grid
(e.g-, .001)"

echo " dlat - latitude spacing of output grid”

echo " edit _remove |differences| > edit”

echo " "

echo "Example: update_grid german_iceland.xyz topo_old.grd 340 343 65
68 .01 .o1"

exit 1

endif
#
# Tirst blockmedian the input data to make the file smaller
#

blockmedian $1 -R$3/$4/$5/$6 -1$7/%8 > block.xyz
#
# make a matching grid from the global topo
#

grd2xyz $2 -R$3/$4/%$5/%6 -S > global.xyz

surface global .xyz -R$3/$4/%$5/%6 -1$7/$8 -T.00 -V -Gglobal .grd
#
# interpolate the new data through the old grid
#

grdtrack block.xyz -Gglobal.grd -S > predict.xyzz
#

awk "{if(1(($4-33) > "$9" || ($3-%4) > "$97)) print($1l, $2, $3-%4)}" <
predict.xyzz > block.xyd
#
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# now make the difference grid

2urface block.xyd -R$3/$4/$5/%$6 -1$7/$8 -T.35 -V -Gdiff.grd
z add the two grids

grdmath global .grd diff.grd ADD = final_topo.grd

z clean up the mess

ﬁm global .grd diff._grd
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gdal_perspective.py

This Python script uses GDAL (http://www.gdal.org/), ImageMagick (http://imagemagick.org)
and PovRay (http://povray.org) to generate a color perspective image of a GDAL-readable grid,
such as netCDF or GeoTiff. This script is useful for generating quality perspective images of
grids for use in DEM development as a tool for QA/QC and for reporting and visualization of the
final DEM product. Developer - Matthew Love, NOAA National

Geophysical Data Center.

#1/usr/bin/env python

import sys

import os

import math

from osgeo import gdal
import numpy as np

gp_version = *0.0.2"
gg_equat = 111321.543

## Colors

trs = (-11000,-10500,-10000,-9500,-9000,-8500,-8000,-7500,-7000,
-6500,-6000,-5500,-5000,-4500,-4000,-3500,-3000, -2500,-2000,
-1500,-1000,-500,-0.001,0,100,200,500,1000,1500,2000,2500,3000,
3500,4000,4500,5000,5500,6000,6500,7000,7500,8000)

colors =
([10,0,121],[26,0,137],[38,0,152],[27,3,166],[16,6,180],[5,9,193],

[0,14,203],[0,22,210],[0,30,216],[0,39,223],[12,68,231], [26,102,240],

[19,117,244],[14,133,249],[21,158,252],[30,178,255], [43,186,255], [55,193,2
55],

[65,200,255],[79,210,255],[94,223,255], [138,227,255] , [138,227,255],

[51,102,0],[51,204,102],[187,228,146],[255,220,185] , [243,202,137], [230, 184
,88]1,

[217,166,39],[168,154,31],[164,144,25],[162,134,19], [159,123,13], [156,113,
71,

[153,102,0],[162,89,89],[178,118,118],[183,147,147],[194,176,176] , [204,204
,204],
[229,229,229],[138,227,255], [51,102,0])

elevs = [-20,-19.09090909,-18.18181818,-17.27272727 ,-16.36363636, -

15.45454545,
-14.54545455,-13.63636364,-12.72727273,-11.81818182,-10.90909091,
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-10,-9.090909091,-8.181818182,-7.272727273,-6.363636364 , -
5.454545455,

-4.545454545,-3.636363636,-2.727272727,-1.818181818, -
0.909090909,-0.001,

0,48.06865898,96.13731797,240.3432949,480.6865898,721.0298848,

961.3731797,1201.716475,1442 05977 ,1682.403064,1922_746359,2163.089654,

2403.432949,2643.776244,2884.119539,3124.462834,3364.806129,3605.149424,
3845.492719]

det scale_el(value, min, max, tr):
if value > 0 and max > O:
return (max * tr) / 8000
elif value < 0 and min < O:
return (min * tr) / -11000
elif value == O:
return O
else: return None

det make_cpt(ingrd, grdmm):
out_fTile = "%s.cpt” %(ingrd)
out _cpt = open(out_Ffile, "w")

## NoData

nd = returnNoData(ingrd)
nd_string = str(nd) + " 0 O O\n"
out_cpt.write(nd_string)

for i,j in enumerate(elevs):
elevs[i] = scale_el(elevs[i], grdmm[4], grdmm[5], trs[i])
if elevs[i] !'= None:
outs = elevs[i],colors[i][0],colors[i][1],colors[i][2]
#print outs
out_cpt.write(" ".join(map(str, outs)))
out cpt.write(''\n"™)
## Get min/max info about ~
def returnMinMax(ingrd):
# Process the grid file
ds = gdal.Open(ingrd)
comp_geot = ds.GetGeoTransform()

ingrd”

cellsize = [float(comp_geot[1]), float(comp_geot[5])]
xmin = float(comp_geot[0])

ymax = Float(comp_geot[3])

#nodata = ds.GetRasterBand(1l) .GetNoDataValue()
#print xmin,ymax

band = ds.GetRasterBand(1)
nodata = band.GetNoDataVvalue()
tgrid = band.ReadAsArray()

#tgrid[tgrid==nodata]=float( " nan”)
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#outarray[np.isnan(outarray)]=ndata
if np.isnan(nodata):

tgrid=np.ma.MaskedArray(tgrid, mask=(np.isnan(tgrid)))
else:

tgrid=np.ma.MaskedArray(tgrid, mask=(tgrid==nodata))

#print comp_geot
Xs = ds.RasterXSize
ys = ds.RasterYSize

zmin = tgrid.min()
zmax = tgrid.max()
xmax = xmin + (cellsize[0] * xs)

ymin = ymax + (cellsize[l] * ys)
return [xmin, xmax, ymin, ymax, zmin, zmax, XS, Yys]

def returnNoData(ingrd):
ds = gdal.Open(ingrd)
return ds.GetRasterBand(1l) .GetNoDataValue()

def degree2radian(deg):
return (deg/7180.0) * math.pi

def radian2degree(rad):
return (rad/math.pi) * 180.0

def latlonlen(lat):
lonlen = math.cos(degree2radian(lat)) * gg_equat
latlen = 1 * gg_equat
return [lonlen, latlen]

def pre_perspective(ingrd, grdmm, cpt):
gd_translate = "gdal_translate -ot UIntl6 -of PNG -scale %s %s O
65535 %s temp.png\n\
gdal_translate -srcwin 1 1 %s %s -oF PNG temp.png dem_16bit.png\n\
gdaldem color-relief %s %s temp2.tif\n\
gdal_translate -srcwin 1 1 %s %s temp2.tif rgb.tif\n\
rm temp.* temp2.*\n\
convert -transparent \"rgb(0,0,0)\" rgb.tif rgb.png\n\
convert -size 10000 dem_16bit.png dem_16bit_10000.png\n\
convert -transparent \"rgb(0,0,0)\" -size 10000 rgb.png
rgb_10000.png\n" %(grdmm[4], grdmm[5], ingrd,

grdmm[6]1-2, grdmm[7]-2, ingrd,

cpt, grdmm[6]-2, grdmm[7]-2)
return gd_translate

def povray_template(ingrd, grdmm, options):
Il1len = latlonlen(grdmm[2])
povr_out = "%s.pov" %(ingrd)
povr_file = open(povr_out, “w")
povr_file.write("'// DEM\n\

\n\
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//global_settings { assumed_gamma 2.2 }\n\
\n\
#include \"colors.inc\"\n\

\n\

#declare Bi = 2;\n\

\n\
//\n\

// Custom parameters

//\n\
#declare
#declare
\n\
#declare
#declare
#declare
#declare
#declare
#declare
\n\

// Obtained from

rgb_image =
dem_image =
xdim = %s;

ydim = %s;

max_y = %s;
min_y = %s;
min_z = %s;
max_z = %s;

start here\n\

\"rgb.png\'"\n\
\"dem_16bit.png\""\n\

//number of pixels
//number of pixels

//maximum
//minimum
//minimum
//maximum

latitude
latitude

in X-direction\n\
in y-direction\n\
extent\n\
extent\n\

elevation\n\
elevation\n\

http://www.csgnetwork.com/degreelenllavcalc.html

\n\

#declare deg_lat_len
#declare deg_lon_len

\n\

// Position of camera
cam_azimuth = %s;\n\

#declare
#declare
#declare
#declare

// Position of the \''sun\"

cam_elevation =

\n\

%s;\n\

cam_distance = %s; \n\
cam_view_angle = %s;\n\

\n\

\n\

%s; //length of a degree of latitude In meters \n\
%s; //length of a degree of longitude in meters\n\

#declare light_azimuth = cam_azimuth+90;\n\

#declare light_elevation =
#declare light_distance =

\n\

%S ;

#declare vertical_exaggeration

//\n\

%s ;\n\

= %s;\n\

// Custom parameters end here\n\

//\n\
\n\
#declare
#declare

lon_scale
z_scale =

min_y));\n\

\n\
#declare

sin(radians(cam

#declare
t#declare

cam_x =

cam_y
cam_z

\n\

deg_lon_len / deg_lat_len;\n\
(100 * (max_z - min_z)) / (deg_lat len * (max_y -

cos(radians(cam_azimuth));\n\
light_distance * cos(radians(light_elevation)) *

t#declare

sin(radians(ligh

t#declare
#declare

\n\

light_x =

light y
light_z

t azimuth

)):\n\

cam_distance * cos(radians(cam_elevation)) *

azimuth));\n\
cam_distance * sin(radians(cam_elevation));\n\
cam_distance * cos(radians(cam_elevation)) *

light_distance * sin(radians(light_elevation));\n\
light _distance * cos(radians(light _elevation)) *
cos(radians(light_azimuth));\n\
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#declare TextureO = // Color elevation image (24-bit RGB PNG)\n\
texture {\n\
pigment{\n\
image_map { \n\
png rgb_image map_type O once interpolate Bi \n\
T \nm\
3} \nm\
finish { ambient 0.4 diffuse 0.8 } \n\
rotate x*90 \n\
\n\
\n\
\n\
height _field { // Unsigned 16-bit PNG DEM\n\
png dem_image \n\
smooth\n\
clipped by {box { <0, 0, 0>, <0.999, 1, 0.999> } F\n\
texture { TextureO }\n\
translate <-0.5, 0, -0.5>\n\
scale <100*lon_scale*xdim/ydim,\n\
vertical _exaggeration*z_scale, //Vertical exaggeration\n\
100>\n\
3T \n\
\n\
\n\
camera {\n\
angle cam_view_angle\n\
location <cam_x, cam_y, cam_z>\n\
look at <0, 0, 0> \n\
A\
\n\
light_source { <light_x, light_y, light_z> color White shadowless
parallel }\n\
\n\
background { White } \n\
" %(grdmm[6],grdmm[7],grdmm[3],
grdmm[2] ,grdmm[4] ,grdmm[5],
Illen[O],1llen[1],0ptions[0],
options[1],options[2],options[3],
options[4],options[5],options[6]))
povr_file.close()
# print(“\ngdal_perspective v.%s" %(gp_version))
def Usage():

print(™)

print(“gdal_perspective.py srcfile [-width n] [-height n]")

print(- [-azimuth n] [-elevation n]%)

print(” [-distance n] [-view-angle n]")

print(” [-1ight-elevation n] [-light-distance n]")
print(" [-vertical-exaggeration n] [-cpt n] [-9]°)
print(™")

sys.exit( 1)

if _ name_ == "_main

ingrd=None
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pov_wid=1000
pov_height=800
pov_azimuth=130
pov_elevation=27
pov_distance=235
pov_view_angle=35
pov_light elevation=30
pov_light_distance=10000
pov_vertical_exag=2
quiet=False
user_cpt=None

gdal .AllRegister()
argv = gdal.GeneralCmdLineProcessor( sys.argv )
if argv i1s None:

sys.exit(0)

# Parse command line arguments.
i =
i

< len(argv):
= argv[i]

if arg == "-width":
pov_wid = sys.argv[i+1]
i=1+1

elif arg == "-height”:
pov_height = sys.argv[i+1]

1 =1 +1

elif arg == "-azimuth":
pov_azimuth = sys.argv[i+1]
=i +1

elif arg == "-view-angle®:
pov_view_angle = sys.argv[i+1]
i=-i1+1

elif arg == "-elevation”:
pov_elevation = sys.argv[i+1]
i=1+1

elif arg == "-distance":
pov_distance = sys.argv[i+1]
i=1+1

elif arg == "-light-elevation”:
pov_distance = sys.argv[i+1]
i=-a1+1

elif arg == "-light-distance”:
pov_distance = sys.argv[i+1]
i=-a1+1
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elif arg == "-vertical-exaggeration-®:
pov_vertical _exag = sys.argv[i+1]
i=1+1

elif arg == "-cpt~:
user_cpt = sys.argv[i+1]

1 =1 +1
elif arg == "-q":
quiet = True

elif arg[0] == *-":
Usage()

elif ingrd is None:
ingrd = arg

else:
Usage()

i=1+1

if ingrd == None:

Usage()
sys.exit(0)

options=[pov_azimuth,pov_elevation,pov_distance,pov_view_angle,pov_light_e
levation,pov_light distance,pov_vertical_exag]
if not quiet:
print(*'gdal_perspective: Obtaining min/max values from grid")
grdmm = returnMinMax(ingrd)
if not quiet:
print(“'gdal_perspective: Generating CPT file'™)
if user_cpt is None:
make_cpt(ingrd, grdmm)
pp_sh = pre_perspective(ingrd,grdmm,"%s.cpt" %(ingrd))
else:
pp_sh = pre_perspective(ingrd,grdmm,user_cpt)
povray_template(ingrd, grdmm, options)
povr_sh = "povray %s.pov +WWs +H%s'" %(ingrd,pov_wid,pov_height)
if not quiet:
print(‘'gdal_perspective: processing grid file™)
os.system(pp_sh)
#print pp_sh
if not quiet:
print(‘'gdal_perspective: processing pov-ray file')
os.system(povr_sh)
#print povr_sh
# Cleanup
os.system(*'rm rgb.* dem_*'")
#--END
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Chapter 9.0 Data Analysis Techniques

9.1 Computing Coherence on 2-D Grids

This chapter provides step-by-step instructions that will show a user how calculate the coherence
between two-dimensional gravity and bathymetry grids.

Contributed by K. M. Marks, NOAA Laboratory for Satellite Altimetry, USA

9.1.1 What is Coherence?

Coherence is a measure of the linear correlation between two inputs. Coherence near one
indicates a near perfect correlation of the two inputs, while coherence near zero indicates the
absence of any significant relationship. A coherence of 0.5 can be interpreted as a signal-to-
noise ratio of 1:1 in one input if the other can be assumed to be noise-free (Bendat and Piersol,
1986; Eq. 6.39). In the example here, the inputs are grids- one is multibeam bathymetry and the
other marine gravity. One may expect a correlation between intermediate wavelength (~15-160
km) gravity and bathymetry anomalies, in accordance with isostatic compensation theory.

9.1.2 Data Grids
We demonstrate the coherence method on grids that lie on the northern flank of the Pacific-

Antarctic spreading ridge and cover the Heirtzler fracture zone (Figure 9.1).

Multibeam Bathymetry Marine Gravity V18.1

-61°
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Figure 9.1 Multibeam bathymetry (left) and marine gravity (right) on the northern flank of the Pacific-
Antarctic spreading ridge.

The multibeam bathymetry grid may be downloaded from the Lamont-Doherty Earth
Observatory website using their Marine Geoscience Data System Geomapapp software
(http://www.geomapapp.org/index.htm). The grid may be obtained on a geographic projection
with a 200 m grid spacing.

The marine gravity anomaly grid (Sandwell and Smith, 1997, version 18.1) is available for
download from the Scripps Institution of Oceanography website
(http://topex.ucsd.edu/MWWW _html/mar_grav.html). The gravity anomalies are derived from
satellite altimeter data. The grid is on a Mercator projection with a 1-minute grid spacing.

9.1.3 Grid Preparation

The grids need to be prepared prior to computing the coherence. The grids are on different
projections and have different grid spacings, and the multibeam survey is irregular in shape and
inclined to the parallels and meridians. To correct for these irregularities and register the
different data types, we sample the gravity grid at each multibeam point so that each data point
record is longitude, latitude, depth, gravity (xyzg). We use GMT routine “grd2xyz” with the *“-S”
option to convert the multibeam grid to xyz points while suppressing points that have no depth
value. We use “grdtrack” to interpolate the gravity grid to the multibeam point locations, thus
obtaining xyzg for each data point record.

We correct for the inclined sides of the multibeam survey by projecting the xyzg points with an
Oblique Mercator projection centered on the multibeam survey and rotating to maximize the
rectangular extent of the coverage, via GMT routine “mapproject.” The projected and rotated
points are shown in Figure 9.2. The projection routine reads positions in longitude and latitude,
and outputs positions in meters from the projection center.
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Figure 9.2 Oblique Mercator projected and rotated multibeam (left) and gravity (right) data points. Red box
outlines trimming boundary.

The command lines used to project the data points shown in Figure 9.1 into the Oblique
Mercator projected locations shown in Figure 9.2 follow. Note that routine “mapproject” is used
three times- first, to bring the multibeam points (mb.xyz) into a Mercator projection matching
that of the gravity grid (grav.18.1_grd) in order to sample it with “grdtrack;” second, to convert
to geographic coordinates; and third, to project the data points into the Oblique Mercator
projection including rotation (via the “~Joa” option).

gmtset ELLIPSOID Sphere

grd2xyz —S mb_grd > mb.xyz

mapproject mb.xyz -Jm1 -R-172.5/-167.5/-62.0001406129/-59.9969352129 | grdtrack
-Ggrav.18.1_grd | mapproject -1 -Jm1 -R-172.5/-167.5/-62.0001406129/-59.9969352129 |
mapproject -C -F -Joa-170/-61/-134/1 -R-172.5/-167.5/-62/-60 > mb.grav.proj.out

Example command lines for plotting the multibeam grid shown in Figure 9.1 follow.

grdgradient mb_grd -A270 -Nt -Ggrad_grd
grdimage mb_grd -Ctopo.cpt -Igrad_grd -Jm1 -K > Fig.9.1.ps
psbasemap -R-172.5/-167.5/-62/-60 -Jm1 -Ba2fl/al:."Multibeam Bathymetry":WeSn
-0 -K >>Fig.9.1.ps
psscale -D2.5/-.5/2.5/.2h -Ctopo.cpt -B1000g1000f1000:meters: -1 -N300 -O>>Fig.9.1.ps

The command lines for plotting the projected multibeam points shown in Figure 9.2 are below.
awk {print $1,$2,$3} mb.grav.proj.out | psxy -Ctopo.cpt -Sc.015 -R-93300/85700/-89800/115500

-Jx.000028 -Ba50000f25000:meters::."Projected Multibeam™:WeSn -K > Fig.9.2.ps
psscale -D2.5/-.5/2.5/.2h -Ctopo.cpt -B1000g1000f1000:meters: -N300 -O>>Fig.9.2.ps

There is more preparation needed for coherence analysis. The projected and rotated data points

need to be gridded, and the grid needs to be “trimmed” so that almost all grid cells have values,
while retaining the largest possible rectangular footprint. GMT routine “surface” is used to grid
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the data points- it fills in gaps in the data by interpolation, the “-R” option is used to select the
desired area (within the trimming boundary, outlined in red in Figure 9.2), and the output is a
grid with a 1 km grid spacing. The “surface” command line follows, and the grids, which are
now ready for the coherence operation, are shown in Figure 9.3.

surface -R-84240/82120/-78790/81820 -11000 mb.grav.proj.out -T0.25 -Gmb.surf.1km_grd

Projected Multibeam Grid Projected Gravity Grid
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Figure 9.3 Multibeam (left) and gravity (right) grids fully prepared for coherence analysis.
The command lines to plot the multibeam grid shown in Figure 9.3 follow.

grdgradient mb.surf.1km_grd -A0 -Ne0.2 -Ggrad_grd

grdimage mb.surf.1km_grd -Igrad_grd -Ctopo.cpt -Jx.000028 -K>Fig.9.3.ps

psbasemap -R-84240/82120/-78790/81820 -Jx.000028 -Ba50000f25000:."Projected Multibeam
Grid":WeSn -0 -K>>Fig.9.3.ps

psscale —D2.329/-.5/2.5/.2h -Ctopo.cpt -B:"depth, meters"; -I -N300 -O >>Fig.9.3.ps

9.1.4 Coherence Computation

We use GMT routine “gravfft” to compute the coherence between grids. This routine is a
generalization of GMT routine “grdfft” which detrends the grids, tapers the edges, applies a two-
dimensional Fast Fourier Transform (FFT), performs the coherence operation, and outputs the
coherence averaged azimuthally as a function of wavelength.

The coherence results can be sensitive to the size of the input grid relative to the FFT grid
dimensions used by “gravfft” for computation. The routine default selects dimensions that are
larger than the input grid file size and that optimize the speed and accuracy of the FFT. Our
experience has shown that the most reliable coherence results are obtained when the data grid is
square and its dimensions are slightly smaller than the optimal FFT grid dimensions. The FFT
dimensions can be specified with the “-N” option. Option “-Ns” prints out a table of suitable
FFT dimensions, we list below sizes through 1024.
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64,72, 75, 80, 81, 90, 96, 100, 108, 120, 125, 128, 135, 144, 150, 160, 162, 180, 192, 200, 216, 225,
240, 243, 250, 256, 270, 288, 300, 320, 324, 360, 375, 384, 400, 405, 432, 450, 480, 486, 500, 512, 540,
576, 600, 625, 640, 648, 675, 720, 729, 750, 768, 800, 810, 864, 900, 960, 972, 1000, 1024

The command line for computing coherence with “gravfft” follows. Two grids are input-
multibeam and gravity grids- and both have been prepared as described above. The output
columns are wavelength in meters, coherence, and one sigma error.

gravfft mb.surf.1km_grd -lgrav.surf.1km_grd/wc > coh.out

Coherence for the Pacific-Antarctic spreading ridge study area is shown in Figure 9.4.
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Figure 9.4 Radial coherence (black line) between grids shown in Figure 9.3. One sigma error bars are
plotted.

For this area, bathymetry and gravity are coherent down to ~16 km.

The command lines used to plot Figure 9.4 follow.

awk ' {print $1/1000.,$2}' coh.out | psxy -R5/200/0/1 -JX-6l/4 -W4
-Ba2f3:"Wavelength (km)":/a.5f.19.5:"Coherence":WeSn -W4 -K > Fig.9.4.ps
awk {print $1/1000.,$2,$3}' coh.out | psxy -Ey -R -JX -W4 -O >> Fig.9.4.ps

9.1.5 Interpreting Coherence Results

Figure 9.4 shows that gravity and bathymetry anomalies in this study area are coherent in the
intermediate wavelength band. Coherence appears to decrease at wavelengths greater than ~100
km because longer wavelength topography is Airy compensated and the gravity signal is
cancelled out. At shorter wavelengths, the coherence is low due to upward continuation of
gravity from the seafloor to the sea surface. The gravity anomalies in Figure 9.1 (and Figure 9.3)
look like a smoothed version of the multibeam bathymetry anomalies because of the upward
continuation.

194




REFERENCES

Bendat JS Piersol AG (1986) Random data: Analysis and measurement procedures, 2" edn.,
Wiley, New York

Sandwell DT, Smith, WHF (1997) Marine gravity anomaly from Geosat and ERS 1 satellite
altimetry, J Geophys Res 102:10039-10054, doi:10.1029/96JB03223

195




ADVANCED TOPICS

Chapter 10.0  Uncertainty

10.1 Sources of Uncertainty

The following has been extracted from 5" Edition, S-44 (2008) Annex A, section A.4 by Rob Hare and
editing for context

Although the following text focuses on uncertainties in data acquired with swath systems, it
should be noted that it is in principle applicable to data acquired with any depth measurement
system. A single-beam echosounder is just a special case of a multibeam echosounder (i.e. nadir
beam only)

With swath systems the distance between the sounding on the seafloor and the positioning
system antenna can be very large, especially in deep water. Because of this, sounding position
uncertainty is a function of the errors in vessel heading, beam angle, refraction correction model
and the water depth in addition to the uncertainty of the positioning system itself.

Roll and pitch errors will also contribute to the uncertainty in the positions of soundings.
Overall, it may be very difficult to determine the position uncertainty for each sounding as a
function of depth. The uncertainties are a function not only of the swath system but also of the
location of, offsets to and accuracies of the auxiliary sensors.

The use of non-vertical beams introduces additional uncertainties caused by incorrect knowledge
of the ship’s orientation at the time of transmission and reception of sonar echoes. Uncertainties
associated with the development of the position of an individual beam should include the
following:

a) Positioning system uncertainty;

b) Range and beam angle uncertainty;

c) The uncertainty associated with the ray path model (including the sound speed profile),

and the beam pointing angle;

d) The uncertainty in vessel heading;

e) System pointing uncertainty resulting from transducer misalignment;

f) Sensor location;

g) Vessel motion sensor errors i.e. roll and pitch;

h) Sensor position offset uncertainty; and

1) Time synchronization / latency.

Contributing factors to the vertical uncertainty include:
a) Vertical datum uncertainty;
b) Vertical positioning system uncertainty (if relevant);
c) Tidal measurement or prediction uncertainty, including co-tidal uncertainty where
appropriate;
d) Range and beam angle uncertainty;
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e) The uncertainty associated with the ray path model (including the sound speed profile),
and the beam pointing angle;

f) Ellipsoidal / vertical datum separation model uncertainty (if relevant);

g) Vessel motion uncertainty, i.e. roll, pitch and heave;

h) Vessel dynamic draught, including static draft, settlement and squat;

i) Seabed slope (when combined with positioning uncertainty); and

J) Time synchronization / latency.

Agencies responsible for the survey quality are encouraged to provide uncertainty budgets for
their own systems.

10.2 Measuring uncertainty

10.2.1 Methods of quality assessment, artifacts

TEXT IN PREPARATION

10.2.2 Comparisons with multibeam

TEXT IN PREPARATION

Local

TEXT IN PREPARATION
Regional

TEXT IN PREPARATION
Global

TEXT IN PREPARATION

10.2.3 Monte Carlo Technique

Contributed by Paul EImore, Naval Research Laboratory, Stennis Space Center, USA

A peer-reviewed methodology for estimating error on historic data sets using a Monte
Carlo technique is published in Jakobsson et al. (Jakobsson et al. 2002); Figure 10.1 illustrates
the procedure. It can be used on either historic or new soundings to provide an error layer for the
GMT Splines-In-Tension routine (Surface routine). In order for this technique to work, estimates
of the horizontal and vertical uncertainties for the soundings are needed.
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In the simulations, the original two-dimensional navigation positions and the one-
dimensional soundings are randomly perturbed using a normally distributed random number
generator (RNG). Let the number of original soundings be J, the number of surveys be K, the
horizontal navigation uncertainty of the K survey be Hk, the vertical sonar uncertainty of the K™
survey be Vi, the number of output grid points be I, and the number of Monte Carlo simulations
be N, with each loop denoted by n. For the K™ survey, the RNG perturbs the position data ~ N{0,
Hk?)" and the vertical position ~ N0, V«?). The gridded bathymetry surface is constructed from
the GMT Surface (or other interpolator of choice) during each loop of the Monte Carlo
simulation, resulting in N different interpolated bathymetry surfaces. The gridded uncertainty
estimate is then the standard deviation of the N surfaces at each i"" grid point, iel. Assuming that
all sounding used have been cleaned and corrected for ship dynamics, sound speed profile errors,
etc., positional uncertainty and the bottom slope predominantly influence the bathymetric
uncertainty estimated from this method.

A benefit of this method is that it is relatively simple to code: one simply needs the
interpolation and RNG routines called within a Monte Carlo shell that perturbs the horizontal and
vertical positions. This procedure, however, is computationally intensive and requires the use of
original soundings data. Attempting this approach for a large number of soundings data may not
be pragmatic.

Monte Carlo Simulations: Let there be .S
data points from K surveys (K =.0) and [
output grid points.

1. Randomly vary the &M source
horizontal position ~ N0, ff.). i/ is
navigation uncertainty of £ survey: &
C K™ survey

2 Randomly vary £ source vertical -
position ~ N(0, Fg): ¥y is sonar vertical
uncertainty of K™ survey;

3.Use GMT Splines-In-Tension (Surface
routine) to interpolate the .Jf perturbed
sounding points

4.Repeat steps 1-3 N times for each
output point; JEF

Output uncertainty
surface: Lon’, Lat’, o’ at
I grid paints

Calculate standard
deviations for N
perturbed grids

N perturbed
grids from
all .Jf points,

Legend

L1 [

process output

Figure 10.1 Process flow for the Monte Carlo procedure of Jakobsson et al (2003).

10.2.4 Bayesian Network Technique

Contributed by Paul EImore, Naval Research Laboratory, Stennis Space Center

T The notation ~ M, o©) means that the quantity follows a normal, or Gaussian, probability distribution with mean
uand variance o
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When the data sets are large, a Bayesian network (BN; a good discussion is given in
Chapter 14 of Russell and Norvig (2003)) can be an alternative to the Monte Carlo method. With
this approach, published in Elmore et al. (2009) and illustrated in Figure 10.2, causal
relationships of navigation error and bottom slope to bathymetric uncertainty are quantified by
conditional probability densities (CPD’s). One uses the Monte Carlo technique on representative
sets of soundings data to tabulate the CPD’s necessary for the statistical inference. The BN then
produces a histogram of this uncertainty estimate for an area given the navigation errors used to
survey the region and bottoms slopes that are present. An intermediate uncertainty is obtained
from the mean plus one standard deviation of the histogram. The final uncertainty estimate is
obtained by first adding the square of this intermediate uncertainty to the square of the vertical
error estimate under the assumption of statistical independence between the two, then computing
the square root of this sum. This type of computation is much less costly than the Monte Carlo
technique both in computation overhead and required input data, potentially leading to a
significantly large (two orders of magnitude) increase in computational speed. Estimates of the
horizontal and vertical uncertainty for the soundings must be available to both train the network
and run the Bayesian Network.

loop 1, c
l=i=]

Distribution of
* Mavigation errors at

™ putput point .
Intermediate
Bayesian Lon', Lat’, oy’ at
netwark 1 grid points

Ls| Bottom slape at [
output point

Legend

L 10 il

process output  Bayes net

Figure 10.2 Conceptual flow of the Bayesian Network approach.

Bayesian Network Design and Access

The Bayesian network itself can be programmed using commercial Netica software,
Version 4.0.8 (2008), which provides a GUI for construction and programming of the BN and (as
of this writing) is free to use for the small Bayesian network created here. Figure 10.3 shows the
network topology as displayed by the Netica GUI from Elmore et al (2009). It consists simply of
two main parent nodes, one for navigation error and one bottom slope, and one child node, the
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intermediate uncertainty estimate. In this example, there are eight different surface navigation
uncertainties categories; Table 10.1 associates historical navigation techniques to uncertainty.
The bottom slope and bathymetric uncertainties follow a logarithmic binning scheme so that one
significant digit is maintained in the uncertainty estimate while keeping the BN to a manageable
size. Once created, the software stores the BN as either a binary object or ASCII file that can be
accessed and manipulated through the use of vendor provided application program interface
(API) libraries.
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Figure 10.3 Bayesian network topology as displayed by the Netica software GUI. The
“Horizontal_Error” node variables follow the navigation errors provided in Table 1, with
the numbers for surface navigation error in meters. The “Bottom_Gradient” and
“Uncertainty_ Estimate” nodes follow a logarithmic binning scheme.
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Table I Horizonial Error Categories

Mavigation Mode Accuracy Navigation Mode Accuracy
GPS/EINS (3 or more Satellites) 10-15 m NAVSAT/Single Range LOEAN/SINS 250 m
GPS/DR (3 or more Satellites) 10-15 m MNAVEAT! SINS 250 m
NAVSAT/Range Range LORAN/SING 150 m MNAVEAT/Single Range LORAN/DR 250 m
NAVSAT/Range Range LORAN/DR 167 m NAVSAT/DR 400 m
NAVSAT/Hyperbolic LORAN/SINS 185 m L[(?ZE{R\\\\\]]J;\ 463 m
NAVSAT/Hyperbolic LORAN/DE 222 m Satellite Altimetry TOO0 m

Table 10.1 Navigation uncertainty categories used in Elmore et al. (2009) for the Bayesian
Network approach to uncertainty estimation. The abbreviations are as follows: GPS -
Global Positioning System; SINS — Ship’s Inertial Navigation System; DR — Dead
Reckoning; NAVSAT — Navy Navigation Satellite System; LORAN - Long Range
Navigation. The “/” means that two or more techniques are combined.

Bayesian Network Training Procedures

Using the procedure from Jakobbson et al. (2003), one ascertains the propagation of
navigational error and bottom slope into bathymetric uncertainty by Monte Carlo simulations.
Let there be a total on M navigation error categories. The results of the simulations (a total of M
x N simulations) to populate the CPT of the BN, or “train” the BN. Figure 10.4 shows a high
level view of the entire training process, bracketed into three main blocks: 1) Monte Carlo
simulations, 2) standard deviation and slope calculations, and 3) Bayes network programming.
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1. Monte Carlo 2. Standard Deviation 3. Bayes Network
Simulations and Slope Calculations Programming
A A |

One-time nen-perturbed, Standard grid
standard run
Lon, Lat,
e Calculate: {;,.n:l I,;,_T
Mente Carlo Simulations Perturbed 1. Bottom slope L____'_’_,,..-—— 1. Compute
Modifications: :drsuf[orc! 1 fram non- bivariate
1.Use windowed __E'___-—'L_ perturbed run Lon, Lat, & histogram
interpolation for —— > (H3), V2|
smoothing uncertainty b~—al Perturbed 2. Calculate _ 2. Assemble
2. Randomly vary source ﬂi%f standard devi- CET file
position ~ N0, /) ation of A
3.Repeat step 1-2 for each H perturbed set
H=H,. . Hy, - Lon, Lat,
————— (), Wz Bayesian
Perturbed network
| erids for it
Legend
process output  Bayes net

Figure 10.4 High level view of the Bayesian network training process. The figure illustrates
computation of the standard deviations as modified from Jakobsson (2003), and use of
these results to construct the conditional probability tables (CPT) for the Bayesian
network.

Figure 10.5 shows a low level flow chart for the Monte Carlo block. In the Monte Carlo
simulations, the original locations of the sounding points (or gridded points acting as sounding
points) are first moved in random directions. A normal RNG (Marsaglia and Tsang 2000)
provides deviations for the north and east positions as specified by the horizontal error category
for the m™ simulation loop, Hm (1 < m < M), such that the RNG ~ N0, Hn?). The data points are
then interpolated to provide a bathymetry surface and stored to an ASCII text file, with the
Monte Carlo loop number and navigation error stored in the file name. As in Jakobbson et al.
(2003), N = 100 Monte Carlo iterations may be performed for each m" set of simulations;
however, a difference between the two is that the set of N Monte Carlo simulations are then
repeated M times for each horizontal error category in order to fully populate the CPT of the BN.
Another difference from the Monte Carlo procedure is that each sounding is assumed to have the
same probability distribution of horizontal errors so that one can obtain a statistical distribution
for bathymetric uncertainty for a range of horizontal errors. Although the actual data do not
necessarily have these errors, it is assumed they do in order to train the network. Also, the
vertical positional will be treated algebraically as discussed in Section 3 below.
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Figure 10.5 Low level flow chart of the Monte Carlo simulations block for the Bayesian
network training process. Here, X and Y are the east and north positions of the output grid
points in meters after conversion to Universal Transverse Mercator (UTM) projection and
specification of a UTM origin in the grid, Z is interpolated depth, So is an unperturbed
interpolation, Smn is the perturbed grid for the nt" Monte Carlo loop and m* Horizontal
Error Category, E’ is error from smoothing. The bold face means that the quantity is a
vector.

Figure 10.6 shows a low level flow chart for the next block of the training process, the
standard deviation and slope calculations block. After completion of the final iteration, the
uncertainty estimate for the set of | output points are computed from the gridded standard
deviation of the Monte Carlo bathymetry surfaces and stored to ASCII files for use below (low
level flow chart shown in Fig. 10.7). Specifically, the ASCII files contain longitude, latitude,
bathymetry, Monte Carlo standard deviation and magnitude of the two-dimensional slope. To
obtain the slopes, an unperturbed calculation of the bathymetry surface is first made, followed by
computation of the bottom gradient throughout the grid. One can use finite differences as
discussed in Zhou and Liu (2004) and Oksanen and Sarjakoski (2005) to calculate bottom
gradient. Longitude and latitude positions are translated to UTM coordinates so that positional
differences and gradients can be computed in meters. Linear extrapolation is used to aid
computation of the gradient along the computational edges.
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Figure 10.6 Low level flow chart of the Standard Deviations block for the Bayes net training

process.

Figure 10.7 shows a low level flow chart for the final block of the training process, the
Bayes network programming block. The BN is programmed using the graphic user interface
(GUI) in Netica on a Windows based PC. The ASCII files containing the Monte Carlo
uncertainties and bathymetric slopes are first read from the standard deviation file discussed in
the above section for the first navigation uncertainty category. Then, using the logarithmic
binning scheme discussed above we compute the bivariate histogram (i.e., three-dimensional
histogram) with slopes and bathymetry uncertainty, respectively, indexing the row and column
bins of the bivariate histogram. This histogram is normalized and written to an ASCII file. This
process is then repeated for subsequent navigation uncertainties with the resultant normalized
bivariate histograms appended to the same output file.
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Figure 10.7 Low level flow chart of the Bayes network programming block for the Bayesian
network training process. The network is stored in a library file that is accessed by API.

After completing this process, the Bayesian network *.neta file is opened in the Netica
GUI, and the CPT for the “Uncertainty Estimate” node is displayed. The CPT is programmed by
simple “copy-and-paste” from the ASCII file into the spreadsheet-like data display for the CPT
in the GUI. The CPT is already arranged to have the same stacked structure as the ASCI| file.

Operational Flow

Figure 10.8 shows how the BN could be integrated into the overall operational system,
with key components and data flow. The end user of the system first defines a region of interest
for uncertainty estimation, followed by query of available navigation and bathymetry for the
area. The navigation metadata would indicate survey era and platform used from the navigation
data to obtain the types of navigation (for horizontal uncertainty) and sonar systems (for vertical
uncertainty) used for the track lines in the area. The fractional lengths of track lines with like
uncertainties could be calculated (i.e. sum of all track lengths with a like error divided by the
total of all track lengths) and become the weights for the BN’s Horizontal Error node. Also
extracted is the bathymetry from the same area to obtain the bottom gradient. The system loops
through each grid point, assigns the bottom gradient to the appropriate bin of the BN’s Bottom
Gradient node, and extracts the resultant histogram. Calculation of mean plus one standard
deviation for this histogram provides the intermediate uncertainty. The final uncertainty estimate
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is obtained by first adding the square of the intermediate uncertainty to the square of the vertical
uncertainty estimate.
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Figure 10.8 Integrated flow chart of the DBDB-V Uncertainty Expert System (DUES) after
programming of the Bayes network component is complete.

10.2.5 Windowed Regression with Kriging Corrections

Contributed by Paul EImore, Naval Research Laboratory, Stennis Space Center

As an alternative to using GMT surface, localized regression techniques of Cleveland
(1979) have been applied to bathymetry problems in Plant et al. (2002). This technique was then
refined by Calder (2006) to provide refinements to the interpolated surface and uncertainty
estimate using ordinary kriging and the Monte Carlo technique discussed in Section A above. An
advantage of this technique is that it provides an uncertainty estimate with the interpolated
surface. A disadvantage is that it requires dense data sounding to be meaningful. The discussion
that follows below closely to the discussions in the papers by Cleveland (1979) and Calder
(2006).
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Linear Smoothing by Locally Weighted Regression (Loess)

Linear smoothing techniques construct the interpolated surface, 2(3), s =matrix of (x, y)

coordinates, from a linear weighted average of known data values. Unlike the splines-in-tension
technique that finds a global solution to the available data, this technique obtains an interpolated
value at a grid point by using only a subset of neighboring points. Mathematically,

i(s)=>als-s,)s,), ((1)

where (s — si) specifies the smoother coefficients and the index i corresponds to the subset of
local points, z(si), to be used for the interpolated value at s, Z(s). A common technique used to
specify these coefficients is locally weighted regression (or “loess”), first published in Cleveland
(1979) and further developed in Cleveland and Devlin (1988). A textbook by Givens and
Hoeting (2005) also discusses the technique. The methodology determines the smoother
coefficients from a weighted least squares polynomial (linear or quadratic) fit of windowed data.

1. Methodology

To summarize Cleveland’s methodology, the two-dimensional case is considered first. These
equations to the three-dimensional case in Section B, but the methodology will remain the same.
Let data points xi and y; be related as

Vi = 9)+ & (G

where g(x) is a smooth function and & is Gaussian noise with zero mean and variance o2
Define §, to be the estimate of g(xi) (i.e. ¥, ~ g(x,)). Let

o the number n be the predetermined number of data points to be used for estimating Y,

e thesetxk, k=1,...,n, be the subset of x;’s (j = 1,...,N; N = total number of data points, n <
N) that are closest to xi

e the distance h; be the distance from x; to the furthest x«.

e the windowing weights to be used for the regression, wi(xi) = W([xx — xi]/hi), where W(x)
is the tricube function, defined as

0 , otherwise

W(x)s{(l‘V'S)i' K<l (Gi)

With these definitions, the loess procedure calculates the set of polynomial coefficients, ﬁl (xi),
that are the values for the g, ’s that minimize

alx )= 3w, 04y, ~ - A, ~L ~ (@)
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where q(xi) is the error function. The interpolated value for g(x;) is then
d . n
Vi = Zﬂ| (Xi )Xid = zak (Xi )yk - (V)
1=0 k1

Some points of interest are as follows (Cleveland 1979).

e The coefficients obtained have a decreasing trend to the edge of the window so that the
data centered in the window generally have the greatest influence.

e The size of the polynomial typically used in Eqgn. (((iv) isd = 1 or 2. For d = 0, the result
is a simple moving average. The d = 1 case is called linear loess or “lowess” smoothing,
and d= 2 is quadratic “loess” smoothing.

e Cubic and higher fits typically are not used as the fits can become over fitted and
numerically unstable.

e This technique also has a robustness option, so that the interpolation can be shielded from
the effects of outliers in the data.

e Cleveland choose the tricube weighting function because it allowed the estimate of the
error variance to be approximated by a chi-square distribution and usually lowered the
variance of the estimate surface as the number of points used for the estimate increased.

Errors propagated into the interpolation by the technique are straight forward to compute.
Under the assumption the data follow Eqn. (((ii), the estimate of the variance for y,, &7, is (Plant
et al. 2002)

n

67 = UzZ[ak )F ((vi)

k=1
which is derivable from independent error propagation.
2. Convolution Approach

Figure 10.9 plots the set of o’s as determined for a centered impulse response using the
linear and quadratic loess interpolators. These coefficients are the smoother weights in Eqn. (((v)
and are also called the “equivalent kernel”. They depend only on the grid points, and, due to their
finite width, act as a window or low-pass filter function on the spatial data (i.e. the smoothing
weights and the data undergo convolution). Hence, one could bypass solving a weighted least
square problem and simply compute the convolution of the smoothing window with the data,
which should be computationally faster. In addition, other windowing functions could be used to
perform the smoothing.
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Figure 10.9 Equivalent kernel weights for linear and quadratic loess windows.

The use of other weighting functions would also allow one to interpolate over data points
with differing accuracy. In this case, Eqns. (((v) and (((vi) become

Y, =iak(xi>(o-k_2 Zn:ak_zjyk :Zn:&k(xi)yk, ((vii)

6! = anakZ&f (x;) ((viii)
where o/ is the variance of yx and &, (x;) = o (X )(ok‘z Zn:ak‘zj :
k=1

Combining windowing with ordinary kriging corrections

Since the above regression technique smooths the data, Calder (2006) provides an ordinary
kriging step for correcting at the sounding points with the Monte Carlo technique to accounts for
navigation uncertainty. The summary of the complete methodology is as follows.

1. Following Plant et al. (2002), interpolate the data with the quadratic loess interpolation
technique of Cleveland (1979) to provide a trend surface for the bathymetry and
uncertainty layer.

2. Restore finer details smoothed by the interpolation from ordinary kriging of the residuals;
add the errors associated with ordinary kriging to the uncertainty layer from Step 1
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assuming statistical independence (i.e. the variances add). The surface generated from
kriging the residuals is the residual surface.

3. Estimate additional uncertainty caused by positional errors from the Monte Carlo
technique of Jakobsson et al. (2002), but repeat steps 1 and 2 above instead of using the
splines-in-tension algorithm at each iteration. As before, add the estimated error to the
uncertainty layer by assuming statistical independence.

In equation form, the final bathymetry surface, Z(s), is the sum of the trend surface, x(s), and the
residual surface, R(S).

Z(s) = u(s) + R(s) ((ix)
The uncertainty layer, oz(S), is
o,(s)=[o(s)+ oils)+ £ ()] . ()

where o,(s) and or(S) are the uncertainties for the trend and residual layers, respectively, and
&(s) is the uncertainty layer associated with positional errors.

1. Quadratic Loess Interpolation for Trend Surface

Extending Eqn. (((iii) through (((vi) to two dimensions, the equations for calculating the
trend surface, w(s) in Egn. (((ix) are as follows.

u(s)=p" (s)B(s), ((xi)

where pT(s)=[x?,y% xy,x y1]and vector B(s)=[B(s)K ,z,(s)] being the set of f(s)’s
that minimize the weighted least squares

q(s)= ivvk ()2 = Bo(S) = BulS)Yi = Bo ()% = Ba(S)XeYic - Ba(S)y2 - By(s)x2) (i)

k=1

using the two-dimensional tri-cube weighting function

(1_|s—sk|3j1|s—sk|<l
w, (s)= [ do | )] do | ((xiii)

0 , otherwise

and the user provided value for do, which Calder’s paper suggests that do be ten times the largest
sample spacing. Information lost by oversmoothing is regained when the residuals are calculated
in the kriging portion.
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Estimates for the variances follow Eqn. (((vi) for like variances in all the data or
6%(s) =30 [e, (s)o, | for differing variances. The ax(s)’s now have azimuthal symmetry and
the same radial dependence as the 1-D case.

In addition, the estimate is made more robust (i.e. eliminate outliers) by flagging estimates
greater than three Mahalanobis units as “no data”. The Mahalanobis distance (Mahalanobis
1936), M(p,m,C), is

M(u,m,C)=(u-m)" C*(u—m) ((xiv)

where p(s) is the vector of all estimated depths and m(s) and C(s) are the corresponding mean
depth measurements and covariances for the windowed (c.f. Eqn. (((xiii)) data sets. To
intuitively explain Eqn. (((xiv), suppose that the data points are all independent and have mean m
and variance . The C matrix is all zeros except for the diagonal elements, which are all &°.
Then, if an estimate differs from its corresponding windowed mean by more than three variances

(i.e. (,u— m)z/o-2 > 3) , that estimate receives the “no data” mark. Eqgn. (((xiv) generalizes this
simpler scenario to account for covariance between the data.

2. Kriging the Residuals

Since loess interpolation is not exact at the data points, residuals, R(s, ), exists between actual
measurements, z(s; ), and the corresponding estimated depths along trend surface, x(s, ), such
that R(s,)=1z(s,)— u(s,). The residual surface in Eqn. (((ix) is found from interpolation of the
R(si)set using ordinary kriging, as an overall but constant unknown bias may exist in the
residuals. The variogram will likely have directional anisotropy, so that Zy(si, sj):zy(h,e),

where h is the separation distance between the two points and & is the heading angle (clockwise
from the north).

To account for this anisotropy, the following semivariance, 7D(si,sj), is used and
constructed (unconditionally valid for two-dimensions (Brandt 1998)) in the following manner:

1) Obtain an empirical estimate of the variogram

2) Compute the average azimuthal variogram from the empirical estimate to detect the
directions of minimum and maximum variation,

3) Fit the variograms along these two axes to the spherical model for variograms

4) Using parameters from the fits to the spherical model and the direction for minimum
variance, construct ;/D(si,s j) from Eqgns. (((xx) — (((xxiii) below. These steps are

now discussed in more detail.
Step 1: Following page 69 in Cressie (1993), the variogram for the residuals is approximated

using the methods-of-moments (or classical) estimator in blocks sizes = 2do (c.f. Egn. (((xiii)), so
that

211




A 1 2
Zj/(h, 0) ~ Zy(hl ! Hl ) = |N (hl )”N 9] (a‘b)EN%I(E(gjs)a )_ R(Sb)) ' ((XV)

The setsN (hi) and N (<9i) contain binned separation distances and heading angles as defined by
the equations

N(hi)z{(a,b);hi_%“gd(sa,sb)shi+%“} ((xvi)
N(ej)z{(a,b): 0, —%sg(sa,sb)s 0, +A7‘9} ((xvii)

where d(s,,s,) and £(s,,s,) are the Euclidian distance and heading angle between s, and s
and|N(h;) and |N(6, ) are the number of bins in these sets. For the data set analyzed in Calder
(2006), Ah, =0.05d,, AG, = 45°, h, =iAh+Ah/2and 6, = JAO .

Step 2: The average azimuthal variogram, 27(6,)=|N(h,} "3 27(h;,6,) is then calculated.
In Calder (2006), 2;7(9j) had two sets of maximum and minima (caused by trending ridges), so
it could be modeled by the function

27(6;)~ 0.59, + g, cos(476, + ¢, ), ((xviii)

which is the second Fourier eigenfunction, Equation (((xviii) is fitted to the data by evaluating
the second discrete Fourier transform coefficient. The phase constant, ¢, is the radian angle
(which goes counterclockwise from the east) where the first minimum is found. It is changed to a
heading angle (again, clockwise from the north), 6,,, from the transformation 6,, = —¢,/2+ /2.

This angle is obtained for each 2do block, then interpolated to get 6,,(s;) for Step 4 below.

Step 3: Two finer-scaled directional variograms are then calculated; one in the 6, direction,
the other in the perpendicular direction, @ ; using the methods-of-moments estimator with angle

bins of + 7/2about each direction. In this case, Ah =0.02d,and the data were truncated to those

within 95% of the mean to reduce outliers. These empirical variograms are fitted to the standard
spherical variogram model (Cressie (1993), Eqgn. (2.3.8); Davis (2002), Eqn. (4.98))

0, h=0
2y(n)={a, +a,(L5(h/a,)-05(h/a,)’) 0<h/a, <1 ((xix)
a, +a,, hla,>1
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using the Levenberg-Marquardt algorithm (Marquardt 1963; Brandt 1999) for fitting (i.e. solving
for ao, a1 and az). Let the modeled variogram along the 6, direction be 2}/0(h) and the fitting
constants be ao, a1 and a. Similarly, let the modeled variogram along the 6 direction be 2y, (h)
and the fitting constants bea;, a;, and a,. When solving for both sets of constants, the
variograms are constrained to equal the same sill at large distances so that a, =a, anda; =a,,

buta, = a,in general.

Step 4: Define the anisotropy parameter, e, =a,/a; . Then, 7, (si,sj), is evaluated in the
following manner.

yD(Si’Sj):yo(d,(Shsj))' (xx)

where
d'(s;,5;)= A0 (s)) 2uco N =5, ). ((xxi)
A(em (Si )’ aaniso) = R(_ 0, (Si ))diag (11 aaniso)R(em (Si )) ’ ((xxii)

and R(8,(s,)) is the standard two-dimensional rotational matrix (Goldstein 1980)

R(0.(s.) = [cos(@ 1 (s))) sm(&m(s,))} (il

sin(0,(s;)) cos(6,(s;))]

For applications where only the bathymetry is needed, ;/D(si : sj), may be sufficient for use.

In hydrographic situations, however, where extra caution is required for navigation safety, an
additional “hydrographic uncertainty” variogram is added to increase the total uncertainty for
safety (see Calder (2006) for details). This variogram is defined to be

27,,(n)=Db, +bh ((xxiv)

The choice of the coefficients is arbitrary, but Calder uses b, =0and b, =6.51x10"*mso that the

95% confidence interval of the uncertainty increases by 0.05 m for every meter of horizontal
separation in soundings. Thus, for hydrography, the final variogram to use is

2ytotal (Si 1 S ) 27D (SI 1 S + 27/H (”S H) ((XXV)

3. Monte Carlo Estimation of Depth Error Due to Positional Stability Errors

This last part is of use for fusion with soundings data, either with other soundings data or a
historical grid, as the position of the soundings contains errors (this part is not applied when
fusing historical gridded data sets). As before (c.f. Section I.A), positioning errors result in errors
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of depth estimates on the interpolation surface as the position of the soundings affect the
interpolated solution; the Monte Carlo technique of Jakobbsson et al. (2002) is used to estimate
this error. At the beginning of each iteration, the locations of the soundings are perturbed
according to a probability density function appropriate for the sounding, often assumed to be
Gaussian unless otherwise known (c.f. Fig. 5 in Calder (2006) for a non-Gaussian example).
Loess interpolation and kriging, using the variogram from the unperturbed set, are repeated at
each iteration. The standard deviation of the solutions at each interpolation point provides s(s) in

Eqgn. (((x).
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10.2.6 Error Growth Model

The following has been extracted from 5" Edition, S-44 (2008) Annex A, section A.5 by Rob Hare and
edited for context

TPU is a combination of random and bias based uncertainties. Random and short period
uncertainties have to be recognized and evaluated both in horizontal and vertical directions.

The propagated uncertainty may be expressed as a variance (in metres?) but is more often
reported as an uncertainty (in metres) derived from variance with the assumption that the
uncertainty follows a known distribution. In the latter case, the confidence level (e.g., 95%) and
the assumed distribution shall be documented. Horizontal uncertainties are generally expressed
as a single value at a 95% level, implying an isotropic (circular) distribution of uncertainty on the
horizontal plane.

In the hydrographic survey process it is necessary to model certain long period or constant
factors related to the physical environment (e.g. tides, sound speed, vessel dynamic draft,
including squat of the survey vessel). Inadequate models may lead to bias type uncertainties in
the survey results. These uncertainties shall be evaluated separately from random type
uncertainties.

TPU is the resultant of these two main uncertainties. The conservative way of calculating the
result is the arithmetic sum, although users should be aware that this may significantly
overestimate the total uncertainty. Most practitioners, and the appropriate ISO standard,
recommend quadratic summation (i.e., summation of suitably scaled variances).

An example is given in S-44 for fixed (a) and depth-variable (b) uncertainty components:
TVU = +,/a’ +(bxdY
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10.2.7 Split-Sample Approach

Contributed by Chris Amante and Matt Love, NOAA National Centers for Environmental
Information (NCEI)

There are a number of techniques used to quantify the uncertainty of interpolated
elevations, e.g., split-sample, cross-validation, jack-knifing, and boot-strapping. Using a split-
sample approach, a percentage of the data is omitted, an interpolation method is applied, and the
differences between the interpolated elevations and the original omitted elevations are calculated.
This method is often used to assess the stability of various interpolation methods by omitting
increasingly greater percentages of the original data and analyzing changes in the uncertainty.

A program for Linux users written in Guile Scheme (http://www.gnu.org/s/quile/) has
been developed to quantify the uncertainty of interpolation methods using a split-sample
approach. The program, named ss_unc.sch, utilizes the Generic Mapping Tools (GMT,;
http://gmt.soest.hawaii.edu), and ancillary programs written in the C programming language by
Matthew Love of the National Oceanic and Atmospheric Administration (NOAA) National
Centers for Environmental Information (NCEI; see glossary).

The program omits a percentage of the xyz points, applies an interpolation method, and
calculates the differences between the interpolated values and the omitted elevations. In order to
quantify the uncertainty of the interpolation method at every data point, the program repeats this
process and aggregates the differences between the original xyz file and the interpolated
elevations. The program produces several useful products to be used in assessing the uncertainty
of various interpolation methods. The products include a histogram (see Figure 10.2.7.1) of the
differences with statistical measurements such as the minimum, maximum, mean, root mean
squared error (RMSE), and standard deviation. In addition, the program produces a binary .grd
file of the differences between the original and interpolated elevations.
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Figure 10.10 Example histogram output from Split-Sample program SS_UNC.

The program has multiple user-defined parameters. The user defines the input xyz file to
be used to evaluate multiple gridding methods, the gridding methods to evaluate, the percentage
of points to be omitted, the grid cell size, the input xyz file delimiter, and the number of
iterations to repeat the process (see example below). Currently the program can evaluate GMT
‘surface,” ‘nearneighbor,” and ‘triangulate’ gridding algorithms. Additional gridding algorithms,
such as MB-System ‘mbgrid,” will be included in the program in the near future.

ss_unc.scm [infile] [-e arg] [-percent arg] [-grd_cells arg] [-delimiter arg] [-dotimes arg] [-
engines? arg] [-help]

infile
-e

-percent
-grd_cells
-delimiter
-dotimes
-engines?
-help

The input xyz file

Specify which gridding engine(s) to use. If multiple engines are desired, separate
them with commas.

Percentage of xyz data to extract, default is 20.

The grid cell size in arc-seconds.

The input xyz delimiter

The number of iterations

Check available engines

Display the help
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Split-sample uncertainty program example:

~] ss_unc.scm h04505_sparse.xyz -e surface, nearneighbor, triangulate -percent 25 -
grd_cells 100 -delimiter **,"" -dotimes 10 > ss_unc_example.sh

~] chmod +x ss_unc_example.sh
~] ./ss_unc_example.sh

Another option currently in progress is to evaluate the stability of the interpolation
method by omitting an increasingly greater percentage of original data. For example, omit 20%
of the original data and increase the percentage of omitted data at 10% intervals until 80% of the

original data has been omitted. This option will produce a line graph depicting the change in
RMSE as a function of the percentage of points omitted for various interpolation methods.
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SS_UNC

SS_UNC

Compare interpolation gridding methods to help determine uncertainty.

Matthew Love
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Copyright © 2011 CIRES.

Permission is granted to make and distribute verbatim copies of this manual provided the copyright notice and
this permission notice are preserved on all copies. Permission is granted to copy and distribute modified
versions of this manual under the conditions for verbatim copying, provided that the entire resulting derived
work is distributed under the terms of a permission notice identical to this one.
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1 Copying

SS UNC is copyright (C) 2011 CIRES and is released under the terms of the GNU General Public License. See
the included file *COPYING’ for the full text of the license (or see section “Copying” in The GNU Emacs
Manual).

This is free software — you are welcome to redistribute it and/or modify it under the terms of the

GNU General Public License as published by the Free Software Foundation; either version 2, or
(at your option) any later version.

SS UNC is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU General Public License for more details.
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2 Introduction

The Split Sample UNCertainty program (SS UNC) is a Guile scheme command-line program designed to run
on the GNU/Linux Operating System. SS UNC is highly configurable, allowing the user to add gridding
engines, change and add command-line options, and even change the way SS UNC runs.
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3 Installing SS UNC

3.1 Dependencies

For SS UNC to work, there are a number of required dependencies:

e  GNU/Linux
e Guile

e GMT

o rpslit

e ncquery

3.2 Autotools

Installation through autotools is fairly straight forward.
1. Unpack the package
~] tar xfvz ss_unc-0.1.tar.gz
2. Enter the package root directory
~] cd ss_unc-0.1
3. Configure and Make the package
The *--prefix’ switch to ./configure specifies where to install files.
~/ss_unc-0.1] ./configure --prefix=~/ss_unc && make
4. Install the built package
~/ss_unc-0.1] make install

3.3 Manual Installation

1. Unpack the package
~] tar xfvz ss_unc-0.1.tar.gz
2. Enter the package root directory
~] cd ss_unc-0.1
3. Enter the package ’src directory
~] cd src
4. Copy ss_unc.scm to a directory locatable with PATH
~] cp ss_unc.scm ~/bin
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4 Using SS UNC

SS UNC is a command-line program designed to be run in a shell program such as bash.

4.1 Basic Usage

For general usage help from the command-line, the ‘-help’ switch can be used. The usage display will
display the default command-line switches as well as any additional switches defined by the user, see
Section 5.2 [Adding Command Line Options], page 6. The *-e” switch specifies the gridding engine to
use in gridding comparisons, see Section 5.1 [Adding Engines], page 6.

~] ss_unc.scm -help

ss_unc.scm version 0.2.0

Usage: ss_unc.scm [infile] [-e arg] [-percent arg] [-grd_cells arg]
[-delimiter arg] [-dotimes arg] [-engines? arg] [-help]

infile The input xyz file.
-delimiter The input xyz record delimiter, default is space (** “*)
-e Specify which gridding engine(s) to use,
if multiple engines are desired, separate them with commas.
-percent Percentage of xyz data to extract, default
is 20, separate values with a comma.
-grd_cells The grid cell size -dotimes The number of iterations -engines?

Check available engines, optionally specify
which engine to get more information about..
-help Display the help

infile

The infile is the input xyz file to perform the gridding algorithms on.

The -e switch specifies which gridding engine(s) to use. To use multiple engines, separate the
engine names with a comma, this will produce histograms and stat files for each of the engines
mentioned.

-percent
The -percent switch specifies the percentage of random points to extract from infile.
If the argument is a list of comma separated values, ss unc.scm will run for each of the
specified percentages, and append the statistics for each into a separate file.

-grd cells
The -grd_cells switch specifies the cell-size to use for gridding operations.

-dotimes

The -dotimes switch allows the user to specify how many iterations of gridding and comparing
will be performed.

-engines?

The -engines? switch without arguments will display a list of the available gridding engines,
optionally specify an engine as an argument to get more details about that engine.
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-help
This switch will display the help text and exit.

When ss unc.scm is run, it will immediately output a number of commands to stdin. If these commands are
redirected to a file, e.g. > ss_unc_test.sh, then that file can be used to generate the output files. The generated
script can be edited to fine-tune some of the commands if needed and can be saved for future use.

4.2 Default Engines

SS UNC comes with a number of gridding engines for general use. To check which engines are available on
the running version of SS UNC, use the ’-engines? switch, which will display all the engine keys which would
be used with the ’-e option, including those added by the user, see Section 5.1 [Adding Engines], page 6.

Each of the search engines has a description, which can be displayed by specifying which engine to display
more information about after the ’-engines? switch:

~] ss_unc.scm -engines?
surface

nearneighbor

triangulate

~] ss_unc.scm -engines? surface
surface

GMT surface (SPLINE)

4.3 Output

SS UNC will generate a number of output files. The type and number of output files will depend on the given
command-line arguments.

e Histogram(s)

o Diff erence Grid(s)

e  Statistics file(s)
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5 Extending SS UNC

SS UNC allows for complete extendibility. By use of hooks and definitions, one could rewrite SS UNC to ones
own desires.

5.1 Adding Engines

SS UNC allows for the adding of new gridding engines. This is accomplished through the configuration file
(~/.ss unc). The scheme function ’ci-add-engine is used to add a new gridding engine into SS UNC:
(si-add-engine ’(engine-name .
(’engine-function ‘‘engine-description’’)))

where engine-function is a function which should accept 2 arguments (input-xyz-file and gridding-cell-size)
and engine-description is a string describing the engine. Adding an engine in this manner will add the engine
to the output of the -engines? command-line switch, seamlessly integrating the added engines into the SS UNC
interface.

5.2 Adding Command Line Options

SS UNC allows for the adding of new command-line options. There are two steps involved in adding
command-line options, adding the option to the help menu and adding a handling function to the command-
line hook.

(define switch-var #f)

(sc-add-option *(-switch . (takes-options?(#t or #f)
"Description™))) (add-hook! ci-command-line-hook
(lambda (a b)
(if (equal? (car b) "-show_url")
(begin
(set! show-url #t)
(parse-options a (cdr b))))))

5.3 Hooks

Hooks are a useful tool in extending scheme code. SS UNC takes advantage of hooks to allow
the user the ability to add command-line options (including in the -help output).

SS UNC provides one hook, listed and described below:

ci-command-line-hook

The ’sc-command-line-hook is the hook that allows adding to the default command-line options. The
hook is run before the general command-line parsing begins, allowing the user to have control over the
command-line environment. This hook is passed 2 options, the first is the command that ran the program
(e.g. /usr/bin/sicl) and the second is the remaining command-line options. The hook will be run for each
command-line option, so the user doesn’t have to write any loops in the configuration files to take
advantage of adding command-line options in this manner.
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6 Examples

Running ss unc.scm

Run ss unc.scm on the comma delimited ascii xyz file test.xyz, randomly extracting 25 percent of the data
points, gridding using surface and triangulate at 10 arc-seconds.

#run the command
~] ss_unc.scm test.xyz -percent 25 -e surface,triangulate \

-grd_cells 10 -delimiter *“,”” > test.sh

#Allow the output script to be executable
~] chmod +x test.sh

#Run the output script
~] ./test.sh

Re-Define the *surface engine function
Redefine the *surface engine function in the SS UNC configuration file, adding a tension parameter.

(define (run-surface in cellsize)
(display (string-append
"surface "
in
g
cellsize
"¢ -T.4-G"
(basename in ".xyz") "_surface.grd"
" $(minmax " in " -I" cellsize "c)"))
(newline))
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SS_UNC.SCM
SS_UNC

SS_uUnc.scm
~f

1/6
02/28/2011

#!/usr/bin/guile \
—e main —s
I#

(use—modules (ice—9 rdelim))

(define percent "20")
(define inxyz ’())

(define grdcellsize "1")
(define do—times "2")
(define outps "out.ps™)
(define delim " ™)

(define version—wanted? #f)
(define help—wanted? #f)

;; Engines ;;

Define some hooks.

(define ci—command-line—hook (make—hook 2))
;; The User Config File, this can be set in the .guile config file.

(if (not (defined? ’ci—config))
(define ci—config
(cond ((file—exists? (string—append (getenv "HOME") "/.ss_unc.conf"))
(string—append (getenv "HOME") "/.ss_unc.conf"))
((file—exists? (string—append (getenv "HOME") "/.ss_unc"))
(string—append (getenv "HOME") "/.ss_unc™)))))

;; The list of default engines. Formatted
;; thusly: *(name . ("function "description™)

;; The *function should accept 2 arguments,
;; the input xyz file and the gridding cellsize

(define ci—engine—alist

’((surface . Crun—surface "GMT surface (SPLINE) \n"))
(triangulate . (Crun—triangulate "GMT triangulate (Triangulation) \n"))
(nearneighbor . ("run—nn "GMT nearneighbor (NEAREST NEIGHBOR) \n"))))

(define (ci—add—engine specs)

"Add a gridding engine to the ’ci—engine—alist in the format
’(name . *function \"description\")"

(append! ci—engine—alist (list specs)))

(define (ci—display—engines engine—alist)
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"Display the available engines in the given ’engine—alist."

(if (pair? engine—alist)
(begin
(display (caar engine—alist))
(newline)
(ci—display—engines (cdr engine—alist)))))

(define (ci—describe—engine ci—eng engine—alist)
"Describe ’ci—eng using the given ’engine—alist"

(display ci—eng)
(newline)

(display "= ")
(newline)

(if (and (assq (string—>symbol ci—eng) engine—alist)

(not (null? (cddr (assq (string—>symbol ci—eng) engine—alist)))))
(display (caddr (assq (string—>symbol ci—eng) engine—alist)))
(display "Sorry, this engine has no description available."))

(newline))

;;———Engine functions:

(define (run—surface in cellsize)
(display (string—append

"surface "

"

cellsize

”C 7Gn
(basename in ".xyz") "_surface.grd"
" $(minmax " in " —1" cellsize “c)"))
(newline))

(define (run—nn in cellsize)
(display (string—append

"nearneighbor "

"
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cellsize
"¢ =S20¢ —N8 -V -G"

(basename in ".xyz") " _nearneighbor.grd"
" $(minmax " in " —1" cellsize "c)"))

(newline))

(define (run—triangulate in cellsize)
(display (string—append

"triangulate "

"
cellsize
e —G"
(basename in ".xyz") "_triangulate.grd"

" $(minmax " in " —I" cellsize "c) > tmp.idk"))

(newline))

;;—PROC:

(define (run—rsplit in percentage)
(display (string—append

"rsplit —percent "

percentage
"—r"in">rand_"

(basename in)

" 2>base "

(basename in)))
(newline))

(define (run—ncquery ingrd inxyz delim d_format outxyz)
(display (string—append

"ncquery —1 "

d_format
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ingrd

inxyz

n_gn

delim

" | grep —v \"nan\" >> "

outxyz))
(newline))

(define (run—xyz2grd inxyz outgrd cellsize)
(display (string—append

"awk —F"

delim

" {print $1,$2,$5}" | "
"xyz2grd "

inxyz

[ v (]

cellsize

"e —G"

outgrd
" $(minmax " inxyz " —I" cellsize "c)"))
(newline))

;;——STATS:

(define (run—pshistogram inxyz outps rperc ptimes engine)
(display
(string—append

"pshistogram "

inxyz
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" =V —Gblue ~-W$(minmax —C "

inxyz " | awk * {print ($10-$9)*.10}*) -L1 —Z0 —T4
—B:\"Value\":/:\"Frequency\"::.:-WSne —U/-.2
5i/=0.75i/\"ss_unc.scm\" =K >"

outps " 2>" outps ".info"))

(newline))

(define (run—pstext inxyz outps
rperc ptimes engine)
(display
(string—append

"pstext —R0/3/0/5 =JX31 —O —N =V << EOF >>"

outps
"\n.2511.51000 LT Iterations: " ptimes
"\n.25 11 10 0 0 LT Percent: " rperc
"\n.25 10.5 10 0 0 LT Cell-Size: " grdcellsize
"\n1.5 11.5 10 0 0 LT Total: $(wc —1 " inxyz " | awk *{print $1}")"

"\n1.511 100 0 LT Min: $(grep min/max " outps ".info | awk *{print $6}")"
"\n1.510.51000 LT Max: $(grep min/max " outps ".info | awk ’{print $7}")"
"\n2.7511.510 0 0 LT Mean: $(tail =1 "

(basename inxyz ".xyzgd") ".stat | awk *{print $4}")"

"\n2.75 11 100 0 LT RMSE: $(tail —1 "

(basename inxyz ".xyzgd") ".stat | awk "{print $5}")"
"\n4 1151000 LT File: " inxyz
"\n4 11 10 0 0 LT Interpolation: " engine

“\nEOF"))

(newline))

(define (set—gmt—defaults)

(display "gmtset COLOR_NAN 255/255/255 DOTS_PR_INCH 300 ANNOT _FONT PRIMARY Times—Roman \
ANNOT_FONT _SIZE_PRIMARY 8 ANNOT FONT SIZE SECONDARY 8 HEADER FONT Times—Roman \
LABEL_FONT Times—Roman LABEL FONT SIZE 8 HEADER _FONT SIZE 10 PAPER MEDIA letter \
UNIX_TIME_POS 0i/~1i PS_COLOR CMYK Y_AXIS_TYPE ver text PLOT DEGREE FORMAT ddd:mm:ss \
D_FORMAT %.1f COLOR_BACKGROUND 0/0/0 COLOR_FOREGROUND 255/255/255 COLOR_NAN 255/255/255")

(newline))

(define (run—stats inxyz outxyz rperc ptimes grdcellsize)

(display (string—append
"awk —F" delim " *{sum+=$5} {sum2+=($5*$5)} END { print \""
rperc "\"\"" ptimes "\" \"" grdcellsize "\",sum/NR,sqrt(sum2/NR)}

inxyz " >>" outxyz))

(newline))

(define (run—ps2raster psfile outf)
(display (string—append
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"ps2raster —T" outf " " psfile))
(newline))

;;———Run through the commands

(define (run—commands
run—times engines p)
(let ((engine—Tlist
(string—split engines #\,)))
(if (> run—times 0)
(begin
(let ((base—xyz
(string—append "base_"
(basename inxyz)))

(rand—xyz (string—append "rand_" (basename inxyz))))
(run—Tsplit inxyz p)
(map (lambda (x)

(primitive—eval
(list (cadr (cadr (assq
(string—>symbol x)
ci—engine—alist)))
base—xyz grdcellsize)))
engine—list)
(map (lambda (x)

(run—ncquery
(string—append (basename base—xyz ".xyz") "_" x ".grd")

rand—xyz
delim
"xyzgd"
(string—append "rand_"p " "
(basename
inxyz ".xyz") " " x ".xyzgd")))

engine—list)

(run—commands (— run—times 1)
engines p)))

(begin

(map (lambda (x)

(run—xyz2grd

(string—append "rand_"p " "
(basename inxyz ".xyz") " " X

" xyzgd")

(string—append "rand_"p "_"
(basename inxyz ".xyz") " " x
".xyzgd.grd")

grdcellsize))

engine—list)

(map (lambda (x)

(run—stats (string—append "rand_" p

(basename inxyz ".xyz") " " x

" xyzgd")

(string—append "rand_"

(basename inxyz ".xyz") "_" x ".stat")
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p do—times grdcellsize)

(run—stats (string—append "rand_" p
(basename inxyz ".xyz") " " x

" xyzgd")

(string—append "rand_"p " "
(basename inxyz ".xyz") " " x ".stat")
p do—times grdcellsize))

engine—list)
(set—gmt—defaults)
(map (lambda (x)

(run—pshistogram

(string—append "rand_" p (basename inxyz ".xyz") " " x ".xyzgd")

(string—append "rand_" p "_" (basename inxyz ".xyz") "_" x ".ps")

p do—times x))

engine—list)
(map (lambda (x)

(run—pstext

(string—append "rand_" p (basename inxyz ".xyz") " " x ".xyzgd")

(string—append "rand_" p (basename inxyz ".xyz") " " x".ps")

p do—times x))

engine—list)
(map (lambda (x)
(run—ps2raster
(string—append "rand_" p "_" (basename inxyz ".xyz") "_" x ".ps")
"G")

engine—list)))))

;; Command-—line options ;;

23 £}

;;———Options
;" (switch . (args? "desc"))

(define ci—option—alist *((infile . (#f "The input xyz file."))
(—e . (#t "Specify which gridding engine(s) to use, \

if multiple engines are desired, separeate them with commas."))
(—percent . (#t "Petcentage of xyz data to extract, default is 20"))
(—grd_cells . (#t "The grid cell size™))
(—delimiter . (#t "The input xyz delimiter"))
(—dotimes . (#t "The number of iterations"))
(—engines? . (#t "Check available engines, optionally specify \

which engine to get more information about.."))
(~help . (#f "Display the help™))))

(define (ci—add—option specs)
(append! ci—option—alist (list specs)))

(define (ci—display—options
option—list)
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(if (pair? option—list)
(begin

(if (cadar option—list)
(display (string—append " ["* (symbol—>string (caar option—list)) " arg]"))
(display (string—append " [ (symbol—>string (caar option—list)) "]")))

(ci—display—options (cdr option—Tlist)))
(display "\n\n")))

(define (ci—describe—options option—list)
(if (pair? option—list)
(begin
(let ((cname (symbol—>string (caar option—list)))
(cdesc (caddr (car option—list))))
(if (> 20 (string—length cname))

(display (string—append

(string—append
chame
(make—string (— 20 (string—length cname)) #\ ))

"\t" cdesc "\n"))))
(ci—describe—options (cdr option—list)))
(display "\n")))

(define (display—help command—name option—list)
(if (pair? option—list)

(begin
(display (basename command—name))
(display " version 0.2.1")
(newline)
(display "Usage: ")
(display (basename command—name))
(ci—display—options option—list)
(ci—describe—options option—list))))

;; Read the given port (’p) and put it into the string ’pstring.

(define (read—port p pstring)

(if (not (eof—object? (peek—char p)))
(read—port p (string—append pstring (read—line p)))
pstring))

;; Parse the command-—line

(define (parse—options cca ccl)
(if (pair? ccl)
(begin
(if (not (hook—empty? ci—command-line—hook))
(run—hook ci—command-line—hook cca ccl))
(cond

;; Help? ;;
((or (equal? (car ccl) "—h")
(equal? (car ccl) "—help")

(equal? (car ccl) "—?"))

(display—help cca ci—option—alist)

235



(exit 1))
((equal? (car ccl) "—percent")

(begin
(set! percent (cadr ccl))
(parse—options cca (cddr ccl))))

;; Engines ;;

((equal? (car ccl) "—engines?")

(if (not (null? (cdr ccl)))
(ci—describe—engine (cadr ccl) ci—engine—alist)
(ci—display—engines ci—engine—alist))

(exit 1))

;; Gridding Engine ;;

((equal? (car ccl) "—e"

(begin
(set! ci—engine (cadr ccl))
(parse—options cca (cddr ccl))))

((equal? (car ccl) "—delimiter")

(begin
(set! delim (cadr ccl))
(parse—options cca (cddr ccl))))

((equal? (car ccl) "—grd cells")
(begin

(set! grdcellsize (cadr ccl))
(parse—options cca (cddr ccl))))

((equal? (car ccl) "—dotimes")

(begin
(set! do—times (cadr ccl))
(parse—options cca (cddr ccl))))

;; Input xyz file ;;

((null? inxyz)
(set! inxyz (car ccl))
(parse—options cca (cdr ccl)))

(else
(parse—options cca (cdr ccl)))))))

;; Load the User Config File
;(display ci—config)

(if (file—exists? ci—config)
(begin
(load ci—config)))
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(if (not (defined? *ci—engine))
(define ci—engine "surface"))

(define (main args)
;; Parse the command-—line
(parse—options (car (command-—line)) (cdr (command—line)))
;; If ’inxyz was not given, get it from ’current—input—port

(if (null? inxyz)
(set! inxyz (read—port (current—input—port) "))

;(display inxyz)

(let ((percent—list (string—split percent #\,)))
(map (lambda (p)
(run—commands (string—>number do—times) ci—engine p))
percent—list)))

;;——END
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RSPLIT
RSPLIT

Randomly extract lines from a text file.
Manual

Matthew Love
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Copyright © 2011 Matthew Love.

Permission is granted to make and distribute verbatim copies of this manual provided the copyright notice and
this permission notice are preserved on all copies. Permission is granted to copy and distribute modified
versions of this manual under the conditions for verbatim copying, provided that the entire resulting derived
work is distributed under the terms of a permission notice identical to this one.
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1 Copying

RSPLIT is copyright (C) 2011 Matthew Love and is released under the terms of the GNU General Public
License. See the included file “COPYING’ for the full text of the license (or see Section “Copying” in The
GNU Emacs Manual).

This is free software — you are welcome to redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2, or (at your option) any later
version.

rsplit is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY: ; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License for more details.
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2 Introduction

Randomly extract a percentage of lines from a text file. The randomly extracted line gets printed to stdout,
optionally, the remaining lines can be printed to stderr, allowing for the splitting of text files.
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3 Installing rsplit

Installation through autotools is fairly straight forward.

1.

Unpack the package
~] tar xfvz rsplit-0.1.3.tar.gz

Enter the package root directory
~] cd rsplit-0.1.3

Configure and Make the package

The “--prefix’ switch to ./configure specifies where to install files.

~[rsplit-0.1.3] ./configure --prefix=~/rsplit && make

Install the built package
~/rsplit] make install

242




4 Using rsplit

RSPLIT is a command-line program designed to be run in a shell program such as bash. For general usage help
from the command-line, the *--help” switch can be used.

~] rsplit --help

Usage: rpslit [OPTIONS] [infile]

Randomly extract a percentage of lines from a text file.

Options:

-p, --percent The percent of lines to randomly extract

from the input.

-1, --line-num Include line numbers in output.

-r, --remaining Send the lines that aren’t extracted to stderr.

--version Print version information and exit.

Example: rsplit test.xyz -p 20 -Ir > test_rand20.xyz 2>test_base.xyz

The *-p, --percent’ switch specifies the percentage of randomly selected points to extract from the given text
file.

The *-1, --line-num’ switch prints the line number along with the original line from the input text file.

The *-r, --remaining’ switch prints the remaining lines after random extraction to stderr.
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5 Examples
Extract 20 percent of the lines in the input text file and print the results to stdout ~] rsplit -p 20

input.txt

Extract 15 percent of the lines in the input text file and write the results to a file, include the line numbers
~] rsplit -p 20 --line-num input.txt > rand20_input.txt

Extract 40 percent of the lines in the input text file, write the results to a file and send the remaining lines to
another file. ~] rsplit test.xyz -p 40 -r >
test_rand40.xyz 2>test_base60.xyz

10.3

10.2.8 Spectral analysis

10.2.9 Slope

10.2.10 Kriging discussion and cautionary note

Sharing uncertainty results

TEXT IN PREPARATION

10.3.1 ASCII files

TEXT IN PREPARATION

10.3.2 netCDF files

TEXT IN PREPARATION

10.3.3“BAG” files

Contributed by Rob Hare, Canadian Hydrographic Service, Canada

Bathymetric Attributed Grid (BAG) is a non-proprietary file format for storing and exchanging
bathymetric data developed by the Open Navigation Surface Working Group. BAG files are

244




gridded, multi-dimensional bathymetric data files that contain position and depth grid data, as
well as position and uncertainty grid data, and the metadata specific to that BAG file.
Information about BAG files may be obtained from the Open Navigation Surface website:

http://www.opennavsurf.org/whitepapers.html
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Chapter 11.0 LANDSAT 8 Satellite-Derived Bathymetry

Contributed by S. Pe’eri,B. Madore and L. Alexander, Center for Coastal and Ocean Mapping,
USA, A. Klemm and A. Armstrong, National Oceanic and Atmospheric Administration, USA, C.
Parrish, Oregon State University, USA, C. Azuike, Nigerian Navy Hydrographic Office Lagos,
Nigeria, and Eunice N. Tetteh, Ghana National Oceanographic Data Centre, Ghana

Satellite derived bathymetry (SDB) is a useful reconnaissance tool that can be used to map near-
shore bathymetry, characterize a coastal area and to monitor seafloor changes that may have
occurred since the last hydrographic survey was conducted. Landsat satellite imagery is most
commonly used for SDB products because it is a free and publicly available resource. Satellite
imagery in the U.S. Geological Survey data archives includes imagery from current and previous
Landsat missions. In the current Landsat 8 mission, an operational land imager (OLI) has been
operational since mid-2013. The swath width of the Landsat imagery is 185 km, and the image
resolution is 30 m. The number of bands and their spectral range differs between Landsat
missions (Figure 11.1). In addition to Landsat imagery, there are several commercial
multispectral satellite platforms (e.g., Ikonos and WorldView) that can also be used for satellite
derived bathymetry.

3] } Landsat 8 (OLI)

I
I
I
: | 4 | } Landsat 7 (ETM+)
100 5
£ Visible | Infrared
5 I
i I
]
[=
= |
Q
£ |
< o |
0.4 0.7 1.0 1.3 1.6 1.9

Wavelength (pm)

Figure 11.1 Bands of Landsat 7 and 8 imagery used in the SDB procedure.

This chapter will describe the SDB procedure step-by-step using Landsat 8 imagery. The
procedure is described in an ESRI ArcMap environment and includes the following key steps in
the satellite-derived procedure include (Pe’eri et al., 2014):
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e Pre-processing (Section 11.1)- Satellite imagery is downloaded based on the geographic location and
environmental conditions (e.g., cloud coverage and sun glint) had to be used.

e Spatial filtering (Section 11.2)- “Speckle noise’ in the Landsat imagery is removed using spatial filtering.
e Water separation (section 11.2)- Dry land and most of the clouds are removed.

o Identifying the extinction depth (Section 11.3)- The optic depth limit for inferring bathymetry (also
known as, the extinction depth) is calculated.

e Applying the bathymetry algorithm (Section 11.3)— The bathymetry is calculated using the Stumpf et al.
(2003) algorithm on the blue and green bands.

o Vertical referencing (Section 11.4)— A statistical analysis between the algorithm values to the chart
soundings references the Digital Elevation Model (DEM) to the chart datum.

Although a radiometric correction of the imagery band is described in Pe’eri et al (2014), this
step will not be described here. The reason is that the quality control on the imagers produced
from the currently operational satellite is good enough to provide a bathymetric product and does
not require this step anymore. Based on the experience of the authors with different satellite
imagery, the blue and green band recommended for SDB are provided in following table:

Table 11.1 Recommended SDB imagery bands from different platforms.

Blue (range in um) Green (range in um) | IR (range in um)
Landsat 7 Band 1 (0.45-0.52) Band 2 (0.52-0.60) Band 4 (0.77-0.90)
Landsat 8 Band 2 (0.45 - 0.51) Band 3 (0.53-0.59) | Band 6 (1.57 - 1.65)
WorldView2 Band 2 (0.45 - 0.51) Band 3 (0.51-0.58) | Band 8 (0.86 —1.04)
WorldView3 Band 2 (0.45 - 0.51) Band 3 (0.51 - 0.58) | Band 8 (0.86 — 1.04)
GeoEye - 1 Band 1 (0.45 - 0.51) Band 2 (0.51-0.58) | Band 4 (0.78 —0.92
Ikonos - 2 Band 1 (0.45 - 0.52) Band 2 (0.51 - 0.60) | Band 4 (0.76 — 0.85)

For more details on satellite-derived bathymetry and hydrographic applications, please refer to
the following references:

Pe’eri, S., C. Parrish, C. Azuike, L. Alexander and A. Armstrong, 2014. Satellite Remote
Sensing as Reconnaissance Tool for Assessing Nautical Chart Adequacy and
Completeness, Marine Geodesy, 37(3), 293-314.

Stumpf, R., K. Holderied and M. Sinclair, 2003, Determination of water depth with high-

resolution satellite imagery over variable bottom types, Limnology and Oceanography,
48, 547-556.
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11.1 Pre-processing

11.1.1  Setting up the workspace (ArcMap)

Open ArcMap (either by a double-click on the ArcMap icon or selection from the windows
Start/All Programs).
Q Archdap 10.2.2 ‘

Note: if this is your first time using ArcMap, you will get the following window. Press OK.

% ArcMap - Getting Started @
Open existing map or make new map using a template
=} Existing Maps A/l My Templates
Browse for more...
= Mew Maps

= Templates 1
[=)- Standard Page S
Architectural J
150 () Page
North Americ
(=) Traditional Layo.
Industry

Blank Map

Browse for more,.,

CihDocuments and SettingsishachakiApplication Data\ESRIDeskkopl 0, 1 ArcMapiTemplates\MNormal mxt

Default geodatabase For this map: ‘wihat is this?

r
“
[1Do nat sho this dislog in the future.

Select Extensions...Under the Customize Tab.

Customize | Windows — Help

Taolbars 3

| Extensions. .. |

Add-In Manager. ..

Customize Mode. ..
Style Manager. ..

ArcMap Options.. .

In the Extensions window, mark 3D Analyst and Spatial Analyst. Press Close.
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Extensions 2 \

Select the extensions pou want to use.

@ 30 Analyst

+-0 #rcSean

+[] Geostatistical Analyst
- Metwork Analpst
+-0O Publisher

o[ Sehematics

o Spatial Analyst
L0 Tracking Analyst

Description:

3D Analyst 10.2.2
Copyright 13393-2014 Esni Inc. All Rights Reserved

Provides tools for suface modeling and 30 visualization.

Close

Note: The following steps apply if 3D Analyst is available in your ArcMap license.

Select Toolbars...under the Customize tab and select 3D Analyst.

Customize | Windows  Help Advanced Editing

| Toolbars 3 | Anirnation

Extensions... ArcScan

Add-In Manager... coGn i

Customize Mode. .. Drata Driven Pages

Data Frame Tools

Diskributed Gendatabase

Skyle Manager. ..

ArcMap Options...

Do

An undocked 3D Analyst toolbar will appear. Dock it next to the upper toolbars.

30 Anakyst - Layer:l J U2 B e = |_ @ @

Select Toolbars...under the Customize tab and select Editor.

Drawy

EditWertices

Editor

Effects

An undocked Editor toolbar will appear. Dock it next to the upper toolbars.

Editor = = © e gl ' ¥ | 1 e \

Select Toolbars...under the Customize tab and select Spatial Analyst.
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Schematic Editor
Schematic Network Analyst
Snapping
Spatial Adjustment

| Spatial Analyst

Standard

An undocked Spatial Analyst toolbar will appear. Dock it next to the upper toolbars.

Layer: | J A=

Activate the Toolbox by clicking on the icon in the upper toolbar.

Windows  Help

& 2|01 E .

In the main menu, click on File/Map Document Properties... Check the box for Store relative

pathnames to data sources. Click OK.
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-

Map Document Properties

o

General

File:
Title:

Summary:

Description:

Author:
Credits:
Tags:

Hyperlink base:

Last Saved:
Last Printed:
Last Exported:

Default
Geodatabase:

Pathnames:

Thumbnail:

Klemm\Desktop$alS_Chart_Adequacy_Ft_Meyers.mxd

5/14/2015 3:25:24 PM

5/13/2015 9:54:25 AM

=
C:\Users\anthony.r.Klemm\Documents\ArcGISYCH
Store relative pathnames to data sources

Make Thumbnail

[ ok

][ Cancel ][

foply |

In order to validate that ArcMap is properly executing the command, click on
Geoprocessing/Geoprocessing Options... in the main menu.

Geoprocessing | Customize Winc

. Buffer

Clip

Intersect

Union

Merge
Dissolve
Search For Tools
ArcToolbox
Environments...
Results
ModelBuilder
Python

OY Hsaea > > >N

Geoprocessing Options...

In Geoprocessing Options window, uncheck the Enable box under Background processing
and press OK.
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Geoprocessing Options

General

I:‘gverwnte the outputs of geoprocessing operations

|| Log geoprocessing aperations to a log file

Background Processing

Script Tool Editor/Debugger
Editor:

Debugger:

ModelBuilder

[#] When connecting elements, display valid parameters when more than one

is available.

Results Management

Keep results younger than:

Display / Temporary Data

B

Appear for how long (seconds)

Stay up if Error occurs

2 Weeks -

|| Add results of geoprocessing operations to the display

About geoprocessing options

|| Results are temparary by default

&

Activate the Catalog by clicking on the icon in the upper toolbar.

M= = Si-T=alEIE

Navigate in the Catalog window, and create a New Folder Connection. Click on the New
Folder Connection button in the Catalog toolbar and select the folder in the directory where

your data is located. (e.g. C:\working).

oot bk @] S B

Navigate in the Catalog window into the desired directory, right-click and select New/File

Geodatabase.

EJ Folder

3 File Geadatabas= % e Description

Cakalog

G 2@ E e S

Location: [ Chart_Adequacy

x

& Home - DocumentsyarcGls
i B Addlns
7 £ Packages
= 2 ProfileGraphDaty
= L@ Defaultgdb
= B Toolbas the
= EE Folder Connections
= £ Ch
7 En
1 ET §RECYCLEBIN
3 C_drive
= [ CARIS
[ r?E?.-_
EEQ B Copy
EEDF
< EIH % Delue
P ETL Rerarmie
2 W oo Refresh

Hews
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Right-click on the new Geodatabase and select Rename.

.Ecgw

M Delete

Rename |

Change the name of the Geodatabase to the chart’s name/number and press Enter.

" [Cotalog A%
G- by @ 5
Lecaten: Lt Rl Geadatabase gdb -

[l Heme - DocumentshArcGlS
£ £ Adding
ke 51 Package:
= [ ProfileGraphData
7 | @ Default.gdh
© @ Taalboxtax
E= Folder Connections
= £ G
= i B
7 (] fRECVCLE. B

0 C_drwe

# 5 CARLE

= 2 Chart_Adequacy .

£ Jrie File Geodatabase oib)

Right-click on the new Geodatabase again and select Make Default Geodatabase.

Dd |j] Cogy
Fu
Ht % Delete
i

La
M e Refresh

Rename

a '| L3 Make Default Geodarabase
e

The new Geodatabase will be recognized as default (marked bold).

Catalog + X 3
e L@ S| wlE (g
y

Locabion: L3 chartooo.gdb - (&
5= _Hfme - Documentshanc G5 - B

& 2dding b

7 £ Packages ]

+ [ ProfiletiraphData =

F 3 Defaultgdl
% @ Toolbowths
= [ Folder Connections
£ £ Ciy
EJE
il 7 $RECYCLEBIN
E3 ©_drive
] CARIE
= Chart_fdequacy
L2 ChartD0D.gdb

Save your project in the Site project directory by selecting File/ Save As...

 Untitled - ArcMap - Arclnfo

Fle | Edit View Bookmarks Insert
3 New. Ctriel
& Open.. (tr40

Make sure to save the MXD using the naming convention <Site>_<project/date>.
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@ Sove &5
Ssvein |, SDB - @ = E b
T B BT !
e it
Recent Places

Desktop
= 3 Fie pame Capeénn_Mé_SDE.mid -

i Saveas lupe Arcap Dicurnsnt * misd) <] [ Cancal |

11.1.2 Importing an Raster Navigation Charts (RNC) into the project

Downloading a NOAA chart

Using a web browser, navigate to NOAA'’s interactive catalog:
http://www.charts.noaa.gov/InteractiveCatalog/nrnc.shtml.

————

g |
7/ office of G

oast Survey

Nautical Charts & Pubs Surveys & Wrecks GIS & Other Products Research & Development Customer Service
| Paper Charts {RNC & PDF) ‘ Electronic Charts (EMC) ] Coast Pilot Help
Place Names ¥ [Standsrd Flace Marme Search search ~/ &uto Zoom | | Map | Satetiite |
S A T= " AR T G0
(< >
v 4 Greenand
iﬁ‘
= Iceland
* LT
154
AN
(| 4800 Narth
E G Atlantic
J ocean
r L
(-]
ind -
nnnnnnn Papua ew

Zoom into the region being examined and click on the chart polygon in the desired area. Make

sure that the chart you are interested is selected (right side of the screen), and click on Download
RNC in BSB format.
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http://www.charts.noaa.gov/InteractiveCatalog/nrnc.shtml

C ral Information & Links
Paper Charts (RNC & PDF) | Electranic Charts (ENC) H Coast Pilat H Help

Soodligpuml

Note: The chart is downloaded in a compress format. Make sure to unzip the chart to your data
directory.

Adding the RNC into the project

In the main menu, load the RNC data to ArcMap by right-clicking on the desired directory and
select Add Data....

®-

Navigate to the directory containing the raster charts, select your chart and press OK.

Add Data @
Lok in: [E|132?4 '] ST R A= Y

132?4 ZKAP
13374 3 KAP
13374 4 KAP
13374 5. KAP
=] USERAGREEMENT.TXT

Show of byvpe:

Datasets, Layers and Results v] [ Cancel ]

Note: The raster chart format may vary between hydrographic offices (e.g., GeoTiff, KAP, etc.)

You may be asked to create pyramids for the scanned chart. Press Yes.

255




Create pyramids for 13274_1KAP (11830 x 6105) =

This raster data source does not hawe pyramids or contains insufficient pyramids,
Pyramids allow For rapid display at varying resolutions.

Pryramid building may take a few moments,
wiould vou like to create pyramids?

ahaut pyramids E

Pyramid resampling technique

Pyramid compression bype

Compression quality

Use my choice and do not show this dialog in the future,

Yes || Mo | | Cancel
Mearest Meighbor -
Default -
75

Right-click on Layers in the Table of Contents window and select Properties...

Table Of Contents

E@i;s-\m =l

s
110
= MNOAALIZTS
RGE
M R:d: Ba
I Green: Ba
M Blue: Ba
= O MOAALZITY
RAR

]

Copy
Rernove

Joins and Relates >

* Zoom To Layer

Zoomm To Raster Resolution

Wisible Scale Range 3
Data 3
Edit Features 3

<7 Sawve As Layer File..

Create Layer Package..
NITF 3

|[ir Properties... |

In the Layer Properties, scroll down under Property to see the Spatial Reference (in this
example Global Mercator (degree units) using a WGS-84 datum). Press OK.
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Layer Properties

| General| Source | Key Metadatal Extent | Diizplay | Symbology

Property Yalue o~
= Global Mercator
Linear Unit Meter (1,000000)
Angular Unit Degree (0,0174532925199433)
fFalse_easting o
fFalse_narthing 1] f_
central_meridian -70 ‘ 5
standard_parallel_1 o
latitude_of _arigin o
Craturn D_WiE5_1954 -

Data Source

Daka Type:
Folder:

Raster:

File System Raster -
E:\C_drivelshachakiPublication_workiManuals\Geboo_Cook_Book

\Landsatd_version\ SDEVESE_ROOT 13274,

13274_1.KAP

Set Data Source,

Referencing a chart

Note: Make sure to acquire copyright permission from the hydrographic organization that

produced the chart before scanning a chart.

Load the scanned chart image to ArcMap by selecting the Add Data...icon.

<+

Navigate to your directory and select the chart in the Add Data window and select Add button.

Add Data

XS

Look in: [E SDE

el @ E 2

EIEBSE_ROGT

Marme:

Show of type:

[DatasetsJ Layers and Results v] ’ Cancel ]

You may be asked to create pyramids for the scanned chart. Press Yes.
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Create pyramids for 13274.tif (3895 = 4670)

Pyramid building mav take a few moments,
w'ould wou like bo create pyramids?

(mesal

This raster data source does not have pyramids or conkains insufficient pyramids.
Pyramids allow for rapid display at warving resolutions.

fibout pyrarnids | oves

1[ [1[a] ] [ Cancel

Pyramid resampling technique
Pyramid compression byvpe

Compression guality

Mearest Meighbor

Default

75

[ use my choice and do nat show this dislog in the Future.

You will also receive an Unknown Spatial Reference warning that this image is not referenced.

Confirm this message by pressing on OK.

& Unknown Spatial Reference

1327 4.tif

4

[] Don't wam me again in this session
7] Dan't wam me again ever

The following data sources vou added are missing spatial reference
infarmation. This data can be drawn in Archap, but cannot be projected:

(]

Your chart is now loaded into ArcMap

3 x
W Red: Band 1
B Goeenc Band 2
W Dlues Dandd
B 2 Toothos | T Table O Cankerts EIE &6

1831 2101 Decirel Degrees

Select the Zoom In (magnify) icon
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e

Zoom in to location that the longitude and latitude graticules intersect. Make a list of at least four
intersection points (note: recommended number of intersection points is nine) around the chart
with their corresponding arbitrary geographic coordinates. In this example the Source Control
Points are X: 2.352° and Y: 1.217° and the Target Control points are X: -70.6333° and Y: 42.7°
(long.: 70°38°’W and lat.: 42°42°N).
{8}-]
as /100

/ 114

M2

Target Control

Point ,
0%,

115

118

121

124

;
/

13274 - Aor
#5sfCorrection: 10/28/2015. Cleared thre

LNM: 4215 (10/20/2015), NM: 4415 (10/3~

To ensure that this chart was printed at the proper scale, the line below should measure six inche
If the line does not measure six inches (152 millimeters), this copy is not cerlified safe for naviga -
V

Source Control e

Point a——

Note: Make sure to identify the horizontal reference system used for the chart for later use (in
this example, WGS-84).

[@E| 20«

Select Data Management Tools / Projections and Transformations / Raster /Warp in the
Toolbox window.
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ArcToolbox O x

= &) Data Managernent Tools -
& Archiving
B Attachrnents
& Data Cornparison
&y Distributed Geodatabase
& Darmains
& Feature Class
& Features
& Fields
By File Geodatabase
&y General
By Generalization
By Geodatabase Adrinistration
& Geornetric Metwork
&y Graph
& Indexes
& Jains
By LAS Dataset
By Layers and Table Views
& Package
& Phatos
= B Projections and Transforrmations
= & Raster
#, Flip
‘{Q Mdirrar
‘{Q Project Raster
#, Register Raster
‘{Q Rescale
‘{Q Rotate
#, Shift
3 rp i

m

Load the input raster (i.e., the scanned chart) as Input Raster in the Warp window. Add the
Source and Target control points (make sure that the order of the control point is the same in
both lists). Validate that the Transformation Type: POLYORDER1 and press OK.

'(Q Sifarp E@

-

Input Raster
[132745if ~|

Source Contral Points
» Coordinate ¥ Coordinate

-

@)

25351219
19.034 1.067
24,855 3.996
26,945 15,162
13.441 13,502
1.27314.17

+

Target Contral Points
¥ Coordinate W Coordinate

-70.6333 42.7
-70.73333 42.63333
-70.5 42,8666
-70.9333 42,8333
-70.6333 42,7333
-70.7666 42,6333

Output Raster Dataset

E:\G_drive\Satelite_Derived_bathymetry\SDE_13274.9db\NOAALS274 WEd
Transformation Type (optional)

POLYORDER] -
Resampling Technique (optional)

NEAREST| -

[ QK ] l Cancel ] [Envirunments.‘. ] [ Show Help ==
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The raster chart is now oriented correctly. However, does not currently contain a horizontal

reference system.

-70.981 42,931 Decimal Degrees

Select Data Management Tools / Projections and Transformations / Define Projection in the

Toolbox window.
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ArcToolbox O x

= B Data Management Tools -

+ & Archiving

+ @ Attachments

+ B Data Cormparison

+ &y Distributed Geodatabase

+ & Domains

+ @ Feature Class

+ @ Features

+ B Fields

+ &y File Geodatabase

+ @ General

+ @y Generalization

+ @y Geodatabase Administration

+ B Geometric Network

+ &y Graph

) @ Indexes

+ B Joins

+ @ LAS Dataset

+ @ Layers and Table Views

+ @y Package

+ & Photos

= B Projections and Transformations

+ @ Raster

57 Batch Project
#, Conwert Coordinate Motation
#, Create Custorn Geographic Transfan

m

#, Create Spatial Reference
-

N Define Projection
#, Project
+ @ Raster
+ B Relationship Classes -
4 10 2

Load the warped image into the Project Raster window and press the Select Reference
Properties icon. Select the proper geographic reference system (in this example, the reference
system is Geographic Coordinate System/World/WGS84.prj). After selecting a reference
system, press OK.

'KQ Define Projection EI@
&Input Dataset o Feature Class o i
| NOAAI3274 WiBe <] E]
Coordinate Syskem
GCS_WG5_1984
(o4 I l Cancel I lEnvirUnmEnts.‘. I I Show Help == I

11.1.3 Control points

Note: There are many format that control points can be provided. Below we show three
examples: 1) ASCII point cloud, 2) S-57 attribute from an ENC (SOUNDG), 3) digitize
soundings.

ASCII point cloud

Note: A recommended ASCII format to import point into ArcMap is Comma Delimited (*.csv).
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Using a text editor it is possible to verify that the ASCII file contains three columns
(easting/longitude, northing/latitude, and depth). In this example, the sounding are provided
geographic coordinates using a WGS-84 ellipsoid).

@ UltraEdit - [ENC_drivelshachakiPublication_work\Manuals\Gebco_Cook_Baol
@ File Edit Search Insert Project Miew Format  Column  Macro

= JesH Sl B 2 lNE &
T -
1 Long, Lat,Depth
| Project | Open | Expla| « [ z -70.773092,42 .804495, 15.8
it = 3 -70.7291357,42.7323642, 24
4 -70.767234,42.718656,5.4
SR 5 -70.806576,42.513014,2.4
-8 i 6 -70.910426,42.835138, 4.2
S E: 7 -70.759575,42.652362,0.9
035 & -70.744148,42.717733,12.1
535 s -70.804639,42.5154,2.4

Load the ASCII point file into ArcMap by selecting Add Data... The data was added as a table
and is only present under the Source tab in the Layers window.

l.+.l -
L

Right-click on the ASCII point file in the Layers window, and select Display XY Data (for
creating an event layer).

Table Of Contents 1 x
4 [0)G 8|
= = Layers
= 3 C\Chart\CapeAnn
=]
B Open
Joins and Relates 4
X Remove
Data 4
Edit Features 4
G2 Geocode Addresses,
#  Display Route Events...
%+ Display XY Data... ‘
[Ef Properties... -

In the Display XY Data window, select Longitude (“Long”) as the X field, Latitude field
(“Lat”) as the Y field and Depth as the Z field. Press the Edit... button to define a coordinate
system. Press OK.
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Display XY Data [?]

X

A table containing ¥ and ¥ coordinate data can be added to the
map as alayer

Choose a table From the map or browse For another table:

|
Specify the fields For the &, ¥ and Z coordinates:
% Fleld: |Lm - \
¥ Field: |Let - \
2 Fields

Coordinate System of Input Coordinates

Description:

Projected Cocrdinate Systern:
Name: WGS_84_LITM_sone_19H

Geographic Coordinate System:
Name: GCS_WGS_1984

[]5how Details

[]wrarn me iF the resulting layer will have restricked Functionality

Note: If you get the following message, press OK. This message brings to your attention that
there is one or more fields that are not X field or Y-field and can be used as Z-field.

-

Table Does Not Have Object-ID Field

X

The table you specified does not have an Object-ID field so you will not

be able to select, query, or edit the features in the resulting layer, or define
relates for them.

After you create this layer, you can export it to a shapefile or feature class
if you need these functions. To export a layer, right-click it in the Table Of

Contents and choose Data=Export Data. Add the exported data to the
map as a new layer.

Your display should look like the following:

Ay O
ol W SR T

SOUNDG S-57 Attribute
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Note: Make sure that you have installed ESRI’s S-57 reader:
(http://www.esri.com/software/arcgis/extensions/esri-s57/download).

Navigate to the directory containing the ENC files, select SOUNDG file from the ENC file and

press Add.

Add Data

o

Look in:

IETJ USSMAOLM

R E-2ETGD

=]
]

Name:

~JOBSTRN_P [JSBDARE P
=JPILPNT_P EISEAARE A
=PIPSOL_L EISILTNK P

EPYLONS_A EJSLCONS A
~RDOSTA_P EsLcons L
RESARE_A EJSLCONS_P

SOUNDG_P

[

EITOPMAR_P
EJUwTROC P
EIwEDKLP P
EIwReCKS P

11 [

Add

Show of type: | patasets, Layers and Results

VJ { Cancel l

In ArcCatalog, select the file geodatabase in the Data directory folder. Create a new feature

class, right-click the geodatabase and select New then Feature Class.

In the Create New Shapefile window, name the file (“Control_points” in this example), select

“
B Folder 2 Refresh
3 FileGeodatabase T N
3 Personal Geadatabase
m [5] Item Description...
# Database Connection..
- [(f Properties..
dE ArcBIS Server Connection..
{i band_b
S Layer.. band_g
165 Group Layer band_ir
bath_slg

| BB Python Toolbox hath clean
) shapefile... biath_m_1

New Shapefile Et:f’”ﬁz

ath_mikw_m
@ Toolbox Creates a new shapefile biue
dBASE ape_Ann.md
[#]  LAS Dataset it
& Address Locator.. UKHO 3321 jpg
$ Composite Address Locator.. | 7-E4® .
H XML D t

”””””” 5253114.438 Meters

Point as the feature type. Click Next.

Create Mew Shapefile

Marme: Control_points

Feature Type: Paint

Spatial Reference

Drescription:

Geographic Coordinate System:

Mame: GCS_WES_1924

[ Shaw Details

[] Coordinates will contain M values. Used to store route data.
[7] Coordinates will contain Z values. sed ta store 30 data,
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http://www.esri.com/software/arcgis/extensions/esri-s57/download

The control point layer will appear in the Table of Contents window. Right-click on the
Control_points layer and select Open Attribute Table...in the Table Of Contents window.

Table Of Contents o x |.
ec 84
= = Layers
Control_points
Bl Copy

Hl % Remaove

= E Open Attribute Table

The In the Table window, click Table Options > Add Field...

Tahle
Sl

B8 Find and Replace..,

Select By Attributes..,

B
B Switch Selection
]

Select All

Add Field... |

In the Add Field window, type: Name: Depth_m, select Type: Float and press OK.

Add Field =
Mame: Drepth_ril
Type: [Float ']
Field Properties
| Precizion | 0 |
| Scale | o |

In the Table of Contents window, right-click on the control point file and select Edit Features
then Start Editing.

Table OF Contents 2% e
EEELIE &
=l = Layers .S,_
ERl Control pairts| ‘-.D
[El Copy )
B0 X Remove +!
B Open Awi %-5 {
. pen Attribute Table
Inins and Relates 5

@ ZoomTolayer

=0 Visible Scale Range 3
Use Symbal Levels
Selection 3 \p
Label Features w
| EditFeatures v |7 sartEditing ]
|

You may get the following message, press Continue.
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Start Editing

Start editing encountered one or more layers with warnings.
118 ¥ou may not be able to edit some lavers if you continue

| Marme Description

@ Cape_Ann_Soundings_...

Spatial reference does not match data frame,
@ Control_paints

Spatial reference does not match data frame,

[T D0 not show this dislog unless there are errors that prevent start editing

Tip: Double-click error to view additional information

Stop Editing

Note: In case the Create Features window does not appear automatically, select the Create
Features icon from the Editor toolbar.

caor~ [ Nit:b ~ 26 @ [E

Select the Control_points layer in the Create Features window and select Point under
Construction Tools.

Create Features

m
%~ B <Search» - @
Control_points
@ Control_points
[

E’Constructiun Tools

|-:E| Paint

& Paint at end of line

Left-click on the sounding with same depth value (in this example 1 ft soundings)

\L

e
"‘ﬁ‘:
!

VT s
1 \ 5

-_7 et W \.\i

In the Editor toolbar, select Save Edits and then select Stop Editing.

Editor=| » ]_|_F' £l

"7 Stop Editing
B SaveEdits

Move...
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In the Table of Contents window, right-click again on the control point file and select Edit
Features then Start Editing.

Table Of Contents ax ﬁ;n HIE:.
3o8 d e o
= = Layers .xr
= | [T (e
B Copy N
= 0 % Remove %‘1 -'c"
0@ B Open Attribute Table

loins and Relates 3

7 Zoom To Layer

=0 Wisible Scale Range 3
Use Symbaol Levels
Selection 3 \%}’

Label Features

-

| Edit Features || o7 StartEditing "
1

Type the depth value in m under the Depth_m column.

% Table
P E- BB

Control_points
|
' FID | Shape* | Id Depth_m

3 0 | Poirt [ EE|

1 | Poirt a 0

o’

In the Editor toolbar, select Save Edits and then select Stop Editing.

Editor~| » . ~

| =/ stopEditing
[ SaveEdits

Move...

Repeat sampling the sounding (the last eight steps) for every depth groups (updating the table
accordingly).

11.1.4  Satellite layers (Landsat)
Open a Web Browser and go to . Login into your account (the Login button is upper right corner

of the window).
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L

Note: The service is free, but the website requires user to login. Users that are accessing this site
for first time need to register (the Register button is upper right corner of the window).

Zoom into the desired region. Create a square around the desired region by clicking on the
corners of the area. The polygon vertex coordinates will appear in the Search Criteria tab.

TERETTIO. et Nets

Search Criteria Summary (Shaw)

Clear Criteria
1. Enter Search Criteria

To narrow your search area: fype in an address or place
name, enter coordinates or click the map to define your
search area (for advanced map tools, view the help
documentation), and/or choose a date range.

Ponon | s

(42" 300 137N, 071" 14°09°W) | Oplions Overlays A Satellite

E3ED
Frecemmeanes
Degreemtinutesecond o

1. Lab 42° 48' 40" N, Lon: 070" 20' 21" W iR

2 Lat 42° 30' 63" N, Lon; 070° 34' 56° W 7 ”7

3. Lab 42° 43' 59° N, Lon: 071° 04' 21" W /R
| 4. Lat 42° 57" 34° N, Lon: O70° 40" 42" W iR
. =3
Recult Optians
Search rom: 01011920 [ to: 01/18/2013
Search months. (all} -

Alternatively, type in a location you are interested in and the country in the Address/Place
located under the Search Criteria tab and click on Show. Select the site of interest from the list
of possible sites with similar names and the location will be shown on the map.

1. Enter Search Criteria

To narrow your search area: type in an address or
place name, enter coordinates or click the map to
define your search area (for advanced map tools, view
the help documentation), and/or choose a date range

Path/Row | Feature

Fort Myers

[svon [cear |

On the top left side of the screen, click on the Data Sets tab.
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EarthExplorer
Hesta

2. Select Your Data Set(s)

Check the boxes for the data set(s) you want to search.
When done selecting data setis), chck the Addional
Criteria or Resulfs buttons below. Click the plus sign

next to the calegory narme 1o shaw a kst of data sels.
[ Use Dala Set Prefiler (whs T

Data Sel Search:

Expand the Landsat Archive and select L8 OLI/TIRS for Landsat8 imagery and click OK then
click Results.

sewren Crtertn. LRl AdomonaiCrisre | FResuts

2. Select Your Data Set(s)

Check the boxes for the data sel(s) you want 1o search
When done selecting data set(s). chck the Additonal
Criterfa or Resufts buftons bedow Click the pius sign
next 1o the category name 1o show a iist of data sets

Use Data Set Prefilter st T

Dala Sat Search

¥ Digital Maps L]

€0

* Forest Carbon Saes

+ Ghoba Fiueialy

+ Gobal Land Survey

+ O

+ JECAM Bites

+ Land Cover

Landsat Arhive [

{3 LB OLUTIRS Pre-WRS-2
£ L7 ETM+ SLC-off (2003-prasent)
i LT ETM+ SLC-on (1999-2003)

) L7 ETM+ Nl Ground S1a80ns (Search Oniy)
GLeETM
O L1-5M88

Select the Results tab.

EarthExplorer

Search Crtena Data Sels Anditional Crtenia -
4, Search Results
If you selected more than one data set to search, use the
dropdown 1o see the search results for each specific data
sel

Note: You must be logged in to download and onder
SCENes

Show Result Controls

Scroll down and look at the quick view results. Select the download icon of the desired data set.
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Search Crdenia | Data Sels :.mmnn:lcmnl I

4. Search Results

If you selected more than one data set to search, use the
dropdaown 1o see the search results for each specific dala
set

Nore: You must be logged in to download and order
scenes

(43" 0003 N

Show Result Controds =

Data Set
ETM+ (1999-2003) - il oslisiiaiiie

T

Disping 1 03 ©
Entity ID: ELPO11R031_7T19990918

Acquisiion Date: 18-SEF-92
Path: 11
1 Row: 21

Yedd XL ®

Before selecting the image, it is possible to preview the image by clicking on Show Browse
Overlay.

Entity ID: LC80120302015304LGRO0
Coordinates: 4318456 -70.84572
Acquisition Date; 31-0CT-15

Path: 12

Row: 30

$[dld /L7 O

Select Download to display the area you are interested to process.

Entity ID; LC80120302015304LGMO0
Coordinates: 43.18456,-70.84572
Acquisition Date: 31-0CT-15

Path: 12

Row: 30

Yudd AT O

Select Level 1 GeoTiff Data Product and press Download in the Download Options window.

pLLLELE | andsatlook "Natural Color” Image (3.9 MB)
LandsatLook "Thermal” Image (673.8 KB)
LandsatLook "Quality” Image (236.5 KB)

ULLILELE | andsatlook images with Geographic Reference (4.8 MB)

| Download | Level 1 GeoTIFF Data Product (710.6 MB)

Extract your *.zip file into your local directory.
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Note: The bands of Landsat imagery are typically download as separate imagery files in *.Tif

format and not as a single multi-

band image (e.g., WV-2).

Note: In case that disk space is an issue, delete the *.zip file and bands B7 to B11.

Load the satellite data to ArcMap by selecting Add Data... in the main menu.

'i.:!:.:' -

Navigate to your directory and select the satellite images in the Add Data window and select
Add. The Blue, Green and Infrared bands in Landsat 8 are numbers as: *_B2.tif, *_Ba3.tif, and

*_B6.tif, respectively.

-
Add Data

==c=)

Look in:

[E Landsata

- & & aE|

B3 E0e

MName:

Show of type:

LC80190392015049L GMOO_B1.TIF
LCa0190392015049L GMOO_B10.TIF  #  C80190392015049L GNOO_B9.TIF
LC80190392015049LGNO0_B11.TIF

LCE0190392015043LGNOO_B4. TIF
LCE0190352015049L GMNO0_B5. TIF
LCA0190392015049L GNOO_B6. TIF|
i LCR0190392015048LGMOO_ET TIF

. C80190392015049L GMOO_BS. TIF

1 C80190392015049L GNOO_BQA.TIF
718019039201 5049L GNOO_MTL bt

LC80190392015049LGN00_B2. TIF; LC80190392015049LGT

Datasets, Layers and Results ']

[ Cancel ]

Note: If your imagery is not on your computer, you will need to use the Connect to Directory in
order to link your project to your computer.

=

|

In case you are asked to create pyramids, press Yes for each image you open.
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[

\
Create pyramids for LC80190392015048L GNOO_B2.TIF (7591 x 7751) |

This raster data source does not have pyramids or contains insuffident pyramids.
Pyramids allow for rapid display at varying resolutions.

Pyramid building may take a few moments.
Would you like to create pyramids?

About pyramids [ Yes 1 l No I l Cancel
Pyramid resampling technigue Mearest Neighbor -
Pyramid compression type Default -
Compression quality 75

[ use my choice and do not show this dislog in the future,

-

The satellite imagery will be loaded with black background (typically, background pixel value is
0).

Right click on the image layer and select the Properties... button.

i K|

Layers

[ QL CA01507

. § L CE01007 ® Copy
Value
High ® FRemove

Liowi = €
Joins and Relates 3

= @ Lcaonsod & Zoom To Layer
Value

High:| 48 Zoom To Raster Resolution

L Vissble Scale Range 3
e |
Data »
- [ LCamsas Edit Festures "
dalue s =
High save As Layer File.
W' Create Layer Package..
Low:Uns  Propertiss.

In the Symbology tab, check the Display Background Value box (in this case black is when the
value is 0).
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|Geﬂeﬁ\ |Source | Key Metadata I Extent | Display‘ Symbology ‘
Show:
= Stretch values along a color ram =
Unique Values o 4 @
Classified
Stretched -
Discrete Color
Color Value  Label Labeling
2406 igh : 24106
I 0 Low:0 3
e -
I [¥]Display Backqround Value: 0 I as[ ]+ L4
R/ []Use hillshade effect 1 Display NoData asD
] Stretch
Type: [FEVCEHt Clip 'I [ Histograms ]
. min: ~ 0.25 max:  0.25 [ invert
- S
sbout symbalaay Apply Gamma Stretch: 1.4770: i
o) o) o)

Press the Apply button and then the OK button in the Layer Properties window. Now the layer is
without the black background. Repeat steps to remove background for the other layers.

Save the project by selecting File/Save in the main menu.

@ Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
(9 New.. Ctrl+N
B Open.. Ctrl+0

‘ Save Cirl+S

11.2 Land/water separation

Note: There are several ways to calculate a threshold value for land/water separation. Two
common options are: 1) Profile, and 2) Identify. A recommended approach is using the profile
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option, however this approach requires 3D Analyst (not all users have this option under their
current ArcMap license).

11.2.1 Identifying the threshold values

Option 1: Profile using 3D Analyst (if available)

In the 3D Analyst toolbar, select the infrared band (*_B6.tif in Landsat 8).

30 Analyst

3D Analyst =

Press the Interpolate Line icon in the 3D Analyst toolbar.
=
Lis¥

Make sure that the infrared band is visible in the project. Using the left button, draw a line that
crosses from land (bright areas) into the water (dark areas). Finalize the line by double-clicking
the left button.

After drawing the line the Profile Graph icon in the 3D Analyst toolbar will be active. Press the
Profile Graph icon.
o, -

The result will be a plot that can be used to extract the land/water threshold. The smooth section
with low values represents water, whereas the fluctuation high value areas represent land. In this
case, the threshold value is around 5750, above the highest pixel values of the water.
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Profile Graph Title

Profile Graph Title

16,000
15,500
15,000
14,500
14,000
13,500
13,000
12,500
12,000
11,500
11,000

|

10,500 |
|

)

10,000
9,500
5,000
8,500
5,000
7,500
7,000
£,500
£,000

5500 ————— e

T T T T T T T T

o 00 1,000 1,500 2,000 2,500 3,000 3,500
Frafile Graph Subtitle

Option 2: Identify function

Activate only the infrared band (*_B6.tif in Landsat 8).

Table Of Contents
8oE&d
= £ Layers

=] LCB0120302013266LGN00_BSTIF

Walue
High : 65535

Low: 0
= [ LC&120302013266LGN00_B2.TIF
Walue

High : 63333

Low: D

High : 42944

Low: 0

Select the Identify icon

Click on several locations over the water and write down the values. Then, click on several
locations over the land and write down the values. The threshold value should be between the
water values and the land values (note: make sure you write down the Pixel Value).
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Identify O x

Identify from: | <Top-rast layer> =
E--L(_:8012DSD2013266LGNDD_B|5.TIF
L5207

E3/I|
Location: 359,954,210 4,724,690.615 Meters 2
Field Yalue
Stretched walue 94
Pixel value 5297

11.2.2 Water body extraction

Select Spatial Analyst Tools / Math /Float from the toolbox.

= @ Spatial Analyst Tools
+ W Conditional
+ p Dersity
+ & Distance
+ & Extraction
+ & Generallzation
i & Groundwater
+ W Hydrology
o & Interpalation
# & Local
# & Map Algebra
= & Math
+ W Bitwisa
+ & Logical
+ & Trigonometric
“, Abs
Divice
Exp
Expl0
Expz
Float

A kR NN

In the Float window, select the infrared band *_B6.tif in Landsat 8) and type in an output raster.

Press OK.

Input raster or constant value

| LC80190392015049L GNOO_B6.TIF | @
Qutput raster i
C:\Working\5DB\PanamaCity\Data\PanamaCity04142015.gdb'\Band_IR @ i
[ OK ] [ Cancel ] [Environmems... ] [ << Hide Help ]

Repeat this step also for the blue *_B2.tif in Landsat 8) and the green *_B3.tif in Landsat 8)

bands.




Input raster or constant value

I LCA0190392015049LGN0O0_B2.TIF

Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\band_b

[ OK ] [ Cancel

Input raster or constant value

I LCA0190392015049LGN0O0_B3.TIF

Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdbband_g

Next, apply a low pass filter (LPF) by selecting Spatial Analyst Tools / Neighborhood / Filter

= @ Spatial Analyst Tools

+ & Conditional

= & Density

= & Distarce

+ & Extraction

+ B Generalization

# & Groundwater

+ & Hydrology

+ & [nterpolation

+ & Local

« & Map Algebra

= & Math

+ & Multivariate

= & Neighborhood
“, Blodk Statistics
8| ter
“. Focal Flow

In the Filter window, select the infrared band in float format. Also, make sure that the Filter
type (optional) is LOW. Press OK.

Input raster

Filter type (optional)

-
|Band_IR 51 @
Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\Band_IR_LFF =
Low -

Ignore MoData in calculations {optional)

[ OK I I Cancel ] [Enviranmenis... ] [ Show Help ==

Repeat this step also for the blue and green float files.
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Input raster

|band_g
Output raster

C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\Band_g_LPF =
Filter type (optional)

Low -

dgnore: NoData in calculations (optionalk

[ O J [ Cancel ] [Envimnmems... ] [ Show Help => ]

5, Filter

Input raster i

| band_b

Output raster
C:\Working'\SDB\PanamaCity\Dats\PanamaCity04142015.gdb\Band_b_LPF

Filter type (optional)
Low -

lgnore MoData in calculations (optional)

[ oK ] [ Cancel ] [Envirunmems... ] [ Show Help »> ]

& — =

Remove the land from the blue and green imagery, by selecting Spatial analyst
Tools/Conditional/Set Null in the Toolbox window.

=& Spatial Analyst Tools
=& Conditional
“, Con
"\% Pick

Fill the Set Null window as follows for the blue band and press OK. Make sure that the threshold
value in the expression is the value calculated from the IR band.

£, Set Null =R

Input conditional raster

-
| Band_IR_LPF |
Expression (optional)

‘ralug’ > 5750
Input False raster or constant value

[Band_B_LPF ~|
Output raster

ENG_drive\satelite_Derived_bathymetry\SDE_13274.9db\UW _Blue

[ (o4 ] [ Cancel ] [Enwmnmentsm ] [ Show Help > ]

Repeat this step also for the green band.

. setal = e
Input conditional raster B
[Band_IR_LFF ~]
Expression (optional)

“value' = 5750

Input False raster or constant value

[Band_6.LFF =]

Qubput raster

E:\G_drivelSatelite_Derived_bathymetry\SDB_13274,gdb\ W _Green )
ok | [ cancel | [Emvironments... | [ showtelp =5 |
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Note: The new green and blue layer should contain areas only water body areas.
11.3 Applying the SDB algorithm and calculating extinction depth

11.3.1  Applying the SDB algorithm

Select Spatial analyst Tools / Map Algebra / Raster Calculator in the Toolbox window.

=@ Spatial Analyst Tools
& Conditional
& Density
& Distance
& Extraction
& Generalization
& Groundwater
& Hydrology
& Interpolation
& Local
=& Map Algebra

In the Raster Calculator window, write the following command: Ln ( ""UW _blue™ )/ Ln (
"UW_green™ ). Name the Output Raster: Bath_alg.

‘K\ Raster Calculator

I Map Algebra expression i

Layers and variables - Exp2 -
{>UW_green Float

Sowon 2 Eled(e] [ elfed -
Surdsin (e i) el

{Band_g_LPF Logi0

<{>Band_IR_LPF B. Log2

{>band_a Mod

Stendy o I [ I | = -

Ln{"UW_blue™ /Ln{"UW _green”)

Output raster
C:\Working\SDB\PanamaCity\Data \PanamaCity04142015.gdb\Bath_alg

QK ] [ Cancel ] [Environmams... ] [ Show Help =>

For visual inspection, right-click on the “Bath_alg” layer from the Table of Contents and select

properties.
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Table Of Contents B

EEELE

= = Layers

SR
F Copy

Rernowe

Qpen Attribute Table

Joins and Relates 3

0 & i x

Zoom To Layer
Zoom To Make Visible

B

Zoorm To Raster Resolution

Visible Scale Range »
Data 3
Edit Features »

Sawe &s Layer File..,

LR

Create Layer Package...
WITF 3

O Properties..

In the Layer Properties window under the Symbology tab, set the color ramp Stretch:
Standard Deviations as follows and press OK.

Yalue Label

Caior I
. LOEIS pgh: L0192

[Cugiay Backgroundvalie: | o (]
[T o hikshacie effect =1 ] Desplay ot 2sl ]|
Skretch
Tyee:  [sandand Devasonn =) [ tegems |
n 25 [ grvere
|7 Apply Gamma Stresch: | 1 =

In the Table of Contents, drag the chart layer above the Bath_alg layer. It now possible to
compare the algorithm results with the chart.

281




Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
0 New.. Ctrl+N
B Open. Ctrl+0

‘ Save Ctrl+5

11.3.2  Depth of extinction calculation

Select Data Management Tool / Projection and Transformations / Project to convert the
control points from geographic coordinates into a UTM projection (the zone will differ with
location).

ArcToolbox
@ Analysis Tools
B9 Cartography Tools
@ Data Interoperability Tools
= &9 Data Management Tools
&y Archiving
&y Attachments
&y Data Comparison
& Distributed Geodatabasze
& Domains
& Feature Class
&y Features
&y Fields
% File Geodatabase
& General
& Generalization
% Geodatabase Administration
&y Geometric Network
&y Graph
&y Indexes
&y Joins
& LAS Dataset
&y Layers and Table Views
&y Package
&y Photos
=] %g Projectiens and Transformations
B Raster
5! Batch Project
‘l‘% Convert Coordinate Notation
"’“ Create Custom Geographic Transformation
"'“ Create Spatial Reference

"\ Define Projection

"\ﬁ Project

In the Project window, Type “Control_points_UTM” as the Output Feature Class and select the
Output Coordinate Systems as: WGS_1984 UTM_zone_19N for this example.
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“ project e

Input: Dataset or Feature Class -
Cape_finn_soundings_CSW j @l
Input Coordinate System (optional)
GCS_WGS_1954

Cutput Dataset or Feature Class

E:\G_drive\Satellite_Derived_bathymetry}SDE_13274, gdb\Contral_painks_UTH
Cutput Coordinate System -
WES_1954_UTH_Zone_L9H P

QK | | Cancel ‘ |Enwr0nments... | | Show Help == |

Note: The input Dataset name will vary according to the method you created your control point
dataset.

Note: In order to NOT select soundings over “false bathymetry” caused by sediment turbulence,
a polygon will be created based on a visual inspection of the algorithm layer.

Right-click again on the “Bath_alg” layer from the Table of Contents and select properties.

Tahle Of Contents 5
ZI 8SE B
B = Layers
Sll ot o
B Ccopy

X Rernowe

Joinz and Relates 3

& ZoomToLayer

1’@ Zoom To Raster Resolution

Wisible Scale Range 3

Data 3
=0

Edit Features 3

<7 Sawe fs Layer File.,
W’ Create Layer Package...
NITF 3

& [l&r Propetties..,

In the Layer Properties window under the Display tab, set the Transparency: 50%o as follows
and press OK.
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Layer Praperties =

| General | Source | Extent| Display | Spmbology

[ Show MapTips
[Tl pisplay raster resolution in table of contents
] Al interactive display for Effects toalbar

Resample during display using:

[Mearest Meighbor (For discrete data) -

Orthorectification

Cortrast: .
= 0 o [ orthorectification using elevation

Brightness: 0 % (@ Constant elevation: l:l
Trapsparency: 5 % DEM I@UW Green -

Elevation adjustment

Display Quality

7 Facter: 1
Coarse Medium Mormal
Geoid: &
[ ok ][ caneel | apew

Make sure that you see the control points over the SDB algorithm.

In ArcCatalog, select the file geodatabase in the Data directory folder. Create a new feature
class, right-click the geodatabase and select New then Feature Class.
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Name the file "ref_mask", select Polygon Features as the feature type. Click Next.

Select a coordinate system from the Layers dropdown. Click Next three more times and then

click Finish.

B B3 Satellite_Derived_bathyrnetry
W-}SDB 13274.adb

[ Bl Copy

B
i g e Refresh
B
% & Administration 3
4 B :
Distributed Geodatabase 3
i 5
0 Feature Dataset... | Mews 4
] Feature Class... | Impaort J
Table... Evnnrt N
Mew Feature Class
endice.,
Relationship Class... Create a new standalone feature
class or a new feature class in this
Raster Catalog... feature dataset,
Raster Dataset... . . .
. Disahled if wou are using a Basic sh
Mosaic Dataset.. license and you have right-clicked [’ P
[0

Toolbox

Address Locator.,

e FBF L

Nare:
Alias
Type

a feature dataset containing data
fypes that cannot be created or
edited using a Basic license, such
as topology.

Cormpaosite Address Locator., E -

W QFeEn

Type of features stored in this feature class:

IPob'gun Features

Geometry Properties

[ Coordinates include M values. Used to store route data
[] Coordinates include Z values. Used to store 3D data

< Back Next >
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MNews Feature Class

Type here ka search

Chaoose the coordinate spstem that will be used for XY coordinates in this data.

Geographic coordinate spstems use latitude and longitude coordinates on a spherical model
of the earth's surface. Projected coordinate sypstems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system.

MECE N 2R

Cj WGS 1984 UTH Zone 13N
Cj WES 1984 UTM Zone 14N
Cj WES 1984 UTM Zone 15N
(:} WES 1984 UTM Zone 16N
Cﬂ WES 1984 UTM Zone 17N
Ci WGS 1984 UTh Zone 18N

4 UTh e 1490
Ci WGS 1984 UTh Zone 200
Cﬁ WGES 1984 UTh Zone 21N

A WIS A0 4 1ITh g T 3301

Current coordinate system:

WES_1984_IUTM_Zane_L9N
WEID: 32619 Authority: EPSG

Projection: Transverse_Mercator
false_easting: 5000000
false_northing: 0.0
central_meridian: -69.0
scale_factar: 0.9996

latitude_of _origin: 0.0

Linear Unit: Meter (1,0}

m,

l < Back I[ Next >

]I Cancel ]

Right-click the ref_mask layer and select Edit Features then Start Editing.

Tabile Of Contents

® B 11389 X

B Bath_al o

vall "
W Higl

Low

[El

Copy

Remove

Open Atribute Table

Jains and Relates v
Zoom To Layer

Visible Scale Range v
Edit Features »

You may get the following message, press Continue.

O

o5

- +
7 ‘Start Editing

L
TR iy
et

)

-

Start Editing

/7o Start editing encountered one or more layers with warnings.
{ ¥ou may not be able to edit some layers if you continue.

| Mame

Description

=
[

ij Cape_ann_soundings_...

Spatial reference does not match data frame.

Tip: Double-click error ta view additional information

[T Do nat shaw this dialog unless there are errars that prevent start editing,

[ Continue | ’Stog Editing I

In the Create Features window, select the Ref_mask feature and select the Polygon option in the

Construction Tools window.
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Create Features 8 x

T - B <Search> v @

ref_mask
[Iref_mask

SOUNDG_UTM
@ SOUNDG_UTM

0
[ construction Tools

‘Q Palygon

o Rectangle

O circle

< Ellipse

@ Freehand

L] Auto Complete Polygon
<l Auto Complete Freehand

Note: In case the Create Features window does not appear automatically, select the Create
Features icon from the Editor toolbar.

Editor = || | Nb:.ch -~ 2 BN

Digitize the areas considered clean from sediment plumes by visually determining a polygon
around the clean area. Make sure to extend the polygon into the deep water in order to calculated
the extinction depth. Double-click to finalize the polygon.

Note: In addition to turbid areas, the near-shore bottom presented on the chart should look
similar to the SDB result. Make sure to avoid digitizing near inlets as the bottom is very dynamic
and the sounding may differ from the SDB result.

In the Editor toolbar, select Save Edits and then select Stop Editing.
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Editor=| » * [ /] 41

"/ Stop Editing
F“ Save Edits

Move...

In ArcToolbox, select Analysis Tools/Extract/Clip.

ArcToolbox
ArcToolbox
©3 2D Analyst Tools
= B Analysis Tools
= B Extract
%, SEleC
"\\‘ Split
"\Q Table Select

For the Input Features select the point feature file (SOUNDG), ref_mask for the Clip Features
select and name the output feature class to points_extract.

., Clip = | =
-
Input Features
N -+
|C0ntr0|_p0|nts_UTM ﬂ
Clip Features
|ref_mask j
Qukput Feature Class
E:\G_driveSatelite_Derived_bathymetry|SDE_13274,gdb\Points_extract]
#¥ Tolerance {optional)
Meters hd -
[ OF ] [ Cancel ] [Environments... ] [ Show Help == ]

In ArcToolbox select Spatial Analyst Tools/Extraction/Extract Values to Points. This
function will allow to sample the algorithm result based on the point feature (point_extract).

= By Spatial Analyst Tools

& Conditional

& Density

%‘; Distance

= & Extraction
‘{Q Extract by Attributes
‘;“ Extract by Circle
‘{ﬁ Extract by Mask
;\ Extract by Points
‘;“ Extract by Polygon
‘{ﬁ Extract by Rectangle
A Bachhaikelbiab el baallaints

‘{% Extract Values to Points

Select points_extract for Input point features. Select the algorithm results (Bath_alg) for Input
raster. Rename the output feature class to point_alg and press OK
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‘{Q Extract Walues to Points

Input paint features

| Points_extract

Input raster

|Bath_a|g

Qutput point Features

E:\G_drive\Satelite_Derived_bathymetry\SDE_13274.gdblPaint _alg

(]

alt

[ &ppend all the input raster attributes to the output point features (optional]

[ Ok ] [ Cancel ] IEnvironments... I [ Show Help ==

Right-click the point_alg layer and select Properties.

R i |
Table Of Contents Tx| no 0 aa®
8¢E = e @ o@®
EEELE S
= Layers ~|laa® '. .-.1
@ T corr
L]
. X Remoave
= points_e:
& B Open Attribute Table
= SOUNDG Joins and Relates 3
& & Zoom To Layer
= & ref_mask
= Visible Scale Range 3
SOUNDG
o & Bath_alg Use Symbol Levels
Value Selection »
High: Label Features
Low:0 Edit Features »
O AIS_poin g Convert Features to Graphics..
O AIS_pain Convert Symbology to Representation...
0 M_QUAL| Data ,
D SOUNDG o, Save As Layer File...
O M_QUAL| _
O UW Blue W’ Create Layer Package...
O UW,Gree‘ [ Properties...

Select the Fields tab in the Layers Properties window and turn off (uncheck) every field except

for the depth measurements (Depth or DEPTH_M, depend on the control points) and the
algorithm results column (RASTERVALU). To turn a field off, click the checkboxes off and

click OK.

Layer Properties @
| General | Souce | Selection | Display | Symbology | Fislds | Diefinition Guery | Labels | Joine & Relates | Time | HTHL Popup|
= EH 4+ - &" Options =
Choose which figlds will be visible =] Appearance
[ oBIECTID Alias Depth
[ shaps Highlight Mo
[ Lang MNurmber Format Murneric
[T Lat Read-Only Mo
-1 Field Details
RASTER¥ALU Data Type Double
Marme Depth
Precision 0
Scale 0
Allow NULL Walues es
0K ] [ Cancel ] [ Apply
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Right-click the point_alg layer and select Open Attribute Table.

Table Of Contents P
0 o8

Layers |

2 (Y _
* ¥ Lopy

[ peints_ext| X Remove
) |l Open Attribute Table

O S9UNDG Jomg and Relates k

The attribute table should contain only the depth column and the RASTERVALU column.

Table
ERE =L
point_alg
DEPTH_M | RASTERVALU
» 5.4 1.01436
[:] 1.015355
5.1 1.014404
19.8 1.019569
57 1.013836
57 1.014791
57 1.014483
17 1.019472
21 1.01542
10.9 1.018564
5.1 1.01423%
5.4 1.015377
14.3 1.019204
146 1.019185
PR 1+ 1 [E]E] 0 outof 153 Selected)
point_alg

Note: Make sure to select both column by clicking on the field headers.

Open the Table Options in the Table window and select Export.

Tahle
Sl ML

B8 Find and Replace..,

Select By Attributes...

Swvitch Selection
Select Al

Add Field..,

Turn &ll Fields On
Showr Field Aliases

KH B oL

Arrange Tahles 3
Restare Default Colurmn Widths
Restare Default Field Order

lains and Relates 3

Related Tables 3

E

Create Graph...
Add Table to Layout
Reload Cache

@

Print...

Peport I3

Export...

Select a destination folder to save the exported data through the Browse folder icon.
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r 5
Export Data @

Export: | All records v]

Use the same coordinate system as:
this layer's source data
the data frame

the feature dataset you export the data into
(only applies if you export to a feature dataset in a geodatabase)
Output table:

C:\Working".SDB\Panama City"Data"Point_Export dbf

J

Select Save as type: dBASE Table and name the file Point_Export.

.
Saving Data

Look in: [@ Home - Chart_Adequacy'\Proces v] « & L_{_ﬁ| == v| g| B @

[ ProfileGraphData
==l point_export.dbf
point_export_2.xlsx
==|point_export_2.dbf
point_export_3.xlsx
==l point_export_3.dbf

MName: Point_Export.dbf
Save as type:  |dBASE Table v] [ Cancel ]

Select No when it asks to add the new table to the current map.
ArcMap ——

l i Do you want to add the new table to the current map?

Note: The next steps are in MS Excel.

Open MS Excel.

Open the saved "Point_Export.dbf” file in MS Excel. In the Data tab, select Sort.




BEEH S Export_Output_2 - Excel
(T3 HOME INSERT  PAGELAYOUT ~FORMULAS ~ DATA  REVIEW VIEW  Acrobat

| Y b o = T [Elconnections 4, [TTH =¥ [ [-N_] v = ] ME €18 &5
ez B B oL S E M X B B o 48 &
From From From FromOther  Existing  Refresh - 7 sof g Textto Flash Remove  Data  Consolidate What-f Group Ungroup Subtotal
Access Web Text Sources- Connections All~ . T Advanced  Columns  Fill  Duplicates Validation - Analysis - - -

et Extemnal Data Connections Sort & Fitter >ata Tools Sutline

In the Sort window, Select RASTERVALU as the Column and Smallest to Largest as the Order.
Press OK.

Sort X
My data has headers

Column Sort On Order
sorthy |RasteRvAl | [v] |values Smallest to Largest []

+§lAdd Level “ < Delete Level “ El3 Copy Level I

Delete all values of -9999 (that represents no data) under the RASTERVALU cell and the
corresponding Depth cell by right-clicking the highlighted cells and selecting delete. Then select
shift cells up.

A B C o) E
1 |Depth RASTERWALU
2 0.30000000000|  -3993,00000000000
3 1.20000000000  -3993,00000000000
4 150000000000 1.009655}1700
5 150000000000 1010321 Delete -7 =]
& 1.20000000000 1.010825] Delete
7 0.30000000000 1.011298] ) shift cells left
g 0,30000000000 1.011457
9 150000000000 1.012082{ © v
10 0.60000000000 1.012284{ (O Entire column
11 0.30000000000 1.012406
12 150000000000 1012466 ok | [ cancel
13 2,70000000000 101268160393
Select again Sort in the Data tab.
BEEH S Export_Output_2 - Excel
(3013 HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Acrobat
BHE D B DE-a0 Y SEHH X - B =2 BEE
L T e e 5oL 20 e 0 T - L i e g S
Get External Data Connections Sort & Filter ata Tools Dutline

In the Sort window, select Depth as the Column and Smallest to Largest as the Order. Press
OK.
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Sort @ ﬁ
+§l Add Level ” xgelete Level “ EE Copy Level ” My data has headers

Column Sort On Order

E Values E Smallest to Largest E

o ) [ema ]

Note: In case of using survey data, make sure to round the depth values to one decimal point.
Otherwise, each depth point might have its own unique value.

Select the Advanced option under the Data tab.

EH S Export_Output_2 - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Acrobat
LR R = T [ connections =T Y A mm v = | e €0 —[—'
A ) Al (Z]A = n= E 1S (512 |
‘_Ei & ly Lo |_ ‘ o 2 [al2) EE= 2E ® Eng 2 et BE

from Ffrom From From Other  Existing  Refresh ) f| Sort  Fitege = Textto Flash Remove Data  Consolidate What-If « Group Ungroup Subtotal
Access Web Text Sources~ Connections All~ : T Advanced Kolumns Fill  Duplicates Validation - Analysis = - -
Get Sort& 9

et External Data Connections sols utline

The default Advance Filer window will show the cell range of the whole dataset. Modify the

List range to only the A column, type Copy to: E:E, check the Unique records only box, and
press OK.

Advanced Filter @IéJ Advanced Filter M

Action Action

(7 Filter the list, in-place

) Fil er e I . Diace
(@ Copy to another location

l List range: SAS1:SAS158

@ Copy to another location

List range: EASI:SESISS

Criteria range:

Criteria range:

Copy to:

[ Unique records only

Column E will have all the depth values organized.

Ii‘_] Point_Export.dbf

A B c D B F

1 |DEPTH_M RASTERVALU DEPTH_M

2 4.50000000000 1.01386141777 4.5
3 5.10000000000 1.01440405846 5.1
4 5.10000000000 1.01423859596 2.4
5 5.10000000000 1.01387035847 57
6 5.10000000000 1.01426672935 6.0
T S TN 1 NMA7RT7AANG [y}

Type in cell D1 the text Average, and type the following term in cell D2:
=AVERAGEIF(A:A,E2,B:B) and press Enter.
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D2 ~ fr | =AVERAGEIF(A:AE2,B:B)

A B C D E F
1 |Depth RASTERVALU Average Depth
2 0.1 1.00370049477 1.006927. 0.1
3 0.1 1.01015424728 0.3
4 0.3 1.00115084648 0.6
5 0.3 1.00124955177 0.9

Drag the results of the cell D2 (bottom right corner) down to the end of the depth value list
(Column E).

A B C D E
1 Depth RASTERVALU Average Depth
2 0.1 1.00370049477 1.00693 0.1
3 0.1 1.01015424728 1.0069 0.3
4 0.3 1.00115084648 1.00568 0.6
5 0.3 1.00124955177 1.00442 0.9

Select Columns D and E. Under the Insert tab, select Scatter/Scatter with only Markers.

m Home Insert Page Layout Formulas Data Review View Acrobat

ERENEEITR - X X 120

PivotTable Table Picture Clip Shapes SmartArt Screenshot | Column  Line Pie Bar Area |Scatter| Ot
- Art - - - - - - - - |che

Tables Ilustrations Charts Scatter

E1l - J~ | DEPTH_M °,
[r——— e

The results will show a linear line at shallow depth that start to curve vertically at deeper water
values. Identify the curve value and mark it in you file sheet as the “Extinction Depth” (Although
the image show an extinction value up to 10 m, we will use 8.2 m in this example to avoid
ambiguity).

30.0
L]
o
L]
“
250 s ¥
L] ’..
of
Y.
200 * %
L]
° *
P,
e %,
150 F4d
s ¥
8’
S
10.0 a
e®
%
. L]
5.0 ;s *% "
. . ¢
e® o *,
* .
oo e © Te
1.0110 1.0120 1.0130 1.0140 1.0150 1.0160 10170 1.0180 1.0190

Note: The x-axis is the SDB result and the y-axis is the charted depth.

11.4 Vertical referencing

11.4.1 Calculating the gain and offset
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Select all the depth values and SDB values from columns D and E that are below the Extinction
Depth (it also recommended to start at depth values above 1 to 2 m, depending on the site).

fyerage Depth

1.0114 0.3

1.0141 0.6

1.0136 0.9

1.0140 1.2

1,0125 1.5 SDB Average Value

1.0151 2.1 20

1.0146 2.7

1.0147 3.0 8.0 . <
1.0150 3.3 . "
1.0143 3.6 o .
1.0148 3.9 o N

1.0156 4.2 . °

1.0157 4.5 50 .«

1.0164 4.8 .

1.0061 5.1 a0 - .

1.0163 5.4 ¢ .

1.0167 5.7 50 o

1.0169 6.0 20 .

1.0169 6.4 .

1.0171 6.7 10 L

1.0173 7.3

1,0175 TE 0o

10172 79 1.0120 1.0130 1.0140 1.0150 1.0160 1.0170 1.0180
1m7? A7

You will receive a scatter plot that will be a linear line, right click on one of the markers and
select Add Trendline...

g%

Delete
¥ Resetto Match Shyle
11 Change Series Chart Type..
Select Data..,

Add Data Labels 4
35 Add Trendline...,

04 Format Data Series...

Make sure the Trend/Regression Type is linear. Check the Display Equation on Chart and
Display R-squared value on chart boxes and press Close.
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The resulting equation of the trend line is used for the referencing (in this example, the gain is

Format Trendline

[ Trendline Options |
Line Color
Line Style
Shadow

Glow and Soft Edges

Trendline Options
Trend/Regression Type

) Exponential

@ Linear

) Logarithmic

& Polynomial Order: |2

) Power

B I

() Moving Average Period: |2

Trendline Name

@ Automatic : Linear (Average)

@) custom:

Forecast

Eorward: (0.0 periods
Backward: (0.0 periods

[[] setIntercept = |0.0
Display Equation on chart
Display R-sgquared value on chart

1393.8 and the offset is -1141.1).

8.0

8.0

7.0

6.0

50

4.0

30

20

0.0
1.0120

10130

SDB Average Value

w=13938x- 14111
R*= 08752

1.0140 1.0150 1.0160

1.0170

10180

Save the Excel Spread sheet into the Data directory as Extinction_Depth.xlIsx. (Excel Workbook

in Excel 2007).
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File name:  Estinction_Depth.slse

[&] Save i — - ]
'-;)\_,,' | » My Lon-uulfn * qduu_l_l_ft-] ¥ Workng ¢ SDE ¢ PanamaCity ¢ Dala ¢ 'y|| |
Oiganize » Mew folier
(] Microscé t Excel Diate madified T
Panamadity(414 20 5.9d0 WIG201512:23 AM  File Tolder
onds
2 Recert Places
B Deskdop
4 Libraries

Save as type | Bxcel Warkboak (".xlsx)

= Hude Folders

Authors: John Barber

Tooks v [ Swe |

11.4.2

SDB - Applying the gain and offset (referencing)

In ArcMap, select in the ArcToolbox Spatial Analyst Tools/Map Algebra/Raster Calculator.

= & Spatial Analyst Tools
& Conditional
& Density
& Distance
& Extraction
&; Generalization
& Groundwater
& Hydrology
& Interpolation
& Local
a &: Map Algebra
’QQ Raster Calculator

Select the algorithm layer and multiply the algorithm layer by the gain value from the excel
sheet, and then subtract the offset value. Save the file as "calc_bathy" and press OK.

ﬁ Raster Calculator EI@

Map Algebra expression

Layers and variables = Conditional =
Syl A EEE ) u
<>UW_Green ! Pick.

Suar ()] (o]

{>Band_B_LFF Math

~
Qurdeor (] o
Band_IR_LPF -

o e ] -
{13935 * ( "Bath_alg" 1) - 1411.1
Dukpuk raster

E:\a_driveiSatellite_Derived_bathymetry\SDE_13274.gdbiCalc_Bathy| i

[ [a]:4 ] [ Cancel ] [Environments... ] [ Show Help == ]

297




Using the Identify button click on a few “point_alg” point (make sure that Identify from:

Visible layers) and compare the values.

Identify

Identify fom: | <Visible layers> &1

=) -point_alg
02261F92FB600001
=-11383_L.KAP

- calc_bathy
- 8,196167

Location: 633,557,531 3,323,218.292 Meters el

DEPTH_M

RASTERVALU 1.017054

1

Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
(9 New.. Ctrl+N
EY Open. Ctrl+0

| Save Ctrl+S
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Chapter 12.0  Digital Terrain Map Editing (DTMediting V1.6)

Contributed by Chaim Keller, The Chai Tables, Israel, and John K. Hall, Geological Survey of
Israel (Retired), Israel

Purpose: Editing of digital terrain map files in 3D.

Supported file formats: (1) Surfer binary version 7 grid files, (2) xyz text height files. (Edited
files can be saved in either format).

Imported File size: Depends on available video memory. For example, a file containing 1024
columns by 1024 rows requires 1.6 Gb of video memory. The program can handle larger files by
breaking the file into tiles. After editing, the tiles can be merged back into a single file.

Editing tools: (1) Multiple types of smoothing tools. (2) Multiple options used for emphasizing
areas needing editing in different color palettes. (3) Tools for raising and lowering heights in a
region. (4) 3D visualization and manipulation.

Platform: Windows

12.1 Toolbar Buttons

(use “F12” key to toggle visibility of toolbar)

Import DTM height file either in Surfer version 7 binary grid file format or xyz ASCII
height file format.

Export DTM height file either in Surfer version 7 binary grid file format or xyz ASCII
height file format.

Circle tool (used for selecting different sized circlular regions for editing).

Rectangular tool (used for selecting varying sized and shaped rectangular regions for
editing).

v Flattening tool. Opens dialog with tools for smoothing, flattening, and filling portions of a
DTM file.

%" Palette tool. Opens dialog with tools for changing palettes globally and locally to aid in
editing.
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o Filling and gouging tool. Opens dialog for use in creating circlar and rectangular mounds
and pits.

v Undo button. Undoes the last editing change.
o8 Magnify button. Increases the vertical exageration by about 10%.

Q Demagnify button. Reduces the vertical exaggeration by about 10%.

€ Help button. Displays this document as a help file.

12.2 Navigation and Editing

rotation - arrow keys,

translation — move — x, + X, -y, +y, move mosue to left, right, bottom, top scene’s borders
zoom — mouse wheel, “z” key (zoom in), “x”” key (zoom out)

joy stick — “space key” + move mouse, or press middle mouse button and drag

commit the edit — left mouse click

12.3 Toolbar Menus

File menu

2 Import DTM height file either in Surfer version 7 binary grid file format or xyz ASCI|I
height file format.

S Open Tile Log file. Opens a log file consisting of the names of tiles generated during
importing an oversized Surfer binary grid file. Individual tiles are listed on the menu and can be
imported by clicking on any of them. Tiles that have been opened once and marked with a
check.

¢a Merge tiles. Used for merging the individual tiles after editing. The indivdual tiles were
produced during importing of an oversized Surfer binary grid file.

Export DTM height file either in Surfer version 7 binary grid file format or xyz ASCII
height file format.
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) Exit the program (You can exit the program more simply by pressing the “ESC” key
anytime.)

Option menu
% Map size. Opens a dialog for redfining the default map size.

B8 Texture size. Opens a dialog for redifining the default textrue size. Smaller textures allow
for finer editing. Larger texures increase the program’s speed.

%" Palette and scaling options. Opens a dialog that can be used for changing the scaling (height
exaggeration) and the palette and heights that define the palette.

« Lighting. Opens a dialog for defining the direction of incident light on the 3D scene.

® Orthographic Projection. Reopens the file with parameters that result in an orthographic
projection (instead of 3D).

"1 Refresh. Redraws the current scene using the last imported file.
Help menu (also use “F1” key when canvas has focus)

©) Help opens quick reference of major menus and commands. Also opens with “F1” key
anywhere in porgram.

12.4 Dialogs (accessed from the File menu)

(Note: hover over item for tooltip)
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Import Heightmap Preferences

Keep temain depth
Stretch image to fit Temain
Impart file determines map size
[ Invert Heightmap

Maxdmum Temain Height (m):
Height scaling factor:

Temain Color (CPU intensive)

Select one (if "Temain Color” checked )
(7) GMT _wysiwygcont {recommended)
(7) GMT_globe (globe colors)

() GMT _seis
@ GMT_rainbow

| Open || Cancel |

Import Heightmap Preferences dialog (above). Opens up when clicking on the Import button
or when reloading a map. Check the “Input file determines map size” checkbox in order to allow
the program to find the optimal map size. Uncheck the “Terrain Color” checkbox to draw the
scene in a grayscale. Check the “Terrain Color” checkbox to draw in color using one of the
palettes listed. Change the plaette used by clicking on the appropriate radio button.

Caolar Palette height boundaries

Height scaling factor:

Madmum Temrain Height {m):
Minimum Temrain Height (m):
Height replacing nulls (m): ICI

| QK || Cancel |

Color Palette height boundaries dialog (above). Appears only if the scene is being drawn with
a plaette. It appears after clicking the “Open” button in the “Import Heightmap Preferences”
dialog and choosing a map file or when reopening a map. The “Height scaling factor” is the
default height exaggeration factor. “Maximum and Minumum Terrain Heights” are the files
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maximum and minimum elevations, respectively. These values define the range of heights used
for defining the range of heights that are painted in uniqued colors. Null values in the input file
are replaced by the height defined in the “Height replacing nulls” textbox.

12.5 Dialogs (accessed by pressing buttons on the tool bar)

Toal Size Tool Intensity [ Use own input

Tool Size Input L
Tool Intensity 72

=

[] Set values above as default

Uze original palette
[ Redffine palette

Select an editing method (@nd fill the required fields):

(7 Smooth the temain

@ Flatten to average elevation of tool’s perpheny

(") Fatten to elevation (m): D

(") Perform running average over IEI poirts

(71 Spline fit {one fit over the the long =xs)

(7 Spline fit {subsequert fits over each xs)

() Clip heights to range: |0 | to |441285 | m)

Tool Preferences (above). Appears when clicking the “Flattening” button on the toolbar (see
above). “Tool Size” changes the size of the tool icons (circular or rectangular). “Tool intensity”
changes the aspect ratio when using a rectangular tool. In order to perform the chosen type of
editing, click on the portion of the map that is in need of editing. Only the region within the
circular or rectangular tool will be edited.

There are seven different types of smoothing tools available.

1. Smooth the terrain — replaces the terrain height with the average height of nine nearest neighbors.

2. Flatten to average elevation of tool’s periphery - extrapolates to the heights within the interior of the cursor
from the heights on the cursor’s border by using a straight line approximation and taking the average over
both directions.

3. Flatten to elevation — substitue the elevations interior to the cursor with the inputed height.

4. Perform running average over n points - interpolate the height at interior points of the cursor from a
running average over n/2 points on either side of the interior point. If the cursor is elongated in one
direction, then a running average is only done in the elongated direction. If there is no cursor elongation,
then the averaged running average over both directions is used.

5. Spline fit over the cursor’s long axis — uses the spline routines of P. Bourke and D. Cholaseuk (see
http://www.flanguasco.org/VisualBasic/VisualBasic.html) along the long axis of the cursor to fit the
interior points of the cursor.
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6. Spline fit over each axis - performs a spline fit of method 5 subsequently in each direction, and then takes
the average of the two fits.

7. Clip heights to range - If a point’s elevation interior to the cursor is larger than the entered range, it’s height
is changed to the entered maximum height. If its elevation is less the entered lower height, the elevation is
set to the minimum height.

Tool Size Tool Intensity  Select one:

[ I |Ise original elevation mnge

[7] Use tool area elevation range
[ Use the entered elevation range

Max Blevation {m) (4412 85
Min Blevation {m) |1144.85
[ Apply globally

Height exaggeration:
Select a palette:

Recale by

(71 GMT _wysiwyge
(7 GMT _globe

(71 GMT _seis

@ GMT _rainbaow

Palette Preferences (above). Opens when clicking on the Palette button on the tooblar. Click
on “Use original elevation range” to repaint areas, whose colors were changed, with the original
colors Click “Use tool area elevation range” to define a local palette based on the range of
heights within the circular or rectangular tool. Click on “Use the entered elevation range” to set
the palette by hand. Click “Apply globally” to apply the new palette globally. A new palette can
be chosen by clicking on one of the four palette options. Change the height exaggeration
(scaling) by adding an integer scale (multiplies the heights). In order to invoke the changes
inputed in the dialog above, click on the map.

Mound Building/Gouging

Toal Size Tool Intensity 7] |lse own input
= Tool Size: Input 56

Tool Intensity 72

[ et values above as default

IUse orginal palette
[ Redifine palette

Tool Preferences (above). This dialog appears when clicking on the “filling and gouging” tool
on the toolbar. The intensity of the filling and gouging is determined by the “Tool Intensity”.
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The region that is filled or gouged is defined by the “Tool Size”. Fill by right clicking on the
appropriate place on the map, gouge by left clicking.

12.6 Dialogs (accessed from the Option menu)

Map Size (rows = columns) .

Select a size (video memary requirements):

(1 128x 128 (requires approx. 25 Mb)

(71256 x 256 (requires approx. 100 Mb)
(7 512x 512 [requires approx. 400 Mb)
i@ 1024 x 1024 {requires appro. 1.6 Gh)
(71 2048 x 2048 {requires approx. 6.4 Gb)

(71 4096 x 4096 (requires approx. 25.6 Gh)

o | o |

Map Size. Appears when clicking the map size menu. Use this dialog to define the default map
size that is limited by the computer’s video memory.

Select a texture size (default: 32x32):;
(71 16x 16 pixels

i@ 32 x 32 pixels

(7) 64 x 64 pheels

(71 128 x 128 pixels

() 256 x 256 pixsis

() 512 x 512 pixels

o [ o |
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Texture Size. Appears when clicking on the “Texture Size” menu. Used for defining the
default layer size. Smaller layers allow for finer editing, but add to the computation time. These
values an only be changed before loading a file.

Lighting Cptions

Select a direction:

(") South East to Morth West
(7 Morth West to South East
(™) South West to North East

@ Morth East to South West

() Morth to South
() South to Morth

oo | conee |

Lighting Options. Used for changing the direction of the ambient light. Appears when
clicking the “Lighting” menu. Experiment with this dialog to produce the best lighting.

Scaling and Palette Cptions

Height exaggeration:

Temain Color (CPU intensive)
Select one (if "Temain Colar” checked )

() GMT_wysiwygcont (recommended)
(1 GMT_globe (globe colors)

(71 GMT _seis

@ GMT_rainbow

IUse the following bounds to set the palette:

Max Elevation {m) D
Min Elevation {m)

[ .
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Scaling and Palette Options. Appears when clicking the “Scaling and Palette Options”.
Change the height exaggeration and or height range for defining the vertex colors. Press
“Accept” to repaint the 3D image using the entered values.

12.7 Brief Manual (for files that can be handled with available video memory)

Click on the “Import” button on the keyboard. Press “Accept”, then choose a file (typically a
Surfer version 7 binary grid file) to load. Press accept, and then press “Accept again” for the
next dialog that appears. The file is then read and plotted. Choose a tool type from the toolbar.
Begin editing by clicking on the “Flatten” tool. Heighlight a region with a new palette by
clicking on the “Palette button” on the toolbar. Change the height exaggeration either by using
the magnification buttons, or by entering an exaggeration scale by hand in the Palette tool dialog
(accessed using the “Palette button”). If the toolbar gets in the way, press “F12” to remove it
from sight (and press “F12” again to make it reappear). When editing is completed, save your
work by clicking on the “Export” button on the keyboard.

12.8 Full Manual

File size considerations

DTMediting can edit any Surver version 7 binary “grd” file size by either breaking up the file
into tiles for indiviudal editing (the individual tiles can be merged at the end of the editing) or by
reducing the resolution of the file to fit into the available memory. So if you need to edit a large
file, then first convert it into “grd” format. The available memory limit is set by the “Map size”
dialog shown above that can be accessed in the “Options menu”. ( The tile option is not
available yet for “xyz” files. However, the map size will be increased to accommodate the
maximum video memory.)

Opening a file

Click the “Import” button (see above for its picture) or the “Import” menu item in the File menu.

The “Importing File” dialog (see above for its picture) appears.

In general, leave the check boxes alone and click “Open”.

A file explorer opens. Choose “grd” format or “xyz” format and then click on the desired file.

The program determines if the file can be handled with the available memory. If it can, the program skips
to step 18. Note that Xyz files can’t be larger than the maximum rows x colunns size that your computer
memory can tolerate. However, “grd” files are not limited to the computer’s memory size. Rather, if the
“grd” file is larger than can be handled with available memory, the following message will appear:

PO
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oo

7.
8.

9.

@ The map size exceeds the maximum size that can be resized
- -

automatically.

(You wil be prompted at a later step to either break the file into tiles, or
reduce its resolution)

Press the “OK” button.

The following dialog appears that can be used to customize the height ranges for determing the color
palette, as well as determining the scale magnification. The program makes a good attempt to determine
these scales automatically. In general, it does a pretty good job, so you can just trust the defaults. Nulls are
usually replaced by zeros. You can the value in this dialog if you wish.

Caolor Palette height boundaries

Height scaling factor:

Maximum Temain Height {m):
Minimum Temain Height {m):
Replace nulls or bad data (m): D

Press the “OK” button.
If you had received the “too large file” warning above, then the following message box will appear

@=% Grid file is too big for avaiable memory. Reduce resclution?

- -

(Hint: Answer 'Mo' to create tiles)

If you want to create tiles of the size set in the “Map size” dialog (see above), then answer “No”. If you
answer “Yes” then the program will reduce the resolution of the file to make it fit into the available
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memory. We will press “No” in order to review the tile creation process (the “Yes” option is
straightforward and doesn’t need further explanation).
10. If the map size was set to 1024 x 1024, then the following dialog will appear:

e

11. Press “Yes” to begin the tile creation process.

12. The program then reports is the root filename of the tiles; press “OK”, and the data extraction process
begins. The first stage of data processing is stuffing the data into the correct 1024 x 1024 data buffer, after
which the 1024 x 1024 tiles are generated one at a time. All along this process, the program reports the
progress. . Warning: this process can take quite a bit of time, depending on data size. As a final step, a tile
“log” file is gnerated with all the names of the tiles and containing information on their ediitng status.

13. After the data processing is completed, the program returns to its resting state.

14. To load the stored tiles, click on the “Open Tile log file” menu item in the File menu (see above).

15. Afile explorer opens with a list of all the “.log” files. Click on the correct one.

16. The individual tiles are then loaded into the File menu as shown below. If a file has been edited, a check
will be present next to its name in the menu. In this way, you don’t have to remember which tiles have
been edited.
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m Pltinme  Llala

P

Import height file

Open Tile log file
Merge tiles

Export height file

Exit

Dead-5ea-entire-binanywy_1_10.grd
Dead-5ea-entire-binarywi_2 10.grd
Dead-5ea-entire-binanyw7_3_10.grd
Dead-Sea-entire-binanyvy_4_10.grd
Dead-5ea-entire-binanvy_1_9.grd
Dead-5ea-entire-binarywi_2 9.grd
Dead-5ea-entire-binaryw7_3_9.grd
Dead-Sea-entire-binanywy_4_9.grd
Dead-5ea-entire-binanwy_1_8.grd
Dead-5ea-entire-binanywi_2_8.grd
Dead-5ea-entire-binanyw7_3_8.grd
Dead-5ea-entire-binanywy_4_8.grd
Dead-5ea-entire-binanviy_1_7.grd

Nead-Sea-entire-hinaree? 2 T.ord

Alt+F4

17. To open one of the tiles for editing, click on its name. The procedure that follows afterwards is identical to

18.

19.

opening a file whose size can be handled by the available memory.

The Color-Palette height boundaries dialog appear (see above). The program usually does a good job in
determining the rescaling factor. So it is usually sufficient to just press the “OK” button.

The program begins to read the file and processes the date for plotting in 3D with the chosen color palette.
This can take some time. After the process finishes, the 3D image of the file appears on the screen ready
for editing. An example is shown below.
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File Options Help

AaE ocldve e 9.8 @

Deadk-Sea-eniire-binaryyi_3_5 g1d

20. The editing tools on the toolbar have now become enabled. Notice the “Coordinates” window on the
bottom right. A continuous readout of coordinates and heights are given as the mouse moves over the
terrain. The name of the file is written on the screen below the “Coordinate” window.

21. There is no one way to successfully edit out artifacts and glitches in the data. We will illustrate a few of
the tools, but in general each terrain will require a different editing method. For this reason, quite a few
methods are provided in this program.

22. Move the terrain around by moving the mouse to the scene’s borders. For example, to move up, place the
mouse on the top border. To rotate, use the arrow keys For much faster rotation control similar to a joy
stick, press the “space bar” while moving the mouse. The terrain will easily rotate in any direction to
follow the motion of the mouse. Zoom in and out with the mouse wheel.

23. We will start our editing by defining a local palette over the region we plan to edit. This will allow us to
magnify the glitches and allow us to follow our progress in editing the out. To do this, click on the
“Palette” toolbar buton (see above). In the picture below, a rectangular cursor was chosen. You can easily
switch between rectangular and circlar cursors by clicking on the circle or rectangle buttons on the toolbar
(see above). The size of the cursor is controled by the “Tool Size”. The shape and direction of the
rectangle is controlled by the the “Rec. Aspect”. Notice how the cursor lies over the terrain, moving up
and down as the terrain changes height. (If a circular cursor was chosen, then “Rec. Aspect” becomes
“Tool Intensity” instead.) If you want to easily change the tool size or aspect during edit, click on the slider
button and use the mouse wheel to change the slider’s value.
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Elle Options Help

@ CcOhw & & @

ToolSizs  Tool Intensty  Select one:

Uss original elsvation range

Uss tool ares elevation range
Use the entered elevation range

M Bevaton (m) (7325 |
i s o)

[ Apply giobaly
Select a palette:

|| XCoordinate: 739654.03

Height exaggeration

Fecsety [ 5228

Y Coordinate: 3436136 95

) GMT_wysivyge
) GMT_globe
) GMT _seis

@ GMT_rainbow

Blevation {m}:-267.01

DEad-Sua-anura-mnaryvf».ij.g'rd

Left click with the mouse to begin calculating a new palette. To define a local palette based on the
maximum and minimum heights within the cursor, click the “Use tool area elevation range” check box (you
first need to uncheck any other checkbox). The picture below shows the result. We can always return to
the original palette defined by the original elevation range by rechecking “use original elevation range”
checkbox. We can also make the palette, defined by the cursor elevation range, universal throughout our
terrain by clicking on the “Apply globally” check box.
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25.

26.

File Options Help

@ CcOhwa 28 @

Tool Size Rect. Aspect  Select one:
Use original elevation range
[¥] Use tool area elevation range

Use the entered elevation range

Mexc Blevation fm)
b vt )
Apply globaly
Height exaggeration.
Select a palette:
i) (©) GMT _wysiwyge
(©) GMT_globe
(C) GMT _seis
(@ GMT _rainbow

We can also change the lighting direction in order to emphasize terrain features. To do that, click the

X Coordinate: 733534.23

Y Coordinate: 3436113.77

Bevation (m):-267.71

DBad-Sua-annra-mnaryvf».ifh.g'rd

“Lighting” menu item in the “Options” menu (see above). The “Lighting Optons” dialog box appears (see

above). Pick a new lighting direction and press “Apply”.

We now begin to edit the selected region by pressing the “Flattening tool” on the toolbar. We will use the
“flaten to average elevation of tool periphery” tool. The result below was optained by flattening first in one
direction, then in the next. We changed directions by clicking on the “Rect. Aspect” slider and moving the

wheel mouse to change the direction of the rectangle. Each time we want to edit, we left click with the

mouse. We also have the “redefine palette” checkbox checked in order to use the new palette we defined in

step 24. We have basically finished editing the chosen region.
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File Options Help

aE Codvea- 268 @

ToolSize  Rect Aspect [ Use own input
Tool Size Input
Rect. Aspect [Bo ]
[T Set values above as defautt

[7] Use original palette:
[7] Redfine palette
Select an editing method (and fill the required fields):
) Smooth the temain
(@) Flatten to average elevation of tool's perphery
€ Fiattento slevation fm)
() Perform nunning average over poirtts.
() Spline fit fone fit over the the long axs)
() Spline fit {subsequert fits over each ais)
(€ Cip heighis to range v m

Daad.nSaamnlué—hm:ryw'_.i_s :ird

27. We then restore the palette in the region by clicking on the “Palette” toolbar button, clicking on the “use
original palette” checkbox (see picture below for the result), redefine the size of the cursor to cover the
entire region in interest, and then left click with the mouse.

File Options Help

aE COnve e 28 @

Tool Size Rect. Aspect  Select one:

7] Use criginal elevation range
{ Use tool area elevation range
Use the entered elevation range
T’ Wiax Elvation )
. Win Blevation fr)
[ Apply globally
e Select = paletis:

Fecoty [5328]

X Coordinate: 739753.80

() GMT _wysiwyge
) GMT_globe
() GMT _seis

® GMT_rainbow

¥ Coordinate: 3436247 21

Elevation fm)-30175

Daad.-Saz-nnme-hm:ryv'f':ij ﬁrd

28. To understand the function of the smoothing tools, see the discussion after The “Smoothing” dialog box
above.
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29. When we are finished editing this tile or file, we press the “Export” button (see above) on the toolbar. A
file explorer appears. The original name of the tile or file is highlighted. We press “Save”, the program
warns us that we are overwriting the original file, we press “Yes”, and the editing we did is saved.

30. We then return to the “File” menu, and notice that the tile we edited is now checked. (see below).

Dead-5ea-entire-binarywi_3_7.grd
Dead-5ea-entire-binarywi_4_7.grd
Dead-5ea-entire-binarywi_1_6.grd
Dead-5ea-entire-binanyi_2_G.grd
Dead-5ea-entire-binarywi_3_6.grd
Dead-5ea-entire-binarywi_4_G.grd
Dead-5ea-entire-binarywi_1_5.grd
Dead-5ea-entire-binanyi_2_5.grd
v Dead-Sea-entire-binanyi_3 5.grd

Mimmdd Crmm mmbies s e R

31. To edit a different tile, we simply left click on the list below of one of the unchecked names. If we try to
click again on the edited tile, nothing happens. To is a safety feature to make sure that your editing is not
lost. If you really want to re-edit it, then click on the name twice. Once to uncheck it. The second time to
reopen it.

32. When all the tiles are edited, merge the edited tiles into a single file by clicking the “Merge tiles” menu
item on the File menu. The default output name is the root name of the tiles with the added suffix “-
merge”. Click “Save” and the process of merging begins. This completes the editing.

A few words about “xyz” format files

Note that in general there are two types of “xyz” files. The first is well-ordered files, e.g., those
outputed by the Global Mapper Program. (Well ordered means that there are no missing x or y
data, and the data is organized in either ascending or descending order). The second type is one
with random xyz entries in no discernable order, or when there are missing entries. This
program can handle both types of xyz files. Appropriate warnings and questions will appear
informing the user of the type of xyz file detected and the required decisions that the user needs
to make. Missing entries are giving the height values determined by the value entered into the
Color Palette height boundaries dialog (see above) in the “Height replacing nulls” text box.

Reopening map files

The DTMediting program keeps track of a maximum of ten height files that have been opened in
the past. These files are recorded in the text file “recent_files.txt” that resides in the program
directory. This file is created after the first height file has been opened by this program. At that
time, a new “Reopen” sub menu appears on the File menu (see picture below). To reopen one
of the displayed files in the sub menu (example shown below), click on it.
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m Options  Help

Import height file

Recpen

@

Open Tile log file
Merge tiles

Export height file

) et Alt+F4

L5 @

Orthographic Projections

An orthorgraphic projection of the currently drawn 3D map can be made by clicking the
“Orthographic Projection” submenu in the “Options” menu. The program will run through the
procedure of redrawing the scene (including most of the dialogs shown in the “opening a file”
section above). The pictures below give an example of the results. (Notice how greyscale
clarifies features in the terrain, e.g., the alluvial fans penetrating into the valley.) These
projections can be edited just like any 3D scene using the editing tools mentioned above. (N.b.,
the source of the terrain is a 1 arcsec, i.e., about 30 meter resoultion, NED DEM file of a portion
of the Sierra Nevada, that has been converted to “grd” format and then split into 1024 x 1024

175.xyz
Dead-5ea-entire-binaryw7_3_4.grd
1753z
Dead-5ea-entire-binaryw7_4_6.grd
175.xyz

Sierras_1_3.grd

Sierras_3_3.xyz

175.xyz

350.xyz

175.3yz

tiles following the procedure mentioned above.)




Brief Program’s source code overview

This program was written in the Game Maker 8.1 scripting language. In that language, programs
consists of “Scripts” (subroutines) and “Objects”. The “Objects” correspond roughly to event
handler routines. They monitor dynamic events caused by the user such as key presses, mouse
clicks, and mouse movement and call the appropriate “Script”. On the program’s onset, the
“oController” object initializes program variables and draws the toolbar and menus. The
“oTerrain” object initializes the canvas. The “oCamera” object initializes the view port. Usually
the first event initiated by the user is to open or reopen a file. The “oController” objects control
the response, and proceed to redirect the program flow to the importHeightMap subroutine that
opens the requested file, or reopens one of the files in the Reopen submenu in the File menu. If
the chosen file is a “grd” file, the file’s data is read by the script importHM_grd. If it isa” xyz”
file, then it is opened by either importHM_ran_xyz for randomly ordered or unaturally truncated
“xyz” files. If the file is well ordered, then the user can decide to read the file’s data by the
routine importHM_xyz routine. The program flows next to the updateTerrain subroutine whose
job is to calculate the shadding and perspective, and then to draw it in 3D (or 2D for
orthographic projections.) The actual terrain editing is done in the in the APIWindows sub
object of the oTerrain object. After editing, the scene is redrawn by the update Terrain
subroutine.

12.9 Download Link (latest program installation package)

http://www.chaitables.com/DTMediting setup.exe

12.10 Download and Installation Instructions for Windows 8 and 8.1

When attempting to download and install the program on Windows 8 (8.1), Windows warns you
that the setup file is not commonly downloaded and could harm your computer. Ignore this
warning and click “Run”. Then an even bigger warning shows up with the message that
“Windows protected your PC”. Ignore this also and click the “More info” link. Then click
“Run anyway”.
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in order to produce an editor for DTMs instead of a terrain generator.) Code for reading binary
files was written by “Walking Code: IsmAvatar”. Code for window type menus was written by
Ravotus (N_Menu dll). The program also makes use of other code and dlls found in
GMLscripts.com and.gmtoolbox.com. In case | forgot to thank someone, let me express my
thanks to all the code sources originating from the Game Maker community.

To do (for someone out there....)

Convert the program to Game Maker Studio compatible code. This will allow for compilation
into native code and hopefully increase the speed of the number crunching routines by an order
of magnitude.
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Chapter 13.0 Mosaics in CARIS

Contributed by Lt. Commander Gustavo Adolfo Gomez-Pimpollo Crespo, Instituto Hidrografico
de la Marina, Spain

Household steps to get mosaics in CARIS, V. 8.1, after editing and cleaning multibeam data

There are different ways to get a mosaic, from a pretty and fast mosaic (high resolution), to an
advanced reflectivity mosaic (low resolution).

CREATE MOSAIC MOSAIC

* EDITMOSAIC.

© Brightness

© Contrast

0 Intensity
* IMAGECLASSIFICATION
* [NTERPOLATE MOSAIC

=}
Q
g
2a
(5]
ot
- #
=N
o
=)
QU‘)
£
5
=2

Edition GeoBars

Figure 13.1 Steps to create a Mosaic.

Figure 13.1 indicates how to get different types of mosaics. The election of one-way or another
depends on the purpose. If the goal is to get a fast mosaic of one specific area to see its
segmentation, it is better to get a pretty mosaic without analyzing the sediments. On the contrary,
if the purpose is to study and analyze the area with the samples obtained in the zone, it is
recommendable to create a mosaic that analyzes the angular response.

Every mosaic depends on a set of variables: correct patch test, vessel speed, sound speed profile
updating, parameters used by the operator, seafloor properties, the overlap conducted between
lines, among others.

Figures 13.2 and 13.3 show the results that you can obtain once you edit, clean, and process the
multibeam backscatter data in order to get a mosaic.
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Figure 13.2 Images provided by the Spanish Navy survey vessel “Antares,” during the hydrographic survey
conducted in Galicia coastal waters (northwestern Spain). This coast is also known as “The coast of death.”
This specific area is the Muros Inlet.

Figure 13.3 Mosaic and image classification.

13.1 Steps to get a pretty mosaic of an area (creating beam pattern correction)
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e  Open the “Mosaic Editor’ (tools, mosaic editor and open command). A toolbar will appear (Mosaic Editor).
e Go to the mosaic layer and take the following options in the process tab.

Processing Engine: Geocoder
Source Data Type: Time series
General options to select:
Auto gain correction

Auto TVG correction
Anti-aliasing

o Despeckle is used when there are isolated pixels with intensity levels that are different to the neighbouring
pixels. Despeckle removes extreme values, but its abuse can give rise to detrimental imagery.

e Selecta line to create its GeoBar (georeferenced backscatter raster) (Fig. 13.4). This line will be the
reference line to make the beam pattern correction. Then, it is better to take a short line on a flat seafloor. If
we know the sediment class it will be much better because it can be set.

Figure 13.4 Create GeoBar.

e Create a beam pattern; go to process, ‘create beam pattern’ and click on the created line with GeoBar (Fig.
13.5). After that, save the beam pattern as a ‘bpt’ file in the session folder (Fig. 13.6).
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Figure 13.5 Create beam pattern.
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= Hide Folders Save Cancel

Figure 13.6 Save beam pattern as “bpt” file.
o Create the beam pattern, select in the ‘process’ tab the following (Fig. 13.7):

Processing Engine: Geocoder.

Source Data Type: Time series.

General options to select:

Auto gain correction

Auto TVG correction

Anti-aliasing

Beam pattern correction and select the ‘bpt’ file that you have created previously.
AVG correction.

Method: Adaptive.

AVG window Size: 300.
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Figure 13.7 Select processing options.

e Select all lines (Ctrl + A) and ‘create GeoBar for all lines’ (It is recommendable the next name to create
GeoBar lines GeoBar_resolution_%l) to apply the beam pattern correction file (Fig. 13.8).

Figure 13.8 Applying GeoBars to all lines. The resolution is the same for all lines.
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Once all GeoBar lines have been created, you can modify the GeoBar lines. These can be edited
in the following way:

e Select a GeoBar line and go to the ‘mosaic editor’ window to take the ‘edit’ tab. In this tab, you can move
the ‘brightness’ and ‘contrast’ bars to adjust them. Do that next with the rest of the lines, or leave
everything like it. The last step is to make the desired mosaic with all the track lines for which GeoBars
have been created.

e (o to the ‘mosaic’ toolbar (or in tools, mosaic editor and create a mosaic) and click ‘create mosaic’.

e Put the name, the desired resolution (it is recommendable to put the same resolution of its component
GeoBars) in meters and select the method ‘Full blend’. The color map can also be modified if you want

(Fig. 13.9).
If the field sheet is not selected, the mosaic will not be created (do not worry, | normally forget
that).

Pyt

Flesobtion 1000 |

Method Fuiond %

clour Mg S ale (P W
| S sd L2 W

Figure 13.9 Create mosaic.

The final mosaic is shown in Fig. 13.10.
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Figure 13.10 Final mosaic.

Once the pretty mosaic is created, it is also possible to conduct image classification (see point
13.3) and compare collected samples from the seafloor in the zone with the sediment analysis
obtained in the program, by selecting Geocoder (see point 13.2).

Concepts to take into account:

It is necessary to divide the area where we want to work in segments. Segmentation means to
study and analyze the area and take samples where the seafloor is different (regions of consistent
acoustic return type). If it is combined physics-based models of how the sound interacts with the
seafloor and radiometric and geometric corrections factors (Geocoder engine is the software tool
that was used to conduct geometric and radiometric corrections), it is possible to analyze the
sediments (i.e., deduce the grain size). Nevertheless, you must not forget other variables that
influence and vary the result (used frequency, angular response, grazing angle, attenuation,
calibration, gain settings, pulse length, beam pattern, software changes, temporal changes, etc.).

The slant range correction reduces the measured time series to depict the image (flat seafloor
assumption).

Beam Pattern correction corrects extreme pixel intensities in the swath angle, on both sides
from nadir (i.e., it eliminates sediment artifacts).
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Angle varying Gain correction removes angular gain artifacts from the imagery in according
with seafloor physical properties.

Full blend method computes the mean of those pixels that overlap. That is the reason why the
more overlap between lines, the better result you will have.

Despeckle is used when there are isolated pixels with intensity levels that are different from the
neighboring pixels, by removing the extreme values, but its abuse can give rise to detrimental
imagery.

13.2 Steps to get an advanced reflectivity mosaic, by analyzing the sediments

This is a step forward from the previous step. This process tries to explain, in the best possible
way, how to carry out the sediment analysis of a specific area (Figs. 3.11, 13.12, and 3.13),
which is totally independent of the pretty mosaic made previously.

Is it possible to work with the GeoBars obtained in the pretty mosaic conducted previously? The
answer to this question is ‘yes’, but it is better to work with the GeoBars directly, line by line.
The result would be much better because you work line by line with the real samples from the
seafloor.

The goal in this point is to carry out an exhaustive analysis of the angular response received from
all beams when it is recorded multibeam backscatter data in a specific area. It is a very tedious
task, because you initially compare the collected samples from the seafloor with the obtained
results in the "CARIS HIPS & SIPS™ program. Those points where the model does not match
with the real sample, you will have to edit, by indicating the real morphology of the seafloor. The
initial result of the model depends on many variables, as it was explained previously. The model
will show better results when the coverage during the survey is 200 % (i.e. overlap between lines
100 %), the vessel reduces speed, among other things.

In this step, you will analyze the sediments line by line exhaustively, by comparing and
analyzing your result with all collected samples in the specific area. The more samples you take
from the seafloor, the better for the result. Therefore, a wide variety of samples of the specific
area are required to perform this tedious step.
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Figure 13.11 Example of a general area.

Figure 13.12 Selected zone in the general area to analyze sediments.

327




Figure 13.13 Enlargement of selected Zone.
Possible steps to analyze sediments are the following:

e Either work with the pretty mosaic created as the previous step, or create GeoBars line by line.
To get better results, a second option is better. So, the steps to perform this option follow:

e Create afield sheet (indicated by a red circle in Fig. 13.14) of the selected area.
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Figure 13.14 Parameters to select in the ‘process’ tab of the ‘“mosaic editor’ window- creating a field sheet
(red circle), and opening the mosaic “mosaic editor” window (yellow circle).

e Besure that in ‘Layers’ window, ‘Ship track lines’ is active.
e If you do not have the ‘mosaic’ toolbar (indicated with a yellow circle in Fig. 13.14) in your display, open
it.

e Select the line or lines to be analyzed with the mouse and click ‘Load a single GeoBar for selected track
line” or the lines that you want to select "Load all GeoBars for selected track line" (it is recommendable
that the analysis be conducted line by line to compare the collected samples with the result of the model
and edit in those places where the comparison does not match) (see Fig. 13.15).
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Figure 13.15 Selection of line to be analyzed.

e Go to the “Mosaic editor’ window and review in the ‘process’ tab that is selected all the things indicated in
Fig. 13.16.

Figure 13.16 Parameters of the process tab in the mosaic editor window.

e Now, select the ‘analysis’ tab and make sure that you select all the things indicated in Fig. 13.17. Be sure
that the line is selected and press the button ‘analyze’ to analyze sediments.
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Figure 13.18 Image after pressing “analyze” button. Each point, from centerline to both sides, represents
grain size, roughness, volume backscatter, and impedance.

Then, in the “Mosaic’ toolbar, do the following:
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e First of all, press the button (from right to left) ‘auto analyze file’, secondly the button ‘open the sediment
analysis graph’ and finally the button ‘sediment analysis options’. After pressing the last button, select what

is indicated in the next figure.

Figure 13.19 Illustration of output.

‘Sediment Analg’i E&J

General Options

Patch

Mever

Once

: pings

File Creation Options

- Do not create file.

- Generate and keep file.

@) Always - Regenerate file every

View Sediment Parameter Overlay

Ok

H Cancel ||

Help

Figure 13.20 Sediment analysis options.

e  Pressing the left button of the mouse on the track line you can see the information by snippets.
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e To see the expected graphic with the lines of roughness, Kirchhoff, volume backscattering and grain size,
you need to go the ‘analysis’ tab and in “display” select the option “advanced” (Fig. 13.21). Then, press
“graphic options” in order to select everything as it is indicated in Fig. 13.22.

Display: | Advanced >

Figure 13.21 Advanced button.

Backscatter Traces

Total Interface

¥] volume []Kirchhoff

Figure 13.22 Sediment analysis graph options.

You are now ready to see the results of the angular response analysis (ARA). ARA is a model
that uses the angular dependence of backscatter to predict seafloor properties. Figure 13.23
shows different results of the model. Are they good?
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Figure 13.23 Three different zones of the same line, showing differences obtainable by analyzing the
sediments with the model.

The green line indicates impedance.
The yellow line indicates the roughness.
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The red line indicates the volume backscatter.
The blue line is the result of the other lines and it indicates the grain size.

To answer to the previous question is necessary to go directly to the points where we have real
samples to compare it. It is probable that the result will not be good. So, what to do?

e  Select the “analysis’ tab and select the following:

Display: advanced.

Source: sediment data.

Results: Click ‘edit’ (make sure that you are over the sample point) and select the grain size that you took
and click ‘insert’ (Fig. 13.24).

M Grain Size Table %]

Grain Size | Class A
1.0 Coarse Sand - Gravelly Sand

1.5 Medium Sand - Gravelly Muddy Sand |
2.0 Medium Sand

2.5 Fine Sand

3.0 Siley Sand

35 Muddy Sand

4.0 Very Fine Sand

4.5 Clayey Sand

5.0 Coarse Silt v
< ?

Insert | | |
ret_|

Figure 13.24 Grain size table.

The more samples you have, the better result you will have because you are introducing real
values to the model.

When you analyze the sediments of your specific area you will see values from 0 to 1, by

indicating the class and the grain size (Fig. 13.25). Those values that are below 0.4 are
theoretically considered as very good. The larger the value, the worse it is.
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Figure 13.25 Class and grain size.

Once you finish your valuable work, you can get a classification of the mosaic. How to do that?
It is easier than the previous steps.

e Right click on your selected mosaic layer and click “classify’ (Fig. 13.26).
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Figure 13.27 Classification options.

e Select the number of classes and the classification color for each class (Fig. 13.27). You can conduct the
classification with the intensity if you want.
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e If the result is not the expected result because you consider that the image classification requires mores
number of classes, change the parameters. You have the option of clicking on the Mosaic intensity layer

and go to properties window (general, color file) to change the color file if you have more than one, edit
(add or remove colors) or even create a new one.

e When you are pleased with the results, click ‘apply’ (Fig. 13.28) and save the crf file (Fig. 13.29).

e Click “close’ and finally click with the middle mouse within the display window to refresh the display. The
classification will be applied to the mosaic (Fig. 13.30).

Classification options

-74.37 -0.07

Mumber of classes:

Minirum Intensity  —74.37

Minimum Intensite  -0.07

Classification colour: ’Class B v] I . v]
in hax Start End
7aces e (D G

-34.06 -29.502

O G
-29.602 -25.151

-25.151 -20.936

wem oo (D D
-0.07 -0.066

[ Classify ] I Apply ] [ Close ] I Help ]

Figure 13.28 Apply classification options.
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Figure 13.29 Save crf file.

Figure 13.30 Image classification.

Is it possible to conduct this image classification in the step 1 when conducting the pretty
mosaic? The answer to this question is “yes’. It is always possible to do it when you have mosaic
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layers. Once you create one mosaic layer, you can do it or even interpolate the mosaic to obtain
another one (Fig. 13.31).
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Figure 13.31 Examples of created interpolation mosaics.

13.3 Image classification

Once you create a mosaic, you can get a classification of it.

e Right click on your elected mosaic layer and click “classify’ (Fig. 13.32).
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Figure 13.32 Classify mosaic layer.

e Select the number of classes and the classification color for each class. You can conduct the classification
with the intensity if you want (Fig. 13.33).

e If the result is not the expected result because you consider that the image classification requires mores
number of classes, change the parameters. You have the option of clicking on the Mosaic intensity layer
and go to properties window (general, color file) to change the color file if you have more than one, edit
(add or remove colors) or even create a new one.

e When you are pleased with the results, click ‘apply’ (Fig. 13.33) and save the crf file (Fig. 13.34).

e Click “close’ and finally click with the middle mouse within the display window to refresh the display. The
classification will be applied to the mosaic (Fig. 13.36).
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Figure 13.33 Classification with intensity.
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Figure 13.34 Save crf file.

The result that you can obtain is similar to Figures 13.35 and 13.36.

342



Figure 13.35 Mosaic and classification image from step 1.
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Figure 13.36 Mosaic and image classification from step 1.

13.4 Print out the analysis of sediments conducted, on the line or lines selected
and analyzed

The steps to conduct it are as follows:

e Select “file’, ‘export’, ‘export wizard’, ‘select sediment analysis to ASCII’ (Fig. 13.3), and electing from
the list (*) those interesting parameters (Fig. 13.38).
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Select Format

MName Date Version o
HIPS Tide to ASCII 08/10/2013 12:32 AM 5100
HIPS to ASCI 08/10/2013 12:33 AM 81.00
HIPS to CARIS Map 08/10/2013 12:34 AM 81.00
HIPS to FAU 08/10§2013 12:33 AM 8100
HIPS to GSF 08/10/2013 12:34 AM 8100 I
HIPS to HOB 08/10/2013 12:34 AM 8100
HIPS to HTF 0810/2013 12:34 AM 5100
Mosaic To ASCI 08/10/2013 12.33 AM 81.00 =
Maosaic To Image 08/10/2013 12:34 AM 8100
Sediment Analysis to ASCIl 08/10/2013 12:33 AM
SIPS to UNISIPS 08/10§2013 12:33 AM 8100 N
< | M | »

< Back Mext = ] l Cancel I [ Help ]

Figure 13.37 Select data in ASCII format.

Analysis Parameters
Roughness - Include Headers In Qutput
Gamma Delimiter
[¥] Wolume _
Grain Size @) Space
Porosity A PN
Tortuosity ‘E‘ "/ Comma
Permeability i @ Tab
v
(") Other
[ Up ] ’ Down I
Qutput
(@) One file () Multiple files
< Back H Mext > ] [ Cancel ] l Help I

Figure 13.38 List of parameters.

(*) The complete list that appears in the Fig. 13.38 is the following:
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Line name, side, sediment type, confidence level, frequency, sound speed, density, loss,
roughness, gamma, volume backscattering, grain size, porosity, tortuosity, permeability and

impedance.

You will only select those parameters that appear in bold (Fig. 13.39).

onfidence F//Lat (DD}
.3 42.754231356N
«3 42.739315758N
.3 42.748658171N
.3 42.750352378N
3 42.751087287N
.3 42.754593129N
.3 42.755494956N
.3 42.748340681N
.3 42.746489952N
.3 42.745589932N
.3

C
[}
[}
[}
[}
@
@
[}
[}
[}
[}
L] 42,727195024N

Figure 13.39 Possible outcome.

Long (DD}
809, 0474598251
809. 0670462451
809, 9528498391
809, 0519898811
809, 0497557240
809.045186286M
009.0842489047W
009.851211085W
009.853658572wW
009.854926754W
009.0876468735W

Frequency

85,008
85,008
85,008
85,008
85,008
85,000
85,000
85,000
85,000
85,000
85,000

Sediment Type

COARSE SILT
VERY FINE SAND
COARSE SILT
COARSE SILT
COARSE SILT
COARSE SILT
SANDY SILT
COARSE SILT
COARSE SILT
COARSE SILT
WVERY FINE SAND

Grain Size

4.87
3.98

Roughness
©0.9811929200243948
0.8838067165157
0.0811929200243948
0.0811929200243948
0.0811929200243948
0.011929200243948
0.011929200243948
0.011929200243948
0.011929200243948
0.011929200243948
©.003843548735831

Tortuosity Permeability I
1.25

1.25
1.25
1.25
1.25
1.25
1.25
1.25
1.25
1.25
1.25

1

B e e

mpedance

1.181083210961662
1.26448686384863
1.18189818683172
1.18189818683172
1.18535949986691
1.17322393408477
1.18196783696681
1.23194567696681
1.17448962098184
1.29194738694565
1.29194738696681
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Chapter 14.0  Nautical Chart Adequacy Procedure

Contributed by A. Klemm and J. Nyberg , National Oceanic and Atmospheric Administration,
USA, S. Pe’eri and R. Wigley, Center for Coastal and Ocean Mapping, USA, Limor Gur-Arieh,
Survey of Israel, Israel, Y. Kamaruddin, National Hydrographic Center of Malaysia, Malaysia,
A. Kimeli, H. Kurita, 1.B. Prasetyawan, J. Roperez, N. Samarakoon, and M. Vallee, Nippon
Foundation/General Bathymetric Chart of the Oceans Scholars Program, USA, J-Y Roh,
Korean Hydrographic and Oceanic Administration, Korea, J. Sydenham, United Kingdom
Hydrographic, U.K.

The nautical chart is a tool used by mariners for safe navigation through the seas and guidance
for anchoring. Due to limited resources and survey priorities, decades may pass until a new
hydrographic survey can be conducted to update the survey measurements that are used to
compile a given chart. Even then, the compilation time to transfer survey data into chart
soundings and contours may take several years. As a result, shoreline and depth data in some
charts are outdated and may have changed over the years due to natural events and/or coastal
development. From a global perspective, the International Hydrographic Office (IHO) reviews in
its C-55 publication (Status of Hydrographic Surveying and Nautical Charting Worldwide) the
percent coverage of hydrographic surveying and nautical charting for a country with navigable
waters under its jurisdiction. For any marine cartographer around the world, a similar set of
questions is raised when evaluating a chart:

e When was last survey conducted over the charted area?
e Have there been any changes to the shoreline or the bathymetry since the last survey?
e Isitpossible to prioritize areas on the chart that require more frequent updates?

e Can we evaluate chart adequacy and update it before we are able to conduct another survey in the area?

In recent years, different types of marine information became accessible to the public with
cartographic value. This marine information includes: horizontal positioning of ships, satellite
imagery, and shallow-water bathymetry collected in non-hydrographic surveys. The Nautical
Chart Adequacy Evaluation (NCAE) procedure described below can provide transitory products
for mariners until a survey that can meet IHO standards can be conducted (IHO, 2008). The
procedure is based on hierarchy of evidence ranging from hydrographic and geodetic standard to
best available resources that The NCAE procedure has been developed in ArcMap ESRI
environment and utilizes different publicly-available non-hydrographic data sources and
products to support policy and cartographic decisions. Three key data sources used in the
procedure are:

e Automatic Identification System (AIS) - Messages that are broadcast over VHF maritime band at a certain
frequency in order to avoid collision. One type of AIS message is a dynamic (position) message that
contains key parameters, such as position, time, speed, and course information.
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o Satellite-Derived Bathymetry (SDB) - Bathymetry estimation derived (reconnaissance approach) using a
band-ratio calculation from satellite imagery. The imagery used in this study are multispectral imagery
acquired by the Landsat satellites.

e  Surveys of opportunity - Surveys that do not meet IHO S-44 order 1 (IHO, 2008). These surveys may have
been conducted for coastal management or oil prospecting programs and are available for analysis.
Typically, only depth measurements are available from these surveys as a point cloud.

The goal of the approach is to develop a standardized procedure that can be transferable to
cartographers, hydrographers and potential chart producers from hydrographic offices and
government agencies around the world. The focus of the procedure is on quality management
based on the hydrographic characteristics of the chart (as opposed to uncertainty management,
where risk is calculated based on potential consequences by different users and vessels in
different marine settings). 1t is assumed that every S-57 attribute can be provided as an ArcMap
feature with a table containing the required fields that are required for S-57. The two main
attributes that will be used in the procedure here are MQUAL and SOUNDG.

Figure 14.1 Schematic illustration of the four source layers used in NCAE algorithm.
Four layers are utilized for the chart adequacy procedure that include (Figure 14.1):

e Bathymetric Difference (Section 14.4) - A current reconnaissance bathymetric dataset is generated using
recent surveys of opportunity and is supplemented using SDB in coastal and shallow-water areas. Although
it is possible to use GIS tools to monitor and quantify changes between the charted and the reconnaissance
depth curves, it was found that manual digitization of a polygon surrounding the areas of discrepancy
provides a quicker and simpler approach to execute. Polygons that have identified areas with discrepancy
were classified with a “10” value. The rest of the charted area that does not contain major bathymetric
differences is classified with a “0” value.

o Vessel traffic (Section 14.5) — The goal of the chart adequacy procedure is to investigate if the information
on the chart is suitable for navigation. Accordingly, the investigation should focus only the traffic routes. In
this procedure are derived from AIS datasets that provide the vessel traffic density. The class values for
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vessel traffic were Boolean conditions that “true” answers (i.e., areas that are considered a navigational
route) were assigned a class value of “1” and a “false” answers (i.e., all other areas) were assigned a value
of “0”. Thus, a multiplication with the vessel traffic layer will retain only the navigational route areas.

e Hydrographic Characteristics (Section 14.6) —It is possible to classify the charted areas based on the
survey dates and survey technology provided by the source diagram or the metadata associated with the
CATZOC. A decision-tree (Table 14.1) was developed using three survey qualifiers that can be received
from RNC or ENC. The values attributed to the classes in the hydrographic characteristics layer range from
“0” to “9”, where higher values indicate that the charted area is less adequate and requires more attention.
The three qualifiers include bottom coverage, positioning technology, and survey technology.

Table 14.1 Ranking of the Hydrographic Characteristics classes based on the three survey qualifiers (bottom
coverage, survey date and survey technology).

Bottom coverage Survey Date Technology Rank
No bottom coverage -- -- 9
Partial bottom coverage Pre-1975 Leadline 9
Partial bottom coverage Pre-1975 SBES 8
Partial bottom coverage Pre-1990 SBES 8
Partial bottom coverage Pre-1990 MBES 7
Partial bottom coverage Pre-2000 SBES 7
Partial bottom coverage Pre-2000 MBES/ALB 6
Partial bottom coverage Post-2000 SBES 6
Partial bottom coverage Post-2000 MBES/ALB 5
Full bottom coverage Pre-1975 Leadline 5
Full bottom coverage Pre-1975 SBES 4
Full bottom coverage Pre-1990 SBES 4
Full bottom coverage Pre-1990 MBES 3
Full bottom coverage Pre-2000 SBES 3
Full bottom coverage Pre-2000 MBES/ALB 2
Full bottom coverage Post-2000 SBES 2
Full bottom coverage Post-2000 MBES/ALB 1

o Reference Surface (Section 14.3) — In is important to evaluate the chart quality in context of depth. This
issue is also noted in the IHO survey standards S-44 (IHO, 2008). The chart quality properties in the chart
adequacy procedure are normalized using the charted surface to provide more weight for shallower areas.
The reference depth is generated using the best available survey data. In this procedure, the survey data
from the chart soundings is gridded using inverse distance weights (IDW) interpolation. In order to avoid
boundary conditions caused by the interpolation or division of “0 meter” depth, depths shallower than 1 m
(to the charted vertical datum) were excluded from the evaluation.

Note: There are many ways to access the information necessary to create and process the
Hydrographic Characteristics Layer. This information may come from survey outlines, the
source diagram on paper charts, hydrographic survey descriptive reports, or the CATZOC
attribute in MQUAL for large scale charts. Not all hydrographic offices have completely
encoded the MQUAL feature with CATZOC, and therefore supplementary information may be
necessary to create the Hydrographic Characteristics layer. In some cases, the source of
technology (TECSOU) has multiple codes (Table 2, Section 14.6). A conservative approach is
used in this procedure, where the lower performing technology is chosen for the assessment.
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14.1 Setting up the workspace (ArcMap)

Open ArcMap (either by a double-click on the ArcMap icon or selection from the windows

Start/All Programs ).

Note: If this is your first time using ArcMap, You will get this window the following window.

Press OK.

% ArcMap - Getting Started

Open existing map or make new map using a template

(=) Existing Maps

~

Browse For mare...

(= Mew Maps
My Te

[=- Templates

= Standard Page S
Architectural

mplates

150 () Page

North Americ
(=~ Traditional Layay

Tndustry

Browse for more... ¥

< | *

My Templates

]

Blank Map

C:\Documents and SettingsishachakiApplication Data\ESRIDeskkapl0. \arcMapiTemplates\Marmal mxt

Default geodatabase For this map!

Wehat is Ehis?

a|=)

[[J oo nat show this dialog in the future.

Select Extensions...Under the Customize Tab.

In the Extensions window, mark 3D Analyst and Spatial Analyst. Press Close.

Customize | Windows Help
Toolbars 3
Extensions. .. |

Add-In Manager ..

Custornize Mode..,
Skyle Manager, ..

ArcMap Cptions, ..
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Extensions

Select the extensions you want to use.
30 Analyst
O ArcSean
[0 Geostatistical Analyst
O Maplex
[ Metwork Analyst
O Publisher
[ Schematics
Spatial Analyst
[ Tracking Analyst

Description:

30 Analyst 10.0
Copyright ©1993-2010 ESRI Inc. Al Rights Reserved

Provides tools for surface madeling and 3D wizualization.

St Eensiors

Note: If 3D Analyst is not available in your ArcMap license, skip the next steps.

Select Toolbars...under the Customize tab and select 3D Analyst.

Customize | Windows  Help Advanced Editing
| Toolbars 3 | Animation
Extensions... ArcScan
COiE0 -

&dd-In Manager. ..

Custamize Mode. .. Data Driven Pages

Data F Tool
Skyle Manager .., & Frame fons

Distributed Geodatabase

ArcMap Options...
Ciraw

An undocked 3D Analyst toolbar will appear. Dock it next to the upper toolbars.

A28k Q@

30 Analyst = Laver: |

Select Toolbars...under the Customize tab and select Editor.

An undocked Editor toolbar will appear. Dock it next to the upper toolbars.

Editar = | = © il . ¥

Select Toolbars...under the Customize tab and select Spatial Analyst.
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Schematic Editor
Schematic Network Analyst
Snapping
Spatial Adjustment

| Spatial Analyst

Standard

An undocked Spatial Analyst toolbar will appear. Dock it next to the upper toolbars.

Layer: | J o=

Activate the Toolbox by clicking on the icon in the upper toolbar.

Windows  Help

& 8 |0E,

In the main menu, click on File/Map Document Properties.... Check the box for Store relative

pathnames to data sources. Click OK.
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-

Map Document Properties

==

General

Eile:
Title:

Summary:

Description:

Author:
Credits:
Tags:

Hyperlink base:

Last Saved:

Last Printed:

Last Exported:

Default
Geodatabase:

Pathnames:

Thumbnail:

Klemm\DesktopAIS_Chart_Adequacy_Ft_Meyers.mxd

5/14/2015 3:25:24 PM

5/13/2015 9:54:25 AM

=
C:\Wsers\Anthony.r.Klemm\Documents\ArcGISYCH
[¥] store relative pathnames to data sources

Make Thumbnail

Delete Thumbna

[ ok

]’ Cancel ][

foply |

In order to validate that ArcMap is properly executing the command, click on
Geoprocessing/Geoprocessing Options... in the main menu,

Geoprocessing | Customize Winc

&
W
=
=
—h
I}
=

Clip

Intersect

Union

Merge
Dissolve
Search For Tools
ArcToolbox
Environments...
Results
ModelBuilder
Python

OY Bz2ea 2 > 222

Geoprocessing Options...

In Geoprocessing Options window, uncheck the Enable box under Background processing
and press OK.
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%

Geoprocessing Options ﬁ

General
Dg\rerwrite the outputs of geoprocessing operations

[¥]Log geoprocessing operations to a log file

Background Processing

| |Enable: Notification D

Appear for how long (seconds)

Stay up if Error occurs

Script Tool Editor/Debugger

Editor:
Debugger:
ModelBuilder

[¥|when connecting elements, display valid parameters when more than one
is available.

Results Management
Keep results younger than: 2 Weeks -

Display / Temporary Data

ﬁdd results of geoprocessing operations to the display
["|results are temporary by default

About geoprocessing options [

oK l l Cancel

Activate the Catalog by clicking on the icon in the upper toolbar.

Windows  Help

M= ] STk

Navigate in the Catalog window, and create a New Folder Connection. Click on the New
Folder Connection button in the Catalog toolbar and select the folder in the directory where
your data is located. (e.g. C:\working).

Cataiog | X%

oo dp B S| S

Navigate in the Catalog window into the desired directory, right-click and select New/File
Geodatabase.
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Catalog X
- L@ S ElE
Location: [ Chart_Adequacy

G5 Home - Dacuments\ArcGls -

i EJ Addlns

# [ Packages

= [ ProfileGraphData
= L Default.gdb
= @ Toolbosthe
= & Folder Connections
= £ iy
£1En
1 B2 JRECYWCLERIN
£ C_dre
= [ CARMS
5 o [e—
= B0 [ Copy
= EIF
< EIH 5% Delete
=M Fenarne
S B R e Refresh
EJ Folder ) ._ M |
LA File Geadatabaze =] Iern Deacription..

Right-click on the new Geodatabase and select Rename.

,' -@;cgw

M Delete

Rename |

Change the name of the Geodatabase to the chart’s name/number and press Enter.

" [Catakog
f- ki@
Locaten: | e Fle Gendatabase. gdb -
£ Home - DocumertshAecGIS

1 £ Adding
1 £ Package:
& [ ProfileraphData
F 132 Defaultadh
il -] T:olho:‘:x
E= Folder Connections
[ =R
B EA
7 [ $RECVILEAMY
£ C_drwe
& £ caRLs
= 2 Chan_Adequacy )
B i File Geodatabase.cis

Right-click on the new Geodatabase again and select Make Default Geodatabase.

= B Chart_Adequacy
| —re—

7 B Da |§] Capy

5 B Fu

2 EIHY 3¢ Delete
o = M Rename
i B La:

5 I pag = Refresh
= = 0|'| L3 Make Default Geodatabase

= P ne

The new Geodatabase should be bold (recognized by ArcMap as the default geodatabase).
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Catalog
R |
Locaten: LG chartion.gdb

| B4 | B 2

L
*

[l Home - DocurnentsiArcGLS
i 7 fddin:
¥ 1 Packages
+ £ ProfileGraphData
® 3 Defaultgds
5 @ Toolbowtbx
=[5 Folder Connections
£ Ch
EJE
il [ $RECYCLE.BIY
£ ©_drive
] CARIS
B Chart_Adequacy
L ChartD00.gdb:

»
yareas §l] | Boiees &l

Save your project in the Site project directory by selecting File/ Save As... .

Make sure to save the MXD using the naming convention <chart name>_<date>.

€ Untitled - ArcMap - Arcinfo

File | Edit View Bookmarks Insert

O New...
& Open...
Save

Ctrl+N
Ctrl+0
Ctrl+S

| Save As...

Save A Copy...
Add Data

Sign In...
ArcGIS Online...

B

Print Preview...

Print...

Create Map Package...
Export Map...

B &80

[+

Exit

Page and Print Setup..

Map Document Properties...

Alt+F4

Q) save As @
Savein: ) Chart_Adequacy - @ ? g El' | &
I Name : Date modified Type
"‘*ﬁ‘ | Processed 8/13/201511:07 AM  File folder
RecentPlaces || powy data 8/6/2015 251 PM  Filefolder
Desktop
=)
Libraries
[ ]
LY
Computer
'Y
k 1| mn b
Metwark
File name: Fort_Myers_08122015 - Save
Save as type: [ﬁrcMap Document v] [ Cancel ]

14.2 Loading the dataset into the project
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14.2.1 Raster Navigation Charts (RNC)

In the main menu, load the RNC data to ArcMap by right-clicking on the desired directory and

select Add Data...

Navigate to the directory containing the raster charts, select your chart and press OK.

'i.:!:.:' -

Add Data

|

Look in: ’E 11427

Mame:

Show of type:

el @ E B

11427_1.KAP; 11427_2.KAP; 11427 3.KAP

Datasets, Layers and Results

*)

[ Cancel

|

Note: The format of the chart between hydrographic office (e.g., GeoTiff, KAP, etc.)

The software should recognize the chart datum. 1E NOT, right-click on Layers in the Table of
Contents window and select Properties...

Table Of Conterts

%S 8

AOMENNNE

- -
Q@

M

. m 1P AddData...

MNews Group Layer
Mews Basemap Layer

Copy

Turn Al Layers Off
Select All Layers

Collapse 2 Layers
Reference Scale

Advanced Drawing Options...
Labeling

Artivate

[~ Propertes...
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In the Data Frame Properties, select the proper datum (coordinate system) under the
Coordinate System tab and press OK.

Note: In this example, the system is: Projected Coordinate Systems/UTM/ WGS 1984/Northern
Hemisphere/WGS1984 UTM Zone 17N.

r 5
Data Frame Properties @

| Feature Cache | Annotation Groups Extent Indicators | Frame | Size and Position
| Genewl | Datafieme | Coordrate System

i v| Type here to search v @ | [ ¢

G} WG51984 UTM Zone 13N -
C-j WGES1984 UTM Zone 14N
Cj WG51984 UTM Zone 15N
G} WG51984 UTM Zone 16N
e ws 1984 UTM Zone 17|
Cj WG51984 UTM Zone 18N
G} WG51984 UTM Zone 19N
C-j WGES1984 UTM Zone 20N
Cj WG51984 UTM Zone 21N

A AMIEC 084 1ITHA T e 301

Current coordinate system:

WGS_1984_UTM_zone_17N ~
WKID: 32617 Authority: EPSG

m

Projection: Transverse_Mercator
false_easting: 500000.0
false_northing: 0.0
central_meridian: -81.0
scale_factor: 0.9996
latitude_of_origin: 0.0

Linear Unit: Meter (1.0}

Transformations. ..

oK | [ Cancel | [ fopy |

14.2.2 S-57 files from the Electronic Navigation Charts (ENC)

Load the ENC layer data to ArcMap by selecting Add Data...

1.:!:.:- *

Navigate to the directory containing the ENC files, select MQUAL and SOUNDG files and
press Add.

358




Select Data Management Tool/ Projection and Transformations/Project to convert the
shapefiles from geographic coordinates into a UTM projection (the zone will differ with

location).

Add Data =)

Lookin: (i1 UssFLIM el Bl Esaes$
"] WRECKS_P [Zo]SILTNK_P |EIPIPARE_A [EIM_COVR_A (=1
. WEDKLP_P |EZ) SEAARE_A [ZPILPNT_P [~ LNDRGM_P B
B VEGATN_A [*-]SBDARE_P [~ OFSPLF_P [EJ LNDRGM_A Eo
“*JUWTROC_P [=JRIVERS_L [ OBSTRN_P [=J LNDMRK_P Eo
B UNSARE_A [ERIVERS A [EOBSTRN_A [=]LNDARE P [EDi
[*JRETRFL P [EIMARCUL A [EJLNDARE A [EDi
~7 SMCFAC_P [EJRESARE A BT (CUGHTS P o
7] SLCONS_P [ZZIRDOSTA_P [EIM_MSYS_A [ED) LAKARE_A =o
=] SLCONS_L [=lpIPsoL_L [EIM_MPUB_A [ HRBFAC_P Eo

4| n *
Name: M_QUAL_A; SOUNDG_P
Show of type: Datasets, Layers and Results v] [ Cancel ]

ArcToolbox
B3 Analysis Teols
@ Cartography Tools
©3 Data Interoperability Tools
= @ Data Management Tools
& Archiving
%: Attachments
&, Data Comparison
& Distributed Geodatabase
& Domains
& Feature Class
& Features
& Fields
& File Geodatabase
& General
& Generalization
& Geodatabase Administration
& Geometric Network
& Graph
& Indlexes
& Joins
& LAS Dataset
& Layers and Table Views
& Package
& Photos
= s Projections and Transformations
& Raster
E! Batch Project
"\% Convert Coordinate Motation
’\% Create Custorn Geographic Transformation
"\% Create Spatial Reference
;m Define Projection

< E=

Type “SOUNDG_UTM?” as the Output Feature Class and select the Output Coordinate Systems

as: WGS_1984 UTM_zone_17N.
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Input Dataset or Feature Class

SOUNDG_P >
Input Coordinate System (optional)
GCS_WGS_1984

Output Dataset or Feature Class
C:\Chart\Shinnecack Inlet, N¥\Charts\Chart1234.gdb\SOUNDG_UTM —

Output Coordinate System

WGS_1984_UTM_zone_17N

Geographic Transformation (optional)

oK I I Cancel l [Envlrunments...] [ Show Help >> ]

Similarly, project the M_QUAL feature class to UTM (WGS-84 ellipsoid).

Input Dataset or Feature Class

[M_QUALA k2
Input Coordinate System (optional) T
GCS_WGS_1984

Qutput Dataset or Feature Class
C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\M_QUAL_UTM

Output Coordinate System

WGS_1984_UTM_zone_17N

oK ] [ Cancel ] [ Environments... ] [ Show Help >> ]

Remove the original SOUNDG_P and the M_QUAL_A layers opened directly from the ENC
(not the new feature class you just created) from your table of contents by right clicking on the
layer, and clicking Remove.

ile Of Contents 1 x
e
= lLayers *

= SoundG ‘

L ]
= m'@ .
® opy

= Od SUMVEYS |x Femove

m

14.2.3 Satellite layers (Landsat)

Open a Web Browser and go to http://earthexplorer.usgs.gov/ . Login into your account (the
Login button is upper right corner of the window).
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http://earthexplorer.usgs.gov/

Note: The service is free, but the website requires user to login. Users that are accessing this site
for first time need to register (the Register button is upper right corner of the window).

Zoom into the desired region. Create a square around the desired region by clicking on the
corners of the area. The polygon vertex coordinates will appear in the Search Criteria tab.

1. Enter Search Criteria
To narrow your search area type in an address or

e s or click the map to
define your search area (for advanced map ools, view
the help documentation), and/or choose a date range.

Farou | Feane

place name, entar coordinate:

o 082° 04 35" W IR

2. Lat 26° 17 49" N, Lon: 082" 24' 25" W R
3. Lat 267 02' 12" N, Lon: D81° 53'22° W /R

4. Lat 267 37 44" N, Lon' 081 43' 58" W IR

Alternatively, type in a location you are interested in and the country in the Address/Place
located under the Search Criteria tab and click on Show. Select the site of interest from the list
of possible sites with similar names and the location will be shown on the map.
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1. Enter Search Criteria

To narrow your search area: type in an address or
place name, enter coordinates or click the map to
define your search area (for advanced map tools, view
the help documentation), and/or choose a date range.

Path/Row | Feature

Fort Myers
s [
On the top left side of the screen, click on the Data Sets tab.

EarthExplorer

Hesia
Search Critena | eFTER=RT

2. Select Your Data Set(s)

Check the boxes for the data set(s) you want to search.
When done selecting data set(s), click the Addiional
Criteria or Resufts buttons below. Click the plus sign

g to the calegory narme 1o shaw a kst of data sets.
[0 Uze Dals Sel Prefiler (whais The?)

Data Sel Search:

Expand the Landsat Archive and select L8 OLI/TIRS for Landsat8 imagery and click OK then
click Results.

searce Ctern  [[IIEEN Aocmonsicriera | Resuts

2. Select Your Data Set(s)

Check the boxes for the data sel(s) you want to search
When done selecting data sei(s), chck the Additonal
Criterfa or Resufts buftons bedow Click the pius sign
next 1o the category name 1o show a iist of data sels

Use Data Set Prefilter amsts ThisT)

Dala Sat Search

¥ Digital Maps [J

|
1
€0
4 Forest Carbon Saes
+ Ghoba Fiueialy
+ Gobal Land Survey
o fC
+ JECAM Bites
+ Land Cover |
Landsat Arhive [
) LB OLITIRS Pre-WRS-2
£ L7 ETM+ SLC-off (2003-present)
) L7 ETHH+ SLC-0n (1999-2003)
@ L7 ETM+ inl Ground Statons (Search Onily)
BLaATH
b L1-5 M35

Select the Results tab.
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EarthExplorer

Home

Search Criteria DatasSels  Additional Criteria

4, Search Results

If you selected more than one data set to search, use the
dropdown 1o see the search results for each specific data
set

Nore: You must be logged in to download and order
SCenes

Show Result Controls k.

Scroll down and look at the quick view results. Select the download icon of the desired data set.

SaannCriena | Daasas | adanons Cruca [EEERR Search Criteria Summary (Show) Clear Critaria
4. Search Results
It you selected more than one data sat to search, use

the dropdown 1o 566 the search results for each specific
data st

Show Result Controls

Dara Ser Cikek harm 4 wepart your s - 0
LB OLITIRS
[ Acauishin Date: 12-AEF 15
17 Path: 15
How: 41
YddILEG

Entity Bz LEG016042201 S002LGN00
Coordinates: 25 00261,41 0463
Acquisition Date: 02APR.15

atn: 16

o 42

YddrLlAG

Entity D= LCS0160422

i .
Copedingtes: 25,
Acaquision Dato:

] Path: 15
How: 42

i :

Yhdd 7L 80

Entity 0z LCB0160412015076LGH00
Coordinates: 27 2311281 50044
Acquisition Date: 17-MAR-15

Path: 16

Raowe 47

YeddILAG

Before selecting the image, it is possible to preview the image by clicking on Show Browse
Overlay.

Entity ID: LCB0160422015076LGMNOD
Coordinates: 25 99287 -81 095756
Acquisition Date: 17-MAR-15

Path: 16

Row: 42

YL ae

19

Select Download to display the area you are interested to process.

Entity ID: LC80160422015076LGNOO
Coordinates: 25 99287 -81 957556
Acquisition Date: 17-MAR-15

Path: 16

Row: 42

YHd L ale

19
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Select Level 1 GeoTiff Data Product and press Download in the Download Options window.

LandsatLook "Natural Color" Image (3.9 MB)
LandsatLook "Thermal’ Image (673.8 KB)

LandsatLook "Quality" Image (236.5 KB)

LandsatLook images with Geographic Reference (4.8 MB)

Download

| Download | Level 1 GeoTIFF Data Product (710.6 MB)

Extract your *.zip file into your local directory.

Note: The bands of Landsat imagery are typically download as separate imagery files in *.Tif
format and not as a single multi-band image (e.g., WV-2).

Note: In case that disk space is an issue, delete the *.zip file and bands B7 to B11.

Load the satellite data to ArcMap by selecting Add Data... in the main menu.

&-

Navigate to your directory and select the satellite images in the Add Data window and select
Add. The Blue, Green and Infrared bands in Landsat 8 are numbers as: *_B2.tif, *_B3.tif, and

*_B6.tif, respectively.

-
Add Data

=)

Look in: [El Landsats

et @ E BB

LCB0190392015048LGN00_E1.TIF

LC80190392015049L GNOO_B2.TIF
LCA0190392015049L GNOO_B3.TIF|
LCA0190392015049L GMNOO_B4. TIF
LC20190392015049L GMNOO_B5. TIF
L C8019039201 50491 GNOO_B6.TIF|
LCE0190392015048LGNOO_BT TIF

Name:

_| 1 C80190392015049L GNOO_BA.TIF
LCB0190392015049LGNO0_B10.TIF  #5 L C80190392015049LGNO0_BI. TIF

LC80190392015049LGNO0_B11.TIF % L C80190392015049L GNOD_BQA.TIF
%11 C80190392015049L GNOO_MT L.t

LCB0190392015049LGNO0_B2,TIF; LC80190392015045LG!

Show of type:

Datasets, Layers and Results

- ] [ Cancel ]

e

Note: If your imagery is not on your computer, you will need to use the Connect to Directory in

order to link your project to your computer.

[+
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In case you are asked to create pyramids, press Yes for each image you open.

%
Create pyramids for LCB0190392015049LGN0O0_B2.TIF (7391 x 7751) &J

This raster data source does not have pyramids or contains insuffident pyramids.
Pyramids allow for rapid display at varying resolutions.

Pyramid building may take a few moments.
Would you like to create pyramids?

About pyramids [ Yes 1 | No | | Cancel
Pyramid resampling technigue Mearest Neighbor -
Pyramid compression type Default -
Compression quality 75

Use my choice and do not show this dialog in the future.

- 4

The satellite imagery will be loaded with black background (typically, background pixel value is
0).

Right click on the image layer and select the Properties... button.

In the Symbology tab, check the Display Background Value box (in this case black is when the
value is 0).
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|Genem\ |Source | Key Metadata I Edent | Display‘ Symbology ‘
Show:
= Stretch values along a color ram & =
Unique Values o 4
Classified
Stretched -
Discrete Color
Color Value  Label Labeling
2406 pigh : 24106
I 0 Low:0
v -
I [V|Display Sackaround Value: 0 I as[]4
T Use hilshade effect 1 Display NoData as
:‘_.“,"‘ [ use hilshade effac E3
A Stretch
Type: [Percent Clip 'I [ Histograms ]
" min: ~ 0.25 max:  0.25 [ invert
Tyl
About symbelo [¥] Apply Gamma Stretch: 1L4770: il
o) o) )

Press the Apply button and then the OK button in the Layer Properties window. Now the layer is
without the black background. Repeat steps to remove background for the other layers.

14.2.4 Automatic Identification System (AIS)

Load the AIS data to ArcMap by selecting Add Data...

'i.:!:.:' -

Navigate to your directory and select the AIS point dataset (in this example:

AIS_points_2011 ft _myers) in the Add Data window and select Add. The AIS broadcast points
in the charted area will appear in the project.
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Select Data Management Tool/ Projection and Transformations/Project to convert the
shapefiles from geographic coordinates into a UTM projection (the zone will differ with
location).

ArcToolbox
BB Analysis Teols
B3 Cartography Tools
&9 Data Interoperability Tocls
= B Date Management Tools
& Archiving
& Attachments
& Data Comparison
%; Distributed Geodatabase
& Domains
%; Feature Class
& Features
%: Fields
& File Geodatabase
%: General
& Generalization
& Geodatabase Administration
& Geometric Network
& Graph
& Indexes
& Joins
& LAS Dataset
%: Layers and Table Views
& Package
& Photos
= %; Projections and Transformations
& Raster
3 Batch Project
;m Convert Coordinate Notation

;‘% Create Custom Geographic Transformation
;m Create Spatial Reference

;‘% Define Projection

"'\% Project

Type “AlS_points UTM” as the Output Feature Class and select the Output Coordinate Systems
as: WGS 1984 UTM_zone 17N.
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Input Dataset or Feature Class

AIS_points_2011_ft_myers adl
Input Coordinate System (optional) i
Longitude / Latitude (WGS 84)

Output Dataset or Feature Class

C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\AIS_points_UTM

Output Coordinate System

WGS_1984_UTM_zone_17N

0K l I Cancel I [ Environments... ] [ Show Help >> ]

Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
00 New.. Ctrl+N
B Open. Ctrl+0
‘ Save Ctrl+S

14.3 Reference surface

Note: Ideally, a complete dataset of survey soundings is available. However, there are many
cases that only the chart sounding (as S-57 SOUNDG) are accessible. A point feature from
either case can be used with the following steps.

Select Interpolation\Inverse Distance Weighted (IDW) from the Spatial Analyst toolbar.

= @ Spatial Analyst Tools

+- 8 Conditiona

o & Dergity

1 & Distarce

=& Extraction

+ B (eneralization

o B Grourchvater

+ & Hydrology

= & [rterpolation

“. Kriging

. Matural Melghbor
. Spline
5 Spline with Barriers
., Topo to Raster
“., Topo to Raster by File
“, Trend

-~
&

Select the survey soundings point feature and the input file, and fill in the following parameters:
depth as Z value field with a Fixed search radius of 500 m and an output cell size of 30 m.
Press OK.
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Note: The selection of 30 m grid is based on the satellite imagery ground resolution. Other grid
resolution may be more adequate for different survey dataset (SDB or surveys of opportunity).

Turn off the point feature and visually evaluate the surface

Remove the land from the blue and green imagery, by selecting Spatial Analyst
Tools/Conditional/Set Null in the Toolbox window.

Spatial Analyst Tools
e

Fill the Set Null window as follows for removing the shoreline to 1 m depth from the reference
surface and press OK.
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[
(o]

#. Set Null
-

Input conditional raster

Ref_Surface [~ |
Expression (optional)

value < 1
Input false raster or constant value

|Ref_Sur‘face =
Output raster

k::\char‘t\Shinnecock Inlet, NY\Charts\Chart1234.qdb\Ref_Surfacelm

OK l ’ Cancel ] ’Environments...] [ Show Help == ] :

Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
(9 New.. Ctrl+N
B Open.. Ctrl+0

‘ Save Ctrl+S

14.4 Bathymetric Difference layer

14.4.1 Satellite Derived Bathymetry (SDB) — Land/water separation

Note: There are several ways to calculate a threshold value for land/water separation. Two
common options are: 1) Profile, and 2) Identify. A recommended approach is using the profile
option, however this approach requires 3D Analyst (not all users have this option under their

current ArcMap license).

Option 1: Profile (using 3D Analyst)

Select Extensions...Under the Customize Tab.

Customize | Windows  Help

Toolbars [

| Exkensions... |

Add-In Manager...

Customize Mode...

Style Manager, ..

ArcMap Options, ..

In the Extensions window, mark 3D Analyst. Press Close.
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Extensions

=)
Select the extensions you want to use.

3D Analyst
ArcScan
Geostatisiical Analyst
Metwark Analyst
Publizher
Schemalics
Spatial Analpst
Tracking Analyst

Description:

30 Analyst 10.1

Copyright ©1933-2012 E =i Inc. A1 Rights Reserved

Provides tools for surface modeling and 30 wizualization.

Activate the 3D Analyst tool bar under the Customize/Toolbars.
| 3D Analyst
Customize | Windows  Helg Acbeanced Editing
Toolbars 3 | Apirmation
Select the infrared band (*_B6.tif in Landsat 8).
3D Analyst~ | [ 113110 GMIL ] Q@

Press the Interpolate Line icon in the 3D Analyst toolbar.

=

Make sure that the infrared band is visible in the project. Using the left button, draw a line that
crosses from land (bright areas) into the water (dark areas). Finalize the line by double-clicking
the left button.
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(") I|ANK

Long
Béach Re

After drawing the line the Profile Graph icon in the 3D Analyst toolbar will be active. Press the
Profile Graph icon.
. -

The result will be a plot that can be used to extract the land/water threshold. The smooth section
with low values represents water, whereas the fluctuation high value areas represent land. In this
case, the threshold value is around 5500 (Landsat 8 image).

Prafile Graph Title

7500

igBgEEEsEiianERERifananiifiantandl

0 W0 &0 B0 SO0 1000 1200 1400 1500 1500
Frofist Graph Sutotis

Option 2: Identify

Activate only the infrared band (*_B6.tif in Landsat 8).
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= [J LCB0160422015076LGMN00_B2.TIF
Value
High: 38225

Low: 0
= O LC80160422015076LGM00_B3.TII

Value
High: 38038

Low: 0

= LC80160422015076LGMO0_B6.TIF
Value
High: 65335

Low: 0
@ 11427 1.KAP

= 11427 2.KAP
= 11427 3.KAP

Select the Identify icon.

v

Click on several locations over the water and write down the values. Then, click on several
locations over the land and write down the values. The threshold value should be between the
water values and the land values (note: make sure you write down the Pixel Value).

Identify o) 23
Identify from:

=-LC801303520 15045LGNO0_B6. TIF

E}
Location: 620,130.840 3,334,747.577 Meters =
Field Value
Pixel valus 5556

Stretched value 31

Note: Once you have identified the threshold value using the one of the two options, you can
separate the blue and green layers as follows:

Convert the infrared band into float format, by selecting Spatial Analyst Tools / Math /Float
from the toolbox.
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= @ Spatial Analyst Tooks
(# & Conditional
i & Darsity
4 t- Distance
1+ & Extraction
(+ & Generalization
# & Groundwater
# & Hydrology
# &- Interpalation
i+ & Local
# & Map Algebra
= & Math
+ & Bitwise
+ & Logical
+ & Trigonometric
Abs
, Divide
. Exp
Expl0
Expe

.

AXAANNN

In the Float window, select the infrared band *_B6.tif in Landsat 8) and type in an output raster.
Press OK.

Input raster or constant value

| Lcao19039201 50491 GMOO_BE.TIF El @ J

Qutput raster

C:\Working\SDB\PanamaCity\Data\PanamaCity041420 15, gdb'Band_IR

[ OK l [ Cancel ] [Environments... ] [ << Hide Help ]

Repeat this step also for the blue *_B2.tif in Landsat 8) and the green *_B3.tif in Landsat 8)
bands.

Input raster or constant value

I LCB0190392015049LGNO0_B2.TIF

Qutput raster
C:Working\SDBEYPanamaCity\Data\PanamaCity041420 15.gdb\band_b

-

Input raster or constant value

I LCB0190392015049LGNO0_E3.TIF

Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\band _g

-

] [Envimnments... ] [ Show Help »> ]

Next, apply a low pass filter (LPF) by selecting Spatial Analyst Tools / Neighborhood / Filter
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= & Spatial Analyst Tools

+ & Conditional

+ B Densiby

# & Distarce

+ & Exdraction

+ & eneralization

= & Groundwater

+ & Hydrology

= & [nterpolation

+ & Local

© & Map Algebra

= & Math

+ & Multivariate

= & Neighborhood
“, Block Statistics
“h Filter
“, Focal Flow

Input raster

In the Filter window, select the infrared band in float format. Also, make sure that the Filter
type (optional) is LOW. Press OK.

|Band_IR

Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\Band_IR_LPF

Filter type (optional)
Low

Ignare MoData in calculations {optional)

[ OK ] [ Cancel ] [Environmems... ] [ Show Help ==

Repeat this step also for the blue and green float files.

Input raster

| band_g
Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\Band_g_LPF

Filter type (optional)
Low

] I Cancel ] [Enviranmenis

H Show Help == ]

Input raster

|-

|band b
Qutput raster
C:\Working\SDB\PanamaCity\Data\PanamaCity04142015.gdb\Band_b_LPF

Filter type (optional)
Low

Ignore MoData in calculations {optional)

El=)
B

[ oK I I Cancel ] [Enviranmenis

] [ Show Help ==
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Remove the land from the blue and green imagery, by selecting Spatial analyst
Tools/Conditional/Set Null in the Toolbox window.

=& Spatial Analyst Tools
=& Conditional
“ Con

Fill the Set Null window as follows for the blue band and press OK. Make sure that the threshold
value in the expression is the value calculated from the IR band.

Input conditional raster

|Band_IR_LPF

Expression (optional)
walue > 5500

Input false raster or constant value

= &

[Band_b_LPF
Qutput raster

= el

C:\Working\SDB'PanamaCity\Data PanamaCity041420 15 adb\UW_blue

[ ox

] [ Cancel ] [Environmems..‘ ] [ Show Help >> ]

Repeat this step also for the green band.

Input conditional raster

[Band_IR_LPF
Expression (optional)
walue > 5500

Input false raster or constant value

| Band_g_LPF
Qutput raster

C:\Working\SDB'\PanamaCity\Data \PanamaCity041420 15.gdb{JW_green

OK

| [Environments... | [ ShowHelp >> |

The new green and blue layer should contain areas only below the water.

Note: Make sure that the Display background value is set to 0 in the layer Properties.

14.4.2 SDB — Applying the bathymetry algorithm

Select Spatial analyst Tools/Map Algebra/Raster Calculator in the Toolbox window.
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=8 Spatial Analyst Tools
& Conditional
& Density
& Distance
& Extraction
& Generalization
& Groundwater
& Hydrology
& Interpolation
& [ocal
=& Map Algebra

Caleulator

In the Raster Calculator window, write the following command: Ln ( "UW _blue” )/ Ln (
"UW_green™ ). Name the Output Raster: Bath_alg.

T RS-

-

ﬁ’% Raster Calculator

Map Algebra expression

>

Layers and variables Exp2 -

Qv )] WEEE) -

<>uw blue e f Int E

S 0[50 0 0 [ ) R I
Wl |<Band_g_LPF . Log10
|t [=dle]

>band_g Mod

> band_b - Power -

Ln{"UW_blue™) fLn{"Uwi_green”)

Qutput raster

C:\Working\SDB'\PanamaCity \Data\PanamaCity04142015.gdb'\Bath_alg @

OK ] [ Cancel ] [En\«'lronmems... ] [ Show Help >

For visual inspection, select the layer properties of the “Bath_alg” layer from the Table of
Contents. In the Layer Properties window under the Symbology tab, set the color ramp
Stretch: Standard Deviations as follows and press Apply.

Layer Properties |

ez | Source | Bxent | Diplay | Smbobgy |

Shiow: Stretch values along a color ra 5
mp =l
e Values &)l
Clagsified ||
wnetche -
| || Demerete Colar
| Caier Value  Label Labebng |
» LOIEIE pgh: 101923
- E
- D94TS Low ; 0.599475
Color Ramp:
[ Diagiay Background value ] a8 ]]
[ Lise hitshade effect 1 Display rieCtz 25|
Skelch = )
Trpe: 5tandard Deviasens »| [ Hstogams |
n: 5

™ arwert

[ apply Gamma Stresch:

Cancel

Cox ]

| [ toow

In the Table of Contents, drag the chart layer above the Bath_alg layer. It now possible to
compare the algorithm results with the chart
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14.4.3 SDB - Vertical referencing and depth of extinction calculation

Note: There are two option for referencing the algorithm result to the chart datum: 1) referencing
using S-57 attributes from an ENC, or 2) manually calculating the gain and offset using a raster
chart. It is recommended to use option 1 when possible, as it provides a fast and accurate
solution. As a byproduct of the referencing procedure, the effective depth of the bathymetry (i.e.,
depth of extinction) is calculated.

Turn on the survey sounding point feature over the algorithm result.

5 B SoundG
.
B MouaL
]
o B L2 LRAP
® B 11477208
® B 11427 3XAP
= & bath_alg
Value
[ High: 1018

le:lM

® [ LOS01604 220050 76LGN0D_B2. TIF
# O LCA016042201 S0TELGNDD_B3.TIF
& O LCB0160422015076LGHNOD_BE.TIF

In order to NOT select soundings over “false bathymetry” caused by sediment turbulence, a
polygon will be created based on a visual inspection of the algorithm layer. In ArcCatalog,
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select the file geodatabase in the Data directory folder. Create a new feature class, right-click the

geodatabase and select New th

en Feature Class.

= £ 508
= 3 PanamaCity
= &5 Deta
® [ USSFLEEM _shape
W 1 Eanam g
® E3J Docs @ Copy
£ £ Proj
# [ SDBtransfer *®
¥ 3 SenerAdminToolk
= & sop =
i £ Source_GDE_Parer =  Refresh
1 £ sqldeveloper B Make Default Geodatabase
# ] stagngtemp
= 3 StatisticsAndFreqy Administration ]
# (5 Student Distributed Geodstebace  »
28 Festure Dataset... New *
[ Festure Class... Import »
| po
:g s Mew Feature Class
. Create a new standalone feature
% Relationship Class... | class ora new festure class in this
B g Catalog feature dataset
£  Rester Dataset... Disabled if you are using a Basic
| Sy Mosaic Dataset... ficense and you have right-chicked
a feature dataset containing data
types that cannot be crested or
1 . Toolbax edited using a Basic icense, such
| as topology.
& Address Locator...
& Composite Address Locator...

Name the file "ref_mask", select Polygon Features as the feature type. Click Next.

ST
Alias
Type

Type of features stored in this feature class:

[Po?ygon Features -

Geometry Properties
[] Coordinates include M values. Used to store route data
[ Coordinates include Z values. Used to store 3D data

< Back MNext > Cancel

Select a coordinate system from the Layers dropdown. Click Next three more times and then

click Finish.
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Ty
=

Choose the coordinate system that will be used for XY coordinates in this data

Geographic coordinate systems use |atitude and longtude coordinates on a spherical model
of the earth’s suface. Projected coordinate systems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system

pe here to search v a& | eﬁ A 4

“|

= EF Favorites -
@ MAD 1983 UTM Zone 18M

@ WGE5 1984 UTM Zone 5N

@ WG5S 1984 UTM Zone 6N

[ was Zone 17N

@ WGE5 1984 UTM Zone 18N

@ WGE5 1984 UTM Zone 19N

[ Geographic Ceordinate Systems 5

[ Projected Coordinate Systems
[l == W -

Current coordinate system:

WGS5_1984_UTM_zone_17MN -
WKID: 32617 Authority: EPSG ¥

Projection: Transverse_Mercator

m

central_meridian: -81.0
scale_factor: 0.9998
latitude_of_origin: 0.0
Linear Unit: Meter {1.0)

[ <Back | Net> | [ Cancel |

Table Of Contents

JaGR 3

= layers

= @ SOUNDG

.
Copy
Remove I
NG . . .

Open Attribute Table ™
Joins and Relates v * >
Zoom To Layes . e

Visible Scele Range v P80
i
Use Symbol Levels | . . +
1 .
Selection (Y 5 . *
|
Latsed Features I
o  a. &6 .
Edit Features b | 7 Start Editing

You may get the following message, press Continue.

Right-click the ref_mask layer and select Edit Features then Start Editing.

Start Editing ae |

O Start editing encountered one or more layers with warnings.
You may not be able to edit some layers if you continue.

[ name | Description

AIS_points_2011_ft_my... Spatial reference does not match data frame.
) M_QUAL_A Spatial reference does not match data frame.
) SOUNDG_P Spatial reference does not match data frame.
SOUNDG_F Spatial reference does not match data frame.
(i) ss_soundings_FtMyers... Spatial reference does not match data frame.

D Do not show this dialog unless there are errors that prevent start editing.

Tip: Double-click error to view additional information " Continue

- T —— - =
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In the Create Features window, select the Ref_mask feature and select the Polygon option in the
Construction Tools window.

Create Features 8 x

& - B <Search> ¥ @

ref_mask
[Iref_mask

SOUNDG_UTM
@ SOUNDG_UTM

0
[ construction Tools

‘Q Palygon

o Rectangle

O Circle

< Ellipse

@ Freehand

L] Auto Complete Polygon
<l Auto Complete Freehand

Note: In case the Create Features window appear automatically, select the Create Features
icon from the Editor toolbar.

caor~ [ Nit:b ~ 26 @ [E

Digitize the areas considered clean from sediment plumes by visually determining a polygon
around the clean area.

In the Editor toolbar, select Save Edits and then select Stop Editing.

Editor=| » * [ /] 41

"/ Stop Editing
B SaveEdits

Move...

In ArcToolbox, select Analysis Tools/Extract/Clip.
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ArcToolbox
&1 ArcToolbox
3 2D Analyst Tools
= @ Analysis Tools
= B Extract
W, SEleC
#, Split
"\Q Table Select

For the Input Features select the point feature file (SOUNDG), ref_mask for the Clip Features
select and name the output feature class to points_extract.

r’\ Clip -—" - = | B i
-
Input Features
[SOUNDG ]
Clip Features
|ref_mask ﬂ
Cutput Feature Class
C:\Working\SDB\Panama City\Data\PanamaCity04142015.gdb \points_extract
XY Tolerance (optional)
Meters hd
[ oK ] [ Cancel ] [Environments... ] | Show Help == |
k.

In ArcToolbox select Spatial Analyst Tools/Extraction/Extract Values to Points. This
function will allow to sample the algorithm result based on the point feature (point_extract).

= B3 spatial Analyst Tools

& Conditional

& Density

& Distance

= & Extraction
‘{Q Extract by Attributes
#, Extract by Circle
“r\ﬁ Extract by Mask
"\Q Extract by Points
#, Extract by Polygon
“r\ﬁ Extract by Rectangle

L T RRTER VN to D

’(% Extract Values to Points

ints

Select points_extract for Input point features. Select the algorithm results (Bath_alg) for Input
raster. Rename the output feature class to point_alg and press OK.
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’K\ Extract Values to Points bt =Ry X

Input point features i
|C:\W0rking\SDB\Panama City\Data'\PanamaCity04142015.gdb\points_extract j
Input raster
| Bath_alg j
QOutput point features

C:\Working\SDB\Panama City\Data\PanamaCity04142015.adblpoint_alg

[ Interpolate values at the point locations (optional)

[ Append all the input raster attributes to the output paint features (optional)

[ OK ] [ Cancel ] [Environmenis... ] | Show Help >> |

Right-click the point_alg layer and select Properties and select the Fields tab.

——————
Table Of Contents IX ae @ anl
8¢E| s @ aw
EEECE i e
- a e
SE=2 Layer ® h. &
[=R=0 point_alg| ® copy
®
. X Remove
=2 points_e:
o fE Open Attribute Table
= & SOUNDG Joins and Relates 3
L @ Zoom To Layer
= M ref_mask
t Visible Scale Range 4
SOUNDG
5 & Bath_alg Use Symbol Levels
Value Selection »
™ High:
' Label Features
Low:0 Edit Features 4
O AIS_poini #o Convert Features to Graphics...
O AIS_poin Convert Symbology to Representation...
0O M_QUAL, Data D
0O SOUNDG| .
@ <” Save As Layer File...
O M_QUAL] _
O UW Blue W Create Layer Package...
O UW_Gree‘ [f Properties...

Turn the visibility off for every field except the depth measurements in meters (DEPTH_M) and
the algorithm results column (RASTERVALU). To turn a field off, click the checkboxes off and
click OK.
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Loy Propertes. RS RRI %, it et &=
| Genersi [ Source [ Setecion | Dispiay | Symboiogy ] Fields |Defniion Query [ Labels [ Joins & Relates| Time | HTML Popup| .
Il | i Bl 1+~ &+ Options =

1| | chaose wihich ields el be visibla | [ Appearance |
| OBIECTED Alas FRASTERVALU
SHAPE Highlight Ne
L’:':T Number Format Numeric ;
| PR Read-Only No | '
f ] crur = Field Details
opL Data Type

Il rver
| scAMM
\ ||| sormaT
SORMND

| Depth
EXFSOU (|
QUAFDS f
[
[

il raservaLy

| i s i |

Lt s = —= ==

Right-click the point_alg layer and select Open Attribute Table.

Table OF Contents B x
= o8 o
o/ layers ]

=) it [gm L
" | [H Copy

[ peints_ext ¥  Remove
b |'En Open Attrbute Table :

013000 i Joimg and Relates 3

The attribute table should contain only the depth column and the RASTERVALU column.

Table
ERAE AL -1
point_alg
DEPTH_M | RASTERVALU
Y 54 101436
[ 1.015355
g1 1.014404
19.8 1.019569
57 1.013836
57 1.014791
57 1.014453
17 1.019472
21 101942
10.9 1.018664
g1 1.01423%
6.4 1.015377
43 1.019204
14.6 1.019185
T 1 om E {0 out of 153 Selected)

point_alg

Open the Table Options in the Table window and select Export.
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Select a destination folder to save the exported data through the Browse folder icon.

B BB
B Find and Replsce l
Ky  Select By Attributes.

B4 Switch Selection

[ Select AR
Add Field.

B Tum Al Fieids On

~ | Show Field Akases
Arrange Tables 3
Restore Default Column Widths
Restore Default Field Order

Joins and Relstes '
Related Tables !
Creste Graph..

Add Table to Layout |

E.

v 6

Reload Cache
Print...
5

Seood

= ]

F Bl
Export Data M

Export: | All records v]

Use the same coordinate system as:
this layer's source data
the data frame

the feature dataset you export the data into
{only applies if you export to a feature dataset in a geodatabase)

Output table:
C:\Working\SDB\Panama City"Data.Point_Export dbf @

|

Switch the save as type to dBASE Table and name the file Point_Export.

-

-
Saving Data ﬁ

Look in: [@ Home - Chart_Adequacy\Proces v] ot @ L-a'| E v| ﬁ| Bl e’

EProfiIeGraphData
==l point_export.dbf
point_export_2.xlsx
==l point_export_2.dbf
point_export_3.xlsx
=Sl point_export_3.dbf

MName: Point_Export.dbf

Save as type: | JBASE Table v] ’ Cancel ]

Select No when it asks to add the new table to the current map.
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ArcMap — |

! . Do you want to add the new table to the current map?

Note: The next steps are in MS Excel.

Open MS Excel.

Open the saved "Point_Export.dbf" file in MS Excel. In the Data tab, select Sort.

BEEH S Export Output 2 - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Acrobat
5 [h 5 By == [Tt [ Connections =TA e e - | v = | ARSI SN ]
A ] ) a| [Z]2 =H A= e 1= 1= |
|,E ‘, 3 | Lo L ‘ 's] 2l |21 Ea BH ® = i g 18 =
From From From From Other Existing Refresh . il Sol Filte Textto Flash Remove Data Consolidate What-If Group Ungroup Subtotal
Access Web Text Sources~ Connections All~ ’ T Advanced  colymns  Fill  Duplicates Validation - Analysis - - -
et External Data Connections Sort & Filter bata Tools utiine

In the Sort window, Select RASTERVALU as the Column and Smallest to Largest as the Order.
Press OK.

Sort X
My data has headers

Column Sort On Order

L] Jvalues [x] [smallest to targest ]

+§lgdd Level “ X Delete Level “ El copy Level I

For any value of -9999 (this represents no data) select both the RASTERVALU cell and the
corresponding Depth cell. Delete all of those sets of cells by right-clicking the highlighted cells
and selecting delete. Then select shift cells up.
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-3
D % Calibri Nun
Eg -
PavstE o B I U- $
Clipboard Font ] Alignment [Pl
B2 - fe | s9m9
A B C D E

Depth RASTERVALU
0.30000000000  -9999.00000000000
0.50000000000  -9995.00000000000
0.30000000000  -9995.00000000000

1
2
3
4
o
: 0.60000000000  -9999.0000000" [ [t
7
8
9

0.30000000000  -9999.000000
0.30000000000  -5999.000000
0.60000000000  -9999.000000
0.30000000000  -3999.000000

Delete

() shift cells left
hift cells up:

10 0.60000000000  -9999.000000 | (' Entire row
11 0.30000000000  -9999 () Entire column
12 0.30000000000  -9999.

13 3.60000000000  -9999.

14 1.20000000000  -9999.

15 0.30000000000  -9999.00000000000

16 1.80000000000  -9999.00000000000

Select again Sort in the Data tab.

B EH S . Export_Output_2 - Excel
HOME INSERT ~ PAGELAYOUT ~FORMULAS DATA REVIEW VIEW  Acrobat

wlely 3 B I alf Y. BE B = B B B

From From From From Other  Existing  Refresh o z| So Filte} T S Textto Flash Remove Data  Consolidate What-If Relationships Group Ungroup Subtotal
Access Web Text Sources= Connections Al 1k : I Advanced  Columns Fill Duplicates Validation - Analysis ~ - -
Get External Data Connections. Sort & Filter Data Tools Outline

In the Sort window, select Depth as the Column and Smallest to Largest as the Order. Press
OK.

" 5
ot L2
My data has headers

Column Sort On Order
sortby  [Bepth T [v] |values (=] smallest to Largest [=]

+§l Add Level H < Delete Level “ Ex Copy Level ]

Co Jlom

Note: In case of using survey data, make sure to round the depth values to one decimal point.
Otherwise, each depth point might have its own unique value.

Select the Advanced option under the Data tab.

[« = . Export_Output_2 - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Acrobat
B ™ B = [T [Elconnections [ZTa| W Cle = B v =5 1
oy [ 2 ) (i3 SRE R X = B
From From From From Other  Existing  Refresh i Z| Sort  Filte - Textto Flash Remove Data  Consolidate What-If b Group Ungroup Subtotal
Access Web Text Sources= Connections All~ e i T Aavanced olumns  Fill Duplicates Validation ~ Analysis = o =
Get External Data Connections Sort & Data Tools Outfine
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The default Advance Filer window will show the cell range of the whole dataset. Modify the
List range to only the A column, type Copy to: E:E, check the Unique records only box, and
press OK.

Advanced Filter 2 S Advanced Filter [

Action

Action

() Eilter the list, in-place
(@) Copy to another location

List range: SAS1:656158 List range: SAS1:6A5158 E |
Criteria range: ‘ Criteria range:
Copy to: Copy to: S

[] Unigue records only

Column E will have all the depth values organized.

IZﬂ Point_Export.dbf

Type in cell D1 the text Average, and type the following term in cell D2:
=AVERAGEIF(A:A,E2,B:B) and press Enter.

Drag the results of the cell D2 (bottom right corner) down to the end of the depth value list

(Column E).

Select Columns D and E. Under the Insert tab, select Scatter/Scatter with only Markers.

D2 -

1 |Depth

N

oW

Depth

0.1
0.1
0.3
0.3

0.1
0.1
0.3
0.3

fr | =AVERAGEIF(A:A,E2,B:B)

B C

RASTERVALU

1.00370049477
1.01015424728
1.00115084648
1.00124955177

B
RASTERVALU
1.00370049477
1.01015424728
1.00115084648
1.00124955177

D E
Average Depth
| 1.[]06927_ 0.1
0.3
0.6
0.9

C D E
Average Depth
1.00693 0.1
1.0069 0.3
1.00568 0.6
1.00442 0.9

A B C D E F

1 DEPTH_M RASTERWALU DEPTH_M

2 4.50000000000 1.01386141777 4.5
3 5.10000000000 1.01440405846 5.1
4 5.10000000000 1.01423859596 5.4
5 5.10000000000 1.01387035847 5.7
6 5.10000000000 1.01426672935 6.0
7 5.10000000000 1.01437878609 6.4
8 5.10000000000 1.01422977448 6.7
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The results will show a linear line at shallow depth that start to curve vertically at deeper water

values. Identify the curve value and
the image show an extinction value

3
&
4
2
o
1.

mark it in you file sheet as the “Extinction Depth” (Although
up to 13 m, we will use 8.8 m in this example).

Average SDB Value

*

005 1006 1007 1008 1009 101 1011 1012 1013

Note: The x-axis is the SDB result and the y-axis is the charted depth.

Select all the depth values and SDB
Depth (it also recommended to start

Select again Scatter/Scatter with o

values from columns D and E that are below the Extinction
at depth values above 1 to 2 m, depending on the site).

Average Depth

1.00693 0.1
1.0069 0.3
1.00568 0.6
1.00442 0.9
1.00279 1.2
1.00611 1.5
1.0029 1.8
1.00369 21
1.0059 2.4
1.00766 27
1.00696 3.0
1.00761 343
1.00873 36
1.00917 3
1.012 42
1.01101 4.5
1.01301 4.8
1.01308 5.1
1.01394 5.4
1.01446 57/
1.01481 6.0
1.01563 6.4
1.01583 6.7
1.01638 7.0
1.01661 i3
1.01721 76
1.0174 79
1.01773 82
1.0181 8.5
1.01842 8.8

nly Markers, located under the Insert tab.
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Art - ol v Charts *

Tabie: IBurtafions Charts Sqatler

F2 - I | =AVERAGEIF[A:A E2 B:B)

You will receive a scatter plot that will be a linear line, right click on one of the markers and
select Add Trendline... .

g *
Delete
K Resetto Match Stele

11 Change Series Chart Type..,
Select Data...

Add Data Labels r
35 Add Trendline...

B4 Format Data Series...

Make sure the regression type is linear. Check the Display Equation on Chart and Display R-
squared value on chart boxes and press Close.

5
Format Trendline P -t
| Trendine Options | Trendline Options
Line Calor Trend/Regression Type
Line Style - : () Exponential
Shadow

@ Linear
Glow and Soft Edges =
= ) Logarithmic
-1 @ polynomial Order: |2
4| © Power
7| © Moving Average Period: |2

Trendline MName

@ Automatic : Linear (Average)

) Custom:

Forecast

Forward: (0.0 periods
Backward: 0.0 periods

[7] setIntercept= 0.0
Display Equation on chart
Display R-sguared value on chart

Close

The resulting equation of the trend line is used for the referencing (in this example, the gain is
458.37 and the offset is -458.82).
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10.0

9.0 .
80 ¥ =458.37x - 458.82 .

' R*=0.9497
70 X,

6.0 s
5.0 SR ,[
40 Pt ®

2.0 .. 2

20 o

10 .

0.0
1002 1004 1006 1008 1.01 1012 1014 1016 1018 1.02

Save the Excel Spread sheet into the Data directory as Extinction_Depth.xlIsx. (Excel Workbook
in Excel 2007).

Panama ity XL 5.gdb

& Downloads

) Recert Places

B Deskdop

4 Libraries

File narne Estinction_Depth.slse

(%] Save As - ——— o]
..;_)\\_'). |5 v my Compuler » Delault (C:) » Working » SDE » Panama City » Data + - [ 49 [[ Search Do |
Organize » Mew folder
[E] Microsc# t Bcel

Save as type | Bxcel Warkboak (".xlsx)

& Hude Folders Tools = | Save |

14.4.4 SDB - Applying the gain and offset (referencing)

In ArcMap, select in the ArcToolbox Spatial Analyst Tools/Map Algebra/Raster Calculator.

= & Spatial Analyst Tools
& Conditional
& Density
& Distance
& Bxtraction
& Generalization
& Groundwater
& Hydrology
& Interpolation
& Local
= & Map Algebra
‘(\3 Raster Calculator

Select the algorithm layer and multiply the algorithm layer by the gain value from the excel
sheet, and then subtract the offset value. Save the file as "calc_bathy" and press OK.

39

1




£, Raster Calculator -

Map Algebra expression

Layers and variables Conditional ol
<{>11425_5.KAP

con E|
Sracrae (£ 0 R S B
<> 11425_2.KAP BB Sethull
<>11425_4.KAP Math
Gr ezl [l
<{>11425_1.KAP £
S, e 5 o v ) A

[ |»

1

(458.37 = ( "Bath_alg1" ) ) - 458.82

&Dutput raster
C:\Chart\shinnecock Inlet, NY\Charts\Chart1234.qdb\calc_bathy @ ol

oK I l Cancel I l Envlronmems...] [ Show Help => ]

Using the Identify button click on a few “point_alg” point (make sure that Identify from:
Visible layers) and compare the values.

Identify o x
Identify from: | <Visible layers> [
- point_alg

02261F92FBE0000 L

E -11389_LKAP

- calc_bathy
~8.196167

Location:  633,557.531 3,323,218.292 Meters =
DEPTH M 8.2
RASTERVALU 1017054

14.45 Generating contour lines (based on the largest-scale chart available)

Select the ArcToolbox Spatial Analyst Tools/Surface/Contour List.

= B9 Spatial Analyst Tools
& Conditional
& Density
&y Distance
& Extraction
& Generalization
& Groundwater
& Hydrology
& Interpolation
& Local
& Map Algebra
%; Math
& Multivariate
&5 Neighborhood
& Overlay
%; Raster Creation
& Reclass
& Solar Radiation
(= % Surface
“r\ Aspect
;\ Contour
’r\ Contour List
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Type in the Contour List window the Contour values that match the largest-scale chart
available in area. Make sure that the depth are in meter (if the chart contours are in feet or
fathoms, then convert those measurements to meters) and press OK.

[, contour List N ] =E)

Input raster

[ calc_bathy =
Output polyline features
C:\Working\SDBPanama City'\Datal\P: ity04142015.9db\SDE _contour_fY]

Contour values

vy

0.91
182
3.66
5.49
9.14

(][] [x] #]

ok || cancel | [Envionments... ] [ showHep x> | l

The contour layer should be inspected with respect to the contour lines of the chart.

14.4.6 Comparing between the derived and the charted bathymetry

Turn on the derived bathymetry and the contour list over the RNC. Notice if there are any
discrepancies between the two (in the case, marked in red circles).
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In ArcCatalog, select the file geodatabase in the Data directory folder. To create a new feature
class, right-click the geodatabase and select New then Feature Class.

= £ soB
E E3 PanamaCity
= E Data
@ (5 USSFLE6M_chape
=
& B Proj ¢
& [ SDBtransfer »
& & ServerAdminToolk
= & sop
© E5 Source_GDB_Parer = Refresh
& 1 sqideveloper (B Make Default Geodatabase
® EJ stagingtemp ;i
® 3 StatisticsAndFreqy Admunistration
® E5 Student Distributed Geodatabase
|8 Festure Dataset... [ New

Name the file "Bath_Diff", select Polygon Features as the feature type. Click Next.

New Feature Class

Namg Bath_Di

Alias
Type
Type otteatures ghored in fus feature class:

| Polygon Featues:

Geomelry Properbes.

e Z values L 0 data

| Coordinates include M values. Used 1o siore routs data.
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Confirm that the coordinate system matches the UTM projection of the project. Click Next three
more times and then click Finish.

Right-click the Bath_Diff layer and select Edit Features then Start Editing.

New Feature Class - - -

=

Choose the coordinate system that will be used for XY coordinates in this data

Geographic coordinate systems uss lattuds and longtude coordinates on a spherical mods!

of the earth's surface. Projected coordinate systems use 3 mathematical conversion to
ransform latitude and longitude coordinates to a two-dimensional linear system

T v | Typehere tosearch

MEE U RE- ¢

= % Favorites
) NAD1983 UTM Zone 18N
€3 WG51984 UTM Zone 5N
€2 WG51984 UTM Zone 6N
RELWGS 1084 UTM Zone 171
€3 WG51984 UTM Zone 18N
€ WG51984 UTM Zone 19N

[ Geographic Coordinate Systems

[ Projected Coordinate Systems

[l = .

m

Current coordinate system:

WGS_1984_UTM_zone_17N
WKID: 32517 Authority: EPSG

Projection: Transverse_Mercator
false_easting: 500000.0
false_northing: 0.0
central_meridian: 51.0
scale_factor: 0.9995
Iatitude_of_origin: 0.0

Linear Unit: Meter (1.0)

<gack | Net> ||

Cancel

Table Of Contents % x

ELELIE

®

Layers

o [

O surve:
o

O surve;

0 AIS_2
o

O surve;
L)

0O mask_

O Natur
110

-

Copy

X Remove

B Open Attribute Table
Joins and Relates

v Zoom To Layer

Visible Scale Range
Use Symbol Levels
Selection

Label Features

[ 4.43

Edit Features

You may get the following message, press Continue.

= Start Editing
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Start Editing & 8

| (i % Start edting encountered one or more layers with warings.
"/ You may not be able to edit some layers f you continue.
|

| Hame Description

(L) ATS_paints_2011_it_my...  Spal
L m_qua_a
D sounnG_p
O sounoe_p
(D) 55_soundings_FtMyers...

Do not show this dislog unbess there are

Tigr: Double-click error to views additional information Contnue

Spatal reference does not match data frame.
Spatal reference does not match data frame.

errurs that prevent start ediling.

|

4

In the Create Features window, select the Ref_mask feature and select the Polygon option in the

Construction Tools window.

Create Features
% - B <Search> @
_Click here to see templates not listed. x|
Bath_Diff

T

B0

[/ Construction Tools

<% Polygan

1 Rectangle

O Circle

O Elipse

r Freehand

1% Auto Complete Polygon

2| Auto Complete Freehand

S @l Boejeo &l

g2

Note: In case the Create Features window does not appear automatically, select the Create
Features icon from the Editor toolbar.

Editor ~ E|

52 . o

2 |E A [E]

Roughly, digitize around the whole bottom feature that does not match between the chart and the
derived bathymetry (any discrepancy between the SDB and the chart).
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In the Editor toolbar, select Save Edits and then select Stop Editing. The Bath_Diff layer now
contained the areas that have changes since the last survey used for the chart.

Editor ~||

» N2 A

"/ 5Stop Editing
B SaveEdits

Move...

Right-click the Bath_Diff layer and select Open Attribute Table.

'EéLnycrs -

= o EEN .
El

Copy
X  Remove

= 0O surveys_C
° | Open Attribute Table J

Open the Table Options in the Table window and select Add Field... .

Table &
L LR
M Find and Replace... x

Bh  Select By Attributes.. ength |  SHAPE Area
171676 52145982.090852

B8 Switch Selection Selected)
[ Select All

1 AddField.. |
FEl Turm AllFid . .. o .. [

In the Add Field window, type Name: BD and press OK.
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[ Add Field =)

Name: BD

Type Short Integer -

|| Field Properties
0 [Aies

Allow NULL Values Yes
Default Value

[ 0K ] [ Cancel
A new field was added to the Table.
Table 0o x
R
Bath_Diff x
OBJECTID * SHAPE * SHAPE_Length SHAPE_Area BD

} 1 | Palygon 29132 171676 52145982.090852 | <Null=

TR 1 » »|[E]S | 0outof1 Selected)

Bath_Diff

Right-click again on the Bath_Diff layer and select Edit Features then Start Editing.

Table Of Contents % X
e8|
= = Layers -
SR =0 Bath_Diff!
o | & Copy
= O survey) ® Remaove
e B Open Attribute Table
B O survey Joins and Relates *
=0 AIS 20 |
M 4 Zoom To Layer
= 0O survey
-] Visible Scale Range J
= 0 mask_ Use Symbol Levels
= Selection *
= O Natur
=110 Label Features
@443 Edit Features »| 7 startEditing
—

Type the value “10” in the BD column for each of the polygons..

Table ox
H-1%- BN
Bath_Diff x
OBJECTID * SHAPE * SHAPE_L ength SHAPE_Area BD -
3 1 | Palygon 29132171676 52145982.090852 [ 10 i
"o 1 » n|[E|=] ./ ©0outof 1 Selected)
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In the Editor toolbar, select Save Edits and then select Stop Editing. The Bath_Diff layer now
contained the areas that have changes since the last survey used for the chart.

Editor | ®

(7]~ &

"/ Stop Editing

[{-:‘F‘ Save Edits

Move...

Select Con toolbox, in Spatial Analyst Tools/Conditional.

3 & Spatial Analyst Tools
[ & Conditional

) Con

“ Pick
“. Set Null

In the Con window, select Ref_Surface for Input conditional raster, then use the following
Expression: “value < 1000”. Type “0” as the Input true constant data, output raster as

“Background” and press OK.

“_ Con = | (S} |-
-

Input conditional raster
|Ref,5urface [~ |
Expression (optional)
Value < 10000
Input true raster or constant value
[o =
Input false raster or constant value (optional)
| =
Output raster
C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\Background_

oK I l Cancel I l Environments... ] [ Show Help >> I

= @ Conversion Tools

& Excel

%; From GPS

& From KML

= & From Raster
‘{Q Raster to ASCI
"‘ Raster to Float
‘{Q Raster to Point
1o Poiygon
‘{Q Raster to Polyline
"‘ Raster Te Video
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In the Raster to Polygon window, select Background for the input raster, make sure that the
Field is Value, and the output polygon feature is Background Poly, and uncheck Simplify
polygons, and press OK.

Input raster
IBackground LI @
Field (optional)

Value -
Output polygon features

C:\Wsers\anthony.r.kKlemm\Documents\ArcGIS\Chart_Adequacy_Ft_Meyers.gdb\Background_paly @
Simplify potygons (optional) =1

[ ok || cancel ||[Envirorments...| | <<HdeHelp |

Select Union toolbox, in Analysis Tools/Overlay.

Aot
B! ArcToolbox
@ 3D Analyst Tools
= & Analysis Tools
& Extract
= & Overlay
“, Erase
“, Identity

“ Intersect

“, Spatial Join

“, Symmetrical Difference

N Union

In the Union window, make sure to load the Bath_Diff layer over the Background_Poly layer

and press OK. Name the output merge.

[
(o]

r
‘\ Union

»

Input Features

|4

CIENEIIEIN

Features Ranks
<> Bath_Diff
<> Background_poly

< | 1 | »

Output Feature Class
C:\Chart\Shinnecock Inlet, MY\Charts\Chart1234.gdb\merge

)

JoinAttributes (optional) I

ALL -
XY Tolerance (optional)
Decimal degrees -
|| Gaps Allowed (optional)
ok |[ cancel |[Environments... | [ Show telp >> |
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Right-click the merge layer and select Open Attribute Table.

* Table Of Contents 2 x
- =7 Layers -

—] erge
o | @ Copy
Back X Remove

— JEEI Open Attribute Table
Bat o o ]

Validate that the BD column in the Table of the Merge file contains a “10” value for the marked
polygons and “0” for the background.

Table 0 x
g B R EE
merge X
OBJECTID SHAPE * FID Bath Diff BD FID Background poly d | ¢
1| Polygon -1 0 1 1
» 2 | Polygon -1 0 2 2
3 | Polygon 1] 10 2 2
< 1 »
T 2 » »|[E]® Qoutof3Selected)
merge

Note: Make sure that both the Bath_Diff and the background layers are projected in a Cartesian
datum (e.g., Transverse Mercator or Universal Transverse Mercator). Otherwise, use Data
Management Tool/ Projection and Transformations/Project to convert the polygons into
Cartesian datum.

Select Polygon to Raster, in ArcToolbox/Conversion Tools/To Raster.
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& ArcToolbox -
& 3D Analyst Tools
@ Analysis Tools
@ Cartography Tools
= @ Conversion Tools
& Excel
& From GPS
& From KML
& From Raster
& From WFS
& JSON
& Metadata
& To CAD
& To Collada
& To Coverage
& To dBASE
& To Geodatabase
& To KML
=] & To Raster
#, ASCII to Raster
“. DEM to Raster
#., Feature to Raster
#, Float to Raster
“, LAS Dataset to Raster
“ Multipatch to Raster
“., Point to Raster

Y Polygon to Raster

m

In Polygon to Raster window, select merge as the Input Features, BD as the Value field, the

Cellsize as 30m and press OK.

T~ — iR
%, Polygon to Raster l =) &

Input Features

merge = @

Value field
BD -

Output Raster Dataset
C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\Bath_Difference @

Cell assignment type (optional)
CELL_CENTER -

Priority field (optional)
MONE -

Cellsize (optional)

: B

OK J ’ Cancel ] ’Environments...] l Show Help => l

The resulting layer should be a thematic map of the bathymetric difference.
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Bathymetric

Difference
o
10

Save the project by selecting File/Save in the main menu.

@ untitled - ArcMap TN

File | Edit View Bookmarks Inser

(0 New.. Ctrl+N

B Open.. Ctrl+0
@ Save Ctrl+S

14.5 Vessel Traffic layer

14.5.1 Calculating the traffic density

Using a web browser (e.g., Google Chrome, MS Internet explorer, etc.), download the Track
Builder Script from the following webpage: http://marinecadastre.gov/ais/ .
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http://marinecadastre.gov/ais/

The Tools
Track Builder Script

This tool converts a collection of point features into a track line. The input data must include date
and time values for each point and an identifier to group points in a line. It is designed to work
with data available from MarineCadastre.gov but will also function with other feature classes that
contain a DateTime field and a unique identifier. When used with MarineCadastre.gov-formatted
data, the tool also offers a function to extract vessel and voyage attributes from related tables for
each line.

Technical Specifications

1. ArcGIS Toolbox ArcPy script designed for ArcGIS for Desktop 10.1 and 10.2
2. ArcGIS for Desktop Standard or Advanced license required for relationship class
functionality

View Tutorial Download

Extract the *.zip (currently, TrackBuiderVersion2.zip to a local directory on your computer or
server.

In the ArcToolbox window, right-click on the main ArcToolbox directory.

ArcToolbox I X Table Of Cantents

- ,"; 51 =
© AddToolbox. s 8 d

Layers

Wi
Add Toolbox

Add atoolbox (a the file) to this
wiindouy $0 you can easily access
the tools it contains and create
newy tools in it

&3 Editing To

In the AddToolbox Window, navigate to your local directory and select TrackBuilder.tbx and
press Open.

Add Toolbox =<
Lockin: |5 Chart_adequacy el B EY BB
L& Chart000.gdb

- TrackBuilder.thx

Mame: TrackBuilder thx

Show of bype:

[Toolboxes v] [ Caneel ]

The TrackBuilder toolbox will be added to the Toolbox window. Select Track Builder V2
from the toolbox
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ArcToolbox

ArcToolbox

@ 3D Analyst Tools

@ Analysis Tools

@ Cartography Tools

) Conversion Tools

&) Data Interoperability Tools
@ Data Management Toaols
@ Editing Tools

@ Geocoding Tools

B Geostatistical Analyst Tools
) Linear Referencing Tools
@ Multidimension Tools

@ Network Analyst Tools

@ Parcel Fabric Tools

B Schematics Tools

@ Server Toals

@ Spatial Analyst Tools

@ Spatial Statistics Tools

= @ Track Builder

o Track Builder v2

@ Tracking Analyst Tools

In the Track Builder Window, select the AIS point feature file (“AlS_points_ UTM”) as Input
Points, MMSI as the ID Field, BASEDATETIME as the DateTime Field, Maximum Time and
Distance for the Break Track Lines using, “20” for the Maximum Time (minutes), “2” for the

Maximum Distance (miles) and press OK.

3" Track Builder v2 ’

Input Paints

[ AIS_points_UTM

ID Field
MMST

DateTime Field

BASEDATETIME|

Qutput Workspace
C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb

Output Name
AIS_trackline

Break Track Lines using:
Maximum Time and Distance

Maximum Time (minutes)

Maximum Distance (miles)

[ o

] [ Cancel I I Environments... I [ Show Help ==

Select Line Density, under ArcToolbox/Spatial Analyst Tools/Density.

= @ Spatial Analyst Tools
& Conditional
= & Density
“, Kernel Density

g Line Density

# Point Density
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In the Kernel Density window, select the AIS_Trackline line feature as Input point or polyline
features, “30” as the Output cell size, “300” as the Search Radius, SQUARE_METERS as the

Area units, and press OK.

Input polyline features
| AIS_trackline -

Population field
NONE

Output raster
C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\AIS_Density
Output cell size (optional)
:
N
Search radius (optional)
oo |

Area units (optional)
SQUARE_METERS

oK l [ Cancel l ’ Environments... ] ’ Show Help == l

14.5.2  Generating the Vessel Traffic layer

Select Con toolbox, in Spatial Analyst Tools/Conditional.

7 @ Spatial Analyst Tools
= & Conditional

] Con

“ Pick
“, Set Null

In the Con window select AIS_density for the Input raster, type the following Expression: “value

> 0.0044”. Type “1” as the Input true raster or constant value and “0” for the Input false raster.
Save the output raster as “Vessel Traffic”.
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(ERSNG < | 5

Input conditional raster —

| a1s_Density

»

|4

K
&) @) @ (= @

Expression (optional)
Value > 0.0044

m

Input true raster or constant value
| I

Input false raster or constant value (optional)
fo
Output raster

C:\Chart\Shinnecock Inlet, NY\Charts\Chart1234.gdb\Vessel_Traffic

|4

[ 0K ] ’ Cancel ] ’ Environments... ] ’ Show Help == ] I

Select Conversion Tools/From Raster/Raster to Polygon.

= a Conversion Tools

% Excel

& From GPS

& From KML

=] % From Raster
#, Rasterto ASCI
K\ Raster to Float
g\ Raster to Point
e to Polyoon
K\ Raster to Polyline
#.,, Raster To Video

In the Raster to Polygon window, select Vessel_Traffic for the input raster, make sure that the
Field is Value, and the output polygon feature is VT_poly, and uncheck Simplify polygons,
and press OK.
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“\ Raster to Polygon = | B | e

-
Input raster
|‘u‘e55eI_Traffic j
Field {optional)

Value Ml E
Output polygon features

Ci\Users\Anthony.r.Klemm\Documents \ArcGIS\Chart_Adequacy_Ft_Meyers.gdbWT_paly

[ oK ] [ Cancel ] [Environments... ] [ Show Help == ]

Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
[0 New.. Ctrl+N
B Open.. Ctrl+0
| Save Ctrl+S

14.6 Hydrographic Characteristics layer

14.6.1 Validation of CATZOC encoding in the MQUAL S-57 attribute

In the Table Of Contents window, right-click on the M_QUAL_UTM layer and select Open
Attribute Table...

5 & Layers
= [0 SoundG

B Copy

=] mMQual X Remove

E Open Attribute Table

— M raTTA

If the MQUAL layer has multiple polygons with varying CATZOC values, then Skip to 6.1.4.

Note: Multiple polygons MQUAL layer is the default source of information to create the H.C.
thematic map.
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Table O x
- B

MQUAL X
FID | Shape* | OBJECTID LNAM RCID | PRIM | GRUP | OBJL | RVER CATZOC SUREND | SURSTA THT =

4 0 | Polygon 0 | USDE2592147600009 Sg24 3 2 308 1| zone of confidence B 1959 1950 USSFL1

1 | Polygon 1 | US090284448500000% 5625 3 2 308 1 | zone of confidence B 1959 1950 USSFL1

2 | Polygon 2 [ US064103203300009 5626 3 2 308 1 | zone of confidence B 1959 1950 USSFL1

3 | Polygon 3 | USD545357458500009 5627 3 2 308 1| zone of confidence B 1959 1950 USSFL1
4 | Polygon 4 | US0Z2424786300009 5802 3 2 308 1| zone of confidence B 1959 1950 USSFLY =

5 | Polygon 5 | USDE9340824400009 5803 3 2 308 1| zone of confidence B 1959 1950 USSFL1

L & | Polygon 6 | US053340064200008 5815 3 2 308 3 | zone of confidence U (data not azsessed) USSFL1

If the MQUAL layer has only has one or two polygons and the CATZOC is encoded as “zone of
confidence U (data not assessed),”” or has not yet been encoded, then it is recommended to use
the source layer from an RNC in order to generate a hydrographic characteristic polygon(See
SDB procedure — Chapter 11, Appendix B) in addition to 6.1.4.

Table [
M_QUAL A
OBJECTID | SHAPE= LNARM RCID | PRIM | GRUP| OBJL | RVER CATZOC SORDAT SORIND
3 0 | Polygon US016327304504335 6641 3 2 308 1 | zone of confidence U (data not azseszed) 20080300 | US,US graph,Chart 12352

If some cases historical hydrographic survey outlines and metadata are available (skip to 6.2). If
available, click Add Data.

+

Navigate to the survey outlines file into your workspace in the Add Data window, select the
survey outlines file and click Add.

Name:

Show of type:

5 CATZOC_output.shp

CATZ0C output.shp

Datasets, Layers and Resuits

- [ conea |

In some cases the most current surveys outlines file will cover an area larger than your area of
interest, you can clip the current survey outlines file to the MQUAL. Select Clip from the

Geoprocessing tab.
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Geoprocessing | Customize  Wind

Buffer

Clip |
Intersect

Unicn

Merge

Dissolve

Search For Tools
ArcToolbox

Environments...

Hxae A A A HNAA

Results

In the Clip window, select the current surveys outlines file as the Input Features and the
M_QUAL_UTM of the chart you are evaluating as the Clip Features. Save the feature class as
“M_QUAL_UTM_Clip” to your Default Geodatabase and press OK.

'3 ~
I\ Clip = | B |
-
Input Features Output Feature Class
|Most_Current_Surveys_outlines ﬂ
] The feature class to be
Clip Features created
| MQUAL | ’
COutput Feature Class
C:\Users\anthony.r.Klemm'Documents\ArcGIS \Default. gdb\Aandote_Most_Current_Surveys_MQUAL_Clip
XY Tolerance (optional)
Meters - L L
[ 0K ] ’ Cancel ] ’En\rironrnents... ] [ < < Hide Help ] ’ Tool Help ]
k.

Note: The MQUAL file in next steps will describe as “M_QUAL_UTM”. If a current surveys
outline file was available, then use “M_QUAL_UTM _clip”.

14.6.2 Input H.C. values using the H.C. Look-up Table

Right-click on the M_QUAL_UTM_clip layer and select Open Attribute Table...in the Table
Of Contents window.

Table Of Contents rx
BEEEXE
= = Layers o
@
O E Copy
= O Recent_{ % Remoave
O
O M_QUA

| 2 Open Attribute Table

In the Table window, click Table Options > Add Field...
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Table
BT

B Find and Replace...
B  Select By Attributes...

B¥  Switch Selection
[%] Select All
| AddField... |

In the Add Field window, type: Name: “HC”, select Type: Short Integer and press OK.

In the Table of Contents, right-click on the M_QUAL_UTM _clip layer and select Edit

Features > Start Editing.

Type the HC rank (Table 14.1 in the Introduction) based on the Technique of Soundings

@ x5

r Bl
Add Field )
Name: HO|
Type: IShort Integer -
Field Properties
Alias
Allow NULL Values Yes
Default Value
[ ok ][ cance |
L

Copy - - *
Aemove e .

Open Aftribute Table [+, L

Joins end Relates 3 * r

Zoom To Layer L -

Vimble Scale Range
Use Symbaol Levels
Zeluction

Labed Featuses

Edit Festures

*
v Pan ¥
- -
-
3 i. 5
T L3
k #  Stat Editing

(TECSOU) IHO code (Table 14.2) and the survey dates, type.

Table m
HC_polygons >
OBJECTID_1 = Shape * | CATZOC | SUREND | SURSTA | TECSOU | SORDAT SORIND Shape_Length Shape_Area HC
3 3 | Polygon 5| 18860508 | 18360311 | 5 18850508 | US,US graph, HO1750 0.40878 0.003593
59 | Polygon 3| 19501117 | 19458082515 19501117 | US,US graph HOFBYT 0.308525 0.002534 5
23 | Polygon 3| 19501117 | 19490919 1,5 19501117 | US,US,graph,HO7876 1.215863 0.007029 5
17 | Polygon 3| 19501130 | 195011081 19501130 | US,US graph HOTS05 0.026457 0.000033 4
15 | Polygon 3| 19501130 | 19501109 |1 19501130 | US,US graph, HOTS05 0.088785 o.0o0114 4
22 | Polvgon 31 19501130( 1950110811 19501130 | US,US, graph HO7205 0.346745 0.001925 4
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Note: Use the highest value for the HC (worst case scenario) if there are multiple techniques to

obtain soundings (TECSOU).

Table 14.2 S-57 TECSOU codes (definitions from IHO S-32).

Code | Technology Definition

1 Found by Echo-sounder Depth was determined by using an instrument that determines depth of
water by measuring the time interval between emission of a sonic or
ultrasonic signal and return of its echo from the bottom.

2 Found by Side-scan-sonar Depth was computed from a record produced by active sonar in which
fixed acoustic beams are directed into the water perpendicularly to the
direction of travel to scan the bottom and generate a record of the bottom
configuration.

3 Found by Multi-beam Depth was determined by using a wide swath echo sounder that uses
multiple beams to measure depths directly below and transverse to the
ship's track.

4 Found by Diver Depth was determined by a person skilled in the practice of diving.

5 Found by Lead-line Depth was determined by using a line, graduated with attached marks and
fastened to a sounding lead.

6 Found by Wire-drag A given area was determined to be free from navigational dangers to a
certain depth by towing a buoyed wire at the desired depth by two
launches, or a least depth was identified using the same technique.

7 Found by Laser Depth was determined by using an instrument that measures distance by
emitting timed pulses of laser light and measuring the time between
emission and reception of the reflected pulses.

8 Found by Vertical acoustic A given area has been swept using a system comprised of multiple echo

system sounder transducers attached to booms deployed from the survey vessel.

9 Electromagnetic sensor Depth was determined by using an instrument that compares
electromagnetic signals.

10 Photogrammetry Depth was determined by applying mathematical techniques to
photographs.

11 Satellite imagery Depth was determined by using instruments placed aboard an artificial
satellite.

12 Found by leveling Depth was determined by using levelling techniques to find the elevation
of the point relative to a datum.

13 Swept by side-scan-sonar A given area was determined to be free from navigational dangers to a
certain depth by towing a side-scan-sonar

14 Computer generated Sounding was determined from a bottom model constructed using a

computer.

In the Editor Toolbar, click EDITOR > STOP EDITING.

Editor=| »

"7 Stop Editing

When prompted to save, click YES.
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Save - ' @

Do you want to save your edits?

14.6.3 Convert vector file HC Polygons to an HC raster

Open the Polygon to Raster (Conversion) Tool.
In the toolbox, click Conversion Tools > To Raster > Polygon to Raster.

ArcToolbox ax
& ArcToolbox -
@ 3D Analyst Tools
@ Analysis Tools
@ Cartography Tools
= @ Conversion Tools
& Cxcel
& From GPS
& From KML
& From Raster
& From WFS
& JSON
& Metadata
& To CAD
& To Collada
& To Coverage
& To dBASE
& To Geodatabase
& To KML
=1 & To Raster
“, ASCIL to Raster
#, DEM to Raster
#, Feature to Raster
#., Float to Raster
#, LAS Dataset to Raster
“. Multipatch to Raster
“., Point to Raster

Y Folygon to Raster|

F Naldine +n Dactar

m

In the Polygon to Raster window, choose: HC_polygons as the Input Features, , HC as the
Value Field, and Cellsize: 30. Press OK.
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r ' IEI B
Polygon to Rast =] o]
& O ygnn (e ] er , !
FrriResires “| cellsize (optional) i
I HC_polygons LI @
Value field The cell size for the output
raster dataset.
HC -
Output Raster Dataset The default cell size is the
0:\anthony KlemmWorkshop Data\Andote Key, FL\Andote_Key_FL.gdb\HC @ shortest of the width or
Cell assignment type (optional) height of the extent of the
CELL_CENTER - input feature dataset, in the
- ) tput spatial reference,
Priority field (optional) out
NONE - divided by 250.
Cellsize {optional)
> 8 - :
ok |[ cancel | [Environmenis...|[ <<tidetep | | Toolhep |
-

The resulting layer is a thematic map of the Hydrographic Characteristics.

Save the project by selecting File/Save in the main menu.

@ untitied - ArcMap L-

File | Edit View Bookmarks Inser
[0 New.. Ctrl+N
B Open.. Ctrl+0

‘ & Save Ctrl+S
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14.7 Chart Adequacy

14.7.1 Archiving the layers

Select Union toolbox, in Analysis Tools/Overlay.

In the Union window, load the feature files of the bathymetric difference (i.e., merge), vessel
traffic (VT_poly), and Hydrographic Characteristics (HC_polygons) feature files. Save the

T

ArcToolbox

& ArcToolbox
& 3D Analyst Tools
= & Analysis Tools
& Extract
= & Overlay
#, Erase
#, Identity
#, Intersect
“, Spatial Join
5 Symmetrical Difference
# Union
“, Update

output feature class as Adequacy_table and press OK.

g 5
 Urion - = 5 [t
i
Input Features
|
Features Ranks
ST _poly
<_“merge £S5
<_HC_polygons
4 | I P
Cutput Feature Class
C:\Users\Anthony.r.Klemm'\Documents\ArcGIS\Chart_Adequacy_Ft_Meyers.gdb\Adequacy _table|
JoinAttributes {optional)
ALL -
XY Tolerance (optional)
Meters )
Gaps Allowed (optional)
oK. ] [ Cancel ] [Environments.‘. ] [ Show Help =>

Right-click the Adequacy_table layer and select Open Attribute Table.
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Open the Table Options in the Table window and select Add Field... .

= Adequaq,r_t"

[
= [0 HC_polygor

Copy

X Remowve

(I |E Open Attribute Table

1 WT sl

Table

B e %8

M Find and Replace...

By Select By Attributes... ength | SHAPE Area
171676 52145982 090852
B8 Switch Selection Selected)
[@ Select All
Add Field...

In the Add Field window, type Name: Chart_Number, make sure that Type: Text (length: 20)

and press OK.

A new field was added to the Table.

organize the table as follows.

Add Field = I — =5
Name: Chart_Number
Type: [Tm -
Field Properties
Alias
Allow NULL Walues es
Default Value
Length 20
[ ok || cance |
b s e o

Drag the fields (left-click on the header of the field) and

Table O x
Adequacy_table s
m
OBJECTID * Chart_Number VT HC BD Shape* | FID_VT_poly | Id | FID_HC_polygons | 1d | FID_BC_B =
1 | <Nul= 0 0 0 [ Polyaon 7] 7 EREL [
2 | =Null= 0 9 0 | Polygon -1 0 1 1
3 | =Null= 0 9 0 | Polygon -1 0 2 2
4 | =Null= 0 4 0 | Polygon -1 0 [ [
5 | =Null= 0 4 0 | Polygon -1 0 7 7
6 | <Null> 0 4 0 | Pohygon -1 0 8| 8 =
4 [ | +
T 0 » n [E|S 0outof16l Selected)

Adequacy_table
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Right-click on the Chart_Number field and select Field Calculator....

Table -
Adequacy_table :
OBJECTID * Chart lumber 1 VT [ HC B | Swges | FDMT poty |50 | FBC potvnons | k|| FDBC |2 ||
1| =Null= =  Sort Ascending 0 | Polygon i —— 3
2 [<Nul= i _ o Foraen 7T e
= SortD d

3 | <Null= OIS EENCING o Polygon 3 : ]

4 | <Nulk= Advanced Sorting... 0 [Polygon X 0 z 2

c : -

> | Nl Summarize... 0 | Polygon 1] o T

& | <Nul- o Foraen I i ]
4 | :

Hod o omE Field Calculator... |

In the Field Calculator window, type in the chart number under “Chart_Number = * and press

OK.

M ~
Field Calculator @
Parser
@) VB Script () Python
Fieide: Type: Functions:
OBJECTID AlF © Number 2::(( ))
Shape ) o)
FID_¥T_poly () String Bl )
1d 5 e P ()
gridcode T ir;tg(( ,‘|:|
FID_HC_polygons B Sty
4.1 s ()
gridcode_1 Tan ()
FID_BC_Merged i
[] Show Codeblock
/ +
Chart_Mumber = E] E] E]
12345| m
About calculating fields [ Qear ] [ — ] [ = ]

Table is now ready to be used for inquiry either in ArcMap as a Table or in MS Excel as a spread
sheet by loading the Adequacy_Table.dbf file.

14.7.2 Calculating the adequacy

Select Spatial analyst Tools/Map Algebra/Raster Calculator in the Toolbox window.
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=& Spatial Analyst Tools
& Conditional
& Density
& Distance
& Extraction
& Generalization
& Groundwater
& Hydrology
& Interpolation
& Local
=& Map Algebra

In the Raster Calculator window, write the following command:
("Vessel_Traffic" * ("HC" + "Bath_Difference" ) ) / "Ref_surfacelm™. Save the output raster as
Chart_Adequacy and press OK.

#., Raster Calculator e @M

i

Map Algebra expression

=7 hal I_AuEguaLy

) Vessel Traffic i CCundmona\ |;|
on =
HC = E
g & Edledl) [WE)ie]|
<> a15_Density

S [l o] (Dol 1)

Background Math

S ENENERIEN PPN

<>Baﬂ1_a|g_Tampa Abs

LTI %

s o 0 £
Cominy

{ "Vessel_Traffic” * { "HC" + "Bath_Difference™) ) / "Ref_sutface Im™

Qutput raster
Ci\Working\Data 30June2015 Workshop MCD\Passage Key Inlet FLYFt_myers,gdb\Chart_Adequacy

OK ] [ Cancel ] [Ervmmnments... ] [ Show Help =>

In the Table of Contents, right-click on the Chart_Adequacy layer and select Properties...

Table Of Contents B Xx
o8
[ Sathls B

[0 AISUSER.POSNMSTR_UMDERWAY

[ 2011 Atlantic Vessel Density

= Chart_Adequacy
O BC_HC_non B Copy
[0 BC_HC X Remove
0O HC
[ BC_rast
[ RefDepth
O MQUAL |
[0 VT_Reclasse:

Joins and Relates 3

Zoom To Layer

O S5_Soundings_p !J'F Zoom To Raster Resolution

[0 MOAA Seamless) .

0 CATZOC FL Visible Scale Range 3

[ Hydro_Discrepa Data 3
< | BT Edit Features 3
Results E * Save As Layer File...

[ Current Session ;J’ Create Layer Package...

= [ Previous Session -
Properties...
= @ 7 Manthi<) Ann |[i‘r B |

In the Layers Properties window, under the Symbology tab, select Show: Classified, select “2”
classes and press Classify...
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,
Layer Properties

| General | Source | Exent [ Display | Symbology

Show:

Natural Breaks (Jenks)

B Draw raster grouping values into classes
Umaue Values ‘ grouping E]

Stretched Figlds
Discrete Color Value <VALUE> MNormalization <Naonex>
Classification

- . -

Symbal  Range

0. 171235515 - 1.728421427
I 1 725421427 - 14.87796882

Label

0.171235815 - 1728421427
1.728421425 - 14.87798882

[] show dass breaks using cell values

About symbology

[T use hillshade effect 7|1

Display NoData as

Classification

Classification Classification Statistics
Method: [Manual -d ] Count: 113060
Classes: 5 Minimum: 0
= Maximum: 1493546581
el SR Sum: 93,516.57422
[ Excusion ... | [ samping... | Mean: 0.827141113
Standard Deviation: 1614304557
Columns: 100 [| Show 5td. Dev. [ show Mean
& Break Values
s0000g S —
I 2
3 1493546581
50000+ -
40000+
30000+
200001
10000+
0 T T T
0 3.733860453 7467732906  11.20159936  14.9354658 E
|| Snap breaks to data values 31030 Elements in Class Cancel

Press OK in the Layer Properties window.
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| General ISource | Extent I Display| Symbology

Show:

Stretched
Discrete Color

Uniaue Values

About symbalogy

|Draw raster grouping values into classes

Fields

Value <VALUE>

Classification
Manual

Color Ramp

Mormalization

<Mone >

. -

Symbal  Range

- 5 - 14.93546581

Label

0-0.5
0.5- 1493546581

[~ Show dlass breaks using cell values

[] Use hilshade effect z L

Display NoData as

oK | [ cancel ][ fopty |

The result is a chart adequacy raster layer classified to adequate (green) and inadequate areas

(red).

14.7.3 Estimating the percentage of inadequate areas for navigation

In the Table of Contents, right-click on the Chart_Adequacy layer and select Properties...
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Table Of Contents

&8 &8 &

[ SatAls

OEBHB

Chart_Adequacy

[0 BC_HC_norn|
[0 BC_HC

[0 HC

[0 BC_rast

[J RefDepth
O MQUAL

[ VWT_Reclasses
55_Soundings_p
MOAA Seamless
CATZOC_FL
Hydro_Discrepar

=

2]
10000 B @ EEEBER

e

~

4 L[}

Results

B Current Session

Chart_Adequgms

O AISUSER.POSMMSTR_UNDERWAY
[J 2011 Atlantic Vessel Density

El

x

Copy
Remave

Joins and Relates

Zoom To Layer

Zoom To Raster Resolution
Visible Scale Range

Data

Edit Features

Save As Layer File...
Create Layer Package...

= [ Previous Session |
= [ 2 Manth(=) Ann

<&
%
5

Properties...

In the Layers Properties window, under the Symbology tab, select Show: Classified, and press

Classify...

-
Layer Properties

—

| General | Source | Extert I Displa:.rl Symbology

Show:

Unigue Values

Stretched
Discrete Color

|Draw raster grouping values into classes

&)

About symbology

o 5 - 1493595581

0.5 - 14.93546531

Fields
Value ZVALUE = Mormalization <MNone
Classification
Manual Qlasseslz v] [ Classify. .. ]
Symbol  Range Label

[7] Show dass breaks using cell values

[[Juse hillshade effect

7|1

Display MoData as

[ ok

][ Cancel ] Apply

——

In the Classification window, select the higher number in the break value box. Write down the

Count: under the Classification Statistics as the total pixel number representing the charted
area and write the number of elements in the class (bottom right if the histogram plot) as the

pixel number of inadequate areas.
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F - -
s |
Classification Classificatiop Slakists
e
Method:  |Manual - colkg 113060
Classes: 5 Minimum: 1]
dusi Maximum: 14,935465861
EERERET Sum: 93,516.57422
[ Standard Deviation: 1.614904557 l
| =
[l Columns: 100 = [ show 5td. Dev. [ show Mean
l % Break Values
I 60000- = g 05
(]
I 50000+ -
o 40000+
30000+
| 20000+
10000+
|
| 0 T T T | QK
| 0 3733866453 T467732906 1120159936 149354658 _
|| [[] Snap breaks to data values @33 Elements in Class
| | |
\ ——

The percentage of inadequate areas for navigation is calculated by following equation:

Pixel number of inadequate areas *100

Percentage =
8 Total pixel number representing the charted area

Close all windows.

Save the project by selecting File/Save in the main menu.

Q Untitled - ArcMap ‘ .

File | Edit View Bookmarks Inser
[J New.. Ctrl+N
E% Open.. Ctrl+0

‘ & Save Ctrl+S
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Appendix A — Example for Chart Adequacy Review Template

Site: Ft. Myers, FL, USA
Compiler: John Doe Date: 1 November 2015

Supervisor: Thomas Jefferson Date: 5 November2015

Data Sources

Raster charts: 11425

11427
Electronic Charts: US4FL19M

US4FL42M
Satellite imagery date (sensor): 15 March, 2015

(Landsat 8)
Dates of AIS data:
July, 2012 to June, 13
Number of pixels Area (Km?)
(1 pixel = 0.0009 Km?)

Total charted area: 113,060 101.75
Adequate for navigation 83,0.21 74.72
Inadequate for navigation 30,039 27.03
Percentage of adequate area 26% 26%

Schematic overview
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Chapter 15.0  Map Digitizer Program Version 2.1.0

Contributed by Chaim Keller, The Chai Tables, Israel, and John K. Hall, Geological Survey of
Israel (Retired), Israel

This software is freeware. Use it and pass it along.

TableWorks is a licensed component of GTCO CalComp Corporation which allows it to be
incorporated into the installation programs that use their table digitizers.

This program is still in its developmental stage. Please report any bugs to the author, Chaim
Keller, at: chaimkeller@yahoo.com

The latest version of this program will be maintained at the following address:
http://www.chaitables.com/MapDigitizer_setup.exe

Introduction

This program was originally conceived as a replacement for a map digitizing program that was
written many years ago by Dr. John K. Hall to run on DOS using Halo graphics and employing a
GTCO digitizer with a 16 button mouse. That program was remarkable for its capability to
digitize a great deal of points in a short amount of time. To bring the software up to date, Dr.
John K. Hall (jkh1@012.net.il) kindly offered to support the writing of its replacement which
can run equally well with or without a GTCO digitizer. However, during the course of the
program development, | drifted from the original idea since it was my feeling that much more
could be accomplished by writing a user-friendly Windows based interface that incorporated
digitizing as well as other features of John Hall’s original suite of DOS programs such as rubber
sheeting (working on a grid of the graticule intersections so as to correct for imperfections in
printing, scanning, etc.) and DTM creation using Hardy Quadratic Surfaces, all in one package.

Program Instructions
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http://www.chaitables.com/MapDigitizer_setup.exe

 Mep Digiizer - o X

Gles Digiizing Help
rozHSHA RL s8% op~nSor2BE, wom ¢ 0
b AISETZ o A0OTMS hogl 1280 ®iE 036 b

Picture: Program in the process of creating Hardy Quadratic Surfaces.
TdEBESa BPEH 0% D@ (@ E 7
123456 78 91011 12131415161718192021 222324 25
lor. -74.19601 lat. 40.07979 height 360 dist:  1.0841 lon. | -74.19990 lat. | 40.07052 height| 115.0
km from cursor Goto coordinate text boxes
Picture: Toolbars and coordinate text boxes.

Buttons (left to right):

1: Options menu, 2: Maps, 3: Open stored contour file (topo_pixel.xyz), 4. Goto coordinates
entered in the coordinate text boxes, 5: Print map, 6: Search for digitized points, 7: Report
listing the digitized points, 8: Backup results as dxf file, 9: Enable GTCO CalComp Tablet
Digitizer interface, 10: Google Earth interface (not supported in this version), 11: GPS interface,
12: Magnifier window (right panel in uppermost picture), 13: Digitize, 14: Extend grid lines,
15: Rubber Sheeting, 16: Eraser, 17: Sweep eraser, 18: Edit digitized points, 19: Hardy
Quadratic Surfaces, 20: Create DTM, 21: Smooth merge areas, 22: Search for highest points,
23: Contours, 24: Profiles, 25: Help

15.1 Toolbar

(buttons, left to right, see picture above)

1. I:I Options. Add maps, change opening map to one of those in a list, define boundaries, change settings
for program features.
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N o o & w DN

®©

11.

12.
13.

14.
15.

16.

17.
18.

19.

20.

21.

22.

23.

I:I Map: Open the map defined in “Options” to be the default.

= Open: Open saved topo_pixel.xyz format file for replotting as contours.
Goto: Go to the coordinates entered in the coordinate text boxes

= Print: Print a screen shot of the map

d4 Search: Search for digitized points.
B Report: Display search results.
ESave: Save the digitized data.

e Tablet: Enable GTCO CalComp Tablet interfacing.

. Google Earth: Plot digitized points on Google Earth (not supported in this version).

¥

™ GPS: Use a GPS device connected to a USB port on your computer to locate your position on the
displayed map (requires a geographic latitude and longitude coordinate system).

gMagnify: Open magnify window.
ﬁ Digitize: Plot previously digitized points and open digitizer dialog
ﬁExtend: Extend partially missing or hidden grid lines.

B Rubber Sheeting: Run the “Rubber Sheeting” Wizard.

iEraser: Click to erase errant contour points (continually press the left mouse button while erasing.)

5

—=_Sweep: Define rectangular region to erase all the digitized points.

Edit: Edit digitized points, i.e., delete (“K”), or move (“R”).

R
ﬂHardy: Drag the mouse to define a rectangular region for calculating Hardy quadratic surfaces. You
must have rubber sheeting activated, as well as having digitized the selected region.

I Merge: Drag the mouse within a region whose elevations have been determined by the Hardy
Quadratic Surfaces calculations. You can choose to create DTM patches from the Hardy quadratic surface
results and merge them onto the base DTM. DTM spacing and units are set in the Options dialog “DTM”
tag. You must also define the path to a folder where the created DTM’s will be stored (use the “Path” tab
in the Options dialog.) You can also use the Hardy Quadratic Surfaces to repair the elevation model that is
being used. When finished merging the desired regions, depress the button, and then continue calculating
Hardy Quadratic Surfaces for other digitized regions (see above). Then repress the merge button. The
merged regions already completed are outlined by boxes. Proceed to select a new region to merge, etc.

& Smooth DTM: Drag the mouse over the borders between merged regions in order to smooth the
transition between them using a spline fit. This button is only activated when merging (see above).

£ Search for highest point: Drag the mouse to select a region to search for the highest elevation. This
button is already activated when an elevation model has been defined (use the “Paths” tab in the Options
dialog) or has been created by merging Hardy Quadratic surfaces. Note that if you click on any point in the
map, the distance from that point in kilometers will be displayed for geographic (e.g., WGS84) and ITM
(Israel Transverse Mercator) DEMs or when using the base DTM as a height model.

@ Contours: Drag the mouse to select a region for plotting colored elevation contours. This button is
only activated if a path to an elevation model has been defined (use the “Paths” tab in the Options dialog),
or after creating a DTM elevation model by merging output from the Hardy Quadratic surface calculations.
To use the latter, you must check the appropriate checkbox in the “DTM” tab of the Options dialog.
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24. =4 profiles: Click on a point and then select which horizon to profile. After the calculation is completed,
an interactive graph of view angle versus azimuth of either the eastern or western horizon for any clicked
point is displayed. To use this option, the map must be defined has having either ITM or geographic
(latitude, longitude) coordinates. You must also enable the saving of xyz coordinate files (i.e.,
‘topo_coord.xyz” files) (Use the “Settings” tab of the Options dialog).

This program has a GPS interface. Press the “GPS” button, and set the Baud rate and COM port
of a NMEA 0183 v3 compatible USB dongle (see picture below). Once the settings are
accepted, the map moves to the GPS location. This option requires that the map has been
gridded to a geographic latitude and longitude grid.

b=+ Com-Port Setup for NMEA 0183 GPS *

[default GPS device]
" ND-100 " ND-1005105C {* Other

Settings
Baud Rate: | 38400 | |COMID |

Preset Settings
Parity: N (none), Data Bits: &

Cancel

Scan Com Port

15.2 Map Parameters

(Options dialog: “Maps” tab)

I
1. Load a map by using the "Options" button (first button on the toolbar). T | This program supports most
types of images with the notable exception of "tif" files (there is no native VB6 support). If you want to
use a tif file, then you will need to convert it to another format.)
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"= Paths/Options

s Settingsl Paths| DTM |

Coordinate

X E{mrdlnate Label - & degr S

Y Coordinate Label Il Feet Wl Fathoms

~Current Map

IE:'xDevStuu:liu:uWI:u'xDigitizer-F‘rniect'xu::4EIEI?4a2.ipg |

Auto Determine Pixel Size |
Y

U Map's Pixel Width | 5056
H 25l | 1iap's Pixel Heiant [ e

~Map Geographic Coordinates of Upper-Left Map Border————————
E xpiel| 314 BB xGeo| 7424572222 %
veel| 37 B v-Geo| 40125 %

~Map Geographic Coordinates of Lower-Fight Map Border———————————————

xpiel| 4737 BB x-geo [ 7412472222 %
j Y PM&IITE Y-Geo |— gy
~Mum. major grid lines {include the outside margin if they ars on the grid)——
XGid [ 4 - YGid [ 4 -
Mzp Geographic Coordingtes of Upper-Left Grid Interssction
_*__ H-Geo ¥-Geo

| e o [ aim

~Map Geographic Coordinates of Lower-Right Grid Intersection

T #-Geo Y-Geo
BL | e S
Add map I Save maps I

2. If you know your map boundaries, then add them into the appropriate text boxes. If not, after saving the

new map, click on the "Map" button, . , (the second button on the toolbar) and use the mouse (and the
magnifier window -- activate it by clicking on the magnifier button g) to determine the screen
coordinates.

3. In order to use all features of this program, you must define the coordinate system of the map and input the
appropriate the grid boundaries into the text boxes in the Option menu. The simplest coordinate scheme
uses the screen coordinates of the map’s four corners and the corresponding geographic coordinates. To

use this method, enter the above coordinates and click on the "Rubber Sheeting Button", = , on the
toolbar and choose "Simple method".

4. A much more accurate coordinate system can be defined by using the grid intersection coordinates through
affine transformations and rubber sheeting based on the routines of Doythser and Hall (Computers &
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Geosciences, 23(7), pp. 785-791, 1997). To use this method, you will need to digitize the grid intersection

by using the Rubber Sheeting Wizard (click on the "Rubber Sheeting"” button on the toolbar, i ). See
below for further discussion of this topic.

Map navigation and zooming can be accomplished by

Using the scroll bars

Clicking on the desired position to center.

Dragging the map

Zoom in and out with the wheel mouse, or use the quick keys "z" and "X".
(This program fully supports a touch screen interface, so use the appropriate
finger gestures to move and zoom).

Arrow keys

Home key (moves map to top left corner)

End key (moves map to bottom right corner)

PgUp key (moves map to top of map)

PgDn key (moves map to bottom of map)

15.3

Program Settings Analysis Parameters

(Options dialog “Settings” tab)

1.

N

a ks

Sk

®

10.

Distance between points on a digitized contour: only generate points with this pixel interval when digitizing
contours. (Larger for more points, smaller for less points.)

Distance between points on a digitized line: Ditto for digitizing lines.

Starting Euclidean color sensitivity: initial Euclidean threshold for a contour color. Decrease the sensitivity
to increase the acceptance threshold and promote longer contouring without a break.

Starting contour interval: Steps in meters when drawing contours.

Hover distance in Pixels to search for digitized points: Used in “Edit” mode. The larger the number, the
farther the program searches around the current mouse position for a digitized point. (Larger numbers
require more CPU.)

Erasing mode brush size. Increases or decreases the area the eraser will erase in “Eraser” mode.

Write output of Hardy Quadratic Surfaces and contouring to xyz output files checkbox. This option must
be checked in order to enable horizon profiles.

Contouring method: pick either 4 or 8 directional Freeman chain methods.

Centering screen while digitizing points checkbox: If checked, the program won’t center the map on the
left mouse click. This allows a region of the screen to remain fixed until the point digitizing is finished.
Warning checkboxes:  If checked, program won’t give messages about missing paths or auto redraw
errors.
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—;'— Paths/Options

M aps EettIHQSI Paths| DTM |
Plotting
Fointz Contours
o B
Lines™ Rubber Sheeting

Color | | | Calaor |

W *use colors bazed on elevation

M awirnum no. of zearch resulks to plot I77R7=
simultaneouzly [depends on computer] -

Analyziz parameters

Diztance between points of a digitized contour 10 j‘
Distance between points of a digitized line 10 j

Starting Euclidean color zensitivity for contour gy =
calor Euclidean comparizon detection —1

Starting contour interval for dizplaying contours | 2 -
of Hardy quadratic surfaces

Hoverdiztance in pisels while in Edit mode | 10 j
kinimum Digitizing Eragzer Bruzh Size | 1 ill
Hardy Quadratic Surfaces
[v wiite wyz data and horizan profiles to fles

Semi-automatic contour detection method
"~ Four directional Freeman chain code method
{* Eight directional Freeman chain code method

Point Digiizing
v Don't center on clicking while digitizing pointz

Wamings
v |gnore missing pathe W Ignore AutoR edraw errars

15.4 Program Paths

(Options dialog: “Paths” tab)

1. Pathto ASTER DEM tiles (“bil” format).
Path to 1 arc sec SRTM tiles (“hgt” format).

w N

created DTM available.

No oA

Radio buttons to choose the elevation model to be used for elevations in the program when there is no

Path to folder that will contain DTM models created by this program.

Path to Google Earth’s exe file (not yet supported in this program version).

Path to directory to write “kml” files (not yet supported in this program version).
Path to Google Earth icon files (not yet supported in this program version).




=

Maps] Settings

ASTER V2 1 arc sec Digital Terrain Model

Paths/Options @

| DTM |

B
Path to ASTER files ﬂ

|I::"-.D evStudioWbhDigitizer-Project ASTER

1 arcgec hgt format (SRTM) files

Browse

d

Path to 1 arcsec hgt files
|Chuza

ground elevations
{~ ASTERWZ 1 arc sec DTM
{* 1 arcsec hgt format (SAETK) DTK

generated DTM hiles folder

d

Browsze

|E:'\.D evStudio'\Whs\Digitizer-Projecthy M ewD Tz

Google E arth
Path to GoogleEarth. exe

kml files directory
|E:'\.D evStudio' Wb\ Digitizer-Project
-

URL of Google lcon to use for Points

i

|htlp:.'.'maps.g-:u:-gle.cum.'mapEiles.’kml.'pal-i.'icn‘n-ig.png

URL of Google lcon to use for Lines/Contours

|htlp:.'.'maps.g-:u:-gle.cum.'mapEiles.’kml.'pal-i.'icn‘n-iﬂ.png

15.5

(Op

1.
2.
3.

DTM Settings

tions dialog: “DTM” tab)

Grid size for creating DTM files in either ITM or UTM coordinates.

Grid size for creating DTM files in geographic latitude and longitude degrees.

Elevation units for created DTMs. Default is meters (doesn’t need to be chosen). If a custom unit is
chosen, the custom conversion factor from meters needs to be entered into the text box. For example, if
creating a DTM in centimeters, enter “100”.

Azimuth range for view angle versus azimuth profiles. For example, if “45” is entered, the profiles will be
calculated from -45 degrees to +45 degrees around due East or due West.

Spacing in azimuth to calculate in the profile. E.g., “0.1” mean steps of 0.1 degrees.
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6. Distance in kilometers east or west of the chosen point to start using elevation points for calculating the
profile. This parameter removes close obstructions from the view.

Choose the elevation model precision. Lower precision saves memory.

8. Check box: use the created DTM elevations for the program elevation display, etc.

~

%5 Paths/Options @ﬂ

bl aps l Settings ] Paths

DTH creating - grid size
Mew [Tk ar UTK agrid

¥ grid spacing [rmeters) 0.025
' anid spacing [meters) 0025

Mew lat/lon grid DT elevation units
# and spacing [arc zecs] " meters
| 1 (" feet
(" fathoms
Y arid spacing [arc zecs] (" decimeters
| 1 " custom
1

Azimuth range for prafile viewer

Half azimuth range [deg.] 45
Azimuth Spacing [deq.] 01
Arnount to shave [km); 05

Elevation output place accuracy
f+ 2 hutes integer [meters]
7 4 butes floating point [meters)
(8 butez double precizion [meters]

[v Usze heightz bazed on generated DT if available

Save

15.6 Digitizing with a Mouse

To begin actual digitizing with a mouse, right click on the map with the mouse or press the

"Digitizer" button, b , on the toolbar. A digitizer dialog appears (see picture below).
Different options can be scrolled by using the SPACE key, or reached more directly by using the
shortcut keys (see below). Press ENTER to activate the currently chosen digitizing method
(displayed on the bottom on the Digitizer Dialog). Press ENTER again to deactivate that
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method. Press SPACE to scroll to a different option, etc., or move to an option directly by using
the shortcut keys listed below. When digitizing below sea level areas in a map, instead of
entering minus signs just click on the “Bathy” check box. You can then enter the depths without
the negative sign, and all the elevations will be recorded as depths below sea level.

-’u Digitizer @

Screen Coordinates B athy.
X 1431 -
Y: 237
Elevation/Depth [map unitz]
Clear
1 2 3
1] B i
! C D
Space Enter

Point {(Blank)

SHORTCUT KEYS:

B: backup to dxf file

C: contour digitizing.

D: (D once) delete last point

DD: (D twice) delete last line

DDD: (D three times) Erasing errant parts of digitized contours.

DDDD: (D four times) Sweep erasing, i.e., erase all digitized points within a rectangular region.

H: pick rectangular region to draw contours of the already digitized points
using the method of Hardy, R., "Multiquadric Equations of Topography and Other
Irregular Surfaces, J. Geophysical Research, 76(8), pp. 1905-1915, 1971.

L: Line digitizing

P: (P once) Point digitizing starting with blank elevation.

PP: (P twice) Point digitizing starting with the last inputted elevation.

S: (S once) Sweep erasing, i.e., erase all digitized points within a rectangular region.

E: Edit mode (used for point editing of contours, points, and lines that were already digitized. This mode
highlights the digitized points and vertices of lines and contours when hovering over them with the mouse.

R: Replace mode (first need to press “E”, see above). Replace last highlighted point or vertex with a new
one at the current position of the cursor.
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o K:Kill mode (first need to press “E”, see above). Deletes the last highlighted point or vertex.

15.6.1  Using the Dialog’s Number Pad

They mean what they are except C changes sign, D adds a decimal point. Buttons designed large
enough for touch screen. Note, the map can be moved and zoomed with standard touch screen
motions.

15.7 Digitizing with the 16 button DrawingBoard VI mouse

(N.B.: You can also use the regular mouse and any of the shortcut keys above at any time.)
Added options are moving in X, Y, Z (zooming). To navigate the map using the digitizer mouse,
select one of the above, and then move (zoom) in one direction by pressing the "1" button. Move
(zoom) in the opposite direction by pressing the 2" button.

The 16 buttons are mapped to do the following:

Button

o 0-uUseitasa left mouse key for the Digitizer Dialog or anywhere on the map
(However, it won't work on any program message dialog box. You will have to use
the regular mouse to acknowledge your answer in those cases.)

e 1 -activates the currently chosen digitizing method
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o 2 - deactivates the currently chosen digitizing method

o 3 -scrolls through all the navigation and digitizing options.
To activate an option press the "1" key. To deactivate,
press the "2" key.

e 4 - enters the numeral "0" to the elevation text box
e 5 -enters the numeral "1" to the elevation text box
o O - enters the numeral "2" to the elevation text box
e [ -enters the numeral "3" to the elevation text box
o 8 -enters the numeral "4" to the elevation text box
o 9 -enters the numeral "5" to the elevation text box
o A -enters the numeral "6" to the elevation text box
o B -enters the numeral "7" to the elevation text box
o C - enters the numeral "8" to the elevation text box
e D -enters the numeral "9" to the elevation text box
« E- changes sign of entered elevation

e [ -adds decimal point to end of entered elevation

15.8 Digitizing Tools Explanation

1. Point digitizing: Used for digitizing trig points and bathymetry depth marks. Enter the elevation/depth
and left click on the mouse. To center the mouse on the point, it is advisable to use the magnification

window. Click on the magnification button, 2 magnify the map as desired using the toolbar buttons,
and center on the point using the cross hairs.
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b b "5:.-""-’5"#

. e
u B Digitizer
Screen Coordinates
==
L

Elevation/Depth [map unitz]

Clear

3 L D

Space | Enter

FPoint (Blank)

2. Line digitizing: Used for digitizing contours. Left click on the starting point. Enter the contour elevation.
Move the mouse to the end point; left click to complete the line. Contours are stored in memory as separate
points separated by a certain number of pixels as defined in the Options dialog "Setting" tab.
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u Digitizer
Screen Coordinates
- 1729

Y 322

Elevation/Depth [map units]

3. Contour digitizing: Uses semi-automatic contour boundary detection known as the Freeman chain method
(4 directional or 8 directional. See for example Dziech, A., "Contour Extraction and Compression-Selected
Topics" [Mobile Robots: Perception & Navigation, Sascah Kolski (Ed.), ISBN: 3-86611-283-1, InTech].
Enter the contour’s elevation. Use the magnification window to determine a detection starting point by
watching the "Color under cursor” color. Click on the darkest color, and the detection will commence. The
color is followed by using RGB Euclidean color comparison criteria. Change the threshold of the
comparison by moving the slider on the main program's toolbar. 0 means accept Euclidean RGB
differences up to 140. Higher slider values are more selective. End contour detection by pressing the ESC
button. If the contour reaches an impassible point, or turns onto itself, you will be prompted to either pick a
new starting point or to finish detecting the current contour. The contours are stored in memory as pointed
separated by a certain number of pixels defined in the Options "Setting" tab. You can change the detection
method from 8 directional (default) to 4 directional in the Option dialog "Setting" tab.

&, &, | Color under cursor | 300% magrified

I""'ﬁ"_'"L_.—-"
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Picture:
contour start.

Contour color display and RGB number to be consulted when determining

fe

Tl Al 7 P —
HPix [ 5346 YR [ 8186
\ 2| | Magnifyer Xpbe 5632 03 : 12112
46 \ &, &, | Color under cursor _ 300% magnified
48 i |
S |
\ ! |
\ |
4
48 /5""_ |
46 51 | |
58 [ Digitizer |
Screen Coordinates Bathy. |
X 5346 v |
\ Y- 5185 2 |
\\ Elevation/D epth' [map uriits] |
46 1 50| Clear |
KeyPad |
48 o 1| z| 2 |
|
Rt i ,/ 81 [ om e |z |
56 . 8 3 L o — |
J Space Enter |
: |
Contours
Bl : '
54 |
|
|
49 |

Picture:

the sensitivity of the color comparison between the starting color (the color clicked on at the

Contour Digitizing interface. Notice slider bar on toolbar that is used for setting

beginning of contouring) with colors encountered during the contouring process (the Euclidean
difference is used to determine how close the colors match).
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oy = e P =
r —
o [ 22 ‘.' &, G, | Color under cursor
rScreen Coordinates- rBathy.
P 5346 = 48 4
'
g l 8186 :
4 £3
Elevation/Depth [map unitz) \
1] Clear \
1
KeyPad 48 /ﬁaf_
a 1 2 3]
- - - - 46
51
A 5 B z
8 El C D o
B Contour following x
Space Enter P
46 |:' 2 | Contour seems to be turming on itzelfl
| Contours ['o you want to continue tracing contours with the curment elevation?
49 Mo, Stop here
T \\‘\f é ™
e a1 ——
56 5 | R L

Picture: Contour reaches impasse and program prompts for response
— AL — [ ¥a] e
] [£=] +42 & & | Coloru
Screen Coordinates Bathy.
X 4332 i
[v
Y: 5433 |- 44
Elervation/Depth [map units) | 5
B0 Clear |
K.epPad wf« 59 Ignore the pause? x
1] 1 2 3 =

t] Escape key preszed, tracing halted...

Rezume’?

4=
T
[L=r]
-

Yes, ignore it ‘ | Mo, pick a new starting paint No, cancel digitizing contours ‘

[}
[du}
| L]
m
=
E o
=+

Space

| Contours ﬁ:\\
i | 51

;/; \.\ a / St 51 e

il () CH

Picture: Contouring was interrupted with the “ESC” button, so program asks for
clarification.
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Eraser: Erases errant contour points while holding down the left mouse button and passing over those
points with the mouse. Does not permanently affect digitized points and lines. Can be activated by
entering the short cut keys (see above) when digitizing, or by directly pressing the “Eraser” button on the

toolbar, i

Hardy quadratic surfaces: —==.. Use it for checking on the quality of the digitizing as well as for
calculating the elevations for a DTM elevation model after completing the digitizing of a section of the
map. Choose a contour interval in the combo box that appears on the coordinate bar. Drag to define a
rectangular region for analysis. Contours are plotted after completion of the calculation. Three temporary
files are written during the initial processing. The "topo-out.GSC" file contains a listing of the digitized
points within the selected rectangular region (pixel coordinates and height). The ".dxf" file contains the
same points with the geographic coordinates. After completion of the analysis, a "topo-out.xyz" file is
generated in the typical DEM xyz file format (if this option is checked in the “Settings” tab of the Options
menu). A pixel xyz file, topo_pixel.xyz is also generated. Both xyz files can be plotted with such
programs like "Global Mapper", or “DTMEditing”.

Sweep erase: Access it from the Digitizer dialog, or directly from the toolbar, g Define a rectangular
region by dragging over the map (see picture below). All digitized points in this region will be deleted
whether they were digitized points, lines, or contours. Best tool to be used for fixing errant digitizing as
revealed by running a Hardy quadratic surface analysis.
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Screen Coordinates B athy.
X: 322 -
Y: 1]

Elewation/D epth [map units]

T
|
|
|
|
|
|
’u Digitizer @ﬂ I
|
|
|
|
|

| Clear
KepPad
a 1 2 3
I 4 5 B Z
Wl 8| 3| c|o
Space Enter

Sweeping

7. Search: &4 . (Can also be accessed from the Digitizer Dialog — see “Short Keys” above). Define
rectangular region by dragging over the map to search for any digitized points from point, line, and contour
digitizing, as well as contour points that were erased by the Eraser tool. The search results are displayed in
the "Report" form. The report form can be used for sorting the points, selecting points according to their
elevation, and plotting individual points (right click on the point's listing in the Report form) or plot a group
of selected points (use the "Plot" button).
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% Map Digitizer - [Search Report]
M Files Digitizing Help

+@cESHPEH 0% o= RRE ?
lon. -T419717 lat, 40.06735 height dist: 05097 lon. | -74.20009 lat. | 40.07135  height| 95.0

{“Select All | Unselect Al ‘ Height filter ‘ Plot selected records ‘

Tope | Imdex | ¥ coord | ' coord | o, | lat. | elervation |
Tl Contour point 115 2104 2961 -74 2558926081504 401.0966792094204 22,86
E_I Cotitaur paint 116 2102 2956 -74. 2550863699614 40, 0867229410903 22,86
E_I Cotitaur paint 17 210 2951 74, 2558348510366 40,0867 447070707 22,86
Bl Contour point 18 2101 2945 -74,255006262366 40.0967445073618 22.86
Bl Cortour point 119 2099 2941 -74.255777153047 40.0967882390316 22.86
Bl Comtour point 120 2096 2937 -74. 2557477054038 401.0968539363909 22.86
Sl Comtour point 121 2094 2931 -74. 2567186765349 401096997 6680608 22.86
Bl Contour point 122 2094 2926 -74 2556900852142 401096997 4653518 22.86
Bl Contour point 123 2099 2925 -74 2556627991644 401.0967874401958 22.86
Bl Contour point 124 2104 2925 -74. 2556355101146 4009667 74120398 2286
B Cartaur point 125 2109 2924 -74. 2556082210649 401.0965673830938 22.86
Bl Camtaur point 126 2114 2922 -74. 2555809320151 401096457 3557277 22,86
E_I Cotitaur paint 127 2118 2919 -74.2565533830411 40, 0863692932611 22,86
E_I Cotitaur paint 128 2123 2916 -74.2556260939914 40, 0862592651051 22,86
E_I Contour paint 129 2128 2913 -74.2554388049416 40,0861 492365491 22,86
Bl Contour point 130 2132 2910 -74,255471 2559676 40.0960611744825 22.86
B Contour point 131 2138 2908 -74,255444226842 400859291 80637 22.86

8. Backup (Save): E Backups all the digitized points in the entire map to a "dxf" file format

9. Edit Mode: (Can also be activated by the shortcut key while digitizing -- see “Shortcut keys” above).
Use this mode for quick editing of digitized points, contours, and lines. When this mode is activated
(pressing the “Edit” button, or pressing “E”), the digitized points, etc., are highlighted when hovering over
them with the mouse. To move a point to a new position close to the last one, press the “R” keyboard
button while the mouse is in the desired new position. To delete a point, press the “K” keyboard button and
the highlighted point is deleted. See pictures below. The hover distance can be changed by changing it in
the “Settings” tab of the Options dialog (see discussion and picture below).
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(W] Digitizer
rScreen Coordinates———
x: 5346

Y I 8186

=

B athy.—

v

rElevvation/Depth [map units}——

Clear

keyPad

Picture:
nearby.

Editing a digitized point. Notice that the point is highlighted when the cursor is
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u Digitizer
Screen Coordinates
" 437
v. [

Elevation/Depth [map units]

F.eyPad

Picture: Point is misplaced (should be in center of trig mark). Cursor is set at correct
position and “R” key is pressed to move it to the correct position (see picture below).
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|

u Digitizer
Screen Coordinates
- 497
Y: 345

Elevvation/Depth [map units]

| | Clear

Picture: Digitized point has been successfully edited to be at the center of the trig point.

15.9 Brief Tutorial on creating a DTM model from a topographic map

1laa
1. Open the Options dialog by clicking on the first toolbar button 1 |. Browse for your topographic map

(Note: “tif” files are not supported, so convert them to a supported format). The program determines the
pixel size of the map. You are then required to define a grid. Click on the relevant check boxes concerning
whether the grid is in latitude and longitude degrees, and whether the elevations on the map are in feet or
fathoms. If you will be using the map corners for the coordinate grid without further rubber sheeting (e.g.,
the map image is not contorted and the corner coordinates are known) then enter the pixel coordinates of
the map’s corner (i.e., where the actual map starts and finishes, and not the corners of the map’s borders).
You can use the buttons in the dialog for pasting the clicked pixel coordinates. For maps using geographic
grids of degrees latitude and longitude, you can enter either decimal degrees, or enter degrees, minutes, and
seconds using a “-“ to separate them, e.g., “-32-42-52” is interpreted by the program to mean -32 degrees,
42 minutes, 52 seconds. Use the buttons next to the relevant text boxes to convert from the “-“ format to
decimal degrees and vice versa. If you will be using rubber sheeting, which is necessary for rotated grids
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or for contorted map images, enter the number of horizontal and vertical grid intersections and the value of
grid coordinates (in whatever unit that is being used by the map) in the relevant boxes.

Click the “Paths” tab and define a path is defined to the folder where the new DTM’s will be stored. You
only have to define paths to ASTER or SRTM tiles if you want the program to display those elevations
when moving the mouse and clicking on the map in the process of creating a DTM. This is extremely
useful when attempting to read contour values, etc.

Click the “DTM” tab and define the grid spacing of the DTM that will be created. For ITM or UTM grids
in units of meters, enter the X, Y spacing in meters in the relevant text boxes. For a geographic latitude and
longitude grid in degrees, enter the X, Y spacing in units of arc seconds.

Press the “Save” button” In the “Maps” tab of the Options dialog to save the map and its associated
parameters. The map is added to a list of previously entered maps. Any of the stored maps can be opened
and viewed and worked on by selecting it from the list.

Open the map by pressing the “Map” button @ (the second button in the toolbar). The first time the map
is loaded, the program creates a binary file containing the colors of each pixel. The toolbar is grayed out
until the end of this operation. This color map is used for editing the digitized points and contours, i.e.,
restoring the original map when erasing, or when replacing or removing digitized points.

You can now proceed with digitizing the map using the Digitizer dialog (click on the Digitizer button, %
, on the toolbar). The Digitizer dialog and the map interface were designed for maximum user friendliness
for mouse, touch screen, and keyboard operations. The map can be easily panned and magnified by any of
the above methods. See above for the brief description of special keys or the interfaces. It is especially
useful to activate the magnification screen (click on the “magnifier” button on the toolbar) when digitizing
the map. The Digitizer dialog offers a wealth of methods for digitizing including points, lines and
contours. Editing can be done easily using erasing, sweeping, and deleting. Note that the Digitizer dialog
was specifically designed for touch screens in order to facilitate the entering of elevations using the digit
buttons. When contouring, it is essential to use the magnifier screen. When you move the mouse over a
contour, the color at the cursor is shown. It is essential to pick the darkest color before clicking to start
contouring.  Adjust the sensitivity of the color threshold to include or exclude similar colors to be
accepted/rejected when determining where the contour goes.

The next step is to define the grid used for outputting the created DTM. This is done by clicking on the

“Rubber Sheeting” button, B . The Rubber Sheeting dialog opens. You can choose several options. If
the map is not contorted and the coordinates of the map coordinates are known and have been entered in the
Maps tab of the Options dialog, then check “Use corner coordinates”. Other check “Rubber Sheeting”.
The idea of the rubber sheeting process is to digitize the intersections of the map’s graticule. If an
intersection is missing, it can be extended by grids to form intersections. To do this, press the “Extend”
grid button and click on the lines beginning and then once again at its end. Repeat this process to extend
more grid lines. Pan to the most North Westerly grid intersection. Left click on that point. If its position
is satisfactory, then click on the “Next” button. Iterate this procedure from North West to North East, then
one grid row down from East to West, continuing across the row, then one row down from West to East.
The wizard will show the geographic coordinates of the next intersection. Continue in this manner until the
last grid intersection on the most Southerneastern corner is clicked. Afterwards, click on the “Activate
calculation method” button.  (Digitizing of the grid can also be down along columns by checking the
bottom check box in the “Geo Coord. Step Size” frame.) Once the rubber sheeting digitizing is finished, it
doesn’t need to be repeated. Each time you press the Rubber Sheeting buttons, the stored intersections are
marked and you are notified that all of them have been already digitized and you are prompted to just press
the “Activate” button.

Once rubber sheeting is defined, elevation values are shown as the mouse moves along the map if the path
to an elevation model has been defined in the “Paths” tab of the Options dialog, or if a DTM has been
already created for this map.

Actual calculation of DTM elevation points can proceed at this point. Click on the “Hardy” button, ==,
and all the digitized points, lines, and contours are shown. Select a rectangular area to calculate the heights
by dragging with the mouse. The number of digitized points you can select is limited by the memory of the
computer and by the patience you have to wait for the calculation to finish.
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10.

11.

12.

After the Hardy Quadratic Surface calculation is complete, contours of the calculated heights are drawn on

the map. To merge these points into a new DTM, click on the “Create DTM” button, I . A prerequisite
for this operation is defining the map’s corner coordinates. To do this, open the Options menu and paste in
the corner pixel and geographic coordinates as displayed in the text boxes (picture shown above).

The program first generates a basis DTM file which at this point is all blank. After completion of the
writing of the basis DTM, define a region within the drawn contours for merging into the base DTM. Do
so by dragging within the contoured regions. It is often best to avoid the edges since the Hardy calculation
can be inaccurate in those places if nothing has been digitized beyond the borders chosen.

The program will then calculate the heights of this region on a grid size defined in the “DTM” tab of the
Options menu and will merge it onto the base DTM. After completion of this process, a box will be drawn
around the boundaries of the merged regions. Continue to merge regions until you have exhausted the
contoured area. Depress the “Create DTM” button and select a new region of the map that has been
digitized for undergoing the Hardy calculation. Continue this process into the entire region of interest has
been converted into a DTM.
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Picture: Colored areas are regions already merged into the base DTM. The rectangle
demarks a new region to be merged that has already undergone the Hardy Quadratic Surface
calculation (results are drawn as contours). Note that the region must be interior to the region
calculated by the Hardy Quadratic Surfaces. It is useful to pick only the region where the
surfaces fit the contours, i.e., far from boundaries which haven’t yet been digitized.
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Picture: New region has been marked as merged onto the DTM.

13. In general, borders between different Hardy calculations will not be smooth (the picture below shows
several such regions defined by the intersection of merge regions). Notice that the program can handle
highly rotated grids to a very high accuracy with the rubber sheeting.
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15.9.1 Smoothing the Borders
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1. To smooth the borders, click the “Smoothing” button, & after merging a section. Drag the mouse to
define a rectangular area that you wish to be smoothed. The two pictures below show the resulting DTM
Surfer grd file from the map above before and after smoothing (plotted using “Glober Mapper”).
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Picture: DTM before smoothing between merged regions (notice that abrupt borders).
Steps in elevation are an artifact of calculating the heights to the nearest integer (this setting can
be changed in the Options Menu “DTM” tab).
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Picture: Finished DTM after smoothing.

2.

Once the DTM of a portion of the map has been completed, the program will display those heights when
the mouse moves to that region (check the “Use heights based on generated DTM” in the “DTM” tab of the
Options menu).

The created DTM is written as a standard Surfer version 7 binary “grd” binary file which can be plotted
with Surfer or with Global Mapper, etc.

15.10

Contouring and Horizon Profiles

Contouring can be done over the map by pressing the “Contour” button \@ (requires that a source is
defined for the elevations). (See picture below). Define a rectangular region to calculate the contours by
dragging over that region using the mouse.

To view the horizon profile from any point in a contoured region, click on any point. (Rubber sheeting
must have been activated so that the point has a geographic latitude and longitude grid in degrees or is an
ITM grid; this option doesn’t support UTM grids. You must also have set the option to write xyz

coordinate files in the “Setting” tab of the Options menu) . Then press the profile button % The
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calculation’s result is plotted on an interactive graph which shows the distance to the horizon and the
theodolite view (angle elevation, i.e., view angle, at any azimuth, i.e., horizontal angular degrees from due
East (or West)). The amount of the horizon that is less than a certain distance from the chosen point can be
shown by setting a distance and clicking on the purple button. A portion of the graph can be zoomed by
dragging over that area. Restore the original axis by pressing the “plot” button.

ﬁ Map Digitize
Files Digitizing Help
Ta=EBE 4 e 0% | PF <= =l R 8 E 7
lan 7414262 lat 40.10311 height 4821  dist 62087 lon | -74.20162 [ 4007035  height] 10488 [2 4]
? Eastern horizon profile
View
Angle
Azimuth {degrees)
ymin = -0.93 ymax = 0.0
| azimuth | view angle | longitude | latitude ‘ distance | height |
| 30 | -0E24 | -741305s4] 40709m18] 7471 | za00 |
Picture: Map with 2 meter contours (the contour interval can be changed by setting it in

the Options dialog “Settings” tag, or by setting it in the drop down list under the toolbar as
shown in the picture). The chosen center point is marked on the map. The Eastern horizon from
that point has been calculated in the graph. The graph is of view angle (the angle a surveyor
measures with a theodolite) versus azimuth (degrees about due East in this example). The
yellow portion of the line marks a region in the horizon which is within 7 kilometers of the point.
This option is activated by pressing the purple button after setting a distance in kilometers.
Notice that there is a display of azimuth, view angle, longitude, latitude, distance, and height at
any point of the graph as the mouse moves along the x direction (azimuth).

3. Searching for the highest point in a region: Click on the “Search” button & and drag over the map to
define a rectangular region for searching. The program will move the blinking cursor to the highest
elevation in the chosen region.
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Annexes

Annex A Additional Resources
Multibeam Data

Baltic Sea Bathymetry Database
http://data.bshc.pro

Earthref.org Seamount Catalog
http://earthref.org/SC

European Marine Observation and Data Network
http://www.emodnet-hydrography.eu/

Geoscience Australia
http://www.ga.gov.au/index.html

University of Hawaii
http://www.soest.hawaii.edu/HMRG/Multibeam/index.php

Japan Agency for Marine-Earth Science and Technology (JAMSTEC):
http://www.godac.jamstec.go.jp/darwin/e

Lamont Doherty Earth Observatory Marine Geoscience Data System
http://www.marine-geo.org/portals/gmrt/

National Centers for Environmental Information (NCEI)
http://www.ngdc.noaa.gov/mgg/bathymetry/multibeam.html

Center for Coastal & Ocean Mapping, Joint Hydrographic Center, University of New
Hampshire
http://ccom.unh.edu/theme/law-sea

Submarine Arctic Science Program (SCICEX) data
http://nsidc.org/scicex/data_inventory.html

Stockholm University Oden Mapping Data Repository
http://oden.geo.su.se
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Bathymetry Models

Altimetric Bathymetry Grid (Smith and Sandwell, 1997)
http://topex.ucsd.edu/WWW _html/mar_topo.html

GEBCO 30 arc-second Bathymetry Grid
http://www.gebco.net

International Bathymetric Chart of the Southern Ocean (IBCSO)
http://www.ibcso.org/data.html

International Bathymetric Chart of the Arctic Ocean (IBCAQO)
http://www.ngdc.noaa.gov/mgg/bathymetry/arctic/

SRTM30_Plus
http://topex.ucsd.edu/WWW html/srtm30 plus.html
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Annex B Glossary

S-44 Terms

The following has been extracted from "IHO Publication S-44 Standards for Hydrographic
Surveys" and edited for context.

Note: The terms defined below are those that are most relevant to this publication. A much
larger selection of terms are defined in IHO Publication S-32 (Hydrographic Dictionary) and this
should be consulted if the required term is not listed here. S-32 is available as an on-line Wiki
at: http://hd.iho.int/en/index.php/Main_Page.

Accuracy: The extent to which a measured or enumerated value agrees with the assumed or
accepted value (see: uncertainty, error).

Bathymetric Model: A digital representation of the topography (bathymetry) of the sea floor by
coordinates and depths.

Blunder: The result of carelessness or a mistake; may be detected through repetition of the
measurement.

Confidence interval: See uncertainty.

Confidence level: The probability that the true value of a measurement will lie within the
specified uncertainty from the measured value. It must be noted that confidence levels (e.g.
95%) depend on the assumed statistical distribution of the data and are calculated differently for
1 Dimensional (1D) and 2 Dimensional (2D) quantities. In the context of this standard, which
assumes Normal distribution of error, the 95% confidence level for 1D quantities (e.g. depth) is
defined as 1.96 x sigma and the 95% confidence level for 2D quantities (e.g. position) is defined
as 2.45 x sigma.

Correction: A quantity which is applied to an observation or function thereof, to diminish or
minimize the effects of errors and obtain an improved value of the observation or function. It is
also applied to reduce an observation to some arbitrary standard. The correction corresponding to
a given error is of the same magnitude as the computed error but of opposite sign.

Error: The difference between an observed or computed value of a quantity and the true value
of that quantity. (N.B. The true value can never be known, therefore the true error can never be
known. It is legitimate to talk about error sources, but the values obtained from what has become
known as an error budget, and from an analysis of residuals, are uncertainty estimates, not errors.
See uncertainty.)

Metadata: Information describing characteristics of data, e.g. the uncertainty of survey data.
ISO definition: Data (describing) about a data set and usage aspect of it. Metadata is data
implicitly attached to a collection of data. Examples of metadata include overall quality, data set
title, source, positional uncertainty and copyright.
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Quality assurance: All those planned and systematic actions necessary to provide adequate
confidence that a product or a service will satisfy given requirements for quality.

Quality control: All procedures which ensure that the product meets certain standards and
specifications.

Reduced depths: Observed depths including all corrections related to the survey and post
processing and reduction to the used vertical datum.

Sounding datum: The vertical datum to which the soundings on a hydrographic survey are
reduced. Also called “datum’ for sounding reduction.

Total horizontal uncertainty (THU): The component of total propagated uncertainty (TPU)
calculated in the horizontal plane. Although THU is quoted as a single figure, THU is a 2D
quantity. The assumption has been made that the uncertainty is isotropic (i.e. there is negligible
correlation between errors in latitude and longitude). This makes a Normal distribution
circularly symmetric allowing a single number to describe the radial distribution of errors about
the true value.

Total propagated uncertainty (TPU): the result of uncertainty propagation, when all
contributing measurement uncertainties, both random and systematic, have been included in the
propagation. Uncertainty propagation combines the effects of measurement uncertainties from
several sources upon the uncertainties of derived or calculated parameters.

Total vertical uncertainty (TVU): The component of total propagated uncertainty (TPU)
calculated in the vertical dimension. TVU is a 1D quantity.

Uncertainty: The interval (about a given value) that will contain the true value of the
measurement at a specific confidence level. The confidence level of the interval and the assumed
statistical distribution of errors must also be quoted. In the context of this standard the terms
uncertainty and confidence interval are equivalent.

Uncertainty Surface: A model, typically grid based, which describes the depth uncertainty of
the product of a survey over a contiguous area of the skin of the earth. The uncertainty surface
should retain sufficient metadata to describe unambiguously the nature of the uncertainty being
described.
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Annex C

ASCII

BAG
BODC

CHM
CHS
CIOH
CIRES

DEM
DHN
DOC
DTM

E
F

G
GEBCO
GEODAS
GGC

GIS
GMT
GPS

H
HIPS

I
IBCAO
IHB
IHO
1I0C

J
JAMSTEC
JODC

Acronyms and Abbreviations

American Standard Code for Information Interchange

Bathymetry Attributed Grid
British Oceanographic Data Centre (UK)

Center of Hydrography and Navigation

Canadian Hydrographic Service

Centro de Investigaciones Oceanograficas e Hidrograficas (Columbia)
Cooperative Institute for Research in Environmental Sciences (USA)

Digital Elevation Model

Directoria de Hidrografia e Navegacao (Brazil)
Department of Commerce (USA)

Digital Topographic Model

General Bathymetric Chart of the Oceans
Geophysical Data System

GEBCO Guiding Committee

Geographic Information System

Generic Mapping Tools

Global Positioning System

Hydrographic Information Processing System

International Bathymetric Chart of the Arctic Ocean
International Hydrographic Bureau (Monaco)
International Hydrographic Organization (Monaco)
Intergovernmental Oceanographic Commission

Japan Agency for Marine-Earth Science and Technology (Japan)
Japan Oceanographic Data Centre (Japan)

459




MBES

N

NCEI
NERC
NESDIS
NGDC
NOAA
NOC
NRL

@)
0GC

P

Q

R
RAS
R/V

S
SCICEX
SHOM
SOEST
SRTM

T
TAR
TIN

UNH
URL
UTM

kilometer

Lamont-Doherty Earth Observatory

meter
Multi-beam echo sounder

National Centers for Environmental Information (USA)

Natural Environment Research Council (UK)

National Environmental Satellite, Data, and Information Service
National Geophysical Data Center (USA)

National Oceanic and Atmospheric Administration (USA)
National Oceanography Centre (UK)

Naval Research Laboratory

Open Geospatial Consortium

Russian Academy of Sciences (RUSSIA)
Research Vessel

Submarine Arctic Science Program

Service Hydrographique et Oceanographique del la Marine (France)
School of Ocean and Earth Science and Technology (USA)

Shuttle Radar Topography Mission

Tape Archive software utility
Triangular Irregular Networks

University of New Hampshire (USA)
Universal Resource Locator
Universal Transverse Mercator
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World Wide Web
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